STLMENTS IN THIS DOCUMENT REGARDING THIRD PARTY PRODUCTS OR SERVICES ARE BASED ON INFORMATION MADE AVAILABLE BY THIRD PARTIES. WASP BARCODE TECHNOLOGIES AND ITS AFFILIATES ARE NOT THE SOURCE OF SUCH INFORMATION. THE INFORMATION IN THIS DOCUMENT IS SUBJECT TO CHANGE WITHOUT NOTICE.

Wasp Barcode Technologies, the Wasp logo, InventoryControl and Labeler are registered trademarks and/or trademarks of Wasp Barcode Technologies in the United States and other countries. Other parties’ trademarks are the property of their respective owners.

Software activation system licensed under Patent No. 5,490,216

Terms, conditions, features, hours and contact information in this document are subject to change without notice. Wasp is committed to providing great products and exceptional customer service. Occasionally we may decide to update our selection and change our service offerings so please check www.waspbarcode.com for the latest information.

InventoryControl Install Key ________________________
(Printed on shipped material)

InventoryControl Registration Key ________________________
(Obtained from www.waspbarcode.com/register)
# Table of Contents

Chapter 1 - Getting Started........................................................................................................................... 1

1.1 Introduction.......................................................................................................................................... 1

1.2 User Log On ........................................................................................................................................ 1

1.3 Using the Sample Company................................................................................................................ 2

1.4 Set Up Cycle Overview........................................................................................................................ 3

1.5 Step One - Create Users..................................................................................................................... 4

1.6 Step Two - Enter Company Information.............................................................................................. 4

1.7 Step Three - Define Sites and Locations............................................................................................. 4

1.8 Step Four - Add Users......................................................................................................................... 5

1.9 Step Five - Print Location Labels ........................................................................................................ 6

1.10 Step Six - Enter Suppliers ................................................................................................................. 6

1.11 Step Seven - Print the Supplier Report............................................................................................... 6

1.12 Step Eight - Create Items.................................................................................................................. 6

1.13 Step Nine - Print Item Labels ............................................................................................................ 7

1.14 Step Ten - Add Inventory.................................................................................................................... 7

1.15 Step Eleven - Print the Inventory by Location Report....................................................................... 8

Chapter 2 - Introductory Materials ................................................................................................................ 9

2.1 Barcode Best Practices....................................................................................................................... 9

2.2 What is a Barcode?............................................................................................................................. 10

2.3 Choosing a Label Printer.................................................................................................................... 11

2.4 Designing and Labeling Sites and Locations ..................................................................................... 12

2.4.1 What is a Site?............................................................................................................................... 12

2.4.2 What is a Location?....................................................................................................................... 12

2.4.3 Labeling Sites and Locations....................................................................................................... 12
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5 Identifying Tracking Needs</td>
<td>14</td>
</tr>
<tr>
<td>2.6 Labeling Items</td>
<td>15</td>
</tr>
<tr>
<td>2.7 Using Cost Tracking and Average Costing FAQ</td>
<td>16</td>
</tr>
<tr>
<td>2.8 Using Custom Fields</td>
<td>22</td>
</tr>
<tr>
<td>2.9 System Administrator Information</td>
<td>24</td>
</tr>
<tr>
<td>Chapter 3 - Business Examples</td>
<td>25</td>
</tr>
<tr>
<td>3.1 About Our Business Examples</td>
<td>25</td>
</tr>
<tr>
<td>3.2 Business Example Overviews</td>
<td>25</td>
</tr>
<tr>
<td>3.3 Setting Up Security Privileges Business Example</td>
<td>27</td>
</tr>
<tr>
<td>3.4 Setting Up Sites and Locations Business Examples</td>
<td>30</td>
</tr>
<tr>
<td>3.5 Setting Up Suppliers Business Examples</td>
<td>32</td>
</tr>
<tr>
<td>3.6 Entering Items Business Examples</td>
<td>33</td>
</tr>
<tr>
<td>Chapter 4 - PC Operation Basics</td>
<td>34</td>
</tr>
<tr>
<td>4.1 User Log On</td>
<td>34</td>
</tr>
<tr>
<td>4.2 About the About Screen</td>
<td>36</td>
</tr>
<tr>
<td>4.3 Main Screen</td>
<td>38</td>
</tr>
<tr>
<td>4.3.1 Section A: Toolbar</td>
<td>39</td>
</tr>
<tr>
<td>4.3.2 Section B: Left-Hand Navigation</td>
<td>39</td>
</tr>
<tr>
<td>4.3.3 Section C: Main Functions</td>
<td>40</td>
</tr>
<tr>
<td>4.3.4 Section D: Context-Sensitive Menus</td>
<td>40</td>
</tr>
<tr>
<td>4.5 Update License Screen</td>
<td>43</td>
</tr>
<tr>
<td>4.6 Selecting Sites</td>
<td>45</td>
</tr>
<tr>
<td>4.6.1 How to Select Sites</td>
<td>45</td>
</tr>
<tr>
<td>4.6.2 Source and Destination Examples</td>
<td>46</td>
</tr>
<tr>
<td>4.7 Logging Out</td>
<td>48</td>
</tr>
</tbody>
</table>
12.10.1 Adding Shipping Methods: ........................................................................................................206

12.10.2 Deleting/Printing/Exporting Ship Methods: ...........................................................................207

12.11 Formatting PO and Pick Order Numbers ....................................................................................210

12.12 Email Distribution List ..............................................................................................................213

Chapter 13 - Creating/Editing/Printing Labels ....................................................................................214

13.1 Selecting a Label Printer ...............................................................................................................214

13.2 Using the Labels Menu ..................................................................................................................215

13.2.1 Editing Labels: ........................................................................................................................215

13.2.2 Creating Custom Labels: ........................................................................................................216

13.2.3 Browsing to an Existing Label: ...............................................................................................217

13.3 Printing Labels from the List Screens ............................................................................................218

Chapter 14 - Reports .............................................................................................................................220

14.1 Report Selection ............................................................................................................................220

14.2 Report Viewer ................................................................................................................................221

Chapter 15 - Administration ..................................................................................................................225

15.1 Administration Menu ......................................................................................................................225

15.2 Company Information Screen ........................................................................................................227

15.2.1 Entering Company Information: ...............................................................................................227

15.2.2 Entering Multiple Address Types: ............................................................................................228

15.2.3 Deleting an Address Type: ......................................................................................................229

15.3 Adding Users/Editing Security Privileges ......................................................................................230

15.3.1 Accessing the Security Privileges Screen: ...............................................................................230

15.3.2 Adding Users to the Security Privileges Screen: .....................................................................231

16.3.3 Editing User Profiles on the Security Privileges Screen: .......................................................233

15.3.4 Making Users Inactive: ............................................................................................................234
16.4.2 Inventory Import Format: .................................................................270
16.4.3 Item Import Format: .................................................................271
16.4.4 Location Table Properties: ..........................................................272
16.4.5 Manufacturer Table Properties: ...............................................273
16.4.6 Supplier Table Properties: .........................................................274
16.4.7 Data Type Definitions: ...............................................................275

Chapter 17 - Performing an Audit ..........................................................278
17.1 Auditing Your Inventory .................................................................278
17.2 Audit Flow Overview .................................................................279
17.3 Beginning the Audit .................................................................279
17.4 Using the Audit Screen ..............................................................280
17.5 Reviewing the Not Counted Items Report ....................................283
17.6 Reconciling the Counts ..............................................................283
17.7 Reviewing the Remainder of the Audit Reports .......................285
17.8 Ending the Audit .................................................................285

Chapter 18 - Search Function .............................................................286
18.1 Searching for Information ..........................................................286
18.2 Advanced Find .................................................................288

Chapter 19 – WDT2200 .................................................................291
19.1 WDT2200 - Setup the Device .................................................291
19.2 WDT2200 - Creating the PDT Database ....................................294
19.3 WDT2200 - Sending Data to PDT ...........................................299
19.4 WDT2200 - Receiving Data from PDT ......................................304
19.5 WDT2200 - Data Cycle ..........................................................307
19.6 WDT2200 - Logging On ..........................................................307
Chapter 1 - Getting Started

1.1 Introduction

We recommend that you read the information found in the Introductory Materials section of this Help file and view the Getting Started prior to beginning setup of your system. The Introductory Materials and video tutorials define key terms and explain concepts used throughout InventoryControl. These materials provide valuable information to make the setup process smooth and simple.

In addition to explaining key terms and concepts, the Introductory Materials provide tips for creating your inventory tracking system and provides real-world business examples detailing how you can customize InventoryControl to work best for your needs. You will also find information on recommended guidelines for creating barcodes in the Barcode Best Practices section. As you work through the steps to set up your software you will find links to Business Examples. These examples detail how different business types, using different versions of InventoryControl, setup their sites, locations, items, etc.

After you have reviewed these materials, click the Begin InventoryControl Set Up link below. A series of steps will appear guiding you through the set up process. Each step provides a brief overview of the process along with a link or links to the help topics containing detailed how to and explanatory information.

1.2 User Log On

The Log On screen appears when InventoryControl is first started and when you select File > Log Out.

Complete both fields, then click OK to logon to the system.
The **User Name** field is not case sensitive.

The **Password** field is case sensitive. Asterisks will be displayed as you type the **Password**.

The first time you open InventoryControl you can enter the following information:

- **User Name:** Admin
- **Password:** (blank)

After log on, the password can be changed via **File > Change Password**.

The Admin account, or any other account with Administration Privilege, can use the **Security Privileges** screen to add Users, set their privileges and reset their passwords. For more information on adding users, please refer to the [Adding Users/Editing Security Privileges](#) topic.

---

### 1.3 Using the Sample Company

The **Sample Company** contains a set of data you can use to learn about InventoryControl. You can practice working with the features and functions contained in the software using this data.

You can enter information into the **Sample Company**; however, when upgrading to a new version, this data will be lost. It is very important that you do not enter any information into the **Sample Company** that you do not want to lose. The **Sample Company** is meant for training purposes only and should not be used as your working database.

**Accessing and Using the Sample Company**

On the **Log In** screen, login as usual, making sure you select the **Use Sample Database** checkbox. InventoryControl opens with **InventoryControl - Wasp Inventory Sample Inc.** displayed in the title bar.
You can use the software as normal once logged in. You can create additional items and add inventory, check inventory in and out, create purchase orders and pick orders, etc. On reports, the company name and each address line will be followed by "trial". Mobile devices are not supported by the sample database.

1.4 Set Up Cycle Overview

After you finish installing your software (using the InventoryControl Quick Start Guide as a reference) you will need to set up your system by entering information into the software. This is referred to as a "cycle" because in multi-warehouse installations you will need to repeat steps 3-7 for each site. The set up process may take hours or even days depending on the size of your organization. While this may seem overwhelming, keep in mind that the return on this time investment will pay off quickly. These steps will result in a complete and accurate count of inventory that will allow you to start using InventoryControl to manage your day-to-day business.

Keep in mind that you can continue to use your previous inventory tracking software while you are setting up InventoryControl. The transition to InventoryControl should take place when you are ready to count your inventory and enter the counts into the software.

Before starting this process, set aside a day or two when you can stop using the old system and transition over to InventoryControl. The audit, or inventory counting, step must be done when you are not receiving or shipping goods. Plan to perform the audit on a weekend or after hours, for example.

Set Up Cycle:

1. Design your barcode labeling system and designate barcode label ranges.
2. Import or input sites, locations, suppliers, manufacturers and customers into InventoryControl.
3. Print barcodes and label sites and locations.
4. Import or input items, making sure to designate additional tracking needs like serial number or lot.
5. Use your handheld or a report to do a complete inventory audit.
6. Using the audit results, print barcode labels for items and label every item.
7. Determine the best method of handheld use for your company and implement it.

If the initial setup process seems daunting, there are organizations that specialize in evaluating your needs and setting up your warehouse for you using InventoryControl. If you need to find an organization in your area to help with this process, please call Wasp Support and we will help you find an integrator.
1.5 Step One - Create Users

**Add Admin User** - When you first log on to InventoryControl, you will use Admin as the user name and leave the password blank. This default user profile gives you access to everything in the system. The first step you should take upon logging in is to create at least one additional admin user (**Administration > Security**). The new admin user should have rights to all areas of the system. You should also change the password for the default admin profile. Since the default admin's password is initially blank, it is important to change the password to prevent other users from logging in under this profile.

1.6 Step Two - Enter Company Information

**Enter Company Information** - Next you should enter your company's information (**Administration > Company Info**). On the **Company Information** screen you will enter your company's name and any addresses needed for receiving, shipping, corporate correspondence, etc. The company name you enter on this screen will appear on all reports and in the title bar of InventoryControl. In addition, if you have the Pro or Enterprise version of InventoryControl, the company name and addresses you enter will appear on Pick Orders and Purchase Orders created in the system.

When you set up your company information, you should enter all addresses to which you might receive inventory, ship inventory, store inventory as well as your corporate address and other business addresses. Having these addresses entered will save you and your employees a lot of time when creating purchase orders and pick orders and when moving, picking, receiving, adding and removing inventory.

1.7 Step Three - Define Sites and Locations

**Define Sites and Define Locations** - Now you are ready to begin entering sites and locations into the database. Locations are the areas into which you will assign inventory, while sites contain the various locations. Usually a site is a warehouse or other building, but it can be an office, a truck, a field, etc.

We suggest creating one site for each building or structure that contains inventory. InventoryControl requires that you define at least one site containing at least one location. You can also have multiple sites that contain multiple locations. There is no limit to the number of locations you can assign to a site.

**View Business Examples**

**Note:** WaspNest Inventory only supports one Site.

A location is typically shorthand for a physical place such as a shelf in your warehouse. Commonly used conventions include Location codes like this:

01 02 05 (for Row #, Shelf #, Bin #)

For the purposes of keeping track of your inventory items, your locations should represent the placement within the site. If your site is a warehouse, the locations are shelves or racks. If your site is a building, the locations may be offices. If you have a fleet of trucks, the locations may be containers in the truck. When deciding how to label each location, choose a numbering scheme that can be interpreted when reading just the label. For example, if you have 7 rows of 5 shelves each and each shelf has four levels, your barcode label scheme should look like A010200 or row A, shelf 01, level 02, bin 00. If you have inventory on trucks in containers, the truck can be a site and each bin in the truck is a location. Put a barcode label on the inside of the truck door so the person moving inventory into or out of the truck can just scan and move. The barcode label should have the barcode and the human readable text...
description of the location as well.

A distribution business, for example, typically places inventory at a specific location in one or more warehouses. InventoryControl requires that you define at least one Site containing at least one Location. If you have multiple warehouses, you can set each one up as a Site, then create multiple locations within each site to represent the specific areas where you will be storing inventory. For instance, you might setup a Site as Warehouse 1 containing Locations Shelf 1, Shelf 2 and Shelf 3.

A fleet business might define each vehicle as a Site with multiple Locations (bins, for example) within each vehicle. In this case you could setup a Site as Vehicle 1 with Locations of Bin1, Bin2 and Bin3. Or each vehicle could be a single Location operating out of one or more Sites. For example, the Site might be Docking 1 with locations of Vehicle 1, Vehicle 2, etc.

A retail business might have multiple Locations at one Site or multiple Locations within each of several Sites. InventoryControl has the flexibility to be configured however it best suits your business needs. Remember that though you must have at least one site containing one location, you could have multiple sites that contain multiple locations. There is no limit to the number of locations you can assign to a site.

It is important to note that you can have the same Location code defined at more than one Site - for instance, Warehouse 1 and Warehouse 2 may each have Location codes of Shelf 1 - so always pay attention to which Site you are working with when performing Inventory transactions.

Setting up your locations now will allow you to just pick a location from a list when you begin adding inventory later. It is possible, however, to define locations as you add inventory. If you would prefer to do this, skip to Step 6 - Enter Suppliers.

If you already have location information contained in another database, you may want to use InventoryControl's Import function rather than manually entering in this information.

For additional information on formatting your Location numbers and descriptions, please refer to the topic Barcode Best Practices.

1.8 Step Four - Add Users

Add Users - You should enter all users who will be using the system and you can assign specific rights to each user that limit their activities to certain functions. It is a good idea to give each user his or her own user name and password rather than sharing a single user profile, as this allows you to keep track of who performs specific functions in the system. InventoryControl keeps a detailed transaction history of every action performed in the software. Each time an item is added, removed, moved, etc., the transaction is logged by InventoryControl and is listed with the user name of the person who performed the transaction, the date/time of the transaction and the type of transaction on the Transaction List (Main Screen > Lists > Transaction List).

View Business Examples
1.9 Step Five - Print Location Labels

Print Location Labels - If you have set up more than one location and you will be using a mobile device with an integrated barcode scanner, it is a good idea to create Location labels for each location you have entered into the system. This allows you to quickly scan a barcode label when auditing or adjusting inventory at that location or when adding, removing, picking or receiving inventory to or from that location.

For ideas and examples of how to configure your labels, click here.

You can print labels automatically after creating your locations or you can print from the Location List. After printing your labels, attach them to each location. For example, if your locations are shelves, attach a label to each shelf to identify it.

1.10 Step Six - Enter Suppliers

Enter Suppliers - Suppliers are those businesses or individuals from which you will be obtaining your inventory. Your business might require that each Item in your inventory have an associated supplier. You can have one supplier or many providing you with inventory.

If you already have supplier information contained in another database, you may want to use InventoryControl's Import function rather than manually entering in this information.

View Business Examples

1.11 Step Seven - Print the Supplier Report

Print the Supplier Report - If you have chosen to import your suppliers or manually enter all suppliers prior to adding items, you should print and review the Supplier Report to make sure all the information was entered correctly. To run the Supplier Report, from the Main screen, select the Reports icon. On the Select Report screen, double click Supplier Report.

1.12 Step Eight - Create Items

Create Items - Items represent the actual material or good that you will have in your inventory. The item is a classification that contains information such as manufacturer, suppliers, a description of the item and unit of measure information. The item is not part of your inventory until you add quantity to it and specify a location for it. For example, you might create an Item entry for Mouse - Wireless. Then you can add inventory, or quantity, to that item at a specific location.

On the Create New Item screen, you can assign the item to multiple locations and even designate one location as the primary location for this item. The primary location will then pre-populate the screen when removing, adding, receiving (Pro and Enterprise Version Only) and picking (Pro and Enterprise Version Only) this item.

If you are using the Enterprise or Professional version of InventoryControl, you can also create items that are non-inventory. This is useful if you need to create an item for marketing pamphlets, counter displays or anything you need to have on-hand but don't necessarily want to include in your inventory amounts. In addition, you can create Kit or Assembly Items. Please refer to the topics Assembly Overview and Kitting Overview for more information.
If you already have item information contained in another database, you may want to use InventoryControl's Import function rather than manually entering in this information. For more information on importing locations, please refer to the topic Importing Into the Database.

View Business Examples

1.13 Step Nine - Print Item Labels

Print Item Labels - Labels can be printed directly from InventoryControl via the Item List screen, at the time a new Item is created or you can access Wasp Labeler to edit or create new labels.

1.14 Step Ten - Add Inventory

Add Inventory - Now that your items have been created, you are ready to add inventory, or quantity to those items at specific locations. Adding inventory is often referred to as receiving inventory. You can think of this step as stocking the InventoryControl program with the inventory that is in your warehouse. Remember that inventory is not the same thing as items, even though inventory is made of items. Adding inventory to an item means you are adding quantity to that item.

When you are adding inventory, you will enter information specific to your inventory such as Location, Quantity, and Cost as well as specific tracked by information such as serial number, date codes and pallet codes. Each time you add inventory for an Item, the transaction is stored separately in InventoryControl allowing for multiple Locations and cost averaging.

If you already have inventory information contained in another database, you may want to use InventoryControl's Import function rather than manually entering in this information.

A Note on Importing Inventory

If you choose to import your inventory you MUST run a backup of your system BEFORE you import the inventory data. Name the backup file something that indicates it was run immediately prior to importing inventory so you can easily identify it if needed later. If you find errors on your import file after you import inventory, you will need to restore this backup to return the system to the pre-import state (your other information will be there). After restoring, you can fix the import file as needed and re-import. ****DO NOT re-import after you have already imported inventory without first restoring the backup.**** Re-importing over existing inventory data will add more inventory to your items rather than fixing problem data.

Congratulations! You are now on your way to populating your inventory database. To add more Items to your database, just return to Step 4 to setup your new Item, then Add your inventory for that Item.
1.15 Step Eleven - Print the Inventory by Location Report

Print the Inventory by Location Report - Printing the Inventory Location Report will allow you to check that your inventory has been entered correctly.

After you have added your inventory you are ready to begin using InventoryControl. Now you can setup your mobile devices, if needed, and begin keeping track of your inventory.
Chapter 2 - Introductory Materials

2.1 Barcode Best Practices

In InventoryControl, when you are asked for a number to identify sites, customers, items, locations etc., you should always use a short sequential set of numbers or numbers and characters. Enter the full text description of the site or location in the description field, not the number field. These numbers can then be printed as a barcode and used to scan locations into mobile devices. You should estimate the largest number of sites or locations you will have and pick a range of numbers that are reserved for each. For instance, if you have up to 60 sites, you should reserve 100 to 199 for your sites. Each new site you enter will get a number from this range. If you want to more closely tie the number to the site, add a one or two letter designation to the end of the site number.

For example, use 100US to designate the main US warehouse and 101UK for the warehouse in the United Kingdom. If you expect to have a few hundred suppliers, reserve 1000 to 2000 for suppliers. Manufacturers can have 500 to 599. Items should start at 20000. This range reservation serves two purposes. First, it allows those who know the ranges to easily distinguish a designation for the warehouse from the designation for an item if all they see is a barcode on a paper or a box. Second, reserving a range of numbers makes the process of deciding what number to use for new designations much easier. If you add a manufacturer and you already used 512, the next is 513. For example, if a stray box is presented to the warehouse manager and she sees barcodes with 100US C050100, she knows this box was stocked in the US warehouse on row C shelf 05 bin 01.00. The box may also have a barcode with 20104 which she knows is the item number and can be used to put the item back into inventory. Without these barcodes, the box might have to be opened to identify the item and then someone would have to track where it came from and where to put it away.

Another thing to consider when creating your numeric representation for locations and items is that some devices only support a reduced set of characters. Some mobile devices, such as the WDT2200, do not have a keyboard that can support lower case letters or the entire range of special characters. With these devices, if your item number is 10000(1) you will not be able to type the item number or scan in the number from a barcode because the parentheses character is not supported. All o

Our internal barcode labels use Code 128 which supports both lower and upper case characters, all numbers and many special characters.

InventoryControl uses the symbology called Code 128 for all the pre-built labels. All the scanners and mobile devices Wasp supplies can read Code 128. Best practices suggest you use Code 128 because it supports all numbers, upper and lower case characters and most special characters. It also reduces the size of most common barcodes.
2.2 What is a Barcode?

A barcode is a graphical representation of a set of numeric or alphanumeric characters that can be read by a barcode scanner.

123 becomes: 

Whse1 becomes: 

Assigning a permanent barcode to each site, location, item, supplier and customer creates an environment where a mobile device can be used to easily keep track of inventory movements and alleviates the problem of data-entry errors.

Barcodes get wider with the amount of numbers and characters you want represented by them. A barcode’s width is determined by the amount of numbers or characters represented by the barcode. Some barcode scanners have a limited width that they can read. If you have very long item numbers or location numbers you may need to reconsider the numbering scheme or the scanner you are using. Also be aware that many of the less expensive barcode readers do not read barcodes that are bent, at an angle, too small or damaged. Consider the possible disposition of your barcodes before choosing a scanner.

There are many different barcode formats or symbologies. The different symbologies can be thought of as different fonts. The same characters are represented by different symbologies in different ways. For example, the two symbologies below represent the same information (Whse1).

These different formats exist to provide ways to compress more data into smaller space, to represent a different set of characters or to enable scanning at different angles or distances. InventoryControl uses the symbology called Code 128 for all the pre-built labels. All the scanners and mobile devices Wasp supplies can read Code 128. Best practices suggest you use Code 128 because it supports all numbers, upper and lower case characters and most special characters. It also reduces the size of most common barcodes.

Barcodes should be printed using a barcode printer or, if you are using Wasp Labeler, using a high quality laser or ink jet printer. You want the barcode label to be high quality because low quality barcodes are
harder to scan and usually do not last long. InventoryControl is bundled with Wasp Labeler, which can print to a regular printer or a barcode printer. Remember to keep plenty of extra label stock and printer ribbons to make sure you never run out. To determine how to best provide good quality labels for daily use, consider the kind of printer you are using.

2.3 Choosing a Label Printer

Organizations that have several hundred new inventory items a week will need to have a dedicated barcode label printer at each site. They should use a good quality label media and use the feature built into InventoryControl that automatically prints inventory tags as soon as the item is received on the PC. The printer needs to be rates for several hundred labels a day and needs to print fast enough to avoid costly slowdowns that can be caused when waiting to put away items after they are received because the labels are not printed. Look for models that can print 4-6 inches per second and can handle media up to 4" wide. Wasp's WPL606 line of printers work well in warehouse conditions.

Many organizations will not need a high-end printer but will still save money and will get better quality long-lasting labels if they use a desktop barcode label printer. These printers allow you to print one or a hundred labels without waste and they are quicker and cheaper than using a standard printer. Wasp's WPL305 line of printers work great for smaller volumes of printing.

A laser printer using standard sheets of labels may work great where product turnover is slow, conditions are well-controlled or new items are not added often. In this case, use the included Labeler software to indicate what label stock is being used. Labeler ships with many standard label templates pre-configured. Pre-print a few pages more than what you have in stock to prepare for new items.
2.4 Designing and Labeling Sites and Locations

2.4.1 What is a Site?

The term Site is used to describe any grouping of locations where you plan to store and track inventory. Usually a site is a warehouse building but it can be an office, a truck or a field, etc.

Site design may be simple if your entire inventory is stored in your two warehouses. If this is the case you can just use the name of the warehouse as the site description. Use a simple site number like W100 in case you ever need to type the site number into a handheld device. For the site number you can use any easily identifiable information about the site like its address or its designation like 140010th or W1400.

Since this product only has two levels of location tracking, you need to design your sites to describe all the levels above the actual physical location of the inventory.

If you have trucks that are tied to a warehouse you can make their site description a composite of the warehouse and truck number, W1400T12. If you have different buildings containing various rooms in which items will be stored, make a composite name of the building and room number, B201R10. You should always make the site number something that can be barcoded so that it can be printed and scanned. See Barcode Best Practices.

2.4.2 What is a Location?

For the purpose of keeping track of your inventory items, your locations should represent the placement within the site. If your site is a warehouse, the locations are shelves or racks. If your site is a building, the locations may be offices. If you have a fleet of trucks, the locations may be containers in the truck. When deciding how to label each location, choose a numbering scheme that can be interpreted when reading just the label. For example, if you have 7 rows of 5 shelves each and each shelf has 4 levels, your barcode label scheme should look like A010200 or Row A, Shelf 01, Level 02, Bin 00. If you have inventory on trucks in containers, the truck can be a site and each bin in the truck is a location. Each bin should get a numeric location designation like 100, 200 or 200. If you do not have locations within the truck, each truck can be a location: T1, T2, T3. Put a label on the inside of the truck door so the person moving inventory into the truck can just scan and move. The label barcode should have the barcode and the human readable text description of the location as well.

2.4.3 Labeling Sites and Locations

Every location where inventory can be stored in your warehouse should have a printed barcode securely attached near the location. This is important because adding, removing or moving inventory using the InventoryControl software requires a location. All processes that require a location are both sped up and made more accurate if you use a barcode to identify each location. Also using a consistent numbering scheme makes finding items in the warehouse much easier. These labels can be stuck to the frame of the shelves, attached to the bin, put on a card and hung from the racks or even stuck to the floor as in the example below:

The first step for designing your labels is to decide on what type of label to print the barcode. A variety of barcode label stock exists that can withstand any environment. There are two kinds of barcode label
printers. Thermal transfer printers that work like an ink jet or laser printers that print by transferring ink from a ribbon to the label paper (stock). Direct Thermal printers do not have a ribbon but use heat to print onto a special label stock. The thermal transfer printers are more expensive to operate but can print on a wider array of label stock and the labels last longer in various kinds of environments. Direct thermal labels are cheaper but may fade if exposed to friction, heat or direct sunlight. Most barcode printers will print both thermal transfer and direct thermal. You want a printer that will do both because what you are using the label for will determine if you should use thermal transfer or the direct thermal. You may need both kinds of labels available for printing.

For all kinds of organizations, you may want to consider using the cheaper direct thermal labels for identifying individual items because you will put them on the packaging of items that will be discarded by the consumer or on item tags used to identify the item at removal time. Use the cheaper label stock when it will be used and discarded. It is often cheaper to reprint a few labels on the cheaper stock if one label is damaged than to use the more expensive stock. You should label your warehouse locations with labels that will last and can take some abuse because you don't want to have to continually reprint and replace these labels.

If your labels contain information you want to be permanent, such as serial numbers, you should use thermal transfer labels on a high quality label stock or, perhaps, polypropylene and a resin ribbon. The importance of the label will determine what stock it is printed on. A serial number that you use for returns or contract maintenance needs to be readable for a long time.

If your labels will be exposed to heat because of the device they are attached to or through exposure to the sun you should use thermal transfer labels. For most locations in a fleet vehicle you should use thermal transfer.

If the majority of your labels are disposable any cheap stock will work fine. Often the major issue is how to apply the label to the item so that the scanner can read the barcode. Make sure the barcode is attached to a flat surface in a place where it will not get scratched or damaged.

Before you label your locations you need to come up with a numbering scheme for each location and item. In InventoryControl there are two fields that describe where the item is: Site and Locations.
2.5 Identifying Tracking Needs

Sometimes it is important to be able to associate an exact item or range of items with an exact customer, serial number, date code or shipment date. This can be important for support and maintenance purposes or for recalls. Often larger cost items that have a warranty or support contract are tracked by serial number so that if the item is sent back for maintenance you can be sure you are not fixing a product that is out of warranty. Some items need to be tracked by lot or date code because the batch they are in is important or they are perishable.

InventoryControl allows you to specify up to four required tracking fields (Serial Number, Lot, Date Code and Pallet) and three optional tracking fields (PO, Supplier and Customer). Selecting a tracking field means that when you process an add, remove, move, audit, pick or receive for this item you will be forced to specify a value for the tracking fields you specified. The three optional tracking fields are always available when Adding and Removing items and can be filled out as needed. You can also select to make these optional fields required on the Create New Item screen. When you select to use one of the optional fields by selecting it on the Create New Item screen the field becomes required for that item. You can select tracking fields on the Edit Item screen as long as no inventory has been added to the item.

Serial Number is the most common and is different from the rest of the tracking fields. Serial Numbers must be unique for each piece of inventory. When an item is tracked by serial number, a unique serial number must be entered for each individual piece of that item you enter into inventory. When the item is removed or moved, the system will also require the serial number. This allows the location and movement of the item to be tracked exactly. The other tracking fields are not required to be unique. If you are tracking by lot you could add 100 items with lot number 206.

Date Code is used if the item has an expiration date or production date that is important for recalls or tracking. Do not use the Date Code field to track when an item is added to InventoryControl. Each Add transaction in InventoryControl is time-stamped to allow you to track when an item was added. To track when an item is added, view the Transaction List (Main Screen > Lists > Transactions) or run the Transaction Report.

There are also three optional tracking fields: PO, Supplier and Customer. As mentioned above, these fields are special fields for the Add and Remove functions that can be filled out but are not required unless you make them required when the item is created.

The required and optional track by fields can be renamed to reflect the names you use. For more information, please refer to the topic Editing Field Names.

After inventory is added to an item, the selections you made to the four tracking fields cannot be changed without first removing all inventory from that item.

<table>
<thead>
<tr>
<th>Tracking Fields Best Practices:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Make sure you specify what you want to track before adding inventory.</td>
</tr>
<tr>
<td>• Make sure you print a label for each track by field you have selected to use and attach them to each item. If the labels are not physically attached to each item, it will be very difficult for you to keep track of which items should be tracked by a specific field.</td>
</tr>
</tbody>
</table>
2.6 Labeling Items

Just as every location should have a barcode, each individual piece of inventory needs a barcode. You should print your item numbers on labels and put them on each individual item before they are put away on a shelf. You get the same time saving and accuracy benefits from labeling inventory items as you get from labeling the locations, but on a greater scale. Sometimes it is not feasible to have a label on each piece of inventory because the item is too small. In this case, put the item's barcode on the container in which the item is stored on the shelf. The label should have the item name as well as a number representing the item encoded as a barcode as in the example shown below:

```
20104
```

It is important not to use a text description or abbreviation as the item number because a numbering scheme is more flexible and easier to encode to a small barcode. Most labeling software can be set up to use a number for the barcode and to print the description or item name under the barcode. InventoryControl allows you to print your item barcodes as the inventory comes in or pre-print barcodes from the Item List screen to apply.

If you pick a numbering scheme and stick to it you will find that you start to recognize the numbers as easily as the names. The specific numbering scheme you use to identify the items can start at 1000 and count up, if that is what you want. Some companies assign all or part of the SKU number they are issued as the item number. Because item models may change over time or sub-models may become available, you may need to use a numbering scheme that can adapt without losing the item's identity. Many companies allow gaps in the numbering scheme to allow for this growth and for changes. For instance, one item number is 19500 and another is 19600. When an optional feature is added to the 19500, it is assigned 19510 since both are kept in inventory. The 19600 item is discontinue and another model takes its place and is assigned 19601. This way, the 195xx line of products is maintained and are easily identified with each other.

**Recommended Barcode Ranges**

<table>
<thead>
<tr>
<th>Barcode Label</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sites</td>
<td>100-199</td>
</tr>
<tr>
<td>Manufacturers</td>
<td>500-599</td>
</tr>
<tr>
<td>Suppliers</td>
<td>1000-2000</td>
</tr>
<tr>
<td>Items</td>
<td>20000 and up</td>
</tr>
</tbody>
</table>
2.7 Using Cost Tracking and Average Costing FAQ

What cost methods are used by InventoryControl?

InventoryControl provides four costing options:

- **Moving Average** - When this method is used, the average cost of a particular item is recalculated based on each purchase.

  **Example:** You purchased 100 computers for $500 each. When you have 10 computers left in stock, you purchase 100 more, but now your cost for the computers is $600 each. InventoryControl will calculate the cost of this item as following:

  Cost of original computers = 10 x 500 = $5,000  
  Cost of new computers = 100 x 600 = $60,000  
  The combined cost of all of the computers is $65,000  

  Average cost of all of this type of computer that you have in inventory (110 computers) is $65,000 / 110 = 590.91

- **First-In, First-Out (FIFO)** - When this method is used, the inventory that is added first is removed first.

  **Example:** If you added or received 50 Barcode Laser Scanners on the 1st, 8th and 15th, you would end up with 150 scanners. If on the 17th you remove 60 scanners, all of the scanners that came in on the 1st and 10 scanners from the 8th would be removed because the scanners on the 1st were first in and, therefore, will be first out. Next to be removed would be scanners from the 8th.

  This also is how the average cost is calculated. If the scanners on the 1st cost $300 each and the scanners on the 8th and 15th cost $320 and $315 each, the average cost on the 16th would be $311.67.

  50 scanners x $300 = $15,000 (from the 1st)  
  50 scanners x $320 = $16,000 (from the 8th)  
  50 scanners x $315 = $15,750 (from the 15th)  

  $46,500 / 150 = $311.67 average cost

  On the 17th you removed 60 scanners so the average cost will become:

  40 scanners x $320 = $12,800 (from the 8th)  
  50 scanners x $315 = $15,750 (from the 15th)  

  $28,550 / 90 = $317.23 average cost

  Inventory valuation is calculated by multiplying the quantity by the average price. The inventory value on the 16th is $46,000 or 150 x $311.67. After 60 are removed the inventory value is $28,550 or $317.23 x 90.

- **Last-In, First-Out (LIFO)** - When this method is used, the inventory that is added last (most recently) is removed first.
50 scanners $300 = $15,000 (from the 1st)
50 scanners $320 = $16,000 (from the 8th)
50 scanners $315 = $15,750 (from the 15th)

$46,500 / 150 = $311.67 average cost

On the 17th you removed 60 scanners so the average cost will become:

40 scanners $320 = $12,800 (from the 8th)
50 scanners $300 = $15,000 (from the 1st)

$27,800 / 90 = $308.89 average cost

- **Legacy Method** (the method used in previous versions of InventoryControl) - This is the method used in previous versions of InventoryControl. The legacy method uses FIFO and manages cost by location and track by level.

---

**How do I determine my Stocking Unit?**

The quantity of an item on all screens and reports is counted using the Stocking Unit you specify or eaches (ea.) if you do not specify a unit. The stocking unit can be entered for each item on the **New** or **Edit Item** screen’s **Additional** tab (shown below):

When you enter the stocking unit, you need to pick the smallest unit of measure that you will ever use to remove a whole item. A good test to use when deciding what the stocking unit should be is to ask yourself how you count and refer to one unit. Think about what your answer would be if you were asked to count how many of this item you have. If the answer is 100 feet of rope, for example, "feet" or "ft" is the stocking unit. If the answer is 20 scanners, then "ea" is the stocking unit because "each" is common when the unit itself is not a standard unit of measure. If the answer is 100 boxes or nails, then "box" or "bx" is the stocking unit.
We will address what you do if you remove in partial quantities or purchase the item in larger quantities than the stocking unit later in this topic.

What is the Cost for my item?

When you input cost for an item into the New or Edit Item screen, the cost is your cost for purchasing one of the stocking units. If one barcode laser scanner costs $300 you would enter 300 into the cost field.

If you remove fractional quantities of an item, the cost should still be for one whole stocking unit. Let's use rope as an example. Normally the rope is sold in increments of a foot so the Stocking Unit is ft. Each foot costs $0.12 making the cost 12 cents. Continuing the rope example, assume that exact multiples of feet are rarely sold. In this case you could change the stocking unit to inches since that is the lowest unit or measure. Since InventoryControl does not do the math for you when determining the quantity you are adding and the cost at add time, you should choose one that makes it easiest for you to add and remove. Regardless of the stocking unit you choose, the cost should be entered for one whole stocking unit.

How is Cost handled when I Add Inventory on the PC?

When inventory is added on the PC, it is assigned a cost for each 1 unit. If you add 20 scanners in the Add screen, the cost will automatically default to the Item Cost (the cost you entered on the New or Edit Item screen > General tab).
If your cost for this add is different from the cost on the item record, you can change the cost on the Add screen to represent the actual cost.

For example, if you purchased these 20 scanners for a discount, change the Cost on the Add screen before you add the items. In the example below, the user received a $50.00 discount on the whole order for ordering 20 scanners so the Cost entered on the Add screen should be $297.50.

20 scanners x $300 = $6,000 - $50 = $5,950 / 20 scanners = $297.50 per scanner.

You are still putting the individual scanner price into the Cost field and you must do the math to make sure it is the correct price.

Tips!

- Since there is limited space on the reports and screens, we suggest you always put in an abbreviation for the stocking unit.

- If you don’t enter a cost when you add items or if you put in the wrong cost, there is no way to edit that transaction and change the price after it has been completed.

- Changing the cost on the Add screen does not change it on the Edit Items screen. The next time you add Barcode Laser Scanners, for example, the cost will still default to $300. If you want to change the default cost you can change the cost on the Edit Item screen by going to Main Screen > Lists > Item. On the Item List, select the item you want to change and then click the Edit button. You can then edit the cost. This only changes the cost that is shown automatically the next time you add an item.

- The List Price and Sale Price fields on the Create New Item screen are for information purposes only. These fields are not used on any reports.

What is the Cost for Order Units Per Supplier?

In the Professional and Enterprise versions of InventoryControl you are able to specify multiple Order Units per Supplier of an item. When you enter an Order Unit that is different from the Stocking Unit, you are telling the system that you are ordering in one unit but when the items are received they will be broken into the different units.

For example, if you order your Barcode Laser Scanners in boxes of 5 but your stocking unit is Each, you need to specify the cost of a box of 5 when you create the Order Unit Settings on the Create New or Edit Item screen, Manage Suppliers tab, as shown in the image below:
How is Zero Cost Inventory Handled?

If inventory is added or received at $0, that quantity is ignored for average price and valuation purposes. The only way stock gets added at $0 is if you import inventory or specify a $0 cost at add or receive time.

50 scanners x $300 = $15,000 (from the 1st)

50 scanners x $320 = $16,000 (from the 8th)

1 scanner was found and added to inventory at $0

50 scanners x $315 = $15,750 (from the 15th)

$46,750 / 150 = $311.67 average cost
The average cost is not $309.60 ($46,750 / 151). Since there is no way to edit the cost of an add or receive after it is processed, InventoryControl ignores the $0 cost adds. If an item is accidentally added at $0 cost the average and valuation would be incorrect until that item is removed through FIFO.

If you do want $0 cost items to be included in the average you can add them at $0.01. Although this would not produce an exact average or valuation, it would have the same effect as averaging in $0 cost items over time.

Inventory that is added using the Adjust screen is added at the average cost for that item at the time of the adjustment. This way the average is not affected since, in most cases, the cost of that item is not known.

Inventory valuation includes the zero cost items when it calculates. The valuation is the number of units times the average price.

$311.67 x 151 scanners = $47,062.17

**How is Cost Handled when Receiving against a Purchase Order?**

If you have the Pro or Enterprise version, you can create a purchase order (PO) and receive against that PO. When you do this, the stocking unit’s cost is calculated from the cost that is on the PO. Please refer to [Purchase Orders Overview](#) for more information on using Purchase Orders.

**How is Cost Handled When Adding and Receiving on the Mobile Devices?**

If you are adding inventory on a mobile device, the cost will transfer as either the Item Cost or the Average Cost, depending on the selection made on the Options screen.

Keep in mind that there is no way to change the price after the handheld transactions are processed on the PC.

If you have the Enterprise or Pro version and the inventory is received against a PO on the handheld, the item cost is calculated from the cost on the PO. If the final cost is different from what was put on the PO you can edit the handheld transactions as described above.

**How is Cost Handled when Importing Inventory?**

Inventory does not import with a cost. If you intend to use cost you should manually add your inventory using the Add screen and specify the cost. Usually you can calculate the average cost of your existing inventory and it is recommended that you use the average cost number to start with.
2.8 Using Custom Fields

InventoryControl allows you to create custom fields on your Items, Sites, etc. This enables you to capture information that is specific to your business needs. The Custom Texts and Custom Numbers and Dates tabs can be found on each of the following screens:

Create New Customer

Create New Manufacturer

Create New Item

Create New Site

Create New Location

Create New Supplier.

Note: The Edit Field Names option on the Options screen must be enabled in order to enter custom text, numbers and dates. For more information on the Options screen, please refer to the Options Screen topic. Below is an example of the Custom Texts tab found on the screens mentioned above:

Note: The fields seen above are not visible when the Edit Field Names option is turned off and no customizations have been applied.

Custom Numbers fields will accept values ranging from -999999999999999.9999 to 999999999999999.9999.
Custom Dates will be displayed in the same format as found elsewhere in the product: "day of the week, month dd, ccyy"

Example:

In this example, with the Edit Field Names option enabled, we have clicked on the Custom Text 1 label (on the Custom Texts tab of the Create New Customer screen) to edit it. The Form field is grayed-out because this label only occurs on the Customer screen.

![Customize Field window]

Click OK to save the customization or Cancel to abort.

When the Edit Field Names option is subsequently disabled, the Customer Screen > Custom Texts tab appears as shown below:

![Create New Customer window]
This field will also be seen in the Edit Customer screen.

---

2.9 System Administrator Information

Knowledge Base Available to Provide Answers and Solutions

The Wasp Bar Code Knowledge Base is available to help you troubleshoot database issues. To access the Knowledge Base, go to www.waspbarcode.com/support, then select Knowledge Base.

Video Tutorials and Printed Manual

The video tutorials can be found in the How to Videos folder and a PDF version of the printed manual can be found in the Quick Start Guides folder on your installation CD. You can also access the video tutorials from the internet at: www.waspbarcode.com/videos.

Changing the System Administrator Password Can Affect Repair Installs

The System Administrator database password must be blank. If you change the System Administrator database password, you will not be able to replace database files.

Supported Mobile Devices

Data can be sent to the PC from any of the two supported devices: the WDT2200 and Windows Mobile Devices, including the WDT3200, WDT3200II and WPA206.
Chapter 3 - Business Examples

3.1 About Our Business Examples

Throughout the help topics you will see links to business examples. These examples outline three hypothetical companies that represent generic business models and how each would commonly use this product. Find the example company that most closely resembles your business and study the scenario included for it in each section of this document. Remember that even though one the example companies may not exactly match your business, these example are broad enough that at least one should encompass all or part of your business needs.

Each of the three companies uses a different version of InventoryControl. The three versions are:

- **Standard** - Contains a wide range of options to help you track your inventory including automatic notification of low-stocked items, check in/out capabilities, add/remove feature, tracking and audit as well as full access to mobile devices.
- **Professional** - All of the features of the Standard version plus it allows for multiple PC's on the network to run InventoryControl. Pick Order, Purchase Order and Receiving capabilities are available along with the ability to assign multiple suppliers to each item.
- **Enterprise** - The top-of-the-line package, Enterprise incorporates all of the benefits of the Professional edition and is installed on your company's SQL server.

**Note:** Even though our example distribution company is using the Enterprise version of InventoryControl, this does not necessarily mean that all distribution companies should use this version. The version of InventoryControl used should be based on your business needs, rather than your business type.

3.2 Business Example Overviews

**Distributing - Enterprise Version of InventoryControl**

**Basic Needs:**

- Multiple Sites and Locations
- Multiple computers running InventoryControl
- Multiple mobile devices in each Location
- Preferred suppliers for items
- Item tracking by serial number and pallet code
- Pick, Receive, Move, Adjust, Add, Remove and Audit at the PC and on the mobile devices

Sebastian Distributing has been in business for many years and has previously used a different inventory software. They have a great deal of inventory in multiple warehouses that they need to manage with InventoryControl. Each warehouse will be a site with multiple locations. The supervisor of each warehouse will use a computer equipped with InventoryControl, but the general manager will be the one who has full administrative privileges. In addition, they have preferred suppliers they would like to associate with each item in their system and will be creating pick and purchase orders as needed. To accommodate all of these needs, they have purchased the Enterprise version of InventoryControl.

Workers in the warehouses will be issued handheld mobile devices to scan barcode labels when receiving goods from suppliers and picking goods for shipment.
Fleet - Professional Version of InventoryControl

Basic Needs:

- Multiple Sites, Multiple Locations
- One PC running InventoryControl
- One mobile device at each Site
- Inventoried and Non-Inventoried Items
- Track some inventory by serial number
- Pick, Receive, Move, Adjust, Add, Remove and Audit at the PC and on the mobile devices.

Rusty's Cable Service has been using a different inventory software. They consider the vehicles to be sites with one location and a storage facility is another site with multiple locations. Most of their inventory is kept in the vehicles. They are looking for a way to easily set up this site/location relationship and to keep track of inventory as it comes into the storage facility, is transferred to the vehicles, and is sold to a customer.

Their inventory consists of items that will eventually be sold to customers such as cable boxes, remotes, and various types of cable as well as items that will remain in inventory, such as tools and other installation equipment. In addition, they have non-inventory items such as pamphlets and cable guides. They want the ability to track cable boxes and remotes by serial number. They also want to equip each driver with a mobile device that can be used to add, remove, move and adjust items as needed.

Mid-sized Reseller - Standard Version of InventoryControl

Basic Needs

- One Site, Multiple Locations
- One PC running InventoryControl
- No mobile devices but a barcode scanner is used at the PC.
- Add, Remove, Adjust, Move and Audit

The example used here is an antique reseller, but this information applies to many different types of businesses, such as second-hand shops, hobby shops, beauty salons, etc., and even small medical/veterinarian businesses who want to track pharmaceuticals and other supplies.

Brady's Bargains is a mid-sized antique reseller with one site and two locations: the storage area and the sales floor. They currently do not have an inventory program and have been keeping up with inventory manually using Excel spreadsheets. They will not be creating purchase orders or pick orders and do not need the ability to assign multiple suppliers to an item, therefore, they have chosen the Standard version of InventoryControl. In addition, Brady's Bargains will not be using mobile devices; they will be inputting information directly into the PC. This shop will be using InventoryControl in conjunction with QuickBooks for their accounting needs and with an unrelated POS system. It is important to note that though InventoryControl does have scanning capabilities and tracks inventory, it is not a POS system and does not perform inventory billing.
3.3 Setting Up Security Privileges Business Example

**Note:** For step by step instructions on adding users, please refer to the topic Adding Users/Editing Security Data.

**Business Type: All** - This example can apply to all business types and InventoryControl versions.

**Step 1 - Prior to adding sites create at least one admin user:** Sebastian Distributing has two warehouses into which they receive goods from suppliers. They then ship those goods to various customers around the country. The manager Pat will be the primary user of the InventoryControl software and will keep track of inventory movements by running reports. Pat will also serve as the system administrator and will take care of maintaining user profiles, creating backups and other administrative tasks. Pat should set herself up with administrative privileges upon accessing the system for the first time. This will set up one administrator besides the default administrator profile. Changes to Pat's user profile do not go into effect until she logs back in again. After setting herself up in the system, Pat should log out of InventoryControl, then log back in using her new user name and password.

Since Pat will have access to all sites, the **User can access all current and future sites** option should be checked. As Pat adds Sites, she will automatically have permission to all of them.

Below is an example of Pat's Security privileges:
Step 2 - After adding sites and locations continue adding users: When she has completed entering her sites and locations, Pat continues setting up security profiles for her employees who will be using InventoryControl. She oversees a supervisor at each of her two warehouses, which are her sites. Each supervisor will need to occasionally log on to the PC to perform basic functions such as manually adding, removing or adjusting inventory, performing audits, checking inventory in and out to customers, etc., and also creating pick orders and purchase orders as needed. The supervisors need access to most of the system but do not need full administrative privileges as they will not be creating users, backups or run reports.

Each of these users should have access only to the warehouse were they work. Below is an example of the supervisor's Security screen:

Within the warehouses there are several workers who will be using mobile devices to add and remove inventory and to perform audits. These workers will use InventoryControl exclusively on the mobile device and will not need to log on to the PC.

These workers only need access to specific locations.

On the next page is an example of the warehouse worker's Security screen:
Keep in mind that you should set up each worker with his or her own user name and password. You can use the **Copy User** feature (*Edit > Copy User*) to quickly add profiles for users with the same settings. This allows you to retain the privileges you have selected after entering a new **User Name** and **Password**.
3.4 Setting Up Sites and Locations Business Examples

Note: For step-by-step instructions on adding sites, please refer to the topic Creating New Sites. For step-by-step instructions on adding locations, please refer to the topic Creating New Locations.

Business Type: Distributing - Multiple Sites/Multiple Locations

Sebastian's Distributing has two warehouses. Each warehouse contains various bins, shelves, etc that will physically contain the inventory. Since this business has multiple warehouses, each warehouse can be setup as a Site, then multiple locations can be created within each site to represent the specific areas where inventory will be stored.

They want to set up their site names based on the city where the warehouse is located and their location names based on where the inventory is kept within the site. However, they also want the ability to scan their sites/locations using the handheld barcode scanners, so they know the site/locations should be a short combination of numbers and characters. Since their warehouses are located in Guthrie, Oklahoma and Plano, Texas they want the Site Description to be Guthrie Warehouse and Plano Warehouse. The Site Codes are set up as numbers: 100G for the Guthrie warehouse and 101P for the Plano warehouse. They follow a similar pattern with their locations. The Location Description details where and what the location is (Guthrie Warehouse, Row A, Shelf 01, Bin 00) and the Location Code is a scannable abbreviation of this (GA0100).

Although this business has only two sites, it has many locations; therefore, they create a .csv file of the sites and locations by exporting this information from the old inventory system and importing it into InventoryControl. For details on importing, refer to the topics Importing Into the Database and Import Specifics/Database Properties. After importing, each site and location should be manually reviewed in InventoryControl to make sure all information is included.

Business Type: Fleet - Multiple Sites/Multiple Locations with From/To Sites Set on the Mobile Devices

The owner of Rusty's Cable Company has narrowed down his options for setting up his sites and locations to two possibilities. He can define the base garage as the site with each vehicle being a location, along with a storage area setup as a location as well. In this instance the site could be named Docking1 and the vehicles set up with names consisting of the abbreviation VEH followed by the last four digits of the VIN number for that vehicle. Alternatively, each vehicle could be set up as a site with one location. For example, the site might be VEH plus the last four digits of the VIN, such as VEH1234, with locations being the various bins and shelves within the vehicles. The flexibility of the site/location design allows companies such as Rusty's fleet business to conform the software to fit their needs.

Rusty has decided to set up his storage area as a site with locations of shelves and his vehicles as sites with one location because he knows that he can use the Site Configuration screen to make each mobile device specific to a vehicle. The Site Configuration screen on the mobile devices allows him to designate one site as the From (Remove, Move, Pick) site and one as the To (Add, Move, Receive) site. He can make the From and To sites the same sites, if needed.

Since the usual transfer of inventory for his business flows directly to the vehicles via add/receive, then to the customer via remove, he can set up the From and To sites as the specific vehicles. When his employees then use the device, any lists and searches are limited to the locations contained in that specific vehicle when adding or removing inventory. If employees need to move inventory from the
storage area to a truck, they can quickly change the settings on the Site Configuration screen and make the From site the storage area. Using the Site Configuration screen saves the employee the time it would take to filter through inventory in all sites. For detailed information on the Site Configuration screen on the PC please see the topic Selecting Sites. For detailed information on the Site Configuration screen on the mobile device, please see the topic WDT2200 - Site Configuration or Windows Mobile Device Site Configuration.

In addition, since Rusty wants his employees to be able to scan sites and locations, he makes sure his Site/Location Codes are short sets of numbers and characters and his Site/Location Descriptions are longer, more detailed descriptions of the code. For example, a Site Code is VEH1234 and the Site Description is VIN 789001234 - White Ford Econoline.

---

Business Type: Reseller - One Site/Multiple Locations

Brady's Bargains has multiple locations at one site. The store itself is set up as the site with locations consisting of areas on the sales floor and areas within a storage area. The manager manually inputs the site and locations using the Create New Site and Create New Location screen. Though they will not be using mobile devices, they do have a barcode scanner at the PC that will be used to scan labels on items. Knowing this, they make sure they set up their Site and Location codes to be scanner friendly. They have set up their Site Code as 100 and the Site Description as Main Store. Their Location Codes follow the pattern of SFA2R12 with Location Descriptions of Sales Floor, Aisle 2, Rack 12.
3.5 Setting Up Suppliers Business Examples

**Note:** For step by step instructions on creating suppliers, please refer to the topic [Creating New Suppliers](#).

**Business Type: Distributing and Fleet - Multiple Suppliers for Each Item**

Sebastian Distributing has established relationships with many different suppliers to obtain their goods. Which supplier they use for a particular item varies depending on how much they are ordering and what Site (warehouse) they are ordering for. Due to this, they want to be able to associate more than one supplier with each item and be able to mark a preferred supplier for some items. To do this, they simply import the entire list of suppliers so they are all added to the database at once (refer to the topic Importing into the Database). Later, after they add their items, they can assign as many suppliers as needed to each item and designate one as the preferred supplier. Since all of the suppliers are already in the database, they can quickly select which suppliers to associate rather than having to enter each supplier manually. They can even designate specific shipping unites of measure for each supplier to use for ordering the item.

**Business Type: Reseller - One Supplier for Some Items**

Brady's Bargains has a list of suppliers from which they regularly receive certain items that they have been maintaining by hand. They will manually input these suppliers on the Create New Suppliers screen before they add the items. They can later manually associate the suppliers to an item using the Edit Item screen/Manage Suppliers tab. Since they are using the Standard version of InventoryControl, they are limited to entering one supplier and one shipping unit of measure for each item.
3.6 Entering Items Business Examples

**Note:** For step by step instructions on adding items, please refer to the topic [Creating New Items](#).

**Business Type: Distributing - Items with Preferred Suppliers**

Sebastian Distributing has many items in their existing database so they will be importing their item information. They also want to streamline the purchase order process for their employees. Many items are typically ordered from the same supplier so they manually enter the preferred supplier information on the [Manage Suppliers](#) tab on the [Edit Item](#) screen for each item after the items are imported. They also set up the preferred shipping unit of measure for each supplier on this tab. By doing this, the preferred supplier information and associated preferred unit of measure will appear on new purchase orders as soon as the item is added to the order.

Another time-saving step they take is to make sure all Item Codes are scannable. They enter the longer, descriptive name in the Item Description field.

---

**Business Type: Fleet - Items with Primary Locations**

Items are typically assigned to the same locations in Rusty's Cable Company. The manager of Rusty's Cable Company has set up their sites as vehicles and each vehicle contains basically the same locations. There are bins for certain types of cables, a bin for remotes, a rack for cable boxes, etc. The configuration for each vehicle is the same. For each item, they want to designate a primary location within each site (vehicle). By doing this, when a user receives or adds an item using the mobile device or on the PC the primary location will automatically appear on the screen, saving the employee from having to search for it. (The location can be changed to something other than the primary location, if needed). This is true for picking or removing inventory as well - the item will be removed from the primary location by default unless the user changes the location.

Designating primary locations works for Rusty's Cable Company in conjunction with the Site Configurations they have selected. The manager has set a primary location for each item in each site and each mobile device's From/To sites are set to a specific vehicle.

To set up primary locations the manager can simply import items, making sure the import file contains a column designating the item as having a preferred location (a Y should be in the Supplier column for that item). Please refer to the Item Import Templates found in your installation folder or on your installation CD for an example of this.

---

**Business Type: Reseller - Items Imported**

Brady's Bargains imports their item list from their existing Excel spreadsheet. They will also be tracking some items so they make sure to import this information correctly. Refer to the Item Import Templates found in your installation folder or on your installation CD and to the topics [Importing Into the Database](#) and [Import Specifics/Database Properties](#).
Chapter 4 - PC Operation Basics

4.1 User Log On

The Log On screen appears when InventoryControl is first started and when you select File > Log Out.

Complete both fields, then click OK to logon to the system.

The User Name field is not case sensitive.

The Password field is case sensitive. Asterisks will be displayed as you type the Password.

The first time you open InventoryControl you can enter the following information:

User Name: Admin

Password: (blank)
After log on, the password can be changed via File > Change Password.

The Admin account, or any other account with Administration Privilege, can use the Security Privileges screen to add Users and set their privileges and reset their passwords. For more information on adding users, please refer to the Adding Users/Editing Security Privileges topic.
4.2 About the About Screen

The About Screen allows you to view and manage licenses and provides program version details.

Note: All screen shots in this help file are of InventoryControl Professional Edition. The screens in other versions of InventoryControl and in WaspNest Inventory may differ. For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

Using/Viewing the About Screen:

1. From the Main Screen, click Help > About. The About screen appears.

   ![About Screen](image)

   This screen displays your version and basic license information.

2. Click the Licenses button to view additional licenses and your mobile device licenses. Below is an example of the Licenses screen:

   ![Licenses Screen](image)
3. Click **OK** to return to the **About** screen.

4. Click **OK** to close the **About** screen.
4.3 Main Screen

The **Main screen** is divided into four sections:

- **Section A: Toolbar**
- **Section B: Left-Hand Navigation**
- **Section C: Main Functions**
- **Section D: Context-Sensitive Menu**

Below is an example of the **Main** screen:

*Note: The Receive/Pick icon only appears on Pro and Enterprise Versions. The Receive/Pick and Mobility icons do not apply to WaspNest Inventory.*
4.3.1 Section A: Toolbar

The toolbar provides access to the following functions:

**File Menu:**
- **Change Password** - Allows the user currently logged in to change his/her password.
- **Log Off** - Logs the current user off of the system.
- **Exit** - Exits the system.

**Tools Menu:**
- **Options** - Accesses the Options screen where you can customize how certain aspects of the software behave.
- **Select Site** - Accesses the Select Site screen. InventoryControl allows you to work with more than one Site and multiple Locations within each Site.
- **Archive Transactions** - Allows you to store older data in an archive.
- **Reset All Field Names** - This option resets any field names you have customized through the Edit Field Names function.
- **Reset All Grid Settings** - This option resets all settings (sorting, grouping, hidden columns) you may have made to your list screens to their default settings.

**Check For Alerts:**

When selected an Alerts drop down list will appear displaying any alerts, such as overdue items.

**Help Menu:**
- **Contents/Index/Search** - Accesses this help file.
- **Update Licenses** - Allows you to update your existing license(s).
- **Check for Updates** - When this option is selected, the system will search for updates to the software and alert you if any exist. You can then download the updates at your convenience. The software automatically searches for updates at start up. This option allows you to manually search for updates at other times. Checking for Updates requires internet access.

4.3.2 Section B: Left-Hand Navigation

This software contains a menu on the left side of the Main Screen that provides access to the following features:

- **New** - Displays a menu of all Create New screens (Customer, Locations, Items, etc.). Select which type of data you want to create from the menu.
- **Lists** - Displays a menu of all Lists in the system. Select which List you want to view from the menu. For detailed information on using the list screens, please refer to the topic Working with Lists.
• **Find** - Displays a menu of data options from which to search (Customer, Locations, etc.) Select which type of data you want to search. A **Find** screen appears allowing you to quickly search for information.

• **Labels** - Displays a menu of labels you can print. Printing Labels utilizes the Labeler software that come bundled with your program. For detailed instructions on using the Labeler software, please refer to the Labeler help file (accessible through the Labeler software).

---

### 4.3.3 Section C: Main Functions

This section displays the primary functions of this software. To access any of these functions:

1. Click on an icon. A menu of options for that function appears at the bottom of the screen (section D - described below).
2. Click on an icon in the menu to access that function.

Available menu options are:

**Administration** - This option provides access to basic administrative functions such as adding users to the system, maintaining user security profiles, backing up and/or restoring the database, importing/exporting information and maintaining your company information.

**Inventory** - This option provides access to the inventory features of the software. From this menu you can add or remove inventory, move inventory from one location to another, adjust inventory amounts and audit all inventory in your system.

**Reports** - This option opens the Reports screen allowing you to select from a wide range of available reports.

**Mobility** - This option does not apply to WaspNest Inventory. This option provides access to your mobile device options.

**Pick/Receive** - This option does not apply to WaspNest Inventory. *(Pro and Enterprise Versions Only)*
- This options provides access to the pick/receive features of the software.

---

### 4.3.4 Section D: Context-Sensitive Menus

The bottom of the **Main Screen** will display a menu based on the selection you make from the **Main Functions** icons.

**Note:** Security does not apply to WaspNest Inventory.

**Examples:**
### Administration Menu

- Company Info
- Security
- Import
- Export
- Backup
- Restore

### Inventory Menu

**Note:** Check-In, Check-Out, Assemble and Disassemble do not apply to WaspNest Inventory.

- Add
- Remove
- Move
- Check-In
- Check-Out
- Adjust
- Assemble
- Disassemble
- Audit

### Receive/Pick Menu

**Note:** Pro and Enterprise Versions Only

- Receive
- Pick
- Manage Ship Methods
- Manage Payment Methods
- Customize Numbers

### Mobility Menu

**Note:** Mobility does not apply to WaspNest Inventory.

This example is of the WDT2200 menu. The icons in this menu will look different if you are using a Windows Mobile® /CE™ mobile device, but the options will be the same.

- Setup Device
- Create PDT Database
- Send Data To
- Receive Data
- Process Mobile

### Reports Menu

This icon opens the Select Report screen. For more information on the Select Report screen, please refer to the topic Selecting Reports.
4.4 Changing Your Password

This feature allows the user currently logged in to change his or her password.

**Note for WaspNest Users:** This feature is not available in WaspNest Inventory. For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

**Changing Your Password:**

1. From the Main Screen, click **File > Change Password**. The **Change Password** screen appears.

2. Enter your old password, your new password, then confirm your new password. As passwords are typed, asterisks will be displayed. Passwords are case sensitive.

3. Click **OK** to save your changes.
4.5 Update License Screen

The **Update License** screen allows you to enter a regular License Key to upgrade from the Demo version, or an Update License Key to increase the number of Mobile Devices InventoryControl will support. You can also view the install serial number and activation code information.

**Updating License(s):**

1. From the **Main Screen**, click **Help > Update License**. The **Update License** screen appears.

2. If the program has not yet been activated, you will be prompted to enter an Activation Code now. Click on the registration link that appears above the serial number and then complete the information on the Wasp support page. An email will be sent back to you that contains the Activation Code. Type this code back into the **Activation Code** field, then click **OK** to activate the program.

If the program has been activated, the following screen appears:
3. Enter a new Serial Number to add additional features such as additional mobile device licenses.

4. Click **OK** or click **Cancel** to exit without updating. Exit and restart the software to use the new key.

If you use this form to upgrade from the Demo version to a Licensed version of this software, the License Key you enter here will be displayed on the **About** screen.

If you use this form to increase the number of Mobile Devices InventoryControl will support, your original License Key will continue to be displayed in Help > **About**, but it will display the new number of mobile devices permitted.
4.6 Selecting Sites

InventoryControl allows you to work with more than one Site and multiple Locations within each Site. At any time, you can limit all your transactions to a specified Source, a specified Destination, or allow transactions at All Sites. These are chosen on the Select Site screen.

Note for WaspNest Inventory Users: WaspNest Inventory only allows for one Site. For information on the benefits of upgrading WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

Keep in mind that you can only select sites to which you have been given access in Security.

Selecting a Source on the Select Site screen determines the locations available in the Location field of the Add, Remove, Check-In, Check-Out, Adjust and Audit functions. It will also determine the locations available in the From Location field of the Move function. Only locations within the Site selected in the Source field will be available for these functions.

Destination determines the locations available in the Move function’s To Location field.

Remember, you are selecting Sites on this screen. When you select a site, you are limiting the inventory functions to locations within that site.

For information on adding new sites, please refer to the Creating a New Site topic. For information on adding new locations, please refer to the Creating New Locations topic.

A Note on Importing: The site specified in the Destination field of the Select Site screen can impact the Locations into which imported inventory will be recorded. When something other than <all> is specified as your Source site, imported inventory will be put into Locations at the specified Source. If you have varying site information you wish to import along with the location and quantity data for each Item Number, you must make sure the Source is set to <all> before importing data into the Inventory table.

This topic discusses:

How to Select Sites

Source and Destination Examples

4.6.1 How to Select Sites:

1. From the Main Screen, select Tools > Select Site. The Select Site screen appears:
By default, all locations are allowed in all functions. This is designated by choosing <all> in both the Source and Destination fields, as shown above.

2. Select the Source and Destination Site to which you want to limit transactions. All locations you have entered in the system will appear in the drop down lists.

3. Select OK to save your changes.

4.6.2 Source and Destination Examples:

Example 1:

If you want to limit the available locations for adding, removing, checking in/out, adjust and auditing inventory to one location (in this example, Warehouse1), you would select that location in the Source field as shown below:

In the above example, inventory can be moved from a location within Warehouse 1 to any other location at another site.

Example 2:

If you want to limit the available locations for adding, removing, checking in/out, adjust and auditing inventory to one location (in this example, Warehouse1), and you want to limit move destinations to one site (in this example, Warehouse2), you would select Warehouse1 in the Source field and Warehouse2 in the Destination field as shown below:
Example 3:

If you want to limit the available locations for adding, removing, checking in/out, adjust and auditing inventory to one location (in this example, Warehouse2), and you want to limit move destinations to locations in the same site, you would select Warehouse2 in the Source field and Warehouse2 in the Destination field as shown below:
4.7 Logging Out

Logging Out allows the current user to log out of the system so another user can log in, if needed.

1. From the Main Screen, click File > Log Out. The Log On screen appears allowing another user to log in.

2. Enter a valid User Name and Password and press OK to log on again or click Cancel to exit.

Note: You can also log in as a different user by going to Administration > Security > Log in as Different User.
4.8 Checking for Software Updates

By default, the software will check for updates to the application and notify you if a more recent version is available when you login to the system. You can then access the Updates website and download the latest version. This ensures you are always working with the most up-to-date version available to you.

This feature is turned on by default.

InventoryControl must be installed on a machine with Internet access to check for updates.

You can turn off the automatic check and perform periodic manual checks, or leave the option on and perform a manual check, if desired.

This topic discusses:

Disabling the Automatic Version Check Feature
Performing a Manual Check

4.8.1 Disabling the Automatic Version Check Feature:

1. From the Main Screen, select Tools > Options. The Options screen appears:

![Options Screen]

- Inventory
  - Allow Negative Quantities on Mobile Devices
    - Automatic Customer Number
    - Automatic Item Numbers
    - Automatic New
    - Automatic Notification of Low Order
    - Decimal Places
  - Support
    - Check For Software Updates
    - Close New Form
    - Edit Field Names
    - Max Row Count
    - Previously Processed Mobile Data
    - Show Cost Information During Pric
    - Show Warning Messages
    - SQL Server Backup Location
  - Email

Allow quantities to go negative on Mobile Devices. This option turns Quantity validation on or off for all supported Mobile Devices.

Yes (Check to turn option on)
2. Highlight the **Check for Software Updates** option and deselect the **Yes** checkbox.

3. Click **OK** to save your changes and to **Close** the **Options** screen. The option is now disabled. You can manually check for updates as needed.

---

**4.8.2 Performing a Manual Check:**

From the **Main Screen**, click **Help > Check for Updates**.

The system will automatically check for a newer version and notify you if one is available. This procedure can be performed at any time.
4.9 Item Stock Level List Screen

The software can automatically notify you of under-stocked items, broken down by location. By enabling the **Automatic Notification of Low Order Item** on the **Options** screen, the software will display the **Item Stock Level List** when you first start up the system. This screen contains items that have a **Quantity** value equal to or less than the **Reorder Quantity** value set for that item and location on the **Location** tab of the **Create New** or **Edit Item** screen. For more information on enabling and disabling this options, please refer to the **Options Screen** topic.

In order for items to appear on this screen, a **Reorder Quantity** must be entered on the **Location** tab of the **Create New Item** screen or, after the item is created, on the **Edit Item** screen.

Below is an example of the Item Stock Level List:

Click the **View Report** button at the bottom of the screen to display the **Reorder Report**.

You can use this report to aid you in creating purchase orders for the under-stocked items.
4.10 Alerts

InventoryControl contains built alerts that you can display to tell you when action needs to be taken on certain items or orders in the system. To access the Alerts feature, select Check for Alerts from the Main screen.

**Note for WaspNest Users:** Alerts are not available in WaspNest Inventory. For more information on the benefits of upgrading, please select Help > Benefits of Upgrading on the Main screen.

The following is a list of Alerts that might appear on your system:

**Kit Item(s) with incomplete info** *This function applies to Pro and Enterprise Version users only.*

**Assembly items with incomplete info** *This function applies to Pro and Enterprise Version users only.*

**Checked Out Item(s) Past Due**

**Purchase Orders Past Due** *This function applies to Pro and Enterprise Version users only.*

**Pick Orders Past Due** *This function applies to Pro and Enterprise Version users only.*

**Expired Items** - This alert displays all items with expired date codes.

**Items Understocked by Location**

**Items Understocked by Item Totals**

**Items with Negative Quantity**

**Items Understocked by Forecasted Item Totals** - This alert appears if InventoryControl determines items need to be re-ordered taking into account the quantity available in house, the quantity on order (via purchase orders), and the quantity scheduled to be removed (via pick orders).

The alert appears if the Total Available plus the quantity on order via Purchase Orders is less than the quantity needed for scheduled Pick Orders (Committed – (Total Available + On Order)).

On the next page is an example of the Alerts menu:
The All New InventoryControl v5

Alert

Kit item(s) with incomplete info: 2
Assembly item(s) with incomplete info: 8
Item(s) Past Due: 1
Purchase order(s) Past Due: 1
Pick order(s) Past Due: 1
Expired Item(s): 1
Item(s) Understocked (By Location): 2
Item(s) Understocked (By Item Totals): 2
Item(s) With Negative Quantity: 1
4.11 Adding Notes

Several screens in the software provide the option to add notes to the record. Clicking on the Add Note button allows you to associate any comments you may have with the record you are creating or editing. This is useful to keep comments associated with the record.

Enter your notes in the text box, then click OK to save and exit.

Notes are displayed along with the date/time it was entered and the user name of the user who added it.
Chapter 5 - Creating New Data

5.1 Creating a New Site

**Note:** You can only have one site in WaspNest Inventory.

The Create New Site screen allows you to add a new Site to your database. Typically, a Site is a building that contains one or more inventory Locations. It is usually a building, but it might also be a fleet vehicle, with one or more bins that can be defined as inventory Locations within that vehicle. For more information on Locations, please refer to the Creating New Locations topic.

It is not uncommon to use this product with only one Site defined. A minimum of one Site is required.

Adding a New Site:

1. From the Main screen, select New > Site.

   **OR**

   From the Main screen, select Lists > Site. On the Site List, select the New icon.

   The Create New Site screen appears:

   ![Create New Site Screen](image)

2. Enter a **Site** and **Description**. **Description** allows you to enter a description of the Site. This is useful when the Site value is vague (For example, Site "H7" could be described as "Hangar 7").

   **Notes** is a text field available to record any additional information you might have about this Site. Click the Add Notes button to edit the Notes field.
3. For information about the Custom Texts and Custom Numbers and Dates tabs, see Using Custom Fields.

4. When you have finished adding information, click the OK/Save button. The system behaves differently at this point depending on your settings on the Options screen.

- When the Close New Form option is turned off: Click Save to commit your entry or click Close to exit the form.
- When the Close New Form option is turned on: Click OK to commit your entry and exit the form or Cancel to exit the form without saving your entry.

For more information about the Options screen, please refer to the Options Screen topic.
5.2 Creating New Customers

The Create New Customer screen allows you to add a new customer to your database. When you are setting up your software for the first time, you may want to import your customers rather than adding them one at a time through this screen. For information on importing information into your database, please refer to the Import Into Database topic.

Adding a Customer:

1. From the Main screen, select New > Customer.

   OR

   From the Main screen, select Lists > Customer. On the Customer List, select the New icon.

The Create New Customer screen appears:

![Create New Customer Screen](image)

Note: This screen is opened automatically when Checking Out or Checking In inventory and a new customer name is entered.

2. Type in the customer information. The Customer No. and Address Type fields are required; all other fields are optional. The customer name and address can then be selected when creating
Pick Orders *(Pro and Enterprise versions only).*

If you have the **Automatic Customer Numbers** option selected on the **Options** screen, the **Customer No.** field will appear populated with the next number in the sequence. For further information on this option, please refer to the **Options Screen** topic.

The software provides you with the ability to enter a Billing Address, Receiving Address and/or Shipping Address for your customers. To enter multiple addresses, follow the steps below:

a. On the **Company Information** screen, enter your company name. Select what type of address you will be entering from the **Address Type** drop-down menu.

b. Enter the remainder of the address information, then click **OK**. You will be returned to the **Administration Menu**.

c. Click the **Company Info** icon again. The **Company Information** screen will reappear populated with the information you just entered.

d. Select a different address type from the **Address Type** drop-down menu. The address lines (Address 1 and 2, City, State, Postal Code and Country) will clear while all other company information will remain on the screen.

e. Enter the new address information, then click **OK**. Repeat these steps for each address type.

3. When you have finished entering data in the **General Information** tab, click the **Additional Information** tab (this tab is optional).
The **Additional Information** tab provides optional fields where you can record the customer's **Phone**, **Extension**, **Fax**, **Cell No.**, **Home No.** and **Email**. In addition, you can create notes on this customer on this tab by clicking the **Add Notes** button.

4. For information about the **Custom Texts** and **Custom Numbers and Dates** tabs, see [Using Custom Fields](#).

5. When you have finished adding information, click the **OK/Save** button. The system behaves differently at this point depending on your settings on the **Options** screen.

- When the **Close New Form** option is turned **off**: Click **Save** to commit your entry or click **Close** to exit the form.

- When the **Close New Form** option is turned **on**: Click **OK** to commit your entry and exit the form or **Cancel** to exit the form without saving your entry.

For more information about setting the **Close New Form** option on the **Options** screen, please refer to the [Options Screen](#) topic.
5.3 Creating New Inventory and Non-Inventory Items

The Create New Item screen allows you to add a new Item to your database and to specify how you want to track each item (by Serial Number, Lot, Date Code and/or Pallet).

**What is an Item?** - Items represent the actual material or good that you will have in your inventory. For example, you might create an Item entry for Mouse - Wireless. Then you can add inventory, or quantity, to that item. If you are using the Enterprise or Professional version of this software, you can also create items that are non-inventory. This is useful if you need to create an item for marketing pamphlets, counter displays or anything you need to have, but for which you don't need to track quantity.

**What is a Non-Inventory Item?** - A non-inventory item is anything you order or receive, but do not want to track the location and quantity of. An example of a non-inventory item might be marketing materials like a product flyer that is taken to trade shows or put in product boxes. Once you are out you may never buy more of that item and you don't need to know how many are left. You may need to include non-inventory items on a purchase order and verify receipt to have a payment paper trail but you do not need to keep track of the item after it is received. InventoryControl allows you to add non-inventory items onto purchase orders in the Pro and Enterprise versions.

**Note:** For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

When you are setting up your software for the first time, you may want to import your items rather than adding them one at a time through this screen. For information on importing information into your database, please refer to the Import Into Database topic.

This topic discusses:

- Accessing the Create New Item Screen
- General Information Tab
- Location Settings Tab
- Additional Information Tab
- Manage Suppliers Tab
- Custom Texts/Custom Numbers and Dates Tab
- Saving the New Item
5.3.1 Accessing the Create New Item Screen:

1. From the **Main** screen, select **New > Item >Inventory or Non-Inventory**.

   **OR**

   From the **Main** screen, select **Lists > Item**. On the **Item List**, select the **New** icon.

   **Note:** For information on creating **Assembly Items**, please see the topic **Creating an Assembly Item** (Pro and Enterprise versions only).

   For information on creating **Kit Items**, please see the topic **Creating a Kit Item** (Pro and Enterprise versions only).

   The **Create New Item** screen appears:
5.3.2 General Information Tab:

The **General Information** tab is where you will enter the basic information about the item. Please see the screen shot above for an example of this tab.

To create the item, enter information in the provided fields. Much of this information is optional. You can be as detailed as you need, but at a minimum you must enter the **Item Number**. Below are descriptions of each field on this tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item Number</strong></td>
<td>The Item Number is often available on a barcode label already attached to the item, such as a UPC code or SKU number. Using an existing barcode for the Item Number allows you to scan or manually enter the number from each item as it comes in without having to print and affix your own barcode inventory item labels. Item numbers in InventoryControl cannot exceed 31 characters. Do not use a description as the item number. You should enter a numeric value in the <strong>Item Number</strong> field. A description of the item can be entered in the <strong>Description</strong> field. <strong>Automatic Item Numbers</strong>: If you have the Automatic Item Numbers option selected on the Options screen, the <strong>Item Number</strong> field will appear populated with the next number in the sequence. For example, if you just created item number 1001, the next number will be 1002. For further information on this option, please refer to the Options Screen topic.</td>
</tr>
<tr>
<td><strong>Category</strong></td>
<td>A <strong>Category</strong> is an optional classification you can give to your items. This provides you with another way to group your items. For example, you could create a Category called laptops and assign that category to any laptop items you have. You might have multiple items representing different makes and models of laptops. If you assign the category &quot;Laptops&quot; to all of those items, you can then group your list by Category and quickly see all laptop items. You can create new Categories by typing in the desired name in the Category field. You will receive a message asking if you want to save the new Category. Select Yes to save. Categories you have already created will appear in a drop down list.</td>
</tr>
<tr>
<td><strong>Checkout Length</strong></td>
<td>This field specifies the default period, in days, that this <strong>Item</strong> can be checked out to a customer.</td>
</tr>
<tr>
<td><strong>Manufacturer</strong></td>
<td>This is the entity that manufactured the item. This field is optional and provides another way to sort and group your items. When a new Manufacturer is typed into the Manufacturer field, you will receive a message asking if you want to save the value as a new Manufacturer.</td>
</tr>
<tr>
<td><strong>Type (Pro and Enterprise Versions Only)</strong></td>
<td>Select <strong>Non-inventory</strong> if you do not want this item to be inventoried, or select <strong>Inventory</strong> to inventory this item. This field will not appear on the Standard version. Non-Inventoried items are those items, such as marketing pamphlets, that you have on hand, but do not want to track.</td>
</tr>
</tbody>
</table>
The **Item To Be Tracked By** section contains check boxes which determine whether the **Serial Number**, **Lot**, **Date Code** and/or **Pallet** of an item will be used to track its movement through your inventory. For a more detailed explanation of tracking fields, please refer to the topic **Identifying Tracking Needs**.

When you are creating your item it is important that you determine how you want to track each item. Typically, small items that are all the same may not need to have any **Track Bys** selected. Items such as printers may need to be tracked by **Serial Number**, so returns and maintenance can be properly tracked. Medical supplies or food may need to be tracked by **Date Code** and/or **Lot**.

If you choose to track by one or more of these fields, you will be prompted to complete them each time you perform a transaction, such as check out, move, remove, add, etc., on this item. For example, if you are tracking item 2233 -VZ Laptop by serial number. Now you want to move a quantity of 5 of this item from on location to another. You will be prompted to enter a unique and valid serial number for each laptop you are moving so that your inventory can be accurately tracked.

**Tracked By options cannot be changed after you add inventory to the item.**

*If you need to change a tracked by item, you will have to remove all inventory from that item, delete the item and create a new record.*

<table>
<thead>
<tr>
<th>Track by</th>
<th>How is it used?</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Serial Number</strong></td>
<td>Serial Numbers must be unique for each item and limit you to managing one item at a time.</td>
<td>Equipment such as printers and radios or anything for which you need to know which specific item you are using.</td>
</tr>
</tbody>
</table>
| **Lot** | These numbers are provided by the manufacturer to indicate from which batch these items were made. | • Medical Supplies  
• Pharmaceuticals  
• Food products |
| **Date Code** | Date Code track the expiration or other "use by" date. | • Food  
• Chemicals |
| **Pallet** | Pallet refers to the pallet from which the item was received. | • Manufacturing Supplies  
• Building Supplies |
You can choose to have the program automatically create and assign serial numbers each time you add inventory for this item (whether manually using the Add Inventory feature or by Receiving Inventory). For example, you create the item "2233 - VZ Laptop" and select to track by serial number. You the enable automatic serial numbers by performing the steps described here. You choose 1000 as your starting number. Now, when you add inventory to this item, InventoryControl will automatically assign serial number to each item starting with 1000. If you add inventory of 500 to this item, the serial numbers assign by InventoryControl will be 1000 - 1500.

To enable Automatic Serial Numbers:

- Click the button to the right of the Serial Number check box. The Auto Serial Number Options screen is displayed:

```
Auto Serial Number Options
Auto Increment Serial Numbers:
Starting Number: 1000
```

- Check the Auto Increment Serial Numbers checkbox to have the software automatically assign incremented serial numbers.

- Enter a Starting Number. This number determines the number at which the serial number sequence starts. Since this option is applied at the Item level, each Item in the program may have its own unique series of serial numbers.

- Click OK to accept your entries.

This section contains check boxes which act much like the Tracked By boxes, but contains a different set of fields (PO, Supplier and Customer) which are always available for use, even if they are not required. For example, if the option is not enabled for the Supplier Code field, a user adding inventory can enter a value for Supplier Code if he knows it or skip entering a value if he doesn't. If this option is enabled, a value for Supplier Code is required to complete the transaction.

Cost specifies the amount your company paid to get this item into inventory. This is an optional tool to help you track your average cost. Cost handling in InventoryControl is designed to show you the average cost and current value of your inventory. You can use this cost information for other purposes as well, such as determining pre-tax and purchase order totals and receiving totals.

This amount represents your cost for purchasing one of the stocking units for this item. If one Barcode Laser Scanner costs $300.00 you will enter 300 into the cost field. If you have items in your inventory that are sold in fractional quantities,
you will need to decide which stocking unit to use. For example, if you have Rope as an item and it costs you $0.12 a foot, you would enter 12 in the Cost field and Feet as the Stocking Unit (entered on the Additional tab). If you rarely sell the rope in exact multiples of feet, you may want to enter your Stocking Unit as Inches, since this is the lowest unit measured, and enter your cost per inch in the Cost field. It is up to you how you want to calculate this; however, you should make sure that the Cost you enter is the cost for one whole Stocking Unit (either Feet or Inches, in our example).

Keep in mind that you can enter a new cost on the Add Inventory screen if you purchase this item at a discount.

For a detailed description for using Cost Tracking and Average Costing, please see the topic Using Cost Tracking and Average Costing.

<table>
<thead>
<tr>
<th>Cost Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legacy Method -</td>
</tr>
<tr>
<td>This is the method used in previous versions of InventoryControl. The legacy method uses FIFO and manages cost by location and track by level.</td>
</tr>
<tr>
<td>Note: If you upgrade your version of InventoryControl to version 6 (which contains additional methods), all existing items will be imported with the legacy method. You can change to a new option on the Edit Item screen.</td>
</tr>
<tr>
<td>Moving Average -</td>
</tr>
<tr>
<td>When this method is used, the average cost of a particular item is recalculated based on each purchase. Cost is calculated on the item level.</td>
</tr>
<tr>
<td>FIFO -</td>
</tr>
<tr>
<td>When this method is used, the inventory that is added first is removed first. Cost is calculated on the item level.</td>
</tr>
<tr>
<td>LIFO -</td>
</tr>
<tr>
<td>When this method is used, the inventory that is added last (most recently) is removed first. Cost is calculated on the item level.</td>
</tr>
</tbody>
</table>

For a detailed description for using Cost Tracking and Average Costing, please see the topic Using Cost Tracking and Average Costing.

<table>
<thead>
<tr>
<th>Average Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is a calculated value that averages the cost paid for the current Quantity. This will be blank when you are entering a new item, but will appear when you are viewing the Edit Item screen for an item that has inventory (quantity).</td>
</tr>
<tr>
<td>If you have 20 quantity of this item at cost 10.00 and add another 30 quantity at cost 8.00,</td>
</tr>
<tr>
<td>Average Cost = ((20 x 10.00) + (30 x 8.00)) / 50 = 8.80</td>
</tr>
<tr>
<td>Removes are calculated using the inventory calculation method you specified. For example, if you are using the FIFO method, if you later remove 5, 5 of the $10.00 items will be removed first,</td>
</tr>
<tr>
<td>Average Cost = ((15 x 10.00) + (30 x 8.00)) / 45 = 8.67</td>
</tr>
<tr>
<td>When calculating Average Cost, the software does not include records that have an average cost of zero. When you run an Inventory Cost Report, the software</td>
</tr>
</tbody>
</table>
does include zero cost quantities when calculating Total Cost.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Price</td>
<td>This field specifies a manufacturer's list price for an item. This field is for your information only and is not included on any reports.</td>
</tr>
<tr>
<td>Sale Price</td>
<td>This field specifies the price at which you sell an item. This field is for your information only and is not included on any reports.</td>
</tr>
<tr>
<td>Min Stock Level</td>
<td>This field specifies the minimum stock level you wish to maintain for this item.</td>
</tr>
<tr>
<td>Max Stock Level</td>
<td>This field specifies the maximum stock level you wish to maintain.</td>
</tr>
<tr>
<td>Reorder Qty</td>
<td>This field specifies the quantity at which you want to reorder inventory.</td>
</tr>
</tbody>
</table>

**Note:** The Minimum Stock Level, Maximum Stock Level and Reorder Quantity fields found on this tab represent these levels at the item level only, meaning these are the stock levels for this item throughout all locations. This means if you have 4 locations, these are the quantities you want to have spread out among those locations. If you want to maintain these levels by location, you can do so on the Location Settings tab (described below).

The fields below only appear on the Edit Item screen.

- The **Total Available** counter is the sum of Total Checked-Out and Total In-House.
- The **Total Checked-Out** counter is the quantity of this item that is currently Checked-Out.
- The **Total In-House** counter is the Total Available less the Total Checked-Out.
- The **Total On Order** counter is the quantity of this item that is currently included on an active Pick Order.
- The **Total Buildable** (applies to Assembly Items only) is the quantity that can be built of this Assembly Item based on the inventory levels of the component items.
- The **Committed** counter (applies to Assembly, Inventory and Non-Inventory items only) is the number that has been committed to a pick order.
- The **Total Shippable** (applies to Kit Items only) is the total on hand amount minus committed quantities for all component items. (Committed is inventory that is contained on a pick order.)

### 5.3.3 Location Settings Tab:

When you have completed the General Information tab, click the Location Settings tab. This tab allows you to enter all locations where this item will be in inventory and to designate a primary location. You can assign items to more than one location. This tab uses the List functionality for grouping, ordering, filtering and deleting.
Complete the fields on this screen as described below:

- **Primary Location** - Select this checkbox if this will be the primary location at this site for this item. A primary location can be selected for each Site you have setup in the system. When you select a primary location, when you Receive quantities of that item from a purchase order, they will automatically be assigned to that location. Also, when you Pick quantities of that item for pick orders, they will automatically be removed from that location. You can change these locations when picking and receiving if necessary. In addition, the primary location will appear in any location fields (on the Add inventory screen, for example), however; you can change the location, if needed.

  Only one primary location can be selected per site.

- **Site and Location** - Click in the box and select a Site and Location from the drop down list. Only sites and locations you have previously selected will appear in this list. Select More to view the Site or Location List. You can also select New Location or New Site to access the Create New screen. These represent the site and the location where the inventory will reside.

- **Quantity** - This number is populated from the Inventory for this item. This number displays how many of this item is currently in stock at the selected site and location. If you are creating a new item this field will be blank (0).

- **Max Stock Level** - Enter the maximum number of this item that you want to have in stock for the selected site and location. This number can be 0 or a positive number, negative numbers are not allowed.

- **Min Stock Level** - Enter the minimum number of this item that you want to have in stock for the selected site and location. This number can be 0 or a positive number, negative numbers are not allowed.

- **Reorder Qnty** - Enter the number at which you want to reorder this item for the selected Site and Location. You can set an option in the software so that the system warns you at login of
any inventory items that have hit their reorder quantity. For further information on setting this option, please refer to the Options Screen topic.

After you have completed all fields, hit ENTER to begin a new line. Your screen will look similar to the following after hitting ENTER:

![Inventory Control Screen with fields and options]

5.3.4 Additional Information Tab:

When you have finished entering information on the Location Settings tab, click the Additional tab. The Additional Information tab provides optional fields where other information about the Item can be recorded. An example of this tab is shown below:
Complete the fields on this tab as described below:

- **Stocking Unit** is the portion by which the quantity will be tracked. At the item level, this should be "Eaches", meaning you should enter how you want each item of this type to be measured. (Examples: bag, barrel, basket, block, bottle, box, carton, container, drum, gallon, jar, pack, package, pallet, section, tub, vial, etc.)

  When entering the stocking unit, you need to pick the smallest unit of measure that you will use to remove a whole item. A good test to use when deciding what the stocking unit should be is to think about what your answer would be if you were asked to count how many of this item you have. If the answer is 100 feet of rope "feet or "ft" is the stocking unit. If the answer is 20 scanners, then "each or "ea." is the stocking unit. Each is common when the unit itself is not a standard unit of measure. If the answer is 100 boxes of nails then "box" or "bx" is the stocking unit.

  You will have the opportunity on the Managing Suppliers tab to enter the Order Unit used by the supplier for shipping purposes (Box, Pallet, Lot, etc.). This is useful if you purchase in larger quantities than you stock. The Order Unit will be used when creating Purchase Orders rather than the "Eaches" UOM that is entered on this tab. Please see the Managing Suppliers Tab section, below.

- **Dimension Unit** is the increment to be used for Length, Width and Height. (Examples: inch, foot, yard, millimeter, centimeter, meter, etc.)

- **Length** is the length of one Unit of Measure expressed in Dimension Units.
- **Width** is the width of one Unit of Measure expressed in Dimension Units.
- **Height** is the height of one Unit of Measure expressed in Dimension Units.
- **Weight Unit** is the increment to be used for mass. (Examples: ounce, pound, ton, milligram, gram, kilogram, metric ton, etc.)
- **Weight** is the mass of one Unit of Measure expressed in Weight Units.
- **Manager** is used to record the name of someone who manages this inventory item.
- **File Reference** is used to record the path to a relevant file that might be an image file, documentation, specifications, etc. This field does not function as a hyperlink. It’s just a static field where a filename or path and filename can be recorded.
- **Add Notes** allows you to record any additional information.

5.3.5 **Manage Suppliers Tab:**

This tab allows you to identify which suppliers you will use for this item and enter detailed supplier information, such as unit of measure. Pro and Enterprise users can enter multiple suppliers for an item and mark one as the default, or preferred supplier. Standard version users can enter only one supplier for each item. WaspNest Inventory users can enter only one supplier for each item.
Adding Suppliers to an Item:

To use this tab you must first select suppliers for this item in the Supplier screen. To do this:

a. Click the New button at the bottom of the list. The fields to the right of the Supplier screen are enabled.

b. Select a Supplier Code from the drop down list. You can also select New Supplier from the list to create a new supplier.

c. Enter the SKU number for this item in the Supplier Item SKU field.

d. Enter the description of this item given by the supplier in the Supplier Item Description field.

e. Enter the number of days lead time the supplier needs to process orders for this item in the Lead Time (in days) field. The lead time is the time from the requisition date to the delivery date. For example, if you need the item by the 15th of the month and the supplier requires 5 days to deliver the order, you would enter 5 here to ensure the order is sent to the supplier timely.

f. The Status field displays the supplier’s current status (Active or Inactive). You can change the status by making a new selection from the drop down menu.

g. You can make this the default supplier for this item by checking the Make this the default Supplier while ordering this item checkbox (Pro and Enterprise versions only). When this is selected, this supplier will automatically populate purchase orders for this item. You can change the supplier on the purchase order, if needed.

h. Any notes entered for this supplier will appear in the Notes section.

i. You can enter the supplier’s unit of measure settings in the Order Unit Settings screen (Pro and Enterprise versions only). This is the unit used by the supplier when shipping this item. This may be box, pallet, etc. This is different from the “Eaches” stocking unit you entered on the Additional tab. For example, you may have entered “jar” for the stocking unit on the Additional tab, but the supplier may ship the item in boxes containing 10 jars. When creating purchase orders, you would want to specify the Order Unit as box rather than jar (or you could end up with 100 boxes of jars rather than 100 jars).

You can also enter the number of the item contained in each of the Order Units and the Cost of the Order Unit.

If you are tracking cost and have entered information in the Cost field (General Tab) and in the Stocking Unit field (Additional Tab), when you receive the item, InventoryControl will do the math and will calculate the cost per item received.

For example, if you order item Barcode Laser Scanners in boxes of 20 at $3500, but your stocking unit is each, you need to specify the cost of a box of 20 when you are setting up your Supplier information here. When the item is received, InventoryControl will calculate the cost per item received. $3500/20 = $175.00.

You can enter multiple order units, if needed. When you are creating your purchase
orders you can then select which one you want to use.

j. When you are done entering supplier information, click the Custom Texts or Custom Numbers and Dates tab (these tabs are optional).

Deleting Suppliers from an Item:

a. Highlight the supplier you want to delete from this item in the Supplier screen.

b. Click the Delete button.

5.3.6 Custom Text and Custom Numbers and Dates Tab:

For information about the Custom Texts and Custom Numbers and Dates tabs, see Using Custom Fields.

5.3.7 Saving the New Item:

When you have finished adding information, click the OK/Save button. The system behaves differently at this point depending on your settings on the Options screen.

- When the Close New Form option is turned off: Click Save to commit your entry or click Close to exit the form.

- When the Close New Form option is turned on: Click OK to commit your entry and exit the form or Cancel to exit the form without saving your entry.

For more information about the Options screen, please refer to the Options Screen topic.
5.6 Automatic Serial Numbers

You can choose to have the program automatically create and assign serial numbers each time you add inventory for this item (whether manually using the Add Inventory feature or by Receiving Inventory). This option is available when creating a new item on the Create New Item screen. For complete details on creating a new item, please refer to the Creating New Item topic.

1. Click the checkbox to make the item you are adding or editing auto increment the serial number for each item added into inventory.

2. If you are using alphabetic or alphanumeric values as Serial Numbers, the Automatic Serial Number option will still generate a numeric Serial Number, beginning with the value of entered in the Starting Number Field, if it does not exist already.

3. Click OK to set the options.
5.7 Creating New Locations

The Create New Location screen allows you to add a new Location to an existing Site or a new Location to a new Site. Locations are places within a Site where inventory resides. The site is usually a building, but it might also be a fleet vehicle, with one more bins that can be defined as inventory Locations within that vehicle. For example, a site might be setup as Building 1 with a location of Supply Closet.

A location is typically shorthand for a physical place such as a shelf in your warehouse. Commonly used conventions include Location codes like this:

01 02 05  (for Row #, Shelf #, Bin #)

When you are setting up your software for the first time, you may want to import your locations rather than adding them one at a time through this screen. For information on importing information into your database, please refer to the Import Into Database topic.

Adding Locations:

1. From the Main Screen, click New > Location.

OR

From the Main Screen, click Lists > Location. Then click the New icon on the Location List.

The Create New Location screen will appear.

2. Select a site from the Site drop down menu, then enter the name of your new Location. The Site and Location fields are both required.
You can type in the name of a new site in the **Site** field. A message will appear asking if you want to add it to your database. Select **Yes** to add it. The **Create New Site** screen will appear allowing you to setup the new site. Complete this screen, the click **OK** to return to the **Create New Location** screen. For detailed information on entering a new site, please refer to the **Creating a New Site** topic.

**Description** allows you to enter a description of the Location. This is useful when the Location value is vague (For example, Location "A7B2" could be described as "Aisle 7 Bin 2").

Click the **Add Notes** button to add additional information to this record.

3. For information about the **Custom Texts** and **Custom Numbers and Dates** tabs, see **Using Custom Fields**.

4. When you have finished adding information, click the **OK/Save** button. The system behaves differently at this point depending on your settings on the **Options** screen.
   - When the **Close New Form** option is turned **off**: Click **Save** to commit your entry or click **Close** to exit the form.
   - When the **Close New Form** option is turned **on**: Click **OK** to commit your entry and exit the form or **Cancel** to exit the form without saving your entry.

   For more information about the **Options** screen, please refer to the **Options Screen** topic.
5.8 Creating New Manufacturers

The Create New Manufacturer screen allows you to add a new Manufacturer to your database. A Manufacturer is typically the company or organization that creates an item you will inventory. If a Manufacturer is also your Supplier for an Item, it is best to setup the company in the software as both a Manufacturer and a Supplier.

When you are setting up your software for the first time, you may want to import your manufacturers rather than adding them one at a time through this screen. For information on importing information into your database, please refer to the Import Into Database topic.

Adding a New Manufacturer:

1. From the Main Screen, click New > Manufacturer.

OR

From the Main Screen, click Lists > Manufacturer. Then click the New icon on the Manufacturer List.

The Create New Manufacturer screen will appear.

![Create New Manufacturer Screen](image)

Note: This screen is opened automatically from the Create New Item screen when a new
manufacturer name is entered.

2. Enter information on this screen as needed. The Name and Address Type fields are required, all other fields are optional.

The software provides you with the ability to enter a Billing Address, Receiving Address and/or Shipping Address for your manufacturers. To enter multiple address, follow the steps below:

   a. On the Company Information screen, enter your company name. Select what type of address you will be entering from the Address Type drop down menu.

   b. Enter the remainder of the address information, then click OK. You will be returned to the Administration Menu.

   c. Click the Company Info icon again. The Company Information screen will reappear populated with the information you just entered.

   d. Select a different address type of the Address Type drop down menu. The address lines (Address 1 and 2, City, State, Postal Code and Country) will clear while all other company information will remain on the screen.

   e. Enter the new address information, then click OK. Repeat these steps for each address type.

3. When you have finished entering data in the General Information tab, click the Additional tab (this tab is optional).
The Additional tab provides optional fields where you can record the manufacturer's Phone, Extension, Fax, Cell No., Home No. and Email. In addition, you can create notes on this manufacturer on this tab by clicking the Add Notes button.

4. For information about the Custom Texts and Custom Numbers and Dates tabs, see Using Custom Fields.

5. When you have finished adding information, click the OK/Save button. The system behaves differently at this point depending on your settings on the Options screen.

- When the Close New Form option is turned off: Click Save to commit your entry or click Close to exit the form.

- When the Close New Form option is turned on: Click OK to commit your entry and exit the form or Cancel to exit the form without saving your entry.

For more information about the Options screen, please refer to the Options Screen topic.
5.8 Creating New Suppliers

The **Create New Supplier** screen allows you to add a new supplier to your database. A supplier is typically the company or organization from which you obtain an Item you will inventory. If a manufacturer is also your supplier for an Item, it is best to add the company in the software as both a Manufacturer and a Supplier.

When you are setting up your software for the first time, you may want to import your suppliers rather than adding them one at a time through this screen. For information on importing information into your database, please refer to the [Import Into Database topic](#).

For examples of how specific business types setup their suppliers, please refer to the topic [Setting up Suppliers Business Examples](#).

**Adding New Suppliers:**

1. From the **Main Screen**, click **New > Suppliers**.

   OR

   From the **Main Screen**, click **Lists > Suppliers**. Then click the **New** icon on the **Supplier List**.

   The **Create New Supplier** screen appears.
2. Enter information on this screen as needed. The **Supplier Code** and **Address Type** fields are required, all other fields are optional. **Supplier Codes** cannot exceed 25 digits. Make sure the **Supplier Code** is a number and the **Supplier Description** is the detailed description of the supplier.

The software provides you with the ability to enter a Billing Address, Receiving Address and/or Shipping Address for your suppliers. To enter multiple address, follow the steps below:

a. On the **Create New Supplier** screen, enter your company name. The default address type is Supplier Billing. You can choose this option, or type in a new address type.

b. If you have entered a new address type, the following screen appears:
The address type that you have entered is not in the database. Do you want to create it?

Click Yes to add this address type to your database.

c. Enter the remainder of the address information. You can then enter another address type, or continue completing the rest of the supplier information. Repeat these steps for each address type.

3. When you have finished entering data in the General Information tab, click the Additional Information tab (this tab is optional).

The Additional Information tab provides optional fields where you can record the
manufacturer's **Phone**, **Extension**, **Fax**, **Cell No.**, **Home No.** and **Email**. In addition, you can create notes on this manufacturer on this tab by clicking the **Add Notes** button.

4. For information about the **Custom Texts** and **Custom Numbers and Dates** tabs, see [Using Custom Fields](#).

5. When you have finished adding information, click the **OK/Save** button. The system behaves differently at this point depending on your settings on the **Options** screen.

   - When the **Close New Form** option is turned off: Click **Save** to commit your entry or click **Close** to exit the form.
   
   - When the **Close New Form** option is turned on: Click **OK** to commit your entry and exit the form or **Cancel** to exit the form without saving your entry.

For more information about the **Options** screen, please refer to the [Options Screen](#) topic.

If a supplier with the same **Supplier Code** is found, the message below will appear when you try to save.

![Duplicate supplier code found](https://example.com/duplicate_supplier_code.png)

A supplier with the same supplier code already exists! Please enter a different supplier code and try again.

Enter a different **Supplier Code** to continue.
Chapter 6 - Editing Data

6.1 Editing Items

The Edit Items screen allows you to modify an existing item. This screen is accessed from the Item List by highlighting an item in the list, then clicking the Edit button on the toolbar. For more information on using the List screens, see the Working with Lists topic.

The Edit Items screen is identical to the New Item screen, except all the information previously entered for the item appears on the screen. You can change any of this information. For information on using each tab of the screen, please refer to the Create New Item topic.

6.2. Editing Assembly Items

Pro and Enterprise Versions Only

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

The Edit Assembly Items screen allows you to modify an existing assembly item. This screen is accessed from the Item List by highlighting an assembly item in the list, then clicking the Edit button on the toolbar. For more information on using the List screens, see the Working with Lists topic.

The Edit Assembly Items screen is identical to the New Assembly Item screen, except all the information previously entered for the item appears on the screen. You can change any of this information. For information on using each tab of the screen, please refer to the Create an Assembly Item topic.

When editing assembly items, there are two points to keep in mind:

1. You will need to sync the mobile device in order for the changes to be transferred.

2. The change of configuration will not impact mobile transactions already done on the device.

   Example: You create an assembly item with two component parts, Item 1 and Item 2. Later, you edit the assembly item to have three component parts, Item 1, Item 2 and Item 3.
6.3 Editing Kit Items

Pro and Enterprise Versions Only

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

The Edit Kit Items screen allows you to modify an existing kit item. This screen is accessed from the Item List by highlighting a kit item in the list, then clicking the Edit button on the toolbar. For more information on using the List screens, see the Working with Lists topic.

The Edit Kit Items screen is identical to the New Kit Item screen, except all the information previously entered for the item appears on the screen. You can change any of this information. For information on using each tab of the screen, please refer to the Creating a Kit Item topic.

When editing Kit items, there are two points to keep in mind:

1. You will need to sync the mobile device in order for the changes to be transferred.
2. The change of configuration will not impact mobile transactions already done on the device.

6.4 Editing Sites

The Edit Site screen allows you to modify an existing site. This screen is accessed from the Site List by highlighting a site in the list, then clicking the Edit button on the toolbar. For more information on using the List screens, see the Working with Lists topic.

The Edit Site screen is identical to the New Site screen, except all the information previously entered for the site appears on the screen. You can change any of this information. For information on using each tab of the screen, please refer to the Create New Site topic.

6.5 Editing Locations (or a Site and Location)

The Edit Location screen allows you to modify an existing location. This screen is accessed from the Location List by highlighting an location in the list, then clicking the Edit button on the toolbar. For more information on using the List screens, see the Working with Lists topic.

The Edit Location screen is identical to the New Location screen, except all the information previously entered for the location appears on the screen. You can change any of this information. For information on using each tab of the screen, please refer to the Create New Location topic.
6.6 Edit Customer

The **Edit Customer** screen allows you to modify an existing customer. This screen is accessed from the **Customer List** by highlighting a customer in the list, then clicking the **Edit** button on the toolbar. For more information on using the List screens, see the **Working with Lists** topic.

The **Edit Customer** screen is identical to the **New Customer** screen, except all the information previously entered for the customer appears on the screen. You can change any of this information. For information on using each tab of the screen, please refer to the **Create New Customers** topic.

6.7 Editing Suppliers

The **Edit Supplier** screen allows you to modify an existing supplier. This screen is accessed from the **Supplier List** by highlighting a supplier in the list, then clicking the **Edit** button on the toolbar. For more information on using the List screens, see the **Working with Lists** topic.

The **Edit Supplier** screen is identical to the **New Supplier** screen, except all the information previously entered for the supplier appears on the screen. You can change any of this information. For information on using each tab of the screen, please refer to the **Create New Supplier** topic.

6.8 Editing Manufacturers

The **Edit Manufacturer** screen allows you to modify an existing manufacturer. This screen is accessed from the **Manufacturer List** by highlighting a manufacturer in the list, then clicking the **Edit** button on the toolbar. For more information on using the List screens, see the **Working with Lists** topic.

The **Edit Manufacturer** screen is identical to the **New Manufacturer** screen, except all the information previously entered for the manufacturer appears on the screen. You can change any of this information. For information on using each tab of the screen, please refer to the **Create New Customers** topic.

6.9 Editing Pick Orders

*Pro and Enterprise Versions Only*

**Note:** For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select **Help > Benefits of Upgrading** on the Main screen.

The **Edit Pick Order** screen allows you to modify an existing purchase order. This screen is accessed from the **Pick Order List** by highlighting an item in the list, then clicking the **Edit** button on the toolbar. For more information on using the List screens, see the **Working with Lists** topic.
The **Edit Pick Order** screen is identical to the **New Pick Order** screen, except all the information previously entered for the order appears on the screen. You can change any of this information. For information on using each tab of the screen, please refer to the **Creating a Pick Order** topic.

---

**6.10 Editing Purchase Orders**

*Pro and Enterprise Versions Only*

**Note:** For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select **Help > Benefits of Upgrading** on the Main screen.

The **Edit Purchase Order** screen allows you to modify an existing purchase order. This screen is accessed from the **Purchase Order List** by highlighting an item in the list, then clicking the **Edit** button on the toolbar. For more information on using the List screens, see the **Working with Lists** topic.

The **Edit Purchase Order** screen is identical to the **New Purchase Order** screen, except all the information previously entered for the order appears on the screen. You can change any of this information. For information on using each tab of the screen, please refer to the **Creating a Purchase Order** topic.
Chapter 7 - Assembly Items

7.1 Assembly Overview

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

Assembly items are created when you combine two or more existing items or multiple quantity of one item to create a new item. You will use the Assembly item type when you want to "build" several of the new items to have on hand in your inventory. You can create Assembly Items using Inventoried, Non-Inventoried (items that are not tracked in inventory, but that you want to have a record of. For instance, you can create an item for marketing pamphlets or instruction booklets.) items and other Assembly items.

Kit Items vs Assembly Items:

While these two item types are used to accomplish similar goals - the grouping of items - they are used for different reasons. Assembly Items are a collection of items that, once grouped, are considered to be a new, single item. The inventory quantities for the individual component items are reduced at the time the Assembly Items are built and the quantity for the Assembly Item is increased. You can build several Assembly Items and keep them on hand in your inventory. In addition, you can move and check in/out Assembly Items.

Kit Items are a collection of items that are sold together, but are listed separately in the transaction (similar to a bill of goods) and continue to be tracked as separate items. A Kit Item is created at the time of sale. You cannot Add inventory in order to have multiple Kit Items on hand. Inventory amounts for the component parts are reduced when the Kit Item is Removed from inventory.

Assembly Item Example:

Sebastian sells modular cabinets. Each cabinet is made of several different sizes of wood panels and hardware. Sebastian tracks each piece used to build these cabinets as a separate piece of inventory in his system, so he will know when he needs to reorder a particular size of panel or piece of hardware. He builds several of each type of cabinet to have on hand to sell as well. When he does this, he creates an Assembly Item in InventoryControl that is made up of each piece of inventory used to build the cabinet. InventoryControl will then deduct the on hand amount for each piece of inventory used in the assembly, and increase the amount on hand of the assembled item.

The flow of Assembly Items is provided below:

1. **Create Your Assembly Item:** Use the Create New Item screen to create your Assembly Item. When Assembly is selected as the Item Type, there is a tab labeled Assembly on the Create New Item screen. Use this tab to indicate what items you want to include in the built Assembly Item. Keep in mind that after you create your Assembly Item, the quantity for that item is zero and the on hand amounts for the included items have not changed. As with other Items, creating the Assembly Item simply tells InventoryControl basic information about the Assembly Item and indicates what other items you want included with it.

2. **Build your Assembly Item:** This is a similar process as Adding Inventory to other item types. In this process you will tell InventoryControl how many of this Assembly Item you want to build.
InventoryControl will check the on hand amounts for each item included in the build to make sure you have enough to complete the desired amount. After the build is complete, the on hand amounts for each item included in your Assembly Item will be reduced by the number built, and the on hand amount for the Assembly Item will be increased.

7.2 Creating an Assembly Item

*This function applies to Pro and Enterprise Version users only.*

**Note:** For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select *Help > Benefits of Upgrading* on the Main screen. Assembly Items are used when you want to combine two or more existing items into one new item.

We recommend you read the Assembly Overview topic before you begin creating Assembly Items.

This topic discusses:

- **Accessing the New Assembly Items Screen**
- **General Information Tab**
- **Location Settings Tab**
- **Assembly Tab**
- **Additional Information Tab**
- **Manage Suppliers Tab**
- **Custom Texts/Custom Numbers and Dates Tab**
- **Saving the New Item**
7.2.1 Accessing the New Assembly Item Screen:

1. From the **Main screen**, select **New > Item > Assembly**.

   The **Create New Item** screen appears:

   ![Create New Item Screen](image)

   Note that in addition to the usual tabs that appear on the **Create New Item** screen, there is also a tab labeled Assembly Information.
7.2.2 General Information Tab:

The **General Information** tab is where you will enter the basic information about the item. Please see the screen shot above for an example of this tab.

Enter the appropriate information in the fields provided:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Number (Required)</td>
<td>The Item Number is often available on a barcode label already attached to the item, such as a UPC code or SKU number. Using an existing barcode for the Item Number allows you to scan or manually enter the number from each item as it comes in without having to print and affix your own barcode inventory item labels. Item numbers in InventoryControl cannot exceed 31 characters. Do not use a description as the item number. You should enter a numeric value in the <strong>Item Number</strong> field. A description of the item can be entered in the <strong>Description</strong> field. <strong>Automatic Item Numbers</strong>: If you have the <strong>Automatic Item Numbers</strong> option selected on the <strong>Options</strong> screen, the <strong>Item Number</strong> field will appear populated with the next number in the sequence. For example, if you just created item number 1001, the next number will be 1002. For further information on this option, please refer to the <strong>Options Screen</strong> topic.</td>
</tr>
<tr>
<td>Category</td>
<td>A <strong>Category</strong> is an optional classification you can give to your items. This provides you with another way to group your items. For example, you could create a Category called laptops and assign that category to any laptop items you have. You might have multiple items representing different makes and models of laptops. If you assign the category &quot;Laptops&quot; to all of those items, you can then group your list by Category and quickly see all laptop items. You can create new Categories by typing in the desired name in the Category field. You will receive a message asking if you want to save the new Category. Select Yes to save. Categories you have already created will appear in a drop down list.</td>
</tr>
<tr>
<td>Checkout Length</td>
<td>This field specifies the default period, in days, that this <strong>Item</strong> can be checked out to a customer.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>This is the entity that manufactured the item. This field is optional and provides another way to sort and group your items. When a new Manufacturer is typed into the Manufacturer field, you will receive a message asking if you want to save the value as a new Manufacturer.</td>
</tr>
<tr>
<td>Type (Pro and Enterprise Versions Only)</td>
<td>When you access the Create New Item screen by selecting <strong>New &gt; Item &gt; Assembly</strong>, this field will automatically be set to <strong>Assembly</strong>. If you accessed it any other way, you can select <strong>Assembly</strong> from the Type drop down.</td>
</tr>
<tr>
<td>Item to be Tracked By</td>
<td>The <strong>Item To Be Tracked By</strong> section contains check boxes which determine whether the <strong>Serial Number, Lot, Date Code</strong> and/or <strong>Pallet</strong> of an item will be used to track its movement through your inventory. For a more detailed explanation of tracking fields, please refer to the topic <strong>Identifying Tracking Needs</strong>. When you are creating your item it is important that you determine how you want</td>
</tr>
</tbody>
</table>
to track each item. Typically, small items that are all the same may not need to have any Track Bys selected. Items such as printers may need to be tracked by Serial Number, so returns and maintenance can be properly tracked. Medical supplies or food may need to be tracked by Date Code and/or Lot.

If you choose to track by one or more of these fields, you will be prompted to complete them each time you perform a transaction, such as check out, move, remove, add, etc., on this item. For example, if you are tracking item 2233 - VZ Laptop by serial number. Now you want to move a quantity of 5 of this item from on location to another. You will be prompted to enter a unique and valid serial number for each laptop you are moving so that your inventory can be accurately tracked.

*Tracked By options cannot be changed after you add inventory to the item. If you need to change a tracked by item, you will have to remove all inventory from that item, delete the item and create a new record.*

<table>
<thead>
<tr>
<th>Track by</th>
<th>How is it used?</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Number</td>
<td>Serial Numbers must be unique for each item and limit you to managing one item at a time.</td>
<td>Equipment such as printers and radios or anything for which you need to know which specific item you are using.</td>
</tr>
</tbody>
</table>
| Lot | These numbers are provided by the manufacturer to indicate from which batch these items were made. | • Medical Supplies  
• Pharmaceuticals  
• Food products |
| Date Code | Date Code track the expiration or other "use by" date. | • Food  
• Chemicals |
| Pallet | Pallet refers to the pallet from which the item was received. | • Manufacturing Supplies  
• Building Supplies |

**Automatic Serial Numbers (Does not apply to WaspNest)**

You can choose to have the program automatically create and assign serial numbers each time you add inventory for this item (whether manually using the Add Inventory feature or by Receiving Inventory). For example, you create the item "2233 - VZ Laptop" and select to track by serial number. You the enable automatic serial numbers by performing the steps described here. You choose 1000 as your starting number. Now, when you add inventory to this item, InventoryControl will automatically assign serial number to each item starting with 1000. If you add inventory of 500 to this item, the serial numbers assign by

92
InventoryControl will be 1000 - 1500.

To enable Automatic Serial Numbers:

a. Click the button to the right of the Serial Number check box. The Auto Serial Number Options screen is displayed:

```
Auto Serial Number Options

Auto Increment Serial Numbers: [ ]

Starting Number: 1000

[Help]  [OK]  [Cancel]
```

b. Check the Auto Increment Serial Numbers checkbox to have the software automatically assign incremented serial numbers.

c. Enter a Starting Number. This number determines the number at which the serial number sequence starts. Since this option is applied at the Item level, each Item in the program may have its own unique series of serial numbers.

d. Click OK to accept your entries.

Require the User to Fill Out (Does not apply to WaspNest)

This section contains check boxes which act much like the Tracked By boxes, but contains a different set of fields (PO, Supplier and Customer) which are always available for use, even if they are not required. For example, if the option is not enabled for the Supplier Code field, a user adding inventory can enter a value for Supplier Code if he knows it or skip entering a value if he doesn't. If this option is enabled, a value for Supplier Code is required to complete the transaction.

Cost

Cost specifies the amount your company paid to get this item into inventory. This is an optional tool to help you track your average cost. Cost handling in InventoryControl is designed to show you the average cost and current value of your inventory. You can use this cost information for other purposes as well, such as determining pre-tax and purchase order totals and receiving totals.

This amount represents your cost for purchasing one of the stocking units for this item. If one Barcode Laser Scanner costs $300.00 you will enter 300 into the cost field. If you have items in your inventory that are sold in fractional quantities, you will need to decide which stocking unit to use. For example, if you have Rope as an item and it costs you $0.12 a foot, you would enter 12 in the Cost field and Feet as the Stocking Unit (entered on the Additional tab). If you rarely sell the rope in exact multiples of feet, you may want to enter your Stocking Unit as Inches, since this is the lowest unit measured, and enter your cost per inch in the Cost field. It is up to you how you want to calculate this; however, you should make sure that the Cost you enter is the cost for one whole Stocking Unit (either Feet or Inches, in our example).

Keep in mind that you can enter a new cost on the Add Inventory screen if you purchase this item at a discount.
| **Cost Method** | Select how you want InventoryControl to calculate cost for this item. Options are:

**Legacy Method** - This is the method used in previous versions of InventoryControl. The legacy method uses FIFO and manages cost by location and track by level.

**Note:** If you upgrade your version of InventoryControl to version 6 (which contains additional methods), all existing items will be imported with the legacy method. You can change to a new option on the **Edit Item** screen.

**Moving Average** - When this method is used, the average cost of a particular item is recalculated based on each purchase. Cost is calculated on the item level.

**FIFO** - When this method is used, the inventory that is added first is removed first. Cost is calculated on the item level.

**LIFO** - When this method is used, the inventory that is added last (most recently) is removed first. Cost is calculated on the item level.

For a detailed description for using Cost Tracking and Average Costing, please [click here](#).

| **Average Cost** | This is a calculated value that averages the cost paid for the current Quantity. This will be blank when you are entering a new item, but will appear when you are viewing the **Edit Item** screen for an item that has inventory (quantity).

If you have 20 quantity of this item at cost 10.00 and add another 30 quantity at cost 8.00,

\[
\text{Average Cost} = \frac{(20 \times 10.00) + (30 \times 8.00)}{50} = 8.80
\]

Removes are calculated using the inventory calculation method you specified. For example, if you are using the FIFO method, if you later remove 5, 5 of the $10.00 items will be removed first,

\[
\text{Average Cost} = \frac{(15 \times 10.00) + (30 \times 8.00)}{45} = 8.67
\]

When calculating Average Cost, the software does not include records that have an average cost of zero. When you run an Inventory Cost Report, the software does include zero cost quantities when calculating Total Cost.

| **List Price** | This field specifies a manufacturer's list price for an item. This field is for your information only and is not included on any reports.

| **Sale Price** | This field specifies the price at which you sell an item. This field is for your information only and is not included on any reports.

| **Min Stock Level** | This field specifies the minimum stock level you wish to maintain for this item.

| **Max Stock** | This field specifies the maximum stock level you wish to maintain. |
| Level | Reorder Qty | This field specifies the quantity at which you want to reorder inventory. |

**Note:** The **Minimum Stock Level**, **Maximum Stock Level** and **Reorder Quantity** fields found on this tab represent these levels at the item level only, meaning these are the stock levels for this item throughout all locations. If you want to maintain these levels by location, you can do so on the **Location Settings** tab (described below).

- The **Total Available** counter is the sum of Total Checked-Out and Total In-House.
- The **Total Checked-Out** counter is the quantity of this item that is currently Checked-Out.
- The **Total In-House** counter is the Total Available less the Total Checked-Out.
- The **Total On Order** counter is the quantity of this item that is currently included on an active Pick Order.
- The **Total Buildable** is the quantity that can be built of this Assembly Item based on the inventory levels of the component items.
- The **Committed** counter is the number of this Assembly Item that has been committed to a pick order.

### 7.2.3 Location Settings Tab:

When you have completed the **General Information** tab, click the **Location Settings** tab. This tab allows you to enter all locations where this item will be in inventory and to designate a primary location. You can assign items to more than one location. This tab uses the List functionality for grouping, ordering, filtering and deleting.
Complete the fields on this screen as described below:

- **Primary Location** - Select this checkbox if this will be the primary location at this site for this item. A primary location can be selected for each Site you have setup in the system. When you select a primary location, when you Receive quantities of that item from a purchase order, they will automatically be assigned to that location. Also, when you Pick quantities of that item for pick orders, they will automatically be removed from that location. You can change these locations when picking and receiving if necessary. In addition, the primary location will appear in any location fields (on the Add inventory screen, for example), however; you can change the location, if needed.

  Only one primary location can be selected per site.

- **Site and Location** - Click in the box and select a Site and Location from the drop down list. Only sites and locations you have previously selected will appear in this list. Select More to view the Site or Location List. You can also select New Location or New Site to access the Create New screen. These represent the site and the location where the inventory will reside.

- **Quantity** - This number is populated from the Inventory for this item. This number displays how many of this item is currently in stock at the selected site and location. When you first create your item, this number will be zero. After you build your Assembly Item, this field will reflect the number you built (which is the quantity in stock).
- **Max Stock Level** - Enter the maximum number of this item that you want to have in stock for the selected site and location. This number can be 0 or a positive number, negative numbers are not allowed.

- **Min Stock Level** - Enter the minimum number of this item that you want to have in stock for the selected Site and Location. This number can be 0 or a positive number, negative numbers are not allowed.

- **Reorder Qty** - Enter the number at which you want to reorder this item for the selected Site and Location. You can set an option in the software so that the system warns you at login of any inventory items that have hit their reorder quantity. For further information on setting this option, please refer to the [Options Screen](#) topic.

After you have completed all fields, hit ENTER to begin a new line. Your screen will look similar to the following after hitting ENTER:

---

### 7.2.4 Assembly Tab:

This is the tab where you will indicate which items you want included in this Assembly Item. You can select any Inventoried, Non-inventoried and/or Assembly item.

---

To select items to include in your Assembly Item:
1. In the Type drop down, select Inventory, Non-Inventory or Assembly.

2. In the Item Number field, select which item you want to add to this assembly. If you select Full List, the Item List will be filtered by the Type you selected (i.e., if Non-Inventory is selected, only non-inventory items will appear on the Item List).

When you tab out of the Item Number field after selecting an item, the Description, Stocking Unit and Total In-House fields will populate with the information for that item.

3. Enter the Quantity you want included in this Assembly Item. This number represents how many of these items is included with each build of this Assembly Item.

   Example: Assume this Assembly Item is a cabinet. For each cabinet, you need 2 long panels, 2 short panels and one back piece and 6 screws. When you enter the long panel item on this tab, you will enter 2 in the Quantity field. When you enter the screws item on this tab, you will enter 6 in the Quantity field, etc.

4. Select the Always Scrap checkbox if you want InventoryControl to always "scrap" or permanently remove the item from inventory during the Disassembly process. You might use this option for a non-inventory item such as a box used for packaging the Assembly Item.

   If the Always Scrap checkbox is not selected, the on hand amount for the item will be increased during Disassembly (the item is assumed to be returned to inventory rather than removed after Disassembly.)
5. Press **ENTER** to access a new line and enter another Item, then repeat the steps above. Your screen will appear similar to the following after pressing **ENTER**:

![Inventory control screen](image)

**Note:** The cost will be calculated and updated based on your selections on this tab unless you have checked the **Do Not Override Cost on the General Tab** checkbox located at the bottom of the **Assembly Information** tab.

### 7.2.5 Additional Information Tab:

When you have finished entering information on the **Assembly** tab, click the **Additional** tab. The **Additional Information** tab provides optional fields where other information about the Item can be recorded. An example of this tab is shown below:
Complete the fields on this tab as described below:

- **Stocking Unit** is the portion by which the quantity will be tracked. At the item level, this should be "Eaches", meaning you should enter how you want each item of this type to be measured. (Examples: bag, barrel, basket, block, bottle, box, carton, container, drum, gallon, jar, pack, package, pallet, section, tub, vial, etc.)

You will have the opportunity on the **Managing Suppliers** tab to enter the Order Unit used by the supplier for shipping purposes (Box, Pallet, Lot, etc.). The Order Unit will be used when creating **Purchase Orders** rather than the "Eaches" UOM that is entered on this tab. Please see the **Managing Suppliers Tab** section, below.

- **Dimension Unit** is the increment to be used for Length, Width and Height. (Examples: inch, foot, yard, millimeter, centimeter, meter, etc.)

- **Length** is the length of one Unit of Measure expressed in Dimension Units.

- **Width** is the width of one Unit of Measure expressed in Dimension Units.

- **Height** is the height of one Unit of Measure expressed in Dimension Units.

- **Weight Unit** is the increment to be used for mass. (Examples: ounce, pound, ton, milligram, gram, kilogram, metric ton, etc.)
• **Weight** is the mass of one Unit of Measure expressed in Weight Units.
• **Manager** is used to record the name of someone who manages this inventory item.
• **File Reference** is used to record the path to a relevant file that might be an image file, documentation, specifications, etc. This field does not function as a hyperlink. It’s just a static field where a filename or path and filename can be recorded.
• **Add Notes** allows you to record any additional information.

7.2.6 Manage Suppliers Tab:

This tab allows you to identify which suppliers you will use for this item and enter detailed supplier information, such as unit of measure.

Adding Suppliers to an Item:

To use this tab you must first select suppliers for this item in the Supplier screen. To do this:

1. Click the **New** button at the bottom of the list. The fields to the right of the Supplier screen are enabled.

2. Select a **Supplier Code** from the drop down list. You can also select **New Supplier** from the list to create a new supplier.

3. Enter the SKU number for this item in the **Supplier Item SKU** field.

4. Enter the description of this item given by the supplier in the **Supplier Item Description** field.
5. Enter the number of days lead time the supplier needs to process orders for this item in the **Lead Time** (in days) field. The lead time is the time from the requisition date to the delivery date. For example, if you need the item by the 15th of the month and the supplier requires 5 days to deliver the order, you would enter 5 here to ensure the order is sent to the supplier timely.

6. The **Status** field displays the supplier's current status (Active or Inactive). You can change the status by making a new selection from the drop down menu.

7. You can make this the default supplier for this item by checking the **Make this the default Supplier while ordering this item** checkbox (**Pro and Enterprise versions only**). When this is selected, this supplier will automatically populate purchase orders for this item. You can change the supplier on the purchase order, if needed.

8. Any notes entered for this supplier will appear in the **Notes** section.

9. You can enter the supplier's unit of measure settings in the **Order Unit Settings** screen (**Pro and Enterprise versions only**). This is the unit used by the supplier when shipping this item. This may be box, pallet, etc. This is different from the "Eaches" stocking unit you entered on the **Additional** tab. For example, you may have entered "jar" for the stocking unit on the **Additional** tab, but the supplier may ship the item in boxes containing 10 jars. When creating purchase orders, you would want to specify the Order Unit as box rather then jar (or you could end up with 100 boxes of jars rather than 100 jars).

10. When you are done entering supplier information, click the **Custom Texts** or **Custom Numbers and Dates** tab (these tabs are optional).

**Deleting Suppliers from an Item:**

1. Highlight the supplier you want to delete from this item in the **Supplier** screen.

2. Click the **Delete** button.

----------

**7.2.7 Custom Text and Custom Numbers and Dates Tab:**

For information about the **Custom Texts** and **Custom Numbers and Dates** tabs, see **Using Custom Fields**.

----------

**7.2.8 Saving the New Item:**

When you have finished adding information, click the **OK/Save** button. The system behaves differently at this point depending on your settings on the **Options** screen.

- When the **Close New Form** option is turned **off**: Click **Save** to commit your entry or click **Close** to exit the form.

- When the **Close New Form** option is turned **on**: Click **OK** to commit your entry and exit the form or **Cancel** to exit the form without saving your entry.
For more information about the Options screen, please refer to the Options Screen topic.

7.3 Building Assembly Items

This function applies to Pro and Enterprise Version users only.

Note: This feature is not available in WaspNest Inventory or the Standard version of InventoryControl. For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

After you create your Assembly Items (see the Creating An Assembly Item topic), you can "build" your Assembly Items as needed using the Assembly feature. Building Assembly Items can be thought of as the "manufacturing" portion of the Assembly Item feature. When you Build an Assembly Item, the on hand amounts for the sub-items are reduced by the number needed to make the Assembly Item, and the on hand amount for the Assembly Item is increased. Assembling/Building Assembly Items increases inventory for the Assembly Item in the same way that Adding increases inventory for other item types.

Building an Assembly Item is a two part process. First, you will select which Assembly Item you want to build (add inventory to), next you will remove the sub-items from inventory. In other words, since your Assembly item is made up of other items, you have to remove the sub-items in order to add inventory to the Assembly Item.

Adding vs. Assembling: Keep in mind that while you can use the Add feature to add inventory to an Assembly item, doing this will not affect the inventory amounts for the sub items. You should only use Add if you want to add inventory to an Assembly Item due to a return (you can also use the Adjust feature for this). To increase your inventory for an Assembly Item and decrease your inventory for the sub-items, use the Assembly feature.

To Assemble Items:

1. From the Main screen, click the Inventory icon.
2. From the Inventory menu, click Assembly. The Build Assembly screen appears:
Note: To prevent fields from clearing, click the pushpin button located to the right of the field you want to lock. This is helpful when you have to perform multiple Builds at one Location, for example. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that field. The Build Assembly button does not have to be clicked between each scan to post these transactions to the Pending Transaction List. If any additional information, such as serial numbers is needed for one or more sub-items tied to this Assembly Item, you will be taken to the Remove screen so you can add this information. See below for information on using the Remove screen.

Clicking the button will unlock the field.

3. In the Item Number field, enter the Item Number of the Assembly Item you want to build. The drop down list will display the last five items selected. Click More to view the Item List. The Item List will be filtered to only show Assembly Items. Click New to create a new Assembly Item.

4. If one of the sub-items has a default location, that location will appear in the Location field. If more than one sub-item has a default location, the field will appear blank. You can change the Location by clicking on the field and entering a new location.

5. Now you can enter the quantity you want to build. Note that the system tells you the maximum number you can build. This number is based on how many of each sub-item you on hand.
6. You can optionally enter Cost. This Cost reflects the cost of the entire Assembly Item (including sub-items).

7. You can optionally enter Notes.

8. If you setup any Track By fields when you created this Assembly Item, the Track By section will be enabled. These Track By fields are tied to the entire Assembly Item (including sub-items).

9. When you have entered all required information (Item Number, Location and any required Track Bys), the Build Assembly button will be enabled.

   The Build Assembly button will not be enabled until all required information is entered in the appropriate fields. The Commit button will not be enabled until at least one Remove is posted to the Pending Transaction List.

   Click this button to continue building your item. If no additional information (such as serial numbers) is needed for any of the associated sub-items, you can click Commit at this point to complete the build process.

   If additional information is needed for one or more items, the Remove screen appears.
This **Remove** screen displays all items tied to this **Assembly Item**. Those items that appear checked as in the example above are ready to be built.

Items that are not checked need additional information, usually a **Track By**.

10. In the **Item Number** field, enter the **Item Number**, or highlight an unchecked item in the display screen. The selected item's information will populate the screen.

11. Enter any missing information, usually a **Track By** such as **Serial Number**. When you are tracking by serial number, click on the **Serial Number** drop down to see a list of all unique serial numbers associated with the selected item. You can also scan this information.

**Note:** To prevent fields from clearing, click the pushpin 🟠 button located to the right of the field you want to lock. This is helpful when you have to perform multiple Builds at one Location, for example. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that field. This feature is especially useful when scanning serial numbers.

Clicking the 🟥 button will unlock the field.
12. Click **Next** when you have completed entering the requested information. You will be returned to the **Assembly** screen. You can choose another **Assembly Item** to build, or click **Commit** to commit your changes to the database.

When you click **Commit**, the inventory quantities for the listed items will be reduced and the quantity for the **Assembly Item** will be increased by the number built.

---

### 7.4 Disassembling Assembly Items

**Pro and Enterprise Versions Only**

**Note:** For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select **Help > Benefits of Upgrading** on the Main screen.

The process of **Disassembling Assembly Items** will reduce your inventory for the Assembly Item and increase your inventory of the associated sub-items. You will be **Removing** inventory for the Assembly Item and **Adding** inventory to the sub-items, unless the sub-item has been marked to be **scrapped**. Scrapping an item means that inventory will be reduced for that item during the Disassembly process. You can mark the sub-item as “Always Scrap” during the Assembly Item creation process so that it will always be scrapped when disassembled. This is useful for packaging materials, such as boxes, that will not be returned to inventory.

**To Disassemble Assembly Items:**

1. From the **Main** screen, click **Inventory**.
2. On the **Inventory** menu, click **Disassemble**. The **Disassemble** screen will appear.
Note: To prevent fields from clearing, click the pushpin button located to the right of the field you want to lock. This is helpful when you have to perform multiple Disassembles at one Location, for example. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that field. The Disassemble button does not have to be clicked between each scan to post these transactions to the Pending Transaction List. If any additional information, such as serial numbers is needed for one or more sub-items tied to this Assembly Item, you will be taken to the Add screen so you can add this information. See below for information on using the Add screen.

Clicking the button will unlock the field.

3. In the Item Number field, enter the Item Number of the Assembly Item you want to Disassemble. The drop down list will display the last five items selected. Click More to view the Item List. The Item List will be filtered to only show Assembly Items.

4. If this Assembly Item is only in one location, that location will appear in the Location field. If the item exists in more than one location, click the drop down menu and select More to view the Location List.

5. Enter the quantity you want to disassemble. The Maximum number that appears directly below this field indicates the amount of this item that you have in inventory. You cannot disassemble more than you have in inventory.

6. The current date will appear in the Disassemble Date field. You can keep this date, or enter a different date on which the Disassembly will occur. If you enter a future date, the inventory counts for the Assembly Item and component items will not be affected until that date.

7. If this Assembly Item is tracked by Serial Number, enter it in the Serial Number field. Remember that this is the serial number for the Assembly Item as a whole (entered on the General tab of the Create New/Edit Assembly Item screen).

8. If this Assembly Item is tracked by Lot, Date Code or Pallet, enter those in the appropriate fields.
9. You can optionally enter a **Customer** in the **Customer** field.

10. When you have completed the information on this screen, click **Disassemble**.

    The **Disassemble** button will not be enabled until all required information is entered in the appropriate fields. The **Commit** button will not be enabled until at least one **Add** is posted to the **Pending Transaction List**.

    If any of the component items are tracked (by serial number, for example), you will be taken to the **Add** screen after you click **Disassemble**.

![Add Screen](image)

The **Add** screen lists all component items for this **Assembly Item**. Items that appear with a green checkmark are ready to be added.

Items that are not checked need additional information, usually a **Track By**.

**Note**: If this **Assembly Item** has been modified, the **View Config History** button, shown below, will appear at the top of the screen.
Click this button to view a list of all previous configurations. The View Config History screen appears.

To switch to a previous configuration, highlight a listing and click the Use This Configuration button.

11. In the Item Number field, enter the Item Number, or highlight an item in the display screen. The selected item’s information will populate the screen.

12. Select a location for this item (if there is only one location or that item has a primary location, this will appear in the Location field).

13. Select the Scrap checkbox if you want to scrap, or discard, this item. This means the inventory for this item will not be increased. You would use this if the item is damaged or you do not want to return it to your inventory for some reason.

   You can also optionally enter a reason if you choose to scrap this item.

14. Enter any missing information, usually a Track By such as Serial Number. You can also scan this information.

   Note: To prevent fields from clearing, click the pushpin button located to the right of the field.
you want to lock. This is helpful when you have to perform multiple Builds at one Location, for example. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that field. This feature is especially useful when scanning serial numbers.

Clicking the button will unlock the field.

15. Click Add when you have entered the requested information. The item will now be check marked in the list.

16. Click Next to continue. You will be returned to the Disassemble screen. You can choose another Assembly Item to build, or click Commit to commit your changes to the database.

When you click Commit, the inventory quantities for the listed items will be increased and the quantity for the Assembly Item will be decreased by the number disassembled. Keep in mind that if an item is marked as "Always Scrap" on the Create New/Edit Item screen, or you have selected the Scrap option on this screen, the inventory for that item will not be increased.
Chapter 8 - Using the List Screens

8.1 Working with Lists

Note: All screen shots in this help file are of InventoryControl Professional Edition. The screens in other versions of InventoryControl and in WaspNest Inventory may differ. For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

This software contains easy to use List screens that allow you to view and access a variety of information quickly. Screens that use the list view are Customer, Manufacturer, Item, Location, Site, Supplier, Inventory, Transaction, Purchase Order and Pick Order. Each of these screens can be accessed by clicking the Lists icon on the Main screen.

Note: These screens all function the same; however, individual options may vary for each screen. This topic covers how to use all possible functions available on the list screens. Keep in mind that not all list screens contain all functions mentioned here.
Below is an example of the basic list screen layout. This is an example of the **Inventory List**. This screen can be divided into three sections (labeled A through C in the example below):

A. Toolbar

B. Contents List

C. Buttons

In addition to these menus there are also "Context-Sensitive Menus" that appear when you right-click on certain areas of the screen. These provide another way to access many of the functions available in the toolbar. These types of menus are also discussed later in this section. **Note:** The Check In/Out functions do not apply to WaspNest Inventory.

---

**8.1.1 Section A: Toolbar**

**Note:** The Check In/Out functions do not apply to WaspNest Inventory.
The toolbar at the top of the list screen provides quick access to a variety of functions and also allows you to customize how the information on the list is displayed. Each of these functions is described below:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Filter accesses the <strong>Find</strong> screen allowing you to quickly lookup information. For more information on the <strong>Find</strong> screen, please see <strong>Searching for Information</strong>.</td>
</tr>
<tr>
<td>Toggle</td>
<td>The <strong>Toggle</strong> button is enabled after you have used the Filter feature to limit the list to certain information. Click the <strong>Toggle</strong> button to view all listings again. For instance, if you have filtered your <strong>Item List</strong> to display only items with Monitor in the description field, you can click the <strong>Toggle</strong> button to display all items on the list again. Click <strong>Toggle</strong> again and the list will again be filtered by your selection.</td>
</tr>
<tr>
<td>Check-In</td>
<td><em>(Applies to the Item and Inventory List screens only.)</em> Highlight a listing that is Checked Out, then click the Check-In button. The Check-In screen allows you to Check-In inventory that has previously been Checked Out to one or more customers. While checking in inventory does not actually add inventory (quantity) to an item, it does free up that inventory to be checked-out to another customer, if needed, or to be included in a pick order. For more information, please refer to the <strong>Checking In Inventory</strong> topic.</td>
</tr>
<tr>
<td>Check-Out</td>
<td><em>(Applies to the Item, Inventory and Customer List screens only.)</em> Highlight a listing, then click the Check-Out button. The Check-Out screen allows you to check-out, or assign, inventory to customers. For more information, please refer to the <strong>Checking Out Inventory</strong> topic.</td>
</tr>
<tr>
<td>Move Inventory</td>
<td><em>(Applies to the Location and Inventory List screens only.)</em> Highlight a listing, then click the Move button. The Move screen allows you to move inventory quantity for an item from one Location to another. When you create an item, you can add which locations it may be. When you then add inventory (quantity) to the item, you select in which location that quantity will reside. The Move function allows you to move that inventory from the originally assigned location to another. By moving inventory in the software, you can easily keep accurate records of where all of your inventory is currently located. For more information, please refer to the <strong>Moving Inventory</strong> topic.</td>
</tr>
<tr>
<td>Add Inventory</td>
<td><em>(Applies to the Item and Inventory List screens only.)</em> Highlight a listing, then click the Add Inventory button, or just click the button to access the Add screen. The Add screen allows you to manually add quantity to items already entered into your database. Inventory is the amount or quantity of a particular item. Items must first be imported or entered on the <strong>Create New Item</strong> screen (by selecting <strong>Lists</strong> &gt; <strong>Item List</strong> &gt; <strong>New</strong>) before you can add quantity to it. For more information, please refer to the <strong>Adding Inventory</strong> topic.</td>
</tr>
<tr>
<td>Remove Inventory</td>
<td><em>(Applies to the Item and Inventory List screens only.)</em> Highlight a listing, then click the Remove button, or just click the button to access the Remove screen. The <strong>Remove Inventory</strong> screen allows you to remove quantity from any item in the database. For more information, please refer to the <strong>Removing Inventory</strong> topic.</td>
</tr>
<tr>
<td>Edit</td>
<td>Highlight a listing on the screen, then click the Edit button. The Edit screen appears allowing you to update and change information.</td>
</tr>
<tr>
<td>New</td>
<td>Accesses the <strong>New</strong> screen allowing you to enter a new Customer, Item, Manufacturer, Site, Supplier, Purchase Order or Pick Order.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Highlight a listing, then click the Duplicate button. The <strong>New</strong> screen appears with all fields populated with the information from the listing you copied.</td>
</tr>
<tr>
<td>Export to File</td>
<td>Export allows you to export the entire list to a comma-delimited text file.</td>
</tr>
</tbody>
</table>

**What is a comma-delimited file?**

This is a type of data format in which each piece of data is separated by a comma. This is a popular format for transferring data from one application to another, because most database
systems are able to import and export comma-delimited data.

For example, data pulled from a database and represented in comma-delimited format looks something like the following. Each column value is separated by a comma from the next column’s value and each row starts a new line:

Adams, Jane, 46, female, New York
Doe, John, 32, male, California
Jones, Sam, 13, male, Texas
Smith, Mary, 64, female, Louisiana

When data is represented in comma-delimited format they also are referred to as comma-separated values, abbreviated CSV.

When the Export button is selected, a screen appears allowing you to specify where the exported data will be saved on your computer. An example of the Export screen is shown below:

Make sure you save this to a location you can remember. You must also choose a name for your file on this screen. After you have made your selections, click Save to export your data.

A confirmation message will appear when your data has been successfully exported by the system.
Print

Print allows you to print the list. When this button is selected, a standard Page Setup screen appears allowing you to enter margins. An example of this screen is shown below:

![Page Setup Screen]

Click the OK button on the Page Setup screen to print the list. The list will print to your default printer.

Group By

The list screens provide you with the capability of "grouping" the displayed information so you can view data in a way that is most easy-to-read for you. You can have one group, two groups, or many groups depending on how you want to view your information. For instance, if you want all inventory on the Inventory List to be displayed grouped by location, you can quickly set this up.

To see the grouping options, click the Group By button. The top of the list screen expands to display the group selections as shown below:

![Group By Options]

Creating Groups

To create a new group, click on a column header, then drag it to the space indicated on the
screen. For example, if you want to group information by Location, click on the Location column header and drag it to the indicated space.

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Item Desc.</th>
<th>Site</th>
<th>L.</th>
<th>Quantity</th>
<th>Orders</th>
<th>Latest</th>
<th>Pallet</th>
<th>Lot</th>
<th>PO</th>
<th>Date Code</th>
<th>Supplier Code</th>
<th>Min Stock Level</th>
<th>Max Stock Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>no track</td>
<td>Site 1</td>
<td>Loc 1</td>
<td>1.00</td>
<td>6/192...</td>
<td>6/18/02.</td>
<td>1</td>
<td>2060</td>
<td>100.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>no track</td>
<td>Site 1</td>
<td>Loc 1</td>
<td>1.00</td>
<td>6/192...</td>
<td>6/18/02.</td>
<td>1</td>
<td>2060</td>
<td>100.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The screen now lists Location as one of your groups and the items are grouped according to what Location they are assigned.

You can create additional groups to further organize your information by continuing to drag and drop column headers.

By default, the groups list information in ascending order (Location 001, Location 002, etc.). You can change this to descending order by clicking on the group name. Notice that after you click on the group name, the arrow next to the name is now pointing in the opposite direction and the information on the screen is reorganized.

Deleting Groups

If you no longer want to display information in a particular group you can easily ungroup the data. For instance, if you have created a group for Location but now wish to remove it, you can do so by clicking on the group name and dragging it down into the column header section. Let go of your cursor anywhere in the column header section and the group disappears.
Hidden Columns - The list allows you to hide columns by right-clicking on a column label and selecting Hide Column. This enables you to hide information you do not usually need.

You can view the columns you have hidden by right clicking on any column and selecting Show Hidden Columns. A pop-up screen similar to the one below appears listing all columns that are not currently visible.

You can return these columns to the full List screen by double-clicking on a listing in the Hidden Columns screen and dragging it back to the column labels section on the List screen.

Assembly and Kit Items Only. This button shows any transactions related to Kit or Assembly Items. For example, Assembling an Item creates a Remove transaction for each component item and Disassembling an Item creates an Add transaction for each component item. Removing a Kit Item creates a Remove transaction for each related item as well. To view these transactions, highlight an Assembly or Kit Item and click the Show Associated Tranx button. The Transaction List will display any transactions associated with the selected Assembly or Kit Item. Below is an example of the Transaction List displaying the associated transactions created when an Assembly Item was Assembled (added). Notice that the Assembly Item's Add transaction is listed in the top grid and the associated Remove transactions for each item.
8.1.2 Section B: Contents List

The contents list displays all data related to the selected list. For example, if you selected Inventory, all Inventory entered in the system will display here, if you selected Manufacturers, all manufacturers will display here, etc.
Sorting Columns: Most of the columns that appear in the lists can be sorted ascending or descending. The columns sort ascending by default. To change the sort order, click on the column heading. An arrow will appear next to the column name to let you know in which direction the information is sorted. The example below shows the Last Name column sorted Ascending.

Selecting a Listing: You can quickly scroll through the listings using the buttons directly below the contents list. Keep in mind that you can also use the Filter button to limit the items that appear in the list (see Section A: Toolbars, above). The list screens can display up to 1000 lines of information at a time. If your list contains more than 1000 items, you must create a filter to show the items not on the list.

Click on a listing to highlight it, then click the button that accesses the desired function. For example, if you want to edit Item 10002, use your mouse to click on that listing in your Item List, then click the Edit button.

Arranging Columns: You can arrange the columns in the list into any order you wish. To change the order, click on a column heading and drag it somewhere else on the list. For example, if you want to make Location the first column in your Inventory List, click on the Location column heading and drag it to the first column in the list as shown below:

After you drop the column into its new position, the list will reorganize with the Group information appearing first:
8.1.3 Section C: Buttons:

This section contains the following buttons:

**Help (F1)** - Click this button (or hit the F1 key on your keyboard) to access this help document.

**Close** - Click this button to close the List. Keep in mind when closing the list that your groups and column settings will be retained.

8.1.4 Context-Sensitive Menus:

The software provides you with a toolbar for quick access to various list features and, in addition, many of these features can also be accessed via "context-sensitive menus". By right-clicking on a column heading, a list of available features appears, as shown below (Note that not all options shown below are available on all screens):

```
<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Sort ASC</th>
<th>Sort DESC</th>
<th>Group By This Column</th>
<th>Show Grouping</th>
<th>Hide Column</th>
<th>Hidden Columns</th>
</tr>
</thead>
</table>
```

Any changes you make to the list via this menu will be retained when the screen is closed and reopened.

This menu allows you to:

**Sort ASC** - Select this option to sort the column in ascending order (A through Z or 1 through 10, etc.).

**Sort DESC** - Select this option to sort the column in descending order (Z through A or 10 through 1, etc.).

**Group By this Column** - Select this option to group the screen by the selected column. Please see Section A - Toolbar above for more information on grouping.

**Show Grouping** - Select this option to show the groups selected for this list screen. Please see Section A - Toolbar above for more information on grouping.
**Hide Columns** - The list allows you to hide columns by right-clicking on a column label and selecting Hide Column. This enables you to hide information you do not usually need. When you hide a column, it will remain hidden until you manually return it to the List screen by following the instructions below.

**Show Hidden Columns** - You can quickly view the columns you have hidden by right clicking on any column and selecting Show Hidden Columns (or by clicking the Show Hidden button). A pop-up screen similar to the one below appears listing all columns that are not currently visible.

You can return these columns to the full List screen by clicking on a listing in the Hidden Columns screen and dragging it back to the column labels section on the List screen.
8.2 Item List Example

The Item List displays all items you have entered in the system. Below is an example of this screen:

![Item List Screen]

The Item List screen allows you to Edit, create New, Copy, Delete, Show, Filter, Export or Print the list of Items. For detailed information regarding each of these options, refer to the Working with Lists topic.
8.3 Inventory List Example

The Inventory List displays all items that have inventory (quantity) in the software. Inventory is the amount or quantity of a particular item. Items must first be imported or entered on the Add Item screen before you can add quantity to it. The Check In and Check Out feature does not apply to WaspNest Inventory.

The Inventory List allows you to Edit, create New, Copy, Delete, Show, Filter, Export or Print a list of Inventory. For detailed information regarding each of these options, refer to the Working with Lists topic.
8.4 Site List Example

The Site List displays all sites you have setup in the system. **Note:** WaspNest Inventory only allows you to have one site.

The Site List screen allows you to Edit, create New, Copy, Delete, Show, Filter, Export or Print the list of Sites. For detailed information regarding each of these options, refer to the Working with Lists topic.
8.5 Location List Example

The Location List displays all locations you have setup in your system. Below is an example of the Location List:

The Location List screen allows you to Edit, create New, Copy, Delete, Show, Filter, Export or Print the list of Locations. For detailed information regarding each of these options, refer to the Working with Lists topic.
8.6 Customer List Example

The **Customer List** displays all customers you have setup in the software. A customer is any person or entity to whom you check-out, receive or send (pick) inventory.

**Note:** All screen shots in this help file are of InventoryControl Professional Edition. The screens in other versions of InventoryControl and in WaspNest Inventory may differ. For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select **Help > Benefits of Upgrading** on the **Main** screen.

The **Customer List** screen allows you to **Edit**, create **New**, **Copy**, **Delete**, **Show**, **Filter**, **Export** or **Print** the list of **Customers**. For detailed information regarding each of these options, refer to the **Working with Lists** topic.
8.7 Manufacturer List

The Manufacturer List displays all manufacturers you have setup in the system.

The Manufacturer List screen allows you to Edit, create New, Copy, Delete, Show, Filter, Export or Print the list of Manufacturers. For detailed information regarding each of these options, refer to the Working with Lists topic.
8.8 Supplier List

The Supplier List displays all suppliers you have setup in the system.

The Supplier List screen allows you to Edit, create New, Copy, Delete, Show, Filter, Export or Print the list of Suppliers. For detailed information regarding each of these options, refer to the Working with Lists topic.
8.9 Pick Order List Example

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

The Pick Order List displays all active pick orders entered in the system. Active pick orders are those that have a status of New, New-Over Due, In Process or In Process-Over Due. Below is an example of the Pick Order List.

![Pick Order List Example](image)

Notice the red flags next to some of the orders on the list. These red flags indicate that the order is past due. The status may be New-Past Due or In Process-Past Due. Overdue orders will appear at the top of the list by default, but you can reorder the list as needed.

The Pick Order List screen allows you to Edit, create New, Copy, Delete, Show, Filter, Export or Print the list of Pick Orders. For detailed information regarding each of these options, refer to the Working with Lists topic.
8.10 Purchase Order List Example

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

The Purchase Order List displays all active purchase orders you have in your system. Active purchase orders are those that have a status of New, New-Over Due, In Process or In Process-Over Due. Below is an example of the Purchase Order List.

Notice the red flags next to some of the orders on the list. These red flags indicate that the order is past due. The status may be New-Past Due or In Process-Past Due. Overdue orders will appear at the top of the list by default, but you can reorder the list as needed.

The Purchase Order List allows you to Edit, create New, Copy, Delete, Show, Filter, Export or Print the list of Purchase Orders. For detailed information regarding each of these options, refer to the Working with Lists topic.
8.11 Transaction List Example

The Transaction List displays all transactions (add, move, remove, etc.) that have occurred in the system along with the date of the transactions and the user who performed them. Below is an example of the Transaction List:

The Transaction List screen allows you to Filter, Export or Print the list of Transactions. For detailed information regarding each of these options, refer to the Working with Lists topic. The Associated Trnx button applies to Assembly and Kit Items only. For more information about the Associated Trnx button, refer to the Toolbar section of the Working with Lists topic.

Keep in mind that the list screens only display a maximum of 1000 rows. If the dates for which you are looking are not shown in the list, use the Filter function to display the records you need.
Chapter 9 - Inventory

9.1 Inventory Menu

The Inventory Menu groups tasks such as Adding/Removing, Moving, Checking In/Out, Adjusting and Auditing inventory into one place. The Checking In/Out feature does not apply to WaspNest Inventory.

To Access the Inventory Menu:

From the Main screen, click the Inventory icon. The Inventory Menu appears at the bottom of the screen.

Click on any of the Inventory Menu icons to go to that function. Detailed descriptions of the options found on the Inventory Menu are provided below:

- **Add** - The Add screen allows you to add inventory (quantity) to an item at a specified location. This allows you to "manually" add quantity to an item rather than receiving the inventory through a fulfilled Purchase Order. For more information on adding inventory, please refer to the Adding Inventory topic. For more information on receiving inventory, please refer to the Receiving Inventory topic.

- **Remove** - The Remove screen allows you to remove inventory (quantity) from an item at a specified location. This allows you to "manually" remove quantity from an item rather than removing it through a pick order. For more information on removing inventory, please refer to the Removing Inventory topic. For more information on pick orders, please refer to the Creating Pick Orders topic.
- **Move** - The Move screen allows you to move inventory for an item from one **Location** to another. When you add inventory (quantity) to an item, you select in which location that quantity will reside. The Move function allows you to move that inventory from the originally assigned location to another. By moving inventory in the software, you can easily keep accurate records of where all of your inventory is currently located. For more information on the Move screen, please refer to the **Moving Inventory** topic.

- **Check-In** - The Check-In screen allows you to check-in, or make available, inventory that has previously been **Checked-Out** to one or more customers. While checking in does not actually add inventory to an item, it does free up that inventory to be checked-out to another customer, if needed, or to be included in a pick order. For more information on the Check-In screen, please refer to the **Checking In Inventory** topic.

- **Check-Out** - The Check-Out screen allows you to check-out, or assign, inventory to a customer for a specified length of time. For more information on the Check-Out screen, please refer to the **Checking Out Inventory** topic.

- **Adjust** - The Adjust screen allows you to modify the quantity of existing items. Adjust is like a “mini” Audit and will update the quantity using FIFO (First In First Out) to make the total equal to the quantity you enter here. The Adjust function is useful if too much or too little quantity is accidentally entered for an item (on a mobile device, for example), inventory is lost, found, broken, etc. and you need to quickly correct the quantity for that item. Adjusting is different from an Audit in that the Audit function makes other functions of the software, such as adding inventory, unavailable to ensure inventory is not added or removed while you are doing the counts. All features are still available when adjusting inventory. For more information on the Adjust screen, please refer to the **Adjusting Inventory** topic.

- **Assemble** - **Pro and Enterprise Versions Only** - This icon opens the **Build Assembly** screen. Build Assembly allows you to add inventory to your Assembly Items. The Build process adds inventory to the Assembly Item while decreasing inventory for the component items. For more information on the Assemble screen, please refer to the **Building Assembly Items** topic.

- **Disassemble** - **Pro and Enterprise Versions Only** - This icon opens the **Disassemble** screen. Disassemble allows you to decrease inventory for your Assembly Items. The Disassemble process removes inventory for the Assembly Item while increasing inventory for the component items. For more information on the Disassemble screen, please refer to the **Disassembling Assembly Items** topic.

- **Audit** - This icon starts the Audit Mode of the software. Audit Mode allows you to check the counts of all your inventory while disabling other features, such as add and remove, to make sure inventory counts in the system do not change while you are performing the audit. If you are using mobile devices, you can use them simultaneously with the PC to perform an audit. For more information on Auditing, please refer to the **Auditing Your Inventory** topic.
9.2 Manually Adding Inventory

The Add Inventory screen allows you to manually add quantity to items already entered into your database. Inventory is the amount or quantity of a particular item. Items must first be imported or entered on the Add Item screen before you can add quantity to it.

Inventory is also added when you add inventory on the mobile devices. For more information on adding inventory on the Wasp 3200 mobile device, please refer to the topic Windows Mobile Device - Adding Inventory. For more information on adding inventory on the WDT2200 mobile device, please refer to the topic WDT2200 - Adding Inventory.

Note: All screen shots in this help file are of InventoryControl Professional Edition. The screens and available features in other versions of InventoryControl and in WaspNest Inventory may differ. For more information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

Pro and Enterprise Version Users Only: Inventory is also added when you receive inventory from a purchase order. For further information on receiving inventory on the PC, please refer to the topic Receiving Inventory.

Pro and Enterprise Version Users Only: Keep in mind that if you want to increase inventory amounts for Assembly Items, you should use the Build Assembly feature rather than the Add feature. Build Assembly will adjust the inventory amounts for all component items. You can use the Add feature if you want to add inventory to the Assembly Item only, without changing the inventory amounts for the component items, such as in the case of a returned item. Use the Add feature for this carefully, so you do not cause the system to have incorrect inventory amounts for the component items.

You cannot Add Non-inventory or Kit items.

Manually Adding Inventory:

1. From the Main screen, click on the Inventory icon. The Inventory menu appears at the bottom of the screen.

2. On the Inventory menu, click Add Inventory. The Add Inventory screen appears.

OR

1. From the Main screen, select Lists > Item. The Item List appears.

2. On the Item List, highlight an item in the grid, then click the Add icon.
**Note:** To prevent fields from clearing, click the pushpin button located to the right of the field you want to lock. This is helpful when you have to perform multiple Adds at one Location. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that field. (The Add button does not have to be clicked between each scan to post these add transactions to the Pending Transaction List.)

Clicking the button will unlock the field.

3. Complete the **Item** fields: Enter the **Item Number** of the item to which you want to add inventory (if you accessed this screen from the **Item List**, this field will already be populated). To enter an **Item Number**, you can type or scan the value into the field, or you can use the drop down list to see the first 10 items in the database, select <more> on the drop down list to see all items in the **Item List** or you can create a new item.

Entering an **Item Number** populates the **Item Number** field as well as the **Description** field and enables the following fields:

- **Location**
- **Quantity** (unless the item is **Tracked By Serial Number** - Set on the **Add** or **Edit Item** screens, which fixes the Quantity to a value of 1)
• **Cost**

• **Date Acquired**

• Any of the associated **Track By** fields: **Serial Number, Date Code, Lot or Pallet** (Set on the **Add** or **Edit Item** screens). A **Track By** field is enabled or disabled at the time the item is created. **Note:** The **Track By** fields are not available in WaspNest Inventory.

Below is an example of the screen with all fields enabled:

![Example Screen](image)

You can use the drop down list of any enabled field to select an existing value for that field or select `<New>` from the **Item Number, Location or Supplier** drop down lists to open the **Create New Item, Create New Location or Create New Supplier** screens.

**Note:** If the **Automatic New** option is enabled on the **Options** screen, the **Create New Item, Create New Location or Create New Supplier** screens will be opened automatically if an unknown **Item Number, Location, or Supplier** is entered. If the **Automatic New** option is turned off when an unknown **Item Number, Location or Supplier** is entered, a prompt will ask if you want to use the **Create New** screen. For more information on enabling and disabling the **Automatic New** option, please refer to the **Options** screen topic.

The **No. of Labels** field determines the number of item labels that will be printed when the transaction is completed if the **Print** checkbox is selected. The **No. of Labels** value defaults to the **Quantity** value but can be modified. The maximum number of labels for this field is 1000. The item label used for this function is named AddTransactionItemLabel.lab and can be modified through the **Labels** interface.

4. Complete the **Track By** fields. As mentioned above, the **Track By** fields are enabled based on the **Item Number** you enter. If there are no Track Bys set for the selected item, these fields will be disabled. **Track By** fields are enabled or disabled at the time the item is entered on the **Create New Item** screen or when editing an item on the **Edit Item** screen. **Note:** The **Track By** fields are not available in WaspNest Inventory.

5. Complete the rest of the screen: If a **Supplier** and/or **Ref #** is required for this item, you can enter it now. Similar to Tracked By fields, the requirement that one or more of these fields be filled out is established at the time the item was entered on the **Create New Item** screen and can be edited on the **Edit Item** screen.

The **Ref #** drop down list displays the last ten **Ref #s** used. The `<More>` option of the **Ref #** drop down list displays all **Ref #s** with active quantity.
The Supplier drop down list displays the last ten suppliers used. The <More> option of the Supplier drop down list displays all suppliers that can be chosen (active suppliers).

The No. of Labels field determines the number of item labels that will be printed if the Print checkbox is checked. The value in this field defaults to the Quantity field value.

The Notes field allows you to add and store additional information that describes the transaction.

6. You can optionally enter the Customer if you want to track return information.

7. When you have finished entering information, click the Add button to post the transaction to the Pending Transaction List. All fields on the Add Inventory screen will be cleared and all but the Item Number field will be disabled. You can either select another item to be added to the Pending Transaction List or you can click Commit to submit the transaction(s).

The Add button will not be enabled until all required information is entered in the appropriate fields. The Commit button will not be enabled until at least one Add is posted to the Pending Transaction List.

At any time, you can review the Pending Transaction List and remove any transactions that were entered in error.
8. If you want to print a receipt of this transaction, enter the number of receipts in the **Print receipt on Commit - Copies** field.

9. Select the **Print Label** checkbox to tell InventoryControl to print the number of labels in the **No. of Labels** field. The file used to print this label is named `AddTransactionItemLabel.lab` and can be customized through the **Labels** feature.

   If the **Print Labels** box is not checked when you click **Commit**, but there is a quantity in the **No. of Labels** field, you will see the following message:

   ![Warning](image.png)

   Click **Yes** to continue without printing labels. Click **No** to print the designated number of labels.
9.3 Removing Inventory

The **Remove Inventory** screen allows you to remove quantity from any item in the database. This can be considered the same as shipping inventory. You can designate which customer this inventory was shipped to on this screen. Inventory is the amount or quantity of a particular item. Items must first be imported or entered on the **Add Item** screen before you can add quantity or remove quantity.

Inventory is also removed when you pick items for a Pick Order (*Applies to Pro and Enterprise Versions only*). For further information on Picking Orders, please refer to the topic **Picking Orders**.

The Remove function uses FIFO (First in First Out) to determine what inventory is removed first. If you Add 5 of Item 123 to Location Bin 1, for example, then another 5 come in on another day, you will have ten of that item. When you later remove 3 of Item 123, the first set of 5 will be subtracted from inventory before the second set.

**Removing Inventory from an Item:**

1. From the **Main** screen, click the **Inventory** icon. The **Inventory** menu appears at the bottom of the screen.

2. On the **Inventory** menu, click the **Remove** icon. The **Remove** screen appears.

**OR**

1. From the **Main** screen, select **Lists > Item**. The **Item List** appears.

2. On the **Item List**, highlight an item in the grid, then click the **Remove** icon.
To prevent fields from clearing, click the Pushpin button located to the right of the field you want to lock for subsequent transactions. This is helpful when you have to perform multiple removes at one Location, for example. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly remove inventory just by repeatedly scanning barcodes into that field. (The Remove button does not have to clicked between each scan to post these remove transactions to the Pending Transaction List.)

Clicking the button will unlock the field.

3. **Complete the Item fields:** Enter the **Item Number** of the item from which you want to remove inventory. To enter an **Item Number**, you can type or scan the value into the field, or you can use the drop down list to select an existing item from the first 10 Items shown there, or select <more> to select an Item from the **Item List**. You can only **Remove** quantity from items with quantity greater than 0. The **Item Number** list on this screen will not display or accept numbers that do not have quantity.

Entering an **Item Number** populates the **Item Number** field as well as the **Description** field and enables the following fields:

- **Quantity** (unless the item is **Tracked By Serial Number** - Set on the Add or Edit Item screens, which fixes the Quantity to a value of 1).
- **Location**
- **Any of the associated Tracked By fields:** The Track By fields do not apply to WaspNest Inventory. Serial Number, Date Code, Lot or Pallet (Set on the Add or Edit Item screens). A Tracked By field is enabled or disabled at the time the item is created.
- Customer
- Notes

Below is an example of the Remove screen with the fields enabled:

![Remove Screen Example]

You can use the drop down list of any enabled field to select an existing value for that field.

**Note:** If the Automatic New option is enabled on the Options screen, the Create New Customer screen will be opened automatically if an unknown Customer is entered. If the Automatic New option is turned off when an unknown Customer is entered, a prompt will ask if you want to use the Create New screen. For more information on the enabling and disabling the Automatic New option, please refer to the Options screen topic.

4. **Complete the Track By fields:** The Track By fields do not apply to WaspNest Inventory. As mentioned above, the Track By fields are enabled based on the Item Number you enter. If there are no Track Bys set for the selected item, these fields will be disabled. Track By fields are enabled or disabled at the time the item is entered on the Create New Item screen or when editing an item on the Edit Item screen.

Since you can only remove existing quantity, if the Tracked By item you are removing is not in the list, make sure you have the right Item Number and Location. The Tracked By fields will only show values that are possible for the selected Item Number and Location. (If an item with a given Serial Number is not in the list, it may be Checked-Out, and thus, not removable.) If you still do not see the Tracked By information you expect, you should make sure the selected Item Number at the
selected **Location** exists and has quantity. Also check that you are using the right **Site**.

5. **Enter the Customer:** Select a **Customer** from the drop-down list. Select `<New>` from the **Customer** drop list to open the **Create New Customer** screen.

   The **Notes** field allows you to add and store additional information that describes the transaction.

6. After you have completed entering the information, click the **Remove** button to add the transaction to the **Pending Transaction List**. All fields on the **Remove** screen will be cleared and all but the **Item Number** field will be disabled. You can either select another item to be removed or you can click **Commit** on the **Pending Transaction List** to submit the transaction(s).

   The **Remove** button will not be enabled until all required information is entered in the appropriate fields. The **Commit** button will not be enabled until at least one **Remove** is posted to the **Pending Transaction List**.

![Pending Transaction List](image)

At any time, you can review the **Pending Transaction List** and remove any transactions that were entered in error.

7. If you want to print a receipt of this transaction, enter the number of receipts in the **Print receipt on Commit - Copies** field.

8. Click **Commit** to submit the transaction(s) to your database.
9.4 Moving Inventory

The **Move Inventory** screen allows you to move inventory quantity for an item from one Location to another. When you create an item, you can add which locations it may be. When you then add inventory (quantity) to the item, you select in which location that quantity will reside. The Move function allows you to move that inventory from the originally assigned location to another. By moving inventory in the software, you can easily keep accurate records of where all of your inventory is currently located.

You can only move inventory that is listed in the system as having a quantity greater than 0 (quantity is added on the Add Inventory screen or when Receiving inventory.)

**Note:** The Track By section does not apply to WaspNest Inventory.

Moving Inventory to a Different Location:

1. From the **Main** screen, click the **Inventory** icon. The **Inventory** menu appears at the bottom of the screen.
2. On the **Inventory** menu, click **Move**. The **Move** screen appears.

**OR**

1. From the **Main** screen, select **Lists > Item**. The **Item List** appears.
2. Highlight the item for which you want to move inventory, then click the **Move** icon. The **Move** screen appears.
To prevent fields from clearing, click the Pushpin button located to the right of the field you want to lock for subsequent transactions. This is helpful when you have to perform multiple removes at one Location, for example. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly remove inventory just by repeatedly scanning barcodes into that field. (The Move button does not have to be clicked between each scan to post these remove transactions to the Pending Transaction List.)

Clicking the button will unlock the field.

3. **Complete the Item Fields:** To Move inventory, first enter the Item Number of the item you want to move. To enter an Item Number, you can type or scan the value into the field, or you can use the drop down list to select an existing item from the 10 items shown or use <more> to select an item from the Item List.

When you enter an item number, the Item Number field is populated as well as the Description and the following fields are enabled:

- **From Location** (filtered by Site)
- **Quantity** (unless the item is Tracked By serial number, then the quantity defaults to 1 and cannot be changed),
- **To Location**
- Any of the associated Track By fields: Serial Number, Date Code, Lot or Pallet. A Tracked By field is enabled or disabled at the time the Item is created.
- **Notes**

Below is an example of the Move screen with the fields enabled:
You can use the drop down list of any enabled field to select an existing value for that field. The To Location field is not enabled until the From Location information is entered.

**Note:** If the Automatic New option is enabled on the Options screen, the Create New Location screen will be opened automatically if an unknown Location is entered. If the Automatic New option is turned off when an unknown Location is entered, a prompt will ask if you want to use the Create New screen. For more information on the enabling and disabling the Automatic New option, please refer to the Options screen topic.

4. **Complete the Track By fields:** Note: Security does not apply to WaspNest Inventory. As mentioned above, the Track By fields are enabled based on the Item Number you enter. If there are no Track Bys set for the selected item, these fields will be disabled. Track By fields are enabled or disabled at the time the item is entered on the Create New Item screen or when editing an item on the Edit Item screen.

Since you can only move existing quantity, if the Tracked By item you are removing is not in the list, make sure you have the right Item Number and Location. The Tracked By fields will only show values that are possible for the selected Item Number and Location. (If an item with a given Serial Number is not in the list, it may be Checked-Out, and thus, not removable.) If you still do not see the Tracked By information you expect, you should make sure the selected Item Number at the selected Location exists and has quantity. Also check that you are using the right Site.

5. **Enter where you want the inventory moved:** After Tracked By information is entered, choose the To Location (where the Inventory is being moved).

The Notes fields allows you to add and store additional information that describes the transaction.
6. After you have entered the information on the screen, click the **Move** button to add the transaction to the **Pending Transaction List**. All fields on the screen will be cleared and all but the **Item Number** field will be disabled. You can either select another item to be added to **Pending Transaction List** or you can click **Commit** on the Pending Transaction List to submit the transaction(s).

The **Move** button will not be enabled until all required information is entered in the appropriate fields. The **Commit** button will not be enabled until at least one move is posted to the **Pending Transaction List**.

At any time, you can review the **Pending Transaction List** and remove any transactions that were entered in error.

7. Check the **Print Receipt** option to print a receipt when the transactions are **Committed**.

8. Click **Commit** to submit the transaction(s) to your database.
9.5 Checking In Inventory

The Check-In screen allows you to Check-In inventory that has previously been Checked-Out to one or more customers. While checking in inventory does not actually add inventory (quantity) to an item, it does free up that inventory to be checked-out to another customer or to be included in a pick order.

Note for WaspNest Users: This feature is not available in WaspNest Inventory. For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

Checking In Inventory:

1. From the Main screen, click the Inventory icon. The Inventory menu appears at the bottom of the screen.

2. On the Inventory menu, click the Check-In icon. The Check-In screen appears.

OR

1. From the Main screen, select Lists > Item. The Item List appears.

2. Highlight the item for which you want to check-in inventory, then click the Check-In icon. The Check-In screen appears.
**Note:** To prevent fields from clearing, click the pushpin button located to the right of the field you want to lock. This is helpful when you have to perform multiple Adds at one Location, for example. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that field. (The **Add** button does not have to be clicked between each scan to post these add transactions to the Pending Transaction List.)

Clicking the button will unlock the field.

3. **Complete the Item fields:** To Check-In Inventory, first enter the **Item Number** of the inventory item you want to Check-In. To input an **Item Number**, you can type or scan the value into the field, or you can use the drop down list to select an existing item from the Item List.

   Entering an item number populates the **Item Number** field as well as the **Description** and **Check-In Location** and will enable the following fields:

   - **Quantity** (unless the item is **Tracked By Serial Number** - Set on the **Add** or **Edit Item** screens, which fixes the Quantity to a value of 1)
   - Any of the associated **Tracked By** fields: **Serial Number**, **Date Code**, **Lot** or **Pallet** (Set on the **Add** or **Edit Item** screens). A **Tracked By** field is enabled or disabled at the time the item is created.

Below is an example of the Check-In screen with the fields enabled:

![Check-In Screen Example](image)

The **Maximum** field displays the quantity of this item currently Checked-Out.

To enter a customer, you can type or scan the value into the field, or you can use the drop down list.
You can only check-In inventory from a customer that was previously entered on the **Create New Customer** screen and only customers who have items checked-out will appear in the **Customer List**. After a customer is selected, the customer information is displayed.

4. **Complete the Track By fields**: As mentioned above, the **Track By** fields are enabled based on the Item Number you enter. If there are no Track Bys set for the selected item, these fields will be disabled. **Track By** fields are enabled or disabled at the time the item is entered on the **Create New Item** screen or when editing an item on the **Edit Item** screen.

If the item being checked-in is tracked by **Serial Number**, after the Serial Number is entered, the default location in the **Location** drop down list will be the location from which the Item was checked-out.

For items not tracked by **Serial Number**, the default check-in location is the first location of all the locations from which this customer has this item checked-out. For example, if a customer has an item checked out from three locations - A, B, and C - Location A will become the default location when the **Item Number** is entered.

5. **Enter the Check-In Location**: The locations included in the **Locations** drop down list are also limited by any other tracked by options that may have been enabled for this item. Thus, the listed locations will:

   1. Have an item Checked-Out by the selected customer 

   and 

   2. Match all other Track By options enabled for this item

Using the previous example, if the **Track By Lot** option is enabled, and the **Lot** for the item at **Locations A** and B is 123, but the **Lot** for this item at **Location C** is 199, once you input 123 in the **Lot** field of the **Check-In** screen, only **Locations A** and B will be displayed in the **Location** drop list.

The default check-in location can be replaced by selecting the location of choice from the drop down list.

<More> can be selected from the drop down list to select any location entering into the system. This will cause the item to be Moved automatically to the selected location immediately after the check-in. Continuing with the example above, if the item came from **Location A** but you want to check it into **Location F**, click <More> and select **Location F**. When the transaction is processed, the item will be checked-in to **Location A** and then moved to **Location F** automatically.

The **Notes** field allows you to add and store additional information that describes the transaction.

6. Once you have entered the required information on the Check-In screen, click the **Check-In** button to add the transaction to the **Pending Transaction List**. All fields on the screen will be cleared and all but the **Item Number** field will be disabled. You can either select another item for Check-In or you can click **Commit** on the **Pending Transaction List** to submit the transaction(s).

The **Check-In** button will not be enabled until all required information is entered in the appropriate fields. The **Commit** button will not be enabled until at least one **Check-In** is posted to the **Pending Transaction List**.
At any time, you can review the **Pending Transaction List** and remove any transactions that were entered in error using the **Remove** and **Remove All** buttons.

7. Check the **Print Receipt** option to print a receipt when the transactions are **Committed**.

8. Click **Commit** to submit the transaction(s) to your database.
9.6 Checking Out Inventory

The Check-Out screen allows you to check-out, or assign, inventory to customers for a specified length of time. Checking out inventory decreases the quantity of that item that you have on-hand, but does not remove the inventory from your database (since it is assumed the inventory will be checked back in). The check-out function is useful if you lease equipment to customers or have a need to temporarily loan-out inventory.

Note for WaspNest Users: This feature is not available for WaspNest Users. For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

You can only check-out inventory that has been added. This means that when you create an item, you must add inventory (quantity) to it before you can check out that item to a customer. Remember that inventory is the amount or quantity of an item. You can add inventory to an item either on the Add Inventory screen or by Receiving inventory.

Checking Out Inventory:

1. From the Main screen, click the Inventory icon. The Inventory menu appears at the bottom of the screen.

2. On the Inventory menu, click the Check-Out icon. The Check-Out screen appears.

OR

1. From the Main screen, select Lists > Item. The Item List appears.

2. Highlight the item for which you want to check-in inventory, then click the Check-Out icon. The Check-Out screen appears.
Note: To prevent fields from clearing, click the pushpin button located to the right of the field you want to lock. This is helpful when you have to perform multiple Adds at one Location, for example. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that field. (The Add button does not have to clicked between each scan to post these add transactions to the Pending Transaction List.)

Clicking the button will unlock the field.

3. **Complete the Customer field:** To Check-Out Inventory, first enter a customer in the Customer field. To input a Customer, you can type or scan the value into the field, you can use the drop down list to select an existing customer from the Customer List or select <New> from the drop down list to access the Create New Customer screen. This will populate the Customer field as well as the Name, Address and Phone fields.

   Note: If the Automatic New option is enabled on the Options screen, the Create Customer screen will be opened automatically if an unknown Customer is entered. If the Automatic New option is turned off when an unknown Customer is entered, a prompt will ask if you want to use the Create New screen. For more information on the enabling and disabling the Automatic New option, please refer to the Options screen topic.

4. **Complete the Item fields:** Next, select the Item Number for the inventory the customer wants to check-out. To input an Item Number, you can type or scan the value into the field, or you can use the drop list to select an existing Item from the Item List.

   Entering an Item Number populates the Item Number field as well as the Description field and enables the following fields:
- **Location** - filtered by **Site**.

- **Quantity** - unless the item is **Tracked By Serial Number** - Set on the **Add** or **Edit Item** screens, which fixes the Quantity to a value of 1.

- Any of the associated **Tracked By** fields: **Serial Number**, **Date Code**, **Lot** or **Pallet** (Set on the **Add** or **Edit Item** screens). A **Tracked By** field is enabled or disabled at the time the item is created.

Below is an example of this screen with the fields enabled:

![Check-Out Screen Example](image)

The **Maximum** value shows the greatest quantity of this Item that can be Checked-Out.

5. **Complete the Track By fields**: As mentioned above, the **Track By** fields are enabled based on the Item Number you enter. If there are no Track Bys set for the selected item, these fields will be disabled. **Track By** fields are enabled or disabled at the time the item is entered on the **Create New Item** screen or when editing an item on the **Edit Item** screen.

Since you can only check-out existing quantity, if the **Tracked By** item you are checking out is not in the list, make sure you have the right **Item Number** and **Location**. The **Tracked By** fields will only show values that are possible for the selected **Item Number** and **Location**. (If an item with a given Serial Number is not in the list, it may be **Checked-Out**, and thus, not removable.) If you still do not see the **Tracked By** information you expect, you should make sure the selected **Item Number** at the selected **Location** exists and has quantity. Also check that you are using the right **Site**.
6. **Complete the Due Date fields:** If you choose the default *Return Date*, it is calculated by adding the number of days specified in the item's *Checkout Length* field to today's date. The Checkout Length is set on the *Create New Item* screen and edited on the *Edit Item* screen. You can override the default return date by selecting the *Custom* or *None* button. *Custom* allows you to specify a return date by entering it in the *Custom Date* field. *None* allows a customer to check-out inventory for an indefinite period of time.

The *Notes* screen allows you to add and store additional information that describes the transaction.

7. After you have entered the inventory information on the *Check-Out* screen, click the *Check-Out* button to add the transaction to the *Pending Transaction List*. All fields on the screen will be cleared and all but the *Customer* and *Item Number* fields will be disabled. You can either select another item to be added to the *Pending Transaction List* or you can click *Commit* to submit the transaction(s).

The *Check-Out* button will not be enabled until all required information is entered in the appropriate fields. The *Commit* button will not be enabled until at least one transaction is posted to the *Pending Transaction List*.

At any time, you can review the *Pending Transaction List* and remove any transactions that were entered in error.

8. Check the *Print Receipt* option to print a receipt when the transactions are *Committed*.

9. Click *Commit* to submit the transaction(s) to your database or *Discard* to close without submitting the transactions.
9.7 Adjusting Inventory Amounts

The **Adjust Inventory** screen allows you to modify the quantity (inventory amount) of existing items. **Adjust** is like a “mini” Audit and will update the quantity using FIFO (First In First Out) to make the total equal to the quantity you enter here. The **Adjust** function is useful if too much or too little quantity is accidentally entered for an item (on a mobile device, for example), inventory is lost, found, broken, etc. and you need to quickly correct the quantity for that item. Adjusting is different from an Audit in that the Audit function makes other functions of the software, such as adding inventory, unavailable to ensure inventory is not added or removed while you are doing the counts. All features are still available when adjusting inventory.

**Note:** An item tracked by **Serial Number** which has been **Checked-Out** cannot be **Adjusted**.

This topic covers:

- **Adjusting Inventory**
- **Duplicate Serial Numbers Warning**

---

### 9.7.1 Adjusting Inventory:

1. From the **Main** screen, click the **Inventory** icon. The **Inventory** menu appears at the bottom of the screen.

2. On the **Inventory** menu, click the **Adjust** icon. The **Adjust** screen appears.
Note: To prevent fields from clearing, click the pushpin button located to the right of the field you want to lock. This is helpful when you have to perform multiple Adds at one Location, for example. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that field. (The Add, Adjust, etc. button does not have to clicked between each scan to post these transactions to the Pending Transaction List.)

Clicking the button will unlock the field.

3. **Complete the Item fields:** To input an **Item Number**, you can type or scan the value into the field, or you can use the drop down list to select an existing item from the **Item List**.

You can use the drop down list of any enabled field to select an existing value for that field.

Entering an item number populates the **Item Number** field as well as the **Description** and enables the following fields:

- **Location** - filtered by **Site**.
- **Quantity**
- **Any of the associated Track By fields**: Any of the associated Track By fields: Serial Number, Date Code, Lot or Pallet. A Tracked By field is enabled or disabled at the time the Item is created.
Below is an example of the screen with the fields enabled:

Selecting a **Reason** from the drop down list allows you to track why this adjustment is being made. The **Reason** also determines if the quantity is positive or negative for **By Difference** adjusts.

**By Count** indicates that the **Quantity** you are entering is the total count of that item at the specified **Location**. For instance, if the software shows that you have 3 of Item A at Location 1, but you have counted 5, you should enter 5.

**By Difference** indicates that the **Quantity** you are entering is the change you want to see in the Quantity for that Item at that Location. For instance, if you just damaged 2 of Item A at Location 1, you can enter 2, set the **Reason** to **Breakage** (-), and the total will be adjusted downward by 2.

4. **Complete the Track By fields**: The **Track By** fields are enabled based on the Item Number you enter. If there are no Track Bys set for the selected item, these fields will be disabled. **Track By** fields are enabled or disabled at the time the item is entered on the **Create New Item** screen or when editing an item on the **Edit Item** screen.

   When an item is tracked by **Serial Number**, 0 and 1 are the only valid values for **Quantity**.
5. **Enter the Quantity:** After you have specified the **Item**, **Location** and **Track Bys**, you should input the total **Quantity** you are adding to the item.

6. **Enter the Transaction Code:** This field allows you to type a new or select a previously committed code that describes the transaction. Transaction Codes can be any code your business assigns to certain types of adjustment transactions. Assigning these codes can help you with reporting as each type of adjustment can (breakage, return, etc.) can be given its own code. This software does not contain any preset codes. This gives you the opportunity to assign a code that best suits your needs, and allows for the entry of codes you already use in your business for these types of transactions.

7. **Enter Notes (Optional):** The **Notes** field allows you to add and store additional information that describes the transaction.

8. Click the **Adjust** button to add the transaction to the **Pending Transaction List**. All fields on the screen will be cleared and all but the **Item Number** field will be disabled. You can either select another item to **Adjust** or you can click **Commit** on the **Pending Transaction List** to submit the transaction(s).

The **Adjust** button will not be enabled until all required information is entered in the appropriate fields. The **Commit** button will not be enabled until at least one transaction is posted to the **Pending Transaction List**.

![Pending Transaction List](image)

At any time, you can review the **Pending Transaction List** and remove any transactions that were entered in error using the **Remove** or **Remove All** buttons.

9. If you want to print a receipt of this transaction, enter the number of receipts in the **Print receipt on Commit - Copies** field.
10. Click **Commit** to submit the transaction(s) to your database.

---

**9.7.2 Duplicate Serial Numbers Warning:**

If you are tracking the item by **Serial Number** and the system detects an item with the same serial number in a location other than the one you selected on the **Adjust** screen, when you click the **Adjust** button you will receive a warning message that states:

"You are trying to adjust an item that is tracked by serial number. We have found that serial number at a different location. Do you want to adjust the item at that location to 0 so you can move it to this location?"

Select **Yes** on this message to adjust the quantity of the item to 0 at the location detected by the software. The quantity adjustment will be made in the location detected by the software and the item will automatically be moved to the location you selected on the **Adjust** screen. The transaction will appear on the **Pending Transaction List**.

Select **No** if you think you have selected the incorrect location. The **Adjust** transaction will not appear on the **Pending Transaction List** and you will be able to correct the location on the **Adjust** screen.
Chapter 10 - Kit Items

10.1 Kitting Overview

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

Kit items are a group of items that are sold together, but are still considered separate inventory items. As opposed to Assembly Items, you cannot add inventory, move or check out/in Kit Items. While Assembly Items can be created in advance (pre-assembled) and kept in inventory, Kit Items are created at pick or remove time.

Kit Items vs Assembly Items

While these two item types are used to accomplish similar goals - the grouping of items - they are used for different reasons. Assembly Items are a collection of items that, once grouped, are considered to be a new, single item. The inventory quantities for the individual component items are reduced at the time the Assembly Items are built and the quantity for the Assembly Item is increased. You can build several Assembly Items and keep them on hand in your inventory. In addition, you can move and check in/out Assembly Items.

Kit Items are a collection of items that are sold together, but are listed separately in the transaction (similar to a bill of goods) and continue to be tracked as separate items. A Kit Item is created at the time of sale. You cannot Add inventory in order to have multiple Kit Items on hand. Inventory amounts for the component parts are reduced when the Kit Item is Removed from inventory.

Kit Item Example:

Here is an example of the workflow for creating a Kit Item:

John’s Computer Store sells custom configured computers. While he keeps all components (monitors, keyboards, CPUs, Printers etc.) in stock, he tracks each of these as separate items. When a customer buys a computer, he or she designates which monitor is needed, which printer, etc. John then creates a Kit Item in InventoryControl made up of the selected components. The Kit Item goes onto his Inventory List with zero quantity and stays that way until he Removes it, which would be the time of customer pick up or shipping. At the time of Removal, the quantity for each component item is reduced and the Kit Item is completely removed from the Item List.

Kit Items should not be confused with Pick Orders. Pick Orders can contain many unrelated items, Kit Items are a group of items that make up a new item (as in the Computer Store example). Kit Items can be included on Pick Orders.

Flow of Kit Items:

1. Create the Kit Item: Use the Create New Item screen to create your kit item. When you access the Create New Item screen for Kit items, there will be a tab labeled Kitting Information. Use this tab to designate which items you want included in this Kit Item. Keep in mind that inventory amounts for the component items are not changed when you create the Kit Item. The Kit Item is added to your Item List.
2. **Remove the Kit Item**: After the Kit Item has been picked and sold, use the Remove function to remove the designated quantity from inventory. At this time, inventory amounts for the component parts will be reduced.

Detailed instructions on how to create Kit Items and Remove them are provided in the following topics:

- Creating Kit Item
- Removing Kit Items
10.2 Creating a Kit Item

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

Kit Items are used when you want to combine two or more existing items in order for them to be sold together. Kit items are not kept or tracked in inventory (you cannot add, move, check out, etc.). We recommend you read the Kitting Overview topic before you begin creating Kit Items.

Note: You can import the general information for a Kit Item, but not the compositional information (i.e. which items make up the component items). If you import Kit Items, you must then finish setting them up manually on the Edit Item screen.

This topic discusses:

Accessing the Create New Items Screen

General Information Tab

Kit Information Tab

Additional Information Tab

Custom Texts/Custom Numbers and Dates Tab

Saving the New Item

10.2.1 Accessing the Create New Items Screen:

1. From the Main Screen, select New > Item > Kit.

The Create New Item screen appears:
10.2.2 General Information Tab:

The **General Information** tab is where you will enter the basic information about the item. Please see the screen shot above for an example of this tab.

Input the appropriate information in the fields provided:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item Number</strong> (Required)</td>
<td>The Item Number is often available on a barcode label already attached to the item, such as a UPC code or SKU number. Using an existing barcode for the Item Number allows you to scan or manually enter the number from each item as it comes in without having to print and affix your own barcode inventory item labels. Item numbers in InventoryControl cannot exceed 31 characters. Do not use a description as the item number. You should enter a numeric value in the <strong>Item Number</strong> field. A description of the item can be entered in the</td>
</tr>
</tbody>
</table>
**Description field.**

**Automatic Item Numbers:** If you have the **Automatic Item Numbers** option selected on the Options screen, the **Item Number** field will appear populated with the next number in the sequence. For example, if you just created item number 1001, the next number will be 1002. For further information on this option, please refer to the **Options Screen** topic.

**Category**

A **Category** is an optional classification you can give to your items. This provides you with another way to group your items. For example, you could create a Category called laptops and assign that category to any laptop items you have. You might have multiple items representing different makes and models of laptops. If you assign the category “Laptops” to all of those items, you can then group your list by Category and quickly see all laptop items.

You can create new Categories by typing in the desired name in the Category field. You will receive a message asking if you want to save the new Category. Select Yes to save. Categories you have already created will appear in a drop down list.

**Checkout Length**

Check Out is not allowed for Kit items.

**Manufacturer**

This is the entity that manufactured the item. This field is optional and provides another way to sort and group your items. When a new Manufacturer is typed into the Manufacturer field, you will receive a message asking if you want to save the value as a new Manufacturer.

**Type (Pro and Enterprise Versions Only)**

When you access the **Create New Item** screen by selecting **New > Item > Kit**, this field will automatically be set to **Kit**. If you accessed it any other way, you can select **Kit** from the **Type** drop down.

**Item to be Tracked By**

Tracking it not available for Kit items. Component items can be tracked.

**Cost**

Cost specifies the amount your company paid to get this item into inventory. This is an optional tool to help you track your average cost. Cost handling in InventoryControl is designed to show you the average cost and current value of your inventory. You can use this cost information for other purposes as well, such as determining pre-tax and purchase order totals and receiving totals.

This amount represents your cost for purchasing one of the stocking units for this item. If one Barcode Laser Scanner costs $300.00 you will enter 300 into the cost field. If you have items in your inventory that are sold in fractional quantities, you will need to decide which stocking unit to use. For example, if you have Rope as an item and it costs you $0.12 a foot, you would enter 12 in the Cost field and Feet as the Stocking Unit (entered on the Additional tab). If you rarely sell the rope in exact multiples of feet, you may want to enter your Stocking Unit as Inches, since this is the lowest unit measured, and enter your cost per inch in the Cost field. It is up to you how you want to calculate this; however, you should make sure that the Cost you enter is the cost for one whole Stocking Unit (either Feet or Inches, in our example).

Keep in mind that you can enter a new cost on the Add Inventory screen if you purchase this item at a discount.

**Cost Method**

Cost Method does not apply to Kit items.

---

165
### Average Cost

This is a calculated value that averages the cost paid for the current Quantity. This will be blank when you are entering a new item, but will appear when you are viewing the **Edit Item** screen for an item that has inventory (quantity).

If you have 20 quantity of this item at cost 10.00 and add another 30 quantity at cost 8.00,

\[
\text{Average Cost} = \frac{(20 \times 10.00) + (30 \times 8.00))}{50} = 8.80
\]

Removes are calculated using the inventory calculation method you specified. For example, if you are using the FIFO method, if you later remove 5, 5 of the $10.00 items will be removed first,

\[
\text{Average Cost} = \frac{(15 \times 10.00) + (30 \times 8.00))}{45} = 8.67
\]

When calculating Average Cost, the software **does not** include records that have an average cost of zero. When you run an Inventory Cost Report, the software **does** include zero cost quantities when calculating Total Cost.

<table>
<thead>
<tr>
<th>List Price</th>
<th>This field specifies a manufacturer's list price for an item. This field is for your information only and is not included on any reports.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sale Price</td>
<td>This field specifies the price at which you sell an item. This field is for your information only and is not included on any reports.</td>
</tr>
<tr>
<td>Min Stock Level</td>
<td>Not available for Kit items.</td>
</tr>
<tr>
<td>Max Stock Level</td>
<td>Not available for Kit items.</td>
</tr>
<tr>
<td>Reorder Qty Total Shippable</td>
<td>Not available for Kit items. The total on hand amount minus committed quantities for all component items. (Committed is inventory that is contained on a pick order.)</td>
</tr>
</tbody>
</table>

### 10.2.2 Kit Information Tab:

This tab is where you will indicate which items you want included in this Kit.
To select items to include in your Kit Item:

1. In the **Type** drop down, select **Inventory**, **Non-Inventory** or **Assembly**.

2. In the **Item Number** field, select which item you want to add to this assembly. If you select **Full List**, the **Item List** will be filtered by the **Type** you selected (i.e., if **Non-Inventory** is selected, only non-inventory items will appear on the **Item List**. If **Assembly** is selected, only Assembly items will appear in the List).

When you tab out of the **Item Number** field after selecting an item, the **Description**, **Stocking Unit** and **Total In-House** fields will populate with the information for that item.

3. Enter the **Quantity** you want included in this **Kit Item**.

4. Press **Enter** to access a new line and enter another Item, then repeat the steps above.

**Note:** The cost will be calculated and updated based on your selections on this tab unless you have checked the **Do Not Override Cost on the General Tab** checkbox located at the bottom of the **Kit Information** tab.
10.2.3 Additional Information Tab:

When you have finished entering information on the Kit Information tab, click the Additional tab. The Additional Information tab provides optional fields where other information about the item can be recorded. An example of this tab is shown below:

Complete the fields on this tab as described below:

- **Stocking Unit** is the portion by which the quantity will be tracked. At the item level, this should be "Eaches", meaning you should enter how you want each item of this type to be measured. (Examples: bag, barrel, basket, block, bottle, box, carton, container, drum, gallon, jar, pack, package, pallet, section, tub, vial, etc.)

You will have the opportunity on the Managing Suppliers tab to enter the Order Unit used by the supplier for shipping purposes (Box, Pallet, Lot, etc.). The Order Unit will be used when creating Purchase Orders rather than the "Eaches" UOM that is entered on this tab. Please see the Managing Suppliers Tab section, below.

- **Dimension Unit** is the increment to be used for Length, Width and Height. (Examples: inch, foot, yard, millimeter, centimeter, meter, etc.)

- **Length** is the length of one Unit of Measure expressed in Dimension Units.

- **Width** is the width of one Unit of Measure expressed in Dimension Units.
• **Height** is the height of one Unit of Measure expressed in Dimension Units.

• **Weight Unit** is the increment to be used for mass. (Examples: ounce, pound, ton, milligram, gram, kilogram, metric ton, etc.)

• **Weight** is the mass of one Unit of Measure expressed in Weight Units.

• **File Reference** is used to record the path to a relevant file that might be an image file, documentation, specifications, etc. This field does not function as a hyperlink. It’s just a static field where a filename or path and filename can be recorded.

• **Add Notes** allows you to record any additional information.

10.2.4 Custom Text and Custom Numbers and Dates Tab:

For information about the **Custom Texts** and **Custom Numbers and Dates** tabs, see [Using Custom Fields](#).

10.2.5 Saving the New Item:

When you have finished adding information, click the **OK/Save** button. The system behaves differently at this point depending on your settings on the **Options** screen.

• When the **Close New Form** option is turned **off**: Click **Save** to commit your entry or click **Close** to exit the form.

• When the **Close New Form** option is turned **on**: Click **OK** to commit your entry and exit the form or **Cancel** to exit the form without saving your entry.

For more information about the **Options** screen, please refer to the [Options Screen](#) topic.
10.3 Removing Kit Items

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

The Remove screen allows you to remove a kit item from the database. This can be considered the same as shipping inventory. You can designate which customer this inventory was shipped to on this screen.

The Remove function uses FIFO (First in First Out) to determine what inventory is removed first. If you Add 5 of Item 123 to Location Bin 1, for example, then another 5 come in on another day, you will have ten of that item. When you later remove 3 of Item 123, the first set of 5 will be subtracted from inventory before the second set.

Removing Inventory from an Item:

1. From the Main screen, click the Inventory icon. The Inventory menu appears at the bottom of the screen.

2. On the Inventory menu, click the Remove icon. The Remove screen appears.

OR

1. From the Main Screen, select Lists > Item. The Item List appears.

2. On the Item List, highlight an item in the grid, then click the Remove icon.
To prevent fields from clearing, click the Pushpin button located to the right of the field you want to lock for subsequent transactions. This is helpful when you have to perform multiple removes at one Location, for example. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly remove inventory just by repeatedly scanning barcodes into that field. (The Remove button does not have to clicked between each scan to post these remove transactions to the Pending Transaction List.)

Clicking the button will unlock the field.

3. **Complete the Item fields:** Enter the **Item Number** of the item from which you want to remove inventory. To enter an **Item Number**, you can type or scan the value into the field, or you can use the drop down list to select an existing item from the first 10 Items shown there, or select <more> to select an Item from the **Item List**. You can only **Remove** quantity from items with quantity greater than 0. The **Item Number** list on this screen will not display or accept numbers that do not have quantity.

Entering an **Item Number** populates the **Item Number** field as well as the **Description** field and enables the following fields:

- **Quantity** (unless the item is **Tracked By Serial Number** - Set on the Add or Edit Item screens, which fixes the Quantity to a value of 1).
- **Location**
- **Any of the associated Tracked By fields:** Track by fields are not used for Kit items, though the individual component items may have trackrys.
- **Customer**
- **Notes**

You can use the drop down list of any enabled field to select an existing value for that field.

**Note:** If the **Automatic New** option is enabled on the Options screen, the Create New Customer screen will be opened automatically if an unknown Customer is entered. If the **Automatic New** option is turned off when an unknown Customer is entered, a prompt will ask if you want to use the Create New screen. For more information on the enabling and disabling the Automatic New option, please refer to the Options screen topic.

4. **Enter the Customer:** Select a **Customer** from the drop down list. Select <New> from the Customer drop list to open the Create New Customer screen.

The **Notes** field allows you to add and store additional information that describes the transaction.

5. After you have completed entering the information, click the **Remove** button to add the transaction to the **Pending Transaction List**. All fields on the **Remove** screen will be cleared and all but the **Item Number** field will be disabled. You can either select another item to be removed or you can click **Commit** on the Pending Transaction List to submit the transaction(s).

The **Remove** button will not be enabled until all required information is entered in the appropriate fields. Click the **Remove** button to continue Removing the kit item. If no additional information
(such as serial numbers) is needed for any of the associated component items, you can click Commit at this point to complete the remove process.

If additional information is needed for one or more items, this Remove screen appears.

This Remove screen displays all items tied to this Kit Item. Those items that appear checked as in the example above are ready to be removed.

Items that are not checked need additional information, usually a Track By or Location, if inventory is kept at more than one location.

6. In the Item Number field, enter the Item Number, or highlight an unchecked item in the display screen. The selected item’s information will populate the screen.

7. Enter any missing information, usually a Track By such as Serial Number. When you are tracking by serial number, click on the Serial Number drop down to see a list of all unique serial numbers associated with the selected item. You can also scan this information.

Note: To prevent fields from clearing, click the pushpin button located to the right of the field you want to lock. This is helpful when you have to enter multiple serial numbers, for example. Pushpins
can be used to lock the values in all but one required field so that a scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that field. This feature is especially useful when scanning serial numbers.

Clicking the button will unlock the field.

8. Click the Next button to continue. You will be returned to the Remove screen where you can enter another item for removal, if needed.

9. If you want to print a receipt of this transaction, enter the number of receipts in the Print receipt on Commit - Copies field.

10. Click Commit to submit the transaction(s) to your database.
Chapter 11 - Pick Orders

11.1 Pick Order Overview

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

Pick Orders are orders that you create when inventory is requested by a customer and needs to be taken (picked) from your warehouse, store, storage facility, etc. and shipped to the customer. InventoryControl allows you to create a pick order that can then be automatically emailed to the warehouse and/or printed for reference.

The basic flow of pick orders is as follows:

1. Your business receives a request for inventory (through an invoice, a sales slip, etc.).

2. A pick order for the requested merchandise is entered on the Create New Pick Order screen. You can enter any item in any quantity on this screen. Actual on-hand amounts are not checked at this point. You can choose to email the order and/or print the order. These two actions occur when you click the Save button.

   A newly created Pick Order has a status of New. The status remains New until pick quantities are entered on the Picking Order screen. If the order becomes overdue before it begins to be picked, the status changes to New - Overdue.

   For detailed information creating pick orders, please see the Creating a Pick Order topic.

3. The Pick Order now appears on your Pick Order List (Lists > Pick Orders). From the Pick Order List you can Edit or Delete (as long as the order is not in process) the order as needed.

   For an example of the Pick Order List, please refer to the Pick Order List Example topic. For detailed information on using the list screen, please refer to the Working with Lists topic.

4. When the order is actually being picked, that is, the inventory is being readied for shipping to the customer, the picked quantities for each item on the order are entered in the Picking Order screen (Receive/Pick menu > Pick). This can be done on the PC or on the mobile devices. At this time, the quantities are checked and you cannot pick more than you actually have in inventory.

   For detailed information on picking orders on the PC, please refer to Picking Orders. For detailed information on picking orders on a Windows Mobile Device, please refer to Windows Mobile Device - Picking Items for Orders. For detailed information on picking orders on the WDT2200, please refer to WDT2200 - Picking Inventory for Orders.

   Pick orders that have some items picked have a status of In Process. If the order becomes overdue, it will have a status of In Process - Overdue.

   For detailed information on the Picking Order screen, please refer to the Picking Orders topic.
5. After the order is fully picked it has a status of **Completed**. You can have InventoryControl automatically email the packing slip to the customer.

### 11.2 Creating a Pick Order

*This function applies to Pro and Enterprise Version users only.*

**Note:** For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > **Benefits of Upgrading** on the Main screen.

Pick orders are created to designate certain inventory to be shipped to a customer. On the **Create New Pick Order** screen, you are creating an order that tells your staff to get the order ready and what inventory to include. These orders can be sent to the mobile devices (although pick orders cannot be created on mobile devices). After the order has been picked, you need to mark it as ready to be shipped on the **Pick Order** screen accessed from the **Receive/Pick** menu. At this point, the inventory is removed from the system. For more information on the **Pick Order** screen, please refer to the **Shipping Pick Orders** topic.

We recommend you review the **Pick/Ship Overview** before creating pick orders for the first time.

**Creating New Pick Orders:**

1. From the **Main** screen, select **New > Pick Order**.

   OR

   From the **Main** screen, click **Lists > Pick Order**. On the **Pick Order List**, click the **New** icon.

   The **Create New Pick Order** screen appears.
Notice that the screen prominently displays the status as **New**. This status message changes based on the state the order is in.

Possible statuses are:

- **New** - This always displays when creating a new order.
- **Issued** - Once the pick order is printed or emailed, the status changes to **Issued**.
- **In Process** - Once the order has started to be picked (via the Pick Order screen accessed from the Receive/Pick menu), the status becomes **In Process** and the Picked Quantity will display for each item on the order.
- **Overdue** - This status can appear for **New** or **In Process** orders that have passed the designated due date. These orders will appear with a symbol on the Pick Order List to alert you of their overdue status.
- **Closed** - This status means the order has been completed and marked as closed.

**Note:** To prevent fields from clearing, click the pushpin button located to the right of the field you want to lock. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that field.

Clicking the button will unlock the field.
1. **Enter a Pick Order Number.** Each pick order is assigned a unique identifier consisting of an alpha-numeric value up to 36 characters. This number can be manually entered each time you create a new pick order or you can create a template that the software will use to automatically generate a number for you. If you have set up a template, click the Generate button to have InventoryControl create and assign an order number. The template can contain any combination of custom text, dates and/or counters enabling you to create a unique identifier that is meaningful to your company. For more information on setting up automatically generated Order Numbers, please refer to the *Formatting PO and Pick Order Numbers* topic.

2. **Enter a Customer in the Customer field.** You can scan a value into this field, manually enter a value or click on the field to view a drop down list. The list contains the last 10 Customers selected on this screen. Select <MORE> to view the entire Customer List or click <New> to go to the Create Customer Supplier screen to add a new customer to the database. When a customer is selected, the Customer Address information automatically populates. If the selected customer has more than one address entered for it, you can select the Address Type from the drop down list.

3. **Enter an Order Date** for this order. This date defaults to today, but you can change this date by clicking the down arrow and selecting a new date.

4. **Enter a Due Date** for this order. You can type in a date in this field or click the down arrow to select a date.

5. **Enter a Reference Number** for this Pick Order (optional).

6. **Select the preferred shipping method** for this order in the Ship Via field from the drop down list. This list contains several commonly used shipping methods, however; you can type in a new shipping method if desired. The new entry will appear in the drop down list for future purchase orders.

   **Note:** If you need to delete a Ship Method you have entered, you can do so on the Manage Ship Methods screen. This screen also allows you to Print, Export and Add New methods. For more information on the Manage Ship Methods screen, please refer to the *Managing Shipping Methods* topic.

7. **Enter any notes you want to associate with this order** in the Notes field.

8. **Now you are ready to enter your item information** in the Line Item Details section. Complete this information as follows:

   - **Type** - Select the type of item that needs to be picked. Options are:
     - **Inventory** - This item is in your inventory database. Use this to pick existing items.
     - **Non-Inventory** - This item is not in your inventory database. Use this to pick items that you do not want to appear in your inventory database, such as marketing fliers or business cards.
     - **Assembly** - Assembly Items are a collection of items that, once grouped, are considered to be a new, single item. Assembly Items are pre-assembled and kept in stock.
     - **Kit** - Kit items are a collection of items that are grouped, or picked, at the time they are sold.
Manual - Use this option to add one-time items, such as shipping and handling, to an order. Manual items cannot be picked on the mobile devices.

- **Item Number** - Enter the **Item Number** of the item you want to add to the order. To enter an **Item Number**, you can type or scan the value into the field, or you can use the drop down list to see the first 10 items in the database, select <more> on the drop down list to see all items in the **Item List**.

You can create a new item by selecting <New> or by entering an unknown item number. When either of these two situations occur, the Create New Item screen appears. For more information on creating items, please refer to the Creating New Items topic.

When you enter an **Item Number** the **Description** field populates.

- **Request Qty** - Enter the requested number of this item. This value can also be scanned. You cannot enter negative numbers. You can enter any item held in your inventory in any amount on this screen. Actual on-hand amounts are not checked at this point so you are not limited to creating pick orders for the quantity of items in your inventory.

- **Stocking Unit** - This field displays the stocking unit entered for this item on the New Item/Edit Item screen. The stocking unit represents how you stock this item in your inventory. For instance, if you stock the unit in boxes of 10. Box of 10 would display in the Stocking Unit field on this screen. For more information on creating items, please refer to the Creating New Items topic.

- **Description** - This field populates after the item number is entered and cannot be changed on this screen. If you need to change the description, you can do so on the Edit Item screen.

9. After you have entered all items for this order, you can optionally select to:

- **Print on Save** - If this box is checked, a copy of this order automatically prints when you click the **Save** button.

- **Email on Save** - If this box is checked, a copy of this order is automatically sent to the email address listed in the **Customer** screen for this customer when you click the **Save** button. If you have selected to view the Email Destination List (selected on the Options screen), the list will appear allowing you to select email addresses or change email addresses as needed. If you have selected not to view the list, the order will automatically be sent to the email address listed in the **Customer** screen from the email address listed in the **Company Information** screen. Please note that if the email addresses are not entered on the **Customer** or **Company Information** screens, you will receive an error message when you try to send emails.

An email is also sent to any CC addresses designated on the Options screen. You can choose to ignore the CC address by deselecting the checkbox next to the CC Addresses field on the Email Destination List.

Below is an example of the Email Destination List:
In order for the email feature to work correctly, you must set your **SMTP Server**, **User Name** and **Password** (if authentication is required for outgoing mail) and the **SMTP Port** on the **Options** screen. If these are not set, an error message will appear.

For more information on setting these email options on the **Options** screen, please refer to the **Options Screen** topic. For more information on the Email Distribution List, please see the **Email Distribution List** topic.

10. Click **Save** to save this order to the database. A newly created pick order has a status of **New**. The status remains **New** until pick quantities are entered on the **Pick** screen. If the order becomes overdue before it begins to be picked, the status changes to **New- Overdue**.

### 11.3 Editing Pick Orders

**Pro and Enterprise Versions Only**

**Note:** For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select **Help > Benefits of Upgrading** on the Main screen.

The **Edit Pick Order** screen allows you to modify an existing purchase order. This screen is accessed from the **Pick Order List** by highlighting an item in the list, then clicking the **Edit** button on the toolbar. For more information on using the List screens, see the **Working with Lists** topic.

The **Edit Purchase Order** screen is identical to the **New Purchase Order** screen, except all the information previously entered for the order appears on the screen. You can change any of this information. For information on using each tab of the screen, please refer to the **Creating a Pick Order** topic.
11.4 Pick Order List Example

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

The Pick Order List displays all active pick orders entered in the system. Active pick orders are those that have a status of New, New-Over Due, In Process or In Process-Over Due. Below is an example of the Pick Order List.

Notice the red flags next to some of the orders on the list. These red flags indicate that the order is past due. The status may be New-Past Due or In Process-Past Due. Overdue orders will appear at the top of the list by default, but you can reorder the list as needed.

The Pick Order List screen allows you to Edit, create New, Copy, Delete, Show, Filter, Export or Print the list of Pick Orders. For detailed information regarding each of these options, refer to the Working with Lists topic.
11.5 Picking Orders

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

When a pick order is actually being picked, meaning the inventory is being readied for shipping to the customer, the quantities that are removed from inventory for each item on the order are entered in the Pick screen. At this time, the quantities are checked and you cannot pick more than you actually have in inventory unless the Over Pick option is enabled on the Options screen.

Picking Orders:

1. From the Main screen, click the Receive/Pick icon. The Receive/Pick menu appears at the bottom of the screen.

2. On the Receive/Pick menu, click the Pick button. The Pick screen appears:

   ![Pick Screen](image)

3. Select which pick order you will be working on from the Order Number drop down list. The most recently selected orders will appear in the list or select <More> to view the Pick Order List. When you select an Order Number, the information for the selected picking order populates the screen:
4. Enter the date these items are to be shipped in the **Ship Date** field.

5. You can optionally type in notes for this order in the **Notes** screen.

6. How you can mark the items as picked. Select the checkbox next to the item you are picking:

   The **Quantity** field becomes enabled allowing you to enter the quantity you picked.

   You must mark these items as picked from one or more locations by clicking the plus sign in front of the listing:

   A box appears allowing you to select a **Location** and a **Quantity** for that location. The **Available Qty** is also shown so you can easily see how many of this item are available at this location.

7. You can select options to be performed upon clicking **Save** from the **On Save** section. Options are:

   - **Print Packing Slip. Copies** - Prints the packing slip containing all items picked for this order. Enter the number of copies of this packing slip you want to print in the field provided.

You can open a pick order and print one or more copies of the packing slip regardless of what state the pick order is in (new, issued). To do this, enter the number of copies you want to print, then click **OK**. All items picked for this order will be included on the packing slip, regardless of the setting of the **Packing Slip for Session** option (see Note, below,
Email Packing Slip - Sends an email containing this packing slip to the selected addresses. If you have selected to view the Email Destination List (selected on the Options screen), the list will appear allowing you to select email address or change email addresses as needed. If you have selected not to view the list, the packing slip will automatically be sent to the email address listed in the Customer screen from the email address listed in the Company Information screen. Please note that if the email addresses are not entered on the Customer or Company Information screens, you will receive an error message when you try to send emails.

An email is also sent to any CC addresses designated on the Options screen. You can choose to ignore the CC address by deselecting the checkbox next to the CC Addresses field on the Email Destination List.

In order for the email feature to work correctly, you must set your SMTP Server, User Name and Password (if authentication is required for outgoing mail) and the SMTP Port on the Options screen. If these are not set, an error message will appear.

For more information on the Options screen, please refer to the Options Screen topic.

Close this Pick Order - Marks this order as closed. Select this option after all items for the order have been picked.

Note on the Packing Slip for Session Option:

By default, the packing slip that can be printed and/or emailed upon saving displays only items picked in the current pick session. If you want to pick multiple times and print a packing slip that displays all the picks for this pick order, including items picked previously, you can select to do so on the Options screen.

For example:

Assume Pick Order 001 a quantity of 5 for item ABC and a quantity of 4 for item XYZ. Today I pick 2 of item ABC and 2 of item XYZ and ship them. The packing slip will display 2 ABC and 2 XYZ. Tomorrow I pick the other 3 of item ABC and 2 of item XYZ and ship them. The packing slip has 3 ABC and 2 XYZ.

This would also be exactly the same if both picks and ships were done on the same day.

If, however, I pick what I have in the morning and don’t ship it and a shipment comes in that day or the next and I complete the order before shipping anything, I will want all of the items picked throughout the day to display on one packing slip. To do this the option must be set on the Options screen to accumulate all of the picks on the pick slip. For more information on this option, please refer to the Options Screen topic.
This feature opens a screen that allows you to quickly type in or scan in information. When you click the Quick/Scan Entry button, a screen similar to the one shown below appears:

You can scan the barcode label on the item and the fields on the Quick/Scan Entry screen will populate with the scanned information. Click the Pick button, then scan the next item and the screen clears and repopulates with the new information. This is an easy method for quickly marking items as picked.
Chapter 12 - Purchase Orders/Receiving

12.1 Purchase Orders/Receiving Overview

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

Purchase orders can be created in InventoryControl when you need to order additional inventory from suppliers. These orders can be emailed to the supplier and/or printed upon creation and can be easily referenced and searched in the system. When you receive shipment of the items on the purchase order, the items can be marked as received either on the PC's Receive screen or on the mobile devices.

InventoryControl allows you to create purchase orders for:

- **Inventory Items** - This item is already in your inventory database. Use this to re-order existing items.
- **Assembly Items** - Assembly items are created when you combine two or more existing items or multiple quantity of one item to create a new item.
- **Non-Inventory Items** - This item is not listed as inventory in your database. Use this to order items for which you do not want to track inventory, such as marketing fliers or business cards.
- **Manually Entered Items** - Use this option to add one-time items, such as shipping and handling, to an order. Be aware that manual items cannot be received on the mobile devices.

With a little advanced planning much of the purchase order creation process can be automated for you. Setting up these four pieces before you begin creating purchase orders will speed the process:

- Set up preferred suppliers for your items (Pro and Enterprise versions only), then you can simply enter the item number on the purchase order and the supplier information will automatically appear on the order.

- Enter a supplier or suppliers for an item and enter that supplier's shipping unit of measure, this information will also automatically appear. Preferred suppliers are entered on the Create New or Edit Item screen, Manage Suppliers tab. Supplier unit of measure information is entered on the Create New or Edit Supplier screen.

- Create a template for your purchase order numbers so that they will be automatically generated for each purchase order you create. These templates are set up on the Formatting PO and Pick Order Numbers screen.

- Make sure you enter a minimum stock level for your items and enable the Automatic Notification option. This enables InventoryControl to notify you of items that have reached their reorder point in a report broken down by location. Minimum stock levels are entered on the Create New or Edit Item screen, General tab. The Automatic Notification option is enabled on the Options screen.

- Enter email addresses for your suppliers. If email addresses are entered, you can select the Email on Save option at the bottom of the Create New Purchase Order screen to automatically send notification emails to the supplier attached the current PO. In addition, you can enable InventoryControl to send notification emails to PO managers, receiving, or anyone for whom you
have entered an email address. You can enter email addresses for your suppliers on the Create New or Edit Supplier screen.

To further streamline the process, you can use a barcode scanner to add information to the scannable fields on the Create New Purchase Order screen, including Supplier, Purchase Order Number and Item Number.

The basic flow from purchase order creation to receiving the items is as follows:

1. When you need to replenish inventory for an item or items, create a purchase order on the Create New Purchase Order screen (accessed from New > Purchase Order). After you select a Supplier for this purchase order, you can click the Items at Re-Order Point button at the bottom of the screen. The system will then check for any items for this supplier that are at or below their reorder points and populate the purchase order with those items.

A newly created Purchase Order has a status of New. The status remains New until item quantities are entered on the Receive screen. If the order becomes overdue before you receive it, the status changes to New - Overdue.

For detailed information creating purchase orders, please see the Creating a Purchase Order topic.
The Purchase Order now appears on your Purchase Order List (Lists > Purchase Orders). From the Purchase Order List you can Edit or Delete (as long as the order has not been partially received) the order as needed.

For an example of the Purchase Order List, please refer to the Purchase Order List Example topic. For detailed information on using the list screen, please refer to the Working with Lists topic.

2. When you begin to receive inventory for the purchase order, you will enter the quantity received for each item on the Receive screen (Receive/Pick menu > Receive). Inventory for an item can be marked as received on the PC’s Receive screen or on the mobile devices. This screen allows you to enter quantities received by location, and can optionally show you costing information as well. Receiving inventory on the Receive screen adds inventory to that item.

Purchase orders that have some items received have a status of In Process. If the order becomes overdue, it will have a status of In Process - Overdue.

For detailed information on the Receive screen, please refer to the Receiving Inventory topic. For detailed information on receiving inventory on the WDT2200, please refer to WDT2200 - Receiving Inventory. For detailed information on receiving inventory on a Windows Mobile Device, please refer to Windows Mobile Device - Receiving Inventory.

3. After the order is fully picked it has a status of Completed.
12.2 Creating a New Purchase Order

*This function applies to Pro and Enterprise Version users only.*

**Note:** For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select **Help > Benefits of Upgrading** on the **Main** screen.

Purchase orders can be created in InventoryControl and emailed directly to your supplier, or printed for faxing or mailing. We recommend you review the topic **Purchase Orders/ Receiving Overview** before using the purchase order feature for the first time.

**Creating New Purchase Orders:**

1. From the **Main** screen, select **New > Purchase Order**.

   **OR**

   From the **Main** screen, select **Lists > Purchase Order**. On the **Purchase Order** List, click the **New** icon.

The **Create New Purchase Order** screen appears.

Notice that the screen prominently displays the status as **New**. This status message changes based on the stage the purchase order is in.
Possible statuses are:

- **New** - This always displays when creating a new order.
- **Issued** - Once the purchase order is printed or emailed, the status changes to Issued.
- **In Process** - Once the order has started to be received (via the Receive screen accessed from the Receive/Pick menu), the status becomes In Process and the Received Quantity will display for each item on the order.
- **Overdue** - This status can appear for New or In Process orders that have passed the designated due date. This orders will appear with a symbol on the Purchase Order List to alert you of their overdue status.
- **Closed** - This status means the order has been completed and marked as closed.

**Note:** To prevent fields from clearing, click the pushpin button located to the right of the field you want to lock. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that field.

Clicking the button will unlock the field.

2. Enter a supplier in the **Supplier** field. You can scan a value into this field, manually enter a value or click on the field to view a drop down list. The list contains the last 10 Suppliers selected on this screen. Select <More> to view the entire Supplier List or click <New> to go to the Create New Supplier screen to add a new supplier to the database.

When a supplier is selected, the **Supplier Address** information automatically populates. If the selected supplier has more than one address, you can select the **Address Type** from the drop down list.

After you enter the **Supplier** information, you can click the **Items at Minimum Stock Level** button at the bottom of the screen. The system will then check for any items for this supplier that are at or below their minimum stock levels and populate the purchase order with those items.

3. Enter a **Purchase Order Number**. Each purchase order is assigned a unique identifier consisting of an alpha-numeric value up to 36 characters. This number can be manually entered each time you create a new purchase order or you can create a template that the software will use to automatically generate a number for you. If you have set up a template, click the **Generate** button to have InventoryControl create and assign a PO number. The template can contain any combination of custom text, dates and/or counters enabling you to create a unique identifier that is meaningful to your company. For more information on setting up automatically generated **Purchase Order Numbers**, please refer to the Formatting PO and Pick Order Numbers topic.

You should set up your numbers to contain a date field, followed by a serialized (count field), at the very least.

4. Select a **Ship To Address** using the drop down menu. All address types you entered on the Company Information screen will appear in the list, or you can select <New> to enter a new address. Selecting <New> opens the Company Information screen allowing you to enter a new address. For more information on the Company Information screen, please refer to the
Entering Company Information topic.

5. Enter a **Reference Number** for this **Purchase Order** (optional).

6. The **Order Date** defaults to today's date. You can change this date by clicking the button next to the field and selecting a new date.

7. Select a **Due Date** for this **Purchase Order**. You can type in a date or click the button next to the field and select a date.

8. Select the preferred **Ship Method** for this order from the drop down list. This list contains several commonly used shipping methods, however; you can type in a new shipping method if desired. The new entry will appear in the drop down list for future purchase orders.

9. Select the **Payment Method** from the drop down list. This list contains several commonly used shipping methods, however; you can type in a new shipping method if desired. The new entry will appear in the drop down list for future purchase orders.

**Note:** If you need to delete a **Ship** or **Payment Method** you have entered, you can do so on the **Manage Ship Methods** or **Manage Payment Methods** screens. These screens also allow you to Print, Export and Add New methods. For more information on the **Manage Ship Methods** screen, please refer to the **Managing Shipping Methods** topic. For more information on the **Manage Payment Methods** screen, please refer to the **Managing Payment Methods** topic.

10. Now you are ready to enter your item information in the **Line Item Details** section. Complete this information as follows:

- **Type** - Select the type of item you are ordering. Options are:
  - Inventory - This item is already in your inventory database. Use this to re-order existing items.
  - Non-Inventory - This item is not listed as inventory in your database. Use this to order items for which you do not want to track quantity, such as marketing fliers or business cards.
  - Manual - Use this option to add one-time items, such as shipping and handling, to an order. Manual items cannot be received on the mobile devices.

- **Item Number** - Enter the **Item Number** of the item you want to order. To enter an **Item Number**, you can type or scan the value into the field, or you can use the drop down list to see the first 10 items in the database, select <more> on the drop down list to see all items in the **Item List**.

  When you enter an **Item Number**, the **Description** field populates.

- **Description** - This field populates after the item number is entered. This field can only be edited if Manual was selected in the **Type** field. If you need to change the description, you can do so on the **Edit Item** screen.

- **Vendor SKU** - This field populates after the item number is entered if a SKU was entered on the Add/Edit Item screen for this vendor. This field can only be edited if Manual was selected in the **Type** field.
• **Ordered QTY** - Enter the quantity you are ordering of this item. This field defaults to 1. You cannot enter negative values in this field.

• **Order Unit** - Select the Order Unit from the drop down field or select `<New>` to enter a new Unit. You may want to enter a new unit here that is not an "eaches" or Stocking Unit measurement. For example, if you want to order 1 box of an item and this item ships in boxes containing 15 units, the "eaches", or Stocking Unit measurement is 15, but for ordering purposes, you could create a new unit that is BOX containing 15 units. You would then order 1 box rather than 15 units to avoid confusion for the supplier.

You can setup multiple Order Unit types for each supplier on the **Create New/Edit Item** screen - **Manage Suppliers** tab. This allows you to enter units based on the suppliers method of shipping (whether the supplier ships in boxes of 15, pallets of 50, etc.) For instance, you could set up a Box and Pallet Order Unit on the **Suppliers** tab so that when you create a Purchase Order for that item to go to the supplier, you can quickly select whether you want a box or a pallet. For more information on the **Add Item** screen - **Manage Suppliers** tab, please refer to the **Creating New Items** topic.

• **Cost** - The cost will populate based on the **Order Unit** selected. You can also type in a new cost here.

• **Line Total** - This field calculates based on the **Quantity** multiplied by the cost.

11. After you have entered all items for this order, you can optionally select to:

• **Print on Save** - If this box is checked, a copy of this order automatically prints when you click the **Save** button.

• **Email on Save** - If this box is checked, a copy of this order is automatically sent to the email address listed in the **Supplier** screen for this supplier when you click the **Save** button. If you have selected to view the **Email Destination List** (selected on the **Options** screen), the list will appear allowing you to select email addresses or change email addresses as needed. If you have selected not to view the list, the order will automatically be sent to the email address listed in the **Supplier** screen **from** the email address listed in the **Company Information** screen. Please note that if the email addresses are not entered on the **Supplier** or **Company Information** screens, you will receive an error message when you try to send emails.

Below is an example of the **Email Destination List**:

![Email Distribution List](image)

An email is also sent to any CC addresses designated on the **Options** screen. You can choose to ignore the CC address by deselecting the checkbox next to the **CC Addresses**.
field on the Email Destination List.

It is a good idea to send yourself or someone else internal to your company a copy of any orders you email to a supplier.

In order for the email feature to work correctly, you must set your SMTP Server, User Name and Password (if authentication is required for outgoing mail) and the SMTP Port on the Options screen. If these are not set, an error message will appear.

For more information on setting these email options on the Options screen, please refer to the Options Screen topic.

- Items at Minimum Stock Level - To help you keep track of items that are in danger of becoming understocked, InventoryControl has an automatic notification system built in. Click the Items at Minimum Stock Level to view a list of all items that are currently at their minimum stock levels and whose default supplier is the supplier selected for this purchase order.

To use this feature, make sure you turn on the Automatic Notification option via the Options screen, then enter a quantity in the Minimum Stock Level field on the Create New or Edit Item screen, Location tab.

12. Click Save to save this purchase order to the database.

12.3 Editing Purchase Orders

Pro and Enterprise Versions Only

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

The Edit Purchase Order screen allows you to modify an existing purchase order. This screen is accessed from the Purchase Order List by highlighting an item in the list, then clicking the Edit button on the toolbar. For more information on using the List screens, see the Working with Lists topic.

The Edit Purchase Order screen is identical to the New Purchase Order screen, except all the information previously entered for the order appears on the screen. You can change any of this information. For information on using each tab of the screen, please refer to the Creating a Purchase Order topic.
12.4 Purchase Order List Example

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

The Purchase Order List displays all active purchase orders you have in your system. Active purchase orders are those that have a status of New, New-Over Due, In Process or In Process-Over Due. Below is an example of the Purchase Order List.

![Purchase Order List Example](image)

Notice the red flags next to some of the orders on the list. These red flags indicate that the order is past due. The status may be New-Past Due or In Process-Past Due. Overdue orders will appear at the top of the list by default, but you can reorder the list as needed.

The Purchase Order List allows you to Edit, create New, Copy, Delete, Show, Filter, Export or Print the list of Purchase Orders. For detailed information regarding each of these options, refer to the Working with Lists topic.
12.5 Receiving Inventory from Purchase Orders

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

When you begin receiving inventory on a purchase order you created in the system, you will mark that inventory as received on the Receive screen. This screen allows you to select which purchase order you are receiving on and to mark individual items on that purchase order as received into a specific location. You can also optionally view costing information on this screen as well.

Receiving Inventory:

1. From the Main screen, click the Receive/Pick icon. The Receive/Pick menu appears at the bottom of the screen.

2. On the Receive/Pick menu, click Receive. The Receive screen appears:

3. On the Receive screen, select which Purchase Order you are receiving on from the drop down list. When you select a Purchase Order, the screen populates with the information from that order as shown below:
4. Enter the date these items were received in the Date field. You can enter previous dates, but not future dates.

5. You can optionally type in a receipt number in the Receipt Number field. If you receive this order in more than one shipment, you can partially receive it and enter in each receipt number as you access the screen. Previously entered receipt numbers, if any, will appear in the Receipt Number drop down list.

6. Now you can mark the items as received. Select the checkbox next to the item you are receiving:

The Quantity field becomes enabled allowing you to enter the quantity you received. In the example above, you would enter however many cartons of this item you received.

You must mark these items as received into one or more locations by clicking the plus sign in front of the listing.
A box appears allowing you to select a Location and a Quantity for that location. Please be aware that quantities entered here are broken into Eaches. For instance, in the example above, 18 cartons of Item 400003 were ordered. Assume there are 200 items per carton. When you enter 5 in the Location/Quantity field, you are telling the system that 5 items from a carton were received into this specific location, rather than 5 cartons being received. If you wanted to receive 5 cartons into this location, you would need to enter 1000 (5 x 200).

7. After you have entered quantity amounts for all items you are receiving, you can (optionally) select tasks from the On Save section. You can select to:

- **Print Receipts**: When this is selected, when you click Save all receipts entered for this Receive screen will print. This means that if you received this order in two separate shipments, and entered two separate receipts in the Receipt Number field, both receipts will print.
- **Print Labels**: When this is selected, when you click Save, labels will print for the received items.
- **Close This PO**: When this is selected, when you click Save, the selected Purchase Order will be marked as closed. You would want to use this when you have received all items from the purchase order.
- **Create Backorder, if necessary**: When this is selected, after you click Save, a backorder will be created for any items that have not been received on this Purchase Order. When a backorder is created you will see the order on the Purchase Order List with the status of New and BO appended to the end of the order number.

8. Click Save to save your changes. The Received Quantity field for each item will go up by the amount you entered as received. When you click Save, the on hand quantities for the items you just received will increase by the amounts you entered.

If you partially received the order, the order's status will change to In Process.
You can scan the barcode label on the item and the fields on the Quick/Scan Entry screen will populate with the scanned information. Click the Receive button, then scan the next item and the screen clears and repopulates with the new information. This is an easy method for quickly marking items as picked.
12.6 Purchase Order FAQ

What is the difference between the Shipping Unit of Measure and the Stocking Unit of Measure?

The **Stocking Unit**, entered on the **Create New Item** or **Edit Item** screen, **Additional** tab, is the portion by which the quantity will be stored in your inventory. This unit represents "Eaches", meaning it represents how you want each item of this type to be measured. Examples are: bag, barrel, basket, block, bottle, box, carton, container, drum, gallon, jar, pack, package, pallet, section, tub, vial, etc.)

The **Shipping Unit**, entered on the **Create New Item** or **Edit Item** screen, **Manage Suppliers** tab, (Pro and Enterprise versions only) isthe unit used by the supplier when shipping this item. This may be box, pallet, etc. This is different from the "Eaches" **Stocking Unit**. For example, you may have entered "jar" for the stocking unit, but the supplier may ship the item in boxes containing 10 jars. In this example, when creating purchase orders, you would specify the **Order Unit** as "box" rather than "jar" (or you could end up with 100 boxes of jars rather than 100 jars).

I have the Standard version of InventoryControl. Can I set up preferred suppliers for my items?

Standard version users are limited to one supplier per item, so this is automatically your preferred supplier. Pro and Enterprise version users can enter multiple suppliers for each item and select one as their preferred supplier.

What is the difference between the Reorder Quantity field found on the Create New Item or Edit Item screen, General tab and the Reorder Quantity field found on the Create New Item or Edit Item screen, Location tab?

The **Reorder Quantity** field on the **General** tab is the reorder quantity for the item throughout all sites and locations. The **Reorder Quantity** field on the **Location** tab is the reorder quantity for the item at a specific location (you can enter this quantity for each location that contains this item).

When you are creating purchase orders, you can click the **Items at Re-Order Quantity** button to see a list of items that have reached their minimum stock levels (by location) for the selected supplier. You can then select which items to add to the purchase order and they will be inserted into the current order. The quantity in the **Reorder Quantity** field on the **Location** tab will be used for the quantity requested on the purchase order.
12.7 Deleting Purchase Orders/Pick Orders

Pro and Enterprise Versions Only

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

You can quickly delete a Purchase Order or Pick Order from the Purchase Order or Pick Order List. Only orders with a status of New can be deleted. Once the status changes to In Process, meaning the order is partially received or partially picked, the order can no longer be deleted (however, these can still be edited or closed).

Deleting Purchase Orders/Pick Orders:

1. From the Main screen, select Lists > Purchase Orders or Lists > Pick Orders, depending on which type of order you want to delete. The List screen appears.

2. On the List screen, highlight the order you want to delete, then click the Delete button. If this order cannot be deleted (has a status of In Process), a warning message will appear notifying you. If the order can be deleted, a confirmation message will appear.

3. Click Yes on the confirmation message to delete the order.
12.8 Receive/Pick Menu

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

The Receive/Pick Menu groups functions for receiving inventory from purchase orders and shipping pick orders into one location. You can also manage your shipping methods and payment methods from this screen as well as customize automatically generated purchase order and pick order numbers.

Receiving can be done either through the PC or on the mobile devices and adds inventory to your database. Pick orders are orders to pick and ship inventory to a customer, thus removing the inventory from your database.

To Access the Receive/Pick Menu:

1. On the Main screen, click the Receive/Pick icon. The Receive/Pick menu appears at the bottom of the screen.

2. Click on any of the Receive/Pick Menu icons to go to that function. Detailed descriptions of the options found on the Receive/Pick Menu are provided below:

   - Receive - The Receive function allows you to receive inventory from a purchase order. This adds inventory to an item in the same way you manually add inventory via the Add Inventory screen (accessed from the Inventory menu or from the Item and Inventory lists). For detailed information on this screen, please refer to the Receiving Inventory...
• **Pick** - The **Pick** function allows you to designate pick orders for shipping or to close a pick order. **Pick Orders** list inventory that needs to be sent to a customer. **Pick** orders remove inventory from an item in the same way you manually remove inventory via the **Remove Inventory** screen (accessed from the **Inventory** menu or from the **Item** and **Inventory** lists.) For information creating a new pick order, please refer to the **Creating a Pick Order** topic. For information on shipping **Pick Orders**, please refer to the **Picking Orders** topic. For an overview of Pick Orders, please refer to the **Pick Orders Overview** topic.

• **Manage Ship Methods** - This function access a screen that allows you to add, delete, export or print shipping methods you have entered into the system (via the **Shipping Method** field on the **Create New Purchase Order** or **Create New Pick Order** screens). For detailed information on this function, please refer to the **Managing Shipping Methods** topic.

• **Manage Payment Methods** - This function access a screen that allows you to add, delete, export or print shipping methods you have entered into the system (via the **Shipping Method** field on the **Create New Purchase Order** screen). For detailed information on this function, please refer to the **Managing Payment Methods** topic.

• **Customize Numbers** - This feature allows you to customize the format of **Purchase Order Numbers** and **Pick Order Numbers** that the software automatically generates when creating a new **Purchase Order** or **Pick Order**. For detailed information on this feature, please refer to the **Customizing Numbers** topic.
12.9 Managing Payment Methods

This function applies to Pro and Enterprise Version users only.

**Note:** For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

This function accesses a screen that allows you to delete, export or print shipping methods you have entered into the system via the Payment Method field on the Create New Purchase Order screen.

This topic discusses:

- Adding Payment Methods
- Deleting/Printing/Exporting Payment Methods

12.9.1 Adding Payment Methods:

**Note:** Payment Methods can also be added on the Create New Purchase Order screen by typing in a new method in the Payment Method field.

1. From the Main screen, click the Receive/Pick icon. The Receive/Pick menu appears at the bottom of the screen.

2. On the Receive/Pick menu, click the Manage Payment Methods icon. The Payment Method List appears displaying all payment methods entered into the system.
3. The last row on the grid is blank. Click in the row and type in the new payment method.

4. Press **ENTER** or the down arrow key on your keyboard to go to the next new row and enter another payment method.

5. Click **Save** to save your additions or **Cancel** to close the screen without saving.

### 12.9.2 Deleting/Printing/Exporting Payment Methods:

1. From the **Main** screen, click the **Receive/Pick** icon. The **Receive/Pick** menu appears at the bottom of the screen.

2. On the **Receive/Pick** menu, click the **Manage Payment Methods** icon. The **Payment Method List** appears displaying all shipping methods entered into the system.
3. Highlight the desired listing, then select the function you want to perform. Options are:

- **Delete** - This deletes the highlighted shipping method from the database. When you select this option, a confirmation message will appear. Select Yes on the confirmation message to delete the method. It will no longer appear in the Payment Methods drop down list.

- **Print** - Allows you to print the Payment Method List. When this option is selected, a standard Page Setup screen appears allowing you to enter margins. An example of this screen is shown below:

- **Export** - Allows you to export the Payment Method List to an external text file. When the Export option is selected, a screen appears allowing you to specify where the exported data will be saved on your computer. An example of the Export screen is shown below:

Click the OK button on the Page Setup screen to print the list. The list will print to your default printer.
Make sure you save this to a location you can remember. You must also choose a name for your file on this screen. After you have made your selections, click **Save** to export your data.

A confirmation message will appear when your data has been successfully exported by the system.
12.10 Managing Shipping Methods

This function applies to Pro and Enterprise Version users only.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

This function accesses a screen that allows you to delete, export or print shipping methods you have entered into the system via the Shipping Method field on the Create New Purchase Order or Create New Pick Order screens. You can also add additional new shipping methods on this screen.

This topic discusses:

Adding Shipping Methods

Deleting/Printing/Exporting Shipping Methods

12.10.1 Adding Shipping Methods:

Note: Shipping Methods can also be added on the Create New Purchase Order and Create New Pick Order screens by typing in a new method in the Shipping Method field.

1. From the Main screen, click the Receive/Pick icon. The Receive/Pick menu appears at the bottom of the screen.

2. On the Receive/Pick menu, click the Manage Shipping Methods icon. The Ship Method List appears displaying all shipping methods entered into the system.
3. The last row on the grid is blank. Click in the row and type in the new shipping method.

4. Click **ENTER** to go to the next new row and enter another shipping method.

5. Click **Save** to save your additions or **Cancel** to close the screen without saving.

---

12.10.2 **Deleting/Printing/Exporting Ship Methods:**

1. From the **Main** screen, click the **Receive/Pick** icon. The **Receive/Pick** menu appears at the bottom of the screen.

2. On the **Receive/Pick** menu, click the **Manage Ship Methods** icon. The **Ship Method List** appears displaying all shipping methods entered into the system.

3. Highlight the desired listing, then select the function you want to perform. Options are:
• **Delete** - This deletes the highlighted shipping method from the database. When you select this option, a confirmation message will appear. Select *Yes* on the confirmation message to delete the method. It will no longer appear in the **Shipping Methods** drop down list. Note that you cannot delete the standard shopping methods that came preloaded in InventoryControl.

• **Print** - Allows you to print the **Ship Method List**. When this option is selected, a standard **Page Setup** screen appears allowing you to enter margins. An example of this screen is shown below:

![Page Setup Screen](image)

Click the **OK** button on the **Page Setup** screen to print the list. The list will print to your default printer.

• **Export** - Allows you to export the **Ship Method List** to an external text file. When the **Export** option is selected, a screen appears allowing you to specify where the exported data will be saved on your computer. An example of the **Export** screen is shown below:
Make sure you save this to a location you can remember. You must also choose a name for your file on this screen. After you have made your selections, click **Save** to export your data.

A confirmation message will appear when your data has been successfully exported by the system.
12.11 Formatting PO and Pick Order Numbers

Pro and Enterprise Versions Only

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

To make creating Purchase Orders and Pick Orders easier, InventoryControl allows you to set up auto-generated numbers. This allows you to quickly create sequential numbers by clicking the Generate button on the Create New Purchase Order and Create New Pick Order screens.

InventoryControl allows you to enter custom text, dates and/or counters, in any combination, to create a unique identifier that is meaningful to your business. You should set up your numbers to contain a date field, followed by a serialized count field, at the very least.

Formatting Purchase Order and Pick Order Numbers:

1. From the Main screen, click the Receive/Pick icon. The Receive/Pick menu appears at the bottom of the screen.

2. On the Receive/Pick menu, click Number Formats. A menu appears allowing you to select to customize Purchase Order Numbers (PO Number) or Pick Order Numbers (Order Number).

3. Click on Purchase Order Numbers or Pick Order Numbers, depending on what you want to customize. The screen for these two are identical so for this example, we are going to select PO Numbers. The Define PO Number Format screen appears.
4. Select the type of value you are entering from the **Type** drop down list. Your options are:

- **Text** - This option enters text or numeric data into the number. If you select **Text**, a text field appears allowing you to enter the text you want to appear in the number.

- **Date** - This option inserts the date into the number. If you select **Date**, a format field appears allowing you to select how you want the date to appear (mm/dd/yy, etc.)

- **Counter** - This option inserts a sequential counter into the number. If you select **Counter**, fields appear allowing you to select how many digits you want to appear in the counter and at what number the counter should start. In the example below, we entered 5 in the Digits field and 2 in the counter field. This means the counter will display up to 5 digits and begin counting at 2.
5. When you have chosen your Type and entered the required values, select Add. Your entries will appear in the grid at the top of the screen and an example of how your number will look appears in the screen at the bottom of the screen.

6. Repeat steps 4 and 5 until you have entered all types of data you want to appear in your number. Your selections will appear in the number in the order they are displayed in the grid.

   You can change the order by highlighting a listing in the grid and clicking the Up or Down buttons.

   You can delete an item in the grid by highlighting it and clicking the Delete button.

7. Click the OK button when you are finished formatting the number.
12.12 Email Distribution List

Pro and Enterprise Versions Only

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

If the Email on Save box is checked on the Create New Pick Order or Create New Purchase Order screen, a copy of this order is automatically sent to the email address listed in the Customer screen for this customer (for Pick Orders) or to the email address listed in the Supplier screen for this supplier (for Purchase Orders) when you click the Save button. If you have selected to view the Email Destination List (selected on the Options screen), the list will appear allowing you to select email addresses or change email addresses as needed. If you have selected not to view the list, the order will automatically be sent. An example of this screen is shown below:

To Addresses: The order is sent to the email address listed in the Customer or Supplier screen. If there is no email address listed on the Customer or Supplier screen, you will receive an error message when you try to send emails. You can add an address to the Customer or Supplier screen, and/or edit the address listing on these screens at any time. See Creating New Suppliers or Creating New Customers for information on the Suppliers or Customers screen.

From Addresses: The order is sent from the email address listed in the Company Information screen. If there is no email address listed on the Company Information screen (this should be your company email address), you will receive an error message when you try to send emails. You can add/edit your company email address at any time on the Company Information screen. See Entering Company Information for more details on the Company Information screen.

CC Addresses: An email is also sent to any CC addresses designated on the Options screen. You can choose to ignore the CC address by deselecting the checkbox next to the CC Addresses field on the Email Destination List.

In order for the email feature to work correctly, you must set your SMTP Server, User Name and Password (if authentication is required for outgoing mail) and the SMTP Port on the Options screen. If these are not set, an error message will appear.

For more information on setting these email options on the Options screen, please refer to the Options Screen topic. For more information on creating pick orders, please refer to the Creating a Pick Order topic. For more information on creating purchase orders, please refer to the Creating a Purchase Order topic.
Chapter 13 - Creating/Editing/Printing Labels

13.1 Selecting a Label Printer

The **Labels** menu provides access to pre-built labels contained in the software or allows you to create new labels.

**Printing, Editing, Creating, Browsing Labels:**

1. **Select a Label Printer:** From the **Main Screen**, click **Options > Select Label Printer**. The **Select Label Printer** screen appears.

2. All printers currently connected to this computer will appear. Highlight the printer you want to use, then click **OK**. You can now begin printing labels.
13.2 Using the Labels Menu

The software allows you to select from several pre-built labels that can be printed the list screens or edited from the Labels menu. You can also create your own unique labels from the Labels menu.

The following topics are covered in this section:

Editing Labels

Creating Custom Labels

Browsing to an Existing Label

13.2.1 Editing Labels:

1. To edit labels, from the Main screen, click Labels.
A list of available labels will appear. If you do not see all the label files shown here upon accessing the list, expand the menu by clicking the + in front of the **Labels** fields.

2. Click on the label you would like to edit. Wasp Labeler will open with the selected label displayed. You can make changes as needed. Please see the Wasp Labeler online help for detailed instructions on editing labels. To access the help, select **Help > Contents** from the Wasp Labeler toolbar.

### 13.2.2 Creating Custom Labels:

1. To create custom labels, from the **Main** screen, click **Labels**. A list of available labels will appear.

2. Select **Create New Label** to open Wasp Labeler without opening an existing .LAB file.
3. Create your label as desired. Please see the Wasp Labeler online help for detailed instructions on creating labels. To access the help, select Help > Contents from the Wasp Labeler toolbar.

**Note:** When saving new labels you have created with Wasp Labeler, they will be listed with the default names shown on the Labels List. The files will automatically save to the .LAB files in the \Labels folder under the folder where you installed InventoryControl. If you are unsure where this is, just use the Windows Find (or Search) command to locate the folder containing the file InventoryControl.exe, then save your .LAB files in the .\Labels folder beneath it.

---

### 13.2.3 Browsing to an Existing Label:

You may have custom labels you have already created that you want to access. To do this:

1. To browse to an existing label file (.LAB file), from the Main screen, click Labels. A list of available labels will appear.

2. Select **Browse to Other Labels**. The standard Windows Explorer screen appears.

3. Navigate to the desired .LAB file and select it. The label will open in Wasp Labeler allowing you to edit or print it.
13.3 Printing Labels from the List Screens

InventoryControl allows you to print Location and Item labels directly from the List screens. The following List screens have label printing functionality:

**Location List** - Print Location Labels

**Item List** - Print Item Labels

**Note:** You must select a label printer prior to printing tags from the List screens. To do this, see the topic [Selecting a Label Printer](#).

To Print Labels:

1. With the desired List screen open (Location or Item), highlight the listing you want to print. You can select multiple listings by holding down the Ctrl key on your keyboard while clicking on listings.

2. Click the **Print Tags/Labels** button on the toolbar.

The following screen appears:

![Number Of Label Copies](Image)

Enter the number of copies of the selected labels you want to print. The total number of labels to be printed will be displayed.

1 label(s) will be printed

3. Enter the number of copies of the selected labels you want to print. If you want to view a preview of how your label will appear, check the **Preview** box.

4. Click the **OK** button.
Chapter 14 - Reports

14.1 Report Selection

This software comes with many built-in reports to help you maintain your inventory.

Selecting a Report:

1. From the **Main** screen, click the **Reports** icon. The **Reports** screen appears:

2. Highlight the desired report, then click the **OK** button, or double-click on the report name. The report opens in the Report Viewer. For more information on viewing reports, please refer to the **Report Viewer** topic.

   Selecting **<Browse To Other Reports>** lets you select the .RPT file you want to open by browsing your drives.
14.2 Report Viewer

The Report Viewer presents reports in an interactive environment that permits keyword searches, printing and export to Adobe Acrobat® Reader™ (.pdf), Microsoft® Excel (.xls), Microsoft® Word (.doc) or Rich Text Format (.rtf) files.

The Report Viewer is accessed by selecting a report name from the Report Selection screen.

The Status Bar in this example reports the current page being viewed, the total number of pages and the current zoom factor.

The left panel shows the report tree that shows how the report is organized and allows you to choose specific nodes.

The ReportViewer Tool Bar provides the following functions:

- **Go to First Page** takes you to the beginning of the report.
- **Go to Previous Page**
- **Go to Next Page**
- **Go to Last Page** takes you to the end of the report.
- **Print Report** launches the Print dialog.
**Refresh** updates the report with current data.

**Export Report** allows you to save the report as your choice of any of the following formats:

- Adobe Acrobat® Reader™ (.pdf file)
- Microsoft® Excel (.xls file)
- Microsoft® Word (.doc file)
- or Rich Text Format (.rtf file)

**Toggle Group Tree OFF/ON** - When this is turned off, it will increase the width of the Report display by turning off the Group Tree area at the left of the ReportViewer screen. When it is on, it will restore the Group Tree display at the left of the ReportViewer screen - the default display.

**Zoom** allows you to scale the Report display via a drop list of percentages:

- Page Width
- Whole Page
- 400%
- 300%
- 200%
- 150%
- 100%
- 75%
- 50%
- 25%
- Customize…

**Search** allows you to find all occurrences of a specified keyword within the displayed Report:
Specify a keyword and click **Find Next** to find the next occurrence.

**Filter** allows you to create filters for the selected report using the Report Filter Setup dialog.

Once a filter has been applied, the filter criteria will be displayed to the right of the **Filter** tool in the toolbar.

Depending on the number of transactions in your database, the Report you have selected, and the performance of your PC, ReportViewer can remain blank for quite some time while it access the database and dynamically builds the Report for display.
Chapter 15 - Administration

15.1 Administration Menu

The Administration Menu groups tasks such as creating/editing your company information, Importing/Exporting functions and maintaining security settings into one place.

Note: All screen shots in this help file are of InventoryControl Professional Edition. The screens and available features in other versions of InventoryControl and in WaspNest Inventory may differ. For more information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

To Access the Administration Menu:

1. From the Main screen, click the Administration icon. The Administration Menu appears at the bottom of the screen.

2. Click on any of the Administration Menu icons to go to that function. Detailed descriptions of the options found on the Administration Menu are provided below:

   - **Company Info** - The Company Information screen allows you to enter or update your company information such as address, phone and email. The Company Name you enter on this screen will be used as the "header" for InventoryControl and will appear on all reports and pre-defined labels. The information on the Company Information screen should be filled out first when you are initially setting up the software. For detailed information on this screen, please refer to the Company Information Screen topic.
- **Security** - The Security Privileges screen allows users set up as Administrators to add users to the system, set user privileges, assign users to specific sites, and delete users. For detailed information on this screen, please refer to the Security Privileges topic. **Note:** This option is not available in WaspNest Inventory.

- **Import/Export** - Import/Export allows you to import data into the database from an file or export data to an external file. Importing data from an external text or .csv file is a quick way to setup your software. For detailed information on Importing, please refer to Importing Into the Database. For detailed information on Exporting, please refer to Exporting to a Text File.

- **Backup/Restore** - The Backup and Restore functions allow you to quickly backup your entire inventory database or restore the database as of the last backup. Backing up your database regular is critical to maintaining your business continuity in the event of a system failure. If you backup regularly, you can easily restore the database and minimize disruption to your business. For detailed information on these functions please refer to the Backup Database topic or the Restore Database topic. **Note:** Backup and Restore is not available in the Enterprise version of InventoryControl.
15.2 Company Information Screen

The **Company Information** screen allows you to enter or update information about your business. The name entered in the **Company Name** field on this screen is used as the application header as well as the header for all reports and pre-defined labels. The information on this screen should be completed first when setting up your software.

This topic covers:

- **Entering Company Information**
- **Entering Multiple Address Types**
- **Deleting an Address Type**

15.2.1 Entering Company Information:

1. From the Main screen, click the **Administration** icon. The **Administration Menu** appears at the bottom of the screen.

2. On the Administration Menu, click the **Company Info** icon. The **Company Information** screen appears.
3. Type in the requested information. The **Company Name** field is mandatory; all other fields on this screen are optional.

4. Click **OK** to save your changes.

### 15.2.2 Entering Multiple Address Types:

This software provides you with the ability to enter a Billing Address, Receiving Address and/or Shipping Address for your company and to create new address types as well. You can enter an address for each site that might have inventory shipped to it from purchase orders. To enter multiple address, follow the steps below:

1. On the **Company Information** screen, enter your company name. Select what type of address you will be entering from the **Address Type** drop down menu, or type in a new address type. For example, you could enter Warehouse 1 in the **Address Type** field.

   ![Address Entry Screen](image)

   **Address Entry Screen**

   - **Address Type**: Corporate Address
   - **Address 1**: 123 Anywhere Road
   - **City**: Flower Mound
   - **State**: Texas
   - **Postal Code**: 75028
   - **Country**: USA

2. If you entered a new address type, a confirmation message will appear verifying that you want to add it to the database. Select **Yes** on this message to save the new address type. The new entry will now appear in the **Address Type** drop down menu on all screens on which you can enter multiple address types (Create/Edit Suppliers, Create/Edit Customers, Create/Edit Manufacturers).

3. Enter the remainder of the address information, then click **OK**. You will be returned to the **Administration Menu**.

4. Click the **Company Info** icon again. The **Company Information** screen will reappear populated with the information you just entered.

5. Select a different address type of the **Address Type** drop down menu, or enter a new one. The address lines (Address 1 and 2, City, State, Postal Code and Country) will clear while all other company information will remain on the screen.

6. Enter the new address information, then click **OK**. Repeat these steps for each address type.
15.2.3 Deleting an Address Type:

You can delete one or more addresses for your company by following the steps below. The delete button is only enabled when you have selected one of the address types you entered. It is not enabled when one of the standard address types (Corporate, Receiving, etc.) is selected.

1. On the Company Information screen, select the address type you want to delete by choosing from the Address Type drop down menu.

2. Click the Delete button. A confirmation screen will appear.

3. Select Yes on the confirmation screen to delete the information for the selected Address Type.

Note: You cannot delete addresses that are part of active Pick Orders.
15.3 Adding Users/Editing Security Privileges

The **Security Privileges** screen allows those users setup as Administrators in the system to add users, set privileges, and/or delete users.

**Note for WaspNest Users:** The Security Privileges feature is not available in WaspNest Inventory. For more information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

A user with *Administration Privileges*, called an Admin User can add new users and make changes to existing users’ security options. We recommend that at least one Admin user in addition to the default Admin user be added to the system soon after installation.

This topic covers:

- **Accessing the Security Privileges Screen**
- **Adding Users on the Security Privileges Screen**
- **Editing User Profiles on the Security Privileges Screen**
- **Making Users Inactive**
- **Copying User Security Profiles**
- **Security Privileges Definitions**
- **Business Examples**

---

### 15.3.1 Accessing the Security Privileges Screen:

1. To access the screen, from the **Main** screen, click the **Administration** icon. The **Administration Menu** appears at the bottom of the screen.

2. Click the **Security** icon on the **Administration Menu**. The **Security Privileges** screen appears.

   **Note:** The **Receive, Pick, Build Assembly and Disassemble Privileges are only available to Pro and Enterprise Version Users.**
When you first access this screen, you will see a user listed as Admin, User (as shown in the screen shot above). This is the default Admin User and this user cannot be changed or deleted. The Admin User profile allows you to access the system for the first time after installation and setup your system. The password for this user can be changed, if needed.

15.3.2 Adding Users to the Security Privileges Screen:

2. **First Name, Last Name**, a **User Name** (used when logging on to the system), a **Password** and **Status** (which is normally set to **Active**) are required. You can optionally enter a Title, Department, Manager and/or Email address. If you mark this employee as Inactive in the **Status** field, **Inactive** will appear next to his/her name in the **User List**.

3. Click **OK** to save the new user information. You will be returned to the **Security Privileges** screen which will now display the new user's profile.

4. All privileges and sites are initially disabled when you enter a new user. This means the user will not be able to access anything in the system. You must select which features you want the user to be able to access by selecting the desired checkboxes in the **Privileges** screen. For example, in the screen shot below, the user Roger Dodger was given access to Add Inventory, Adjust Inventory and Delete and to Site 200.
5. Click **OK** when you have selected all privileges to which you want this user to have access. These selections can later be changed by any user who has **Administration Privilege**.

6. If you have more than one **Site**, you can limit this user's access to whichever sites you want. To do this, select the **Sites** to which you want this user to have access. Click **Select All** to quickly give the user access to all sites.

   Click the "**User can access all current and future sites**" to automatically give this user access to any sites you may add in the future.

7. Click **Save** to save your changes to this user.

---

**16.3.3 Editing User Profiles on the Security Privileges Screen:**

1. On the **Security Privileges** screen, highlight the user name you want to edit in the **User List**. You can now change the selections in the **Privileges** screen by selecting or de-selecting checkboxes. An existing user's information can be updated by any user with Administration Privilege. In addition to the ability to change other values, this is where an Administration user can reset a **Password** for a user that has forgotten it.

2. If you want to change the user name or personal information, highlight the user name in the **User List** and click **Edit > Update User**. The **Update Existing User** screen will appear populated with the selected user's information.
3. Type in new data as needed, then click the **OK** button. You will be returned to the **Security Privileges** screen.

4. Click **OK** on the **Security Privileges** screen to save your changes. **If you change your own security privileges the changes will not go into effect until the next time you log on.**

   **Note:** If you select **Cancel**, you will exit the screen **without** saving changes made to the Privileges section on the currently selected user. Changes previously made to other users **will** be saved. A message will appear asking if you want to discard changes. Select **Yes** to close the screen without saving the changes, or **No** to save any changes.

   The **Admin,User** is unique in that its user name and privileges cannot be changed. Only the password can be changed for the Admin user.

### 15.3.4 Making Users Inactive:

Admin Users can mark users as Inactive, meaning all privileges are revoked and the user's login will be inactivated.

1. On the **Security Privileges** screen, highlight the user name you want to make inactive in the **User List**.

2. Select **Edit > Update User**. The **Update Existing User** screen appears.

3. Select **Inactive** from the **Status** drop down menu.

4. Click **OK** on the **Update Existing User** screen. You will be returned to the **Security Privileges** screen.

5. Select **OK** on the **Security Privileges** screen.

### 15.3.5 Copying User Security Profiles:

If you have multiple users who will have the same security privileges, you can create one profile, then copy it to other users, streamlining the setup process. To do this:

1. On the **Security Privileges** screen, highlight the user name you want to copy in the **User List**.

2. Select **Edit > Copy User Settings**. The **Add New User** screen appears.

3. Enter the name and personal information of the user you are adding, then click **OK** on the **Add New User** screen. You will be returned to the **Security Privileges** screen. The user name you just added will appear in the **User List** and the **Privileges** will be those that you copied.
15.3.6 Security Privileges Definitions:

Add Inventory: The user will be able to manually add inventory to the system.

Adjust Inventory: The user will be able to adjust inventory amounts.

Administration Privilege: The user will be able to modify existing users’ Security Privileges and perform all functions in the system.

Allow PC Login: The user will be able to login to the program.

Audit: The user will be able to perform all audit functions.

Backup and Restore: The user will be able to backup and restore the inventory database.

Be aware that Restore can cause a loss of data added to the database since the date and time of the backup file chosen.

Build Assembly - The user will be able to use the Build Assembly function to add inventory to Assembly Items.

Check In: The user will be able to Check-In inventory.

Check Out: The user will be able to Check-Out inventory.

Delete: The user will be able to delete records.

Disassembly - The user will be able to disassembleAssembly Items.

Edit: The user will be able to make changes to records.

Labels: The user will be able to create labels.

Move: The user will be able to Move inventory to another location.

New: The user will be able to create new items, suppliers, etc.

Pick: The user will be able to pick inventory from pick orders on the Pick screen.

Process Mobile Device Data: The user will be able to process and apply transactions that have been downloaded from a mobile device.

Receive Inventory: The user will be able to mark inventory as Received from purchase orders on the Receive screen.

Remove Inventory: The user will be able to manually Remove inventory.

WDT2200: The user will be able to use a WDT2200 mobile device to perform transactions.
15.4 Backing up the Database

**Note for Enterprise Users:** The Backup feature is not available in the Enterprise version. You must use SQL to perform backups.

Backing up your database is an important maintenance step that should be performed on a regular basis. Having a current backup helps to minimize data loss in the case of a system shut down or power failure. If you do experience a catastrophic system failure of some kind, having a current backup ensures you can quickly restore the most recent database. For information on restoring your database, please refer to the [Restoring the Database](#) topic.

**Note:** Each time you Audit your inventory, a backup file is automatically created with the date/time included in the file name. For more information on performing an Audit, please refer to the [Auditing Your Inventory](#) topic.

**Note for Remote Installations:**
If you have installed your database on a remote PC/Server (a PC/Server other than the one where you are running InventoryControl), you can specify a folder on that PC/Server to which the backup file will be saved. This option is set on the Options screen. For more information on designating a backup folder, please refer to the [Options Screen](#) topic.

### Backing Up Your Database:

1. From the Main screen, click the Administration icon. The Administration Menu appears at the bottom of the screen.

2. On the Administration Menu, click Backup. The Backup Database screen appears.

3. Enter a name for this backup in the Backup File field. It is a good idea to specify a name that will help you select the right backup file later if you need to restore the database. Adding the date in the file name is a good way to know which file is the latest.

   By default, the backup file is written to:

   C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Backup

   Use the Browse button to select a different location.

4. Click OK to backup the database.

**Important Note:** The network version of the InventoryControl does NOT browse the file system on the local machine. Instead of the local file system the file system on the machine where the database is installed will be displayed.
15.5 Restore the Database

Then software allows you to quickly restore a backup database. This is usually used when there has been some type of catastrophic system loss and allows you to minimize downtime in your business by restoring the last saved database.

You can also restore over an existing database, but keep in mind that restoring erases all data currently in your database and replaces it with the data in the backup, including all inventory, users and items. If there is a chance you will want to recover transactions that have been entered since the backup was done, it is a good idea to backup again before restoring. Save the backup to a different file name than the one you are about to restore.

Note for Enterprise Users: The Backup feature is not available in the Enterprise version. You must use SQL to perform backups.

Restoring Your Database:

1. From the Main screen, click the Administration icon. The Administration menu appears at the bottom of the screen.

2. On the Administration menu, click Restore. The Restore Database screen appears.

3. Enter the location and name of the backup in the Restore From File field, or you can click Browse to search for a file

   By default, backup files are located in:

   C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Backup

4. Click OK to perform the database restore.

Important Notes:

The network version does NOT browse the file system on the local machine. Instead of the local machine file system, the file system on the machine where the database is installed will be displayed.

If you receive an error when trying to restore the database that states "not all connections to the database are closed", make sure no other users are logged in to the system. Close InventoryControl and try to restore again.
15.6 Options Screen

The Options screen is where you can turn off and on some automatic processes for inventory functions and control how the software performs in certain situations.

Note: This topic lists all options available in the Professional and Enterprise version of InventoryControl. Not all options are available in the Standard version of InventoryControl or in WaspNest Inventory. For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

This topic covers the following:

Accessing the Options Screen

Inventory Options

Allow Negative Quantities on Mobile Devices (Batch devices only)

Allow Over Pick

Allow Over Receive

Automatic Customer Number

Automatic Item Numbers

Automatic New

Automatic Notification of Low Order Items

Decimal Places

Enforce Date Code as a True Date

Item Cost When Add Inventory from Mobile Device

Packing Slip for Session

Transaction Code List

Support Options

Check for Software Updates

Close New Form
Edit Field Names

Max Row Count

Previously Processed Mobile Data

Show Cost Information During Receiving (applies to Pro and Enterprise Versions Only)

Show Warning Messages

SQL Server Backup Location

Email Options

Always Show Email Destination List

Packing Slip CC Emails

Pick Order CC Emails

Purchase Order CC Emails

SMTP Password

SMTP Port

SMTP Server

SMTP SSL/TSL

SMTP User
15.6.1 Accessing the Options Screen:

From the Main screen, select Tools > Options. The Options screen appears.

All of these options affect all users. Changes made by one user will affect other users who log in.

If the user accessing the Options screen does not have Administration Privileges (setup on the Security screen), the Options screen will look like the following:
15.6.2 Allow Negative Quantities on Mobile Devices

This option pertains to batch devices only. **Negative quantities are not allowed on wireless devices.**

This option allows you to remove or move items from inventory on the mobile device even though the quantity of those items may have been at zero, according to the database, the last time the mobile device was synchronized. This option is valuable in a batch processing environment.

If you have more than one mobile device, a situation might arise where some inventory is Added on one mobile device for a location. The next mobile device comes along and sees the inventory ready for Remove, but since both devices have not been synchronized to the PC, the second device does not show that inventory exists. In this case, if **Allow Negative Quantities on Mobile Devices** is turned off, mobile devices would have to synchronize before the item could be removed.

Leaving this option turned on allows mobile device users to do their job in the field but opens up the possibility of error. The responsibility for confirmation of batch processing on multiple mobile devices falls to the PC user. Many safeguards and methods of verifying the recurring data have been added to help facilitate this effort. See the **Pending Uploads** topic for more information.

To enable this option, select the **Yes** checkbox.
15.6.3 Allow Over Pick

When this option is selected, users can mark more inventory as "picked" than is indicated on the Pick Order. This applies to the PC and mobile devices.

15.6.4 Allow Over Receive

When this option is selected, users can mark more inventory as "received" than is indicated on the Purchase Order. This applies to the PC and mobile devices.

15.6.5 Automatic Customer Number

This option allows you to enable automatic generation of a Customer Number when you are creating new customers.

An automatically generated Customer Number will always be 1 greater than the value of the largest customer number currently in your database.

If you are using alphabetic or alphanumeric values as Customer Numbers, the Automatic Customer Number option will still generate a numeric Customer Number, beginning with a value of 1, if it does not exist already.

15.6.6 Automatic Item Numbers:

This option allows you to enable automatic generation of an Item Number when you are creating a new item or when duplicating an existing item from the Item List.

An automatically generated Item Number will always be 1 greater than the value of the largest Item Number currently in your database.

If you are using alphabetic or alphanumeric values as Item Numbers, the Automatic Item Number option will still generate a numeric Item Number, beginning with a value of 1, if it does not exist already.

15.6.7 Automatic New

This option enables the automatic opening the New screen when an entered value (Item Number, for example) is not in the database.

When the Automatic New option is enabled:

The Create New Item screen is opened if an unknown Item Number is entered on the Add Inventory, Create New Purchase Order or Create New Pick Order screen.

The Create New Location screen is opened if an unknown Location is entered on the Add Inventory screen or in the To Location field of the Move Inventory screen.

The Create New Supplier screen will be opened if an unknown Supplier is entered on the Add Inventory or Create New Purchase Order screen.
The **Create New Customer** screen will be opened if an unknown **Customer** is entered on the **Remove Inventory, Create New Pick Order** or **Check-Out Inventory** screens.

When the **Automatic New** option is disabled:

A prompt will ask you if you want to continue to the appropriate **Create New** screen. Sometimes, when data input has a high error rate, this is more desirable as it allows the user to verify the number entered.

**15.6.8 Automatic Notification of Low Order Items**

When this option is enabled, the software will notify you if the **Item Stock Level List** contains items that have a **Quantity** value equal to or less than the **Min. Stock Level** value set for that item and location on the **Create New Item** or screen/Location tab. This notification appears for the location level only. This notification will appear immediately after logging in to the software.

**15.6.9 Decimal Places**

This option allows you to set the number of decimal places to display in numeric fields where this is possible.

All values entered in numeric fields are stored to the number of **Decimal Places** allowed by this option at the time you entered the value, but screens and reports will always display numeric values to the number of Decimal Places **currently** allowed by this option.

If the number of decimal places currently allowed by this option is **greater than** the number of decimal places allowed when a value was stored, the value will be displayed with trailing zeros.

For example, if a value of 25.5 was stored when Decimal Places was set to 1, it will be displayed as 25.500 if Decimal Places is later set to 3.

If the number of decimal places currently allowed is **less than** the number of decimal places allowed when a value was stored, the value, as displayed, will be rounded. For example, if a value of 25.5 was stored when Decimal Places was set to 1, it will be displayed as 26 if Decimal Places is later set to 0. (Values rounded for display at the currently specified number of Decimal Places will retain their original number of decimal places as stored in the database.)

Enter a value within the range 0 through 4.

**15.6.10 Enforce Date Code as a True Date**

When this option is selected, any dates entered into InventoryControl must be in the format mm/dd/yyyy.

**15.6.11 Item Cost When Add Inventory from Mobile Device:**

Turn this option on to use the item's average cost when adding from a mobile device. Leave this option off (default) to use the item's set cost when adding from a mobile device. Average Cost is the cost of an item over time, including any discounts, price increases, etc. The Item Cost is the value you have entered on the **Create New/Edit Item screen > General Tab**.
15.6.12 Packing Slip for Session:

The packing slip that can be printed and/or emailed upon saving by default displays only items picked in the current pick session. If you want to pick multiple times and print a packing slip that displays all the picks for this pick order, including items picked previously, you can select to do so on the Options screen.

*For example:*

Assume Pick Order 001 a quantity of 5 for item ABC and a quantity of 4 for item XYZ. Today I pick 2 of item ABC and 2 of item XYZ and ship them. The packing slip will display 2 ABC and 2 XYZ. Tomorrow I pick the other 3 of item ABC and 2 of item XYZ and ship them. The packing slip has 3 ABC and 2 XYZ.

This would also be exactly the same if both picks and ships were done on the same day.

If, however, I pick what I have in the morning and don’t ship it and a shipment comes in that day or the next and I complete the order before shipping anything I will want all of the items picked throughout the day to display on one packing slip. To do this, select **Yes** for this option.

15.6.13 Transaction Code List:

This option affects what displays in the Transaction Code drop down lists on the Audit and Adjust screens. You can choose to show only those transaction codes created by the currently logged in user, or show all transaction codes regardless of who created them. The options available are:

- **Logged In User** - Select this option to display the last ten transaction codes created by the currently logged in user. The last 10 codes created by the current user will display.

- **All Users** - Select this option to display transaction codes created by all users. When you select this option you can also enter the number of transaction codes to show (up to 30).

15.6.14 Check for Software Updates:

When this option is enabled, the system will automatically search for a newer version of the software when you log on to the system. If a new version is found, you will receive a notification and can then go to the Wasp website to download the new version.

This option is enabled when the **Yes** checkbox is selected. This option is enabled by default. You can disable the option by deselecting the checkbox. Manual checks can still be performed (via the Help menu). For more information on manually checking for updates, please refer to [Checking for Software Updates](#).

15.6.15 Close New Form:

When this option is turned on, the **Create New** screen is automatically closed each time a new record is created.
When this option is disabled, upon clicking the Save button on the Create New screen, the entry will be saved, the screen will remain open with the fields cleared, ready for another entry. Clicking the Close button will exit the Create New screen.

When this option is enabled, upon clicking the OK button on the Create New screen, the screen will close automatically. Clicking the Cancel button on the Create New screen will exit the form without saving any entry made.

It might be desirable to turn this option off when first entering data, for speed, then turn it on later to avoid confusion when using it infrequently.

15.6.16 Edit Field Names:

When this option is enabled, users setup with Administrative Privileges on the Security screen can edit the names of some labels and tool tips in the software. You might want to change a field name if your business calls one of the functions or fields something different than the default values. Or, you might want to change the tool tip if you want to give special instructions to your users.

For detailed instructions on how to edit fields once this option is enabled, please refer to the Editing Field Names topic.

15.6.17 Max Row Count:

This option allows you to specify the maximum number of rows to be displayed on most lists. The number of rows can be limited to improve performance. If you notice that it takes more than a few seconds for your list screens to appear you can reduce the number of rows to speed this up.

A value of 0 indicates all rows should be displayed.

Values between 1 and 99 are invalid.

100 is the smallest maximum that can be specified.

Transaction List - The Transaction List is handled differently than other lists due to the usually large amount of listings. In the case of the transaction list:

- if 0 is entered, the transaction list is limited to 10,000 rows,
- if there is a maximum set (either higher or lower than 10,000), the list will be limited to the number of rows specified.

For example, if you enter 16,000 in the Maximum Number field, 16,000 rows will be displayed on the Transaction List.

15.6.18 Previously Processed Mobile Data:

When this option is turned on, the software alerts you if you attempt to upload data from the mobile device to the PC when that data has previously been uploaded.

With this option turned on, if you upload and process data from the mobile device to the PC and then attempt to upload and process that same data again, in the Pending Uploads wizard, a symbol displays in the Accept column indicating this data will not be processed again because it has already been processed. Below is an example of the symbol that will appear:
When this option is turned off, you still will not be able to re-process data that has already been processed. The drop-down list in the first screen of the Pending Uploads wizard simply will not display the processed XML file.

15.6.19 Show Cost Information During Receiving:

*(applies to Pro and Enterprise Versions Only)*

When this option is enabled, cost information will display on the Receive screen when you are receiving inventory from a purchase order. This option is disabled by default. To enable this option, select the checkbox.

15.6.20 Show Warning Messages:

This option allows you to enable or disable the display of warning messages.

15.6.21 SQL Server Backup Location:

This option is useful if you have your database installed on a different PC/Server than where you are running the software.

Enter an existing directory on the PC/Server where the SQL database is installed (this is where you installed the database during the initial installation process). Make sure the user who will be performing the backups (Administration Menu > Backup) has permission to the database.

If a location is not entered, the Microsoft SQL Server backup directory will be used to store backups. This is where the system will look for backup files when you try to restore the database as well.

If you specify a folder and SQL Server does not have rights to write to that folder, you will receive an error message and the backup will fail. It is your responsibility to give SQL Server the proper rights to write the backup in the specified folder.

For information on how to give permissions to a folder, please refer to Wasp Technical Support, Knowledge Base and Downloads on the internet.

By default, if you do not have a remote connection to your database, the backup folder is: C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Backup

15.6.22 Always Show Email Destination List:

Select Yes to always have the list of email destinations appear when you select the Send Emails Upon Save on the New Purchase Order and New Pick Order or the Pick (to email the packing slip) screens. This list allows you to select the email addresses to which the order will be sent.
If you deselect the **Yes** checkbox, the list will not appear and the emails will automatically be sent to every address on the list.

**15.6.23 Packing Slip CC Emails:**

You can enter email address here to which a copy of the slip will automatically be sent if you have the **Email Packing Slip** checkbox selected on the **Pick** screen. The CC email addresses are in addition to any email addresses selected on the **Pick** screen - **Email Destination List** (see above).

**15.6.24 Pick Order CC Emails:**

You can enter email address here to which a copy of the order will automatically be sent if you have the **Email On Save** checkbox selected on the **Create New Pick Order** screen. The CC email addresses are in addition to any email addresses selected on the **Create New Pick Order** screen - **Email Destination List** (see above).

**15.6.25 Purchase Order CC Emails:**

You can enter email address here to which a copy of the order will automatically be sent if you have the **Email On Save** checkbox selected on the **Create New Purchase Order** screen. The CC email addresses are in addition to any email addresses selected on the **Create New Purchase Order** screen - **Email Destination List** (see above).

**15.6.26 SMTP Password:**

If your SMTP server requires authentication to send outgoing mail, enter the password here. If it does not require authentication, leave this field blank.

**15.6.27 SMTP Port:**

Enter the SMTP mail server listening port here. The default port is 25.

**15.6.28 SMTP Server:**

Enter the name of an outgoing mail server that supports SMTP for delivering notification emails. Enter the name of the same outgoing mail server that is setup in your own email program. If you do not was InventoryControl to send notification emails, leave this field blank.

**15.6.29 SMTP SSL/TSL:**

Turn this option on for all SMTP servers that require SSL or TSL, including GMail SMTP servers.

**Note on using GMail:** To use a GMail SMTP server to send out mail from InventoryControl:

1. Go to www.gmail.com and setup your gmail account.
2. Have your IT department open port 587 and 465 on your computer.
3. Turn on the **SMTP SSL/TSL** option, and set up the other SMTP related options on the **Options** screen.
The GMail SMTP server address is smtp.gmail.com. The SMTP user should be 'yourgmailname@gmail.com' (don't forget @gmail.com). The SMTP Password is your Gmail account password.

Please be aware that you need to turn this option on for all SMTP servers that require SSL or TSL, not just for GMail SMTP servers.

15.6.30 SMTP User:

If your SMTP server requires authentication to send outgoing mail, enter the user name here. If it does not require authentication, leave this field blank.
15.7 Archiving Transactions

The **Archive Transaction** feature allows you to archive inactive transactions prior to a specified date. This date defaults to the value specified when you enabled this option on the **Options** screen. For more information on enabling this option, please refer to the **Options Screen** topic.

Only inactive transactions are eligible for archive. These are transactions that no longer impact the current inventory. For instance, if you added a quantity of 10 to a specific item number and all of those have since been removed, the initial add transaction is inactive and will be archived if it occurred before the date specified.

Archiving is useful to keep your database running quickly by storing unused information.

**Archiving Transactions:**

1. From the **Main** screen, click **Tools > Archive Transactions**. The **Archive Transactions** screen appears.

2. Set the **Transaction Date** to the date before which inactive transactions will be archived, or leave it at the default date.

3. Click **OK** to archive the selected inactive transactions or click **Cancel** to close the screen without archiving any data.

4. If desired, you can run the **Transaction History (Archived) Report** to review the archived transactions.
15.8 Editing Field Names

When the Edit Field Names option is enabled on the Options screen, users setup with Administrative Privileges on the Security screen can edit some field and function names. Editing Field Names is useful if your business calls one of the functions or fields something different than the default values, or if you want to change the Tool Tip (the text that appears when you hover the cursor over a field) to provide special instructions to your users. For example, if your business refers to adding inventory as increasing inventory, you may want to change the name of the Add field to Increase to avoid confusion for your employees.

For more information on the Options screen, please refer to the Options Screen topic. For more information on setting security privileges, please refer to the Security Privileges topic.

Please see the Using Custom Fields topic for additional information about customizing this software.

This topic discusses:

**Editing Field Names**

**Resetting Field Names to their Default Values**

15.8.1 Editing Field Names:

1. When this option is enabled several field names throughout the program will appear in recessed boxes, as seen below. **Note:** The Check-In and Check-Out options are disabled for WaspNest Inventory.

Click on a recessed label, such as Add. The Customize Field screen appears:

![Customize Field Screen](image-url)
2. You can change the text of the Label (or field name) and that field's associated Tool Tip or click Set to Default to reset the field and tool tip to its original name.

Note: Some fields allow the you to edit the tool tip and not the label itself. This is because some label names must remain fixed due to internal constraints.

The Form field is disabled, as shown above, for labels throughout the program except for some of the labels on the Create New Item screen. The Form field for these few labels on the Create New Item screen permit you to specify custom tool tips for different Inventory screens like Add, Remove, etc. The same label is used for each, but the tool tips can be unique.

For example, in the screen shot below, we are customizing the Item Number label on the Create New Item screen. Here, the Form field is enabled and Item has been selected from the drop down list.

![Customize Field](Image)

The custom Label value, "Stock #:" that we entered will appear on all screens instead of the default Label value, "Item Number", and the custom Tool Tip value, "Enter Stock # in this field. Stock # must be unique.", will appear on all screens as well (instead of the original Tool tip).

Next we change the Form value from Item (the default Form value shown above) to Inventory_Transactions, as seen in the drop down list below.

![Customize Field](Image)

Now the custom Label, "Stock ", will continue to appear on all screens instead of the default Label value, "Item Number", but the custom Tool Tip will only be displayed where this field occurs within all of the Inventory transactions.
The scope of the custom Tool Tip for this field could be narrowed further by selecting a single Inventory transaction, such as Remove from the Form drop down list.

3. Now select if you want this field to be Visible and/or Required.

De-selecting the Visible option completely removes the field from the forms where it occurs. This can be used to streamline data input operations by removing the distraction of unused fields. (The label will still be visible while the Edit Labels option is turned on.)

Selecting the Required option makes data entry mandatory for transactions that use the field being customized. The Visible option will be grayed-out when the Required option is selected (Required fields must be visible).

Some customizable fields must be both visible and required for the software to perform correctly. In this case, the Visible and Required checkboxes will be disabled.

4. Click OK to save your changes.

15.8.2 Resetting Field Names to their Default Values:

You can quickly restore the default values for all editable fields by following the instructions below.

1. From the Main screen, click Tools > Reset All Field Names.

A message appears asking if you want to reset all field names to their default values.

2. Select Yes on the message. All field names you have changed will return to their original values.

Note: The Reset All Field Names option on the Tools menu is disabled if the Edit Field Names option is disabled on the Options screen or the user currently logged in does not have Administrative Privileges.
15.9 Using Custom Fields

InventoryControl allows you to create custom fields on your Items, Sites, etc. This enables you to capture information that is specific to your business needs. The **Custom Texts** and **Custom Numbers and Dates** tabs can be found on each of the following screens:

**Create New Customer**

**Create New Manufacturer**

**Create New Item**

**Create New Site**

**Create New Location**

**Create New Supplier.**

**Note:** The **Edit Field Names** option on the **Options** screen must be enabled in order to enter custom text, numbers and dates. For more information on the **Options** screen, please refer to the **Options Screen** topic. Below is an example of the **Custom Texts** tab found on the screens mentioned above:
Note: The fields seen above are not visible when the Edit Field Names option is turned off and no customizations have been applied.

Custom Numbers fields will accept values ranging from -999999999999999.9999 to 999999999999999.9999.

Custom Dates will be displayed in the same format as found elsewhere in the product: "day of the week, month dd, ccyy"

Example:

Here, with the Edit Field Names option enabled, we have clicked on the Custom Text 1 label (on the Custom Texts tab of the Create New Customer screen) to edit it. The Form field is grayed-out because this label only occurs on the Customer screen.

Click OK to save the customization or Cancel to abort.

When the Edit Field Names option is subsequently disabled, the Customer Screen/Custom Texts tab appear as shown below:
This field will also be seen in the **Edit Customer** screen.
Chapter 16 - Importing/Exporting

16.1 Importing Into the Database

**Import** allows you to bring data into the program's database from external sources such as .CSV or .TXT files. This allows you to quickly add information to your database rather than having to manually add it when you are initially setting up your software.

Data must be imported into the database in the following order:

1. Site
2. Locations
3. Suppliers
4. Manufacturers
5. Customers
6. Items
7. Inventory

Samples for each import type are installed in the InventoryControl/Import Samples folder. Use these samples to verify you have the correct data and format.

This topic covers:

- Tips for Importing Data
- How to Import Data
- Required Fields
- Handling Import Errors
- Notes on Importing Inventory

16.1.1 Tips for Importing Data:

- Do not attempt to use **Import** to modify existing records.

- Imported data will be truncated if field lengths exceed those within the program's database. Data Types and Sizes for each Table that can receive data via Import are documented in the **Database Properties** topic.

- If your data normally resides in a different data format, you must first use your existing database software's **File > Export** or **File > Save As** function to translate the data to a .csv or .txt file.

- You must strip out all currency symbols, including (but not limited to) these examples: $, €, ¥, £, §, or ¢, if you are about to import them into a numeric field, such as Cost, List Price, etc. They
are permissible in text fields.

- Commas, sometimes used as "thousands" separators, should be removed from numeric fields.

- Commas are permissible in text fields only when residing within a pair of double quotes, which will cause them to be treated as normal text, not as field delimiters.

- If you intend to import data to all available tables, make sure you import in the order specified above. It is also a good idea to review the information found in the Related Data Fields topic before proceeding with importing information.

16.1.2 How to Import Data:

In the example below, we will show how to import Locations. The steps are the same for importing all other types of information.

1. From the Main screen, click the Administration icon. The Administration Menu appears at the bottom of the screen.

2. On the Administration Menu, click Import. The Import Wizard/Step 1: Origination and Destination Data screen will appear.

3. Enter the location and file name of the file you want to import, or click the ... button located to the right of the Import File field to search for a file. Then select the table to which you want to import data from the To table drop down menu.
4. Click **Next** when you are ready to proceed. The **Step 2: Field Delimiter** screen appears.

![Import Wizard Step 2: Field Delimiter](image)

Delimiters are used to separate the data items in a database (the columns in the database table) when transporting the database to another application. For example, a comma-separated values file (CSV file) is one in which each value in the cells of a table row is delimited by and separated from the next value by a comma. The beginning of a row is indicated by a new line character.

5. Specify the field **Delimiter** used in the file from which you are importing data. This will always be a comma for .csv files, but any of the characters shown in the list box can be used with .txt files.

The preview window at the bottom of the screen will show you if your selected Delimiter is correct by displaying each column the system finds in your file when using that Delimiter. If all the data is in one column of the preview pane, you have not selected the right Delimiter.

Select the **First row contains column headings** option only if the first record of the file you are importing does not contain actual data. Import cannot remove subtotals, section headers, or any other records within the file that do not match the format of the actual data records. These must be removed before you attempt the import.
6. Click **Next** when you are ready to proceed. The **Step 3: Field Mapping** screen appears.

![Step 3: Field Mapping](image)

The **Field Mapping** screen allows you to associate columns which occur within your imported data file and corresponding fields within the table into which data will be written. Depending on the contents of your original database, not every column in your imported data needs to be mapped to a corresponding field in the program. The object is to bring over at least the required fields and any others that may be of use.

**Note:** If the **First Row Contains Column Heading** checkbox was checked in Step 2, the Import Wizard automatically compares the import file's **Import Data Column** heading to the **Map To** column heading. If a match is found, the Import Wizard populates the Field Mapping **Import Data Column** and **Map To** values. You may change the mapping for any column if necessary.

**Special Note for Importing Items:** When importing into the Item table, there are seven **Map To** fields which allow you to use the Import Data Columns for the purpose of enabling or disabling the **Item To Be Tracked By** or **Require the user to fill out** options found on the **Create New Item** and **Edit Item** screens. For more information on these options, please refer to the **Create New Item** topic.

<table>
<thead>
<tr>
<th>Tracked By or Required Option is Enabled For This Record</th>
<th>Tracked By or Required Option is Disabled For This Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>True</td>
<td>False</td>
</tr>
<tr>
<td>T</td>
<td>F</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

259
These values are case-insensitive, but they are the only values allowed. Anything else will be rejected by Import. The default value is False.

The **Map To** fields, to which data columns containing these True/False values can be mapped, are named as follows in the Map To drop list:

- Date Code (Track by?)
- Lot (Track by?)
- Pallet (Track by?)
- Serial Number (Track by?)
- Customer (Required ?)
- PO (Required ?)
- Supplier (Required ?)

If, for example, you wanted every item being imported to be tracked by Serial Number, you could create a new column in your source data that contains the word "yes" in every cell of that column. If you chose to name this column TrackSer in your source data, you would then map from the TrackSer column to the Serial Number (Track by?) field.

You could just as easily edit this TrackSer column to turn on Serial Number tracking for some items and not others, by specifying values of "yes" or "no", as necessary. In either case, when you import the items, mapping your TrackSer column to the Serial Number (Track by?) field will correctly set the Tracked By Serial Number option for each item being imported. This negates the need to manually edit each imported item's Item To Be Tracked By Serial Number option after importing the items.

True/False, T/F, Yes/No or 0/1 columns can be added to your source data for any or all of the seven Map To fields shown above, so that the Tracked By and Required options are set for each item at the time of import.

Each record added to an **Auto Generated Number** field takes the maximum number present in its column and increments this value by 1. For an import, if the Employee table already has an ID field value that is equal to 100 and the Import Wizard recognized that your import file contains a value in a mapped column that is equal to or less than 100, it will present you with a Default Value of the first import record. All subsequent imported records will increment this value by 1. If this condition does not exist, the import will proceed with the values included in the import delimited text file.

7. Click **Finish** when you are done mapping all the desired fields to the table. A confirmation screen will appear that the data has been imported. You can verify the import by going to the List screen (**Main Screen > Lists**) and viewing the list for that type of information. For example, if you just imported Locations, view the Locations List to verify the new information is there.
16.1.3 Required Import Fields:

All tables have some required fields that must be mapped. These are listed below:

<table>
<thead>
<tr>
<th>Table</th>
<th>Required Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>Site</td>
</tr>
<tr>
<td>Location</td>
<td>Location, Site</td>
</tr>
<tr>
<td>Supplier</td>
<td>Supplier Code</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Name</td>
</tr>
<tr>
<td>Customer</td>
<td>Customer Number</td>
</tr>
<tr>
<td>Item</td>
<td>Item Number, Item Type</td>
</tr>
<tr>
<td>Inventory</td>
<td>Item Number, Quantity, Site and Location</td>
</tr>
</tbody>
</table>

**Example:** Site and Location are required fields for importing Locations. If you fail to map columns for the Location table’s required fields, you will receive this prompt:

![Error prompt](image)

The following fields are required for each object record that you are importing. Please map them and try again.

Location, Site

16.1.4 Handling Import Errors:

If any of the information you just imported contains errors, a message will appear when you click the Finish button telling you to check the error report. Click OK on this message to view the Error report.

It is not uncommon to get an error like this when duplicates occur in your source data. Duplicate errors can be ignored and the Import can be considered to have completed successfully. For other error types, find the records that are in error; fix them; make a new import file (.txt or .csv) containing only these records and do another Import. Alternatively, you can enter these records manually.
16.1.5 Notes on Importing Inventory:

The steps for importing inventory are the same as those listed above; however, there is some important information to be aware of when you are importing inventory:

- Importing data into the Inventory table is optional. It is equivalent to manually adding inventory at the PC. Quantity and Location data, imported along with an Item Number, increases Item quantities in the database. You cannot remove inventory by importing negative quantities.

- The value specified in the Select Site screen/From Site field can impact the Locations into which imported Inventory information will be recorded. When something other than <all> is specified as your From site, imported inventory will be put into Locations at the specified From Site. If you have varying Site information you wish to import along with the Location and Quantity data for each Item Number, you must make sure the From Site is set to <all> in Select Site before importing data into the Inventory table. For further information on the Select Site screen, please see the Select Site topic.

- Item Number, Quantity, Site and Location are all required fields for Importing into the Inventory table. If, while importing Inventory data, a previously unknown value for either Item Number, Site, Location, or Supplier Code is read, a new Item Number, Site, Location or Supplier Code will not be created using the new value. Instead, the Inventory record being imported will be rejected. Negative values for Quantity can also cause an Inventory record to be rejected.

- If one or more Tracked By or Require the user to fill out options are enabled for the Item Number specified in an Inventory record that fails to supply that information, the record will be rejected. For more information on these options, please refer to the Create New Item topic.
16.2 Exporting to a Text File

This software allows you to create text files containing data from one or more fields within each of the program's tables. For example, if you want to create a text file of all of the manufacturers in your database, the Export function allows you to quickly do this.

Data types and sizes for each table from which data can be exported are documented in the Database Properties topic.

How to Export Data:

1. From the Main screen, click the Administration icon. The Administration Menu appears at the bottom of the screen.

2. On the Administration Menu, click Export. The Export Wizard/Step 1: Origination and Destination Data screen appears.

3. Select the table from which you want to export from the Export Table drop down menu. Then select the file to which you want to export the data. Here, the Supplier table has been selected for import to an external file named Suppliers.csv (a comma separated values file). Export also supports creation of .TXT files.

4. Click Next to continue. The Step 2: Export Field Selection screen appears.
The Export Field Selection screen allows you to select which of the Fields available in the table you have chosen to pull data from will be exported to the specified file.

To select a field, highlight a listing in the Fields available screen, then click the \( \text{>} \) button to add it to the Fields selected box.

Click the \( \text{>>} \) button to add all of the available fields to the Fields selected box.

After adding one or more fields to the Fields selected box, you can use the \( \text{<} \) or \( \text{<<} \) buttons to return fields to the Fields available box.

The graphic below displays this screen with all Fields available selected.
5. When you are finished selecting all the fields you want to use, click the Up or Down buttons to sequence the fields in the desired order. This is the order they will appear in your exported file. The Preview window at the bottom of the screen displays how your file will look.

6. Click Next to continue. The Step 3: Destination File Format screen appears.
The **Destination File Format** screen allows you to specify the Field Delimiter of choice and whether or not to **Include field names on first row**.

Delimiters are used to separate the data items in a database (the columns in the database table) when transporting the database to another application. For example, a comma-separated values file (CSV file) is one in which each value in the cells of a table row is delimited by and separated from the next value by a comma. The beginning of a row is indicated by a new line character.

If the file name you specified in Step 1 uses the extension .CSV, you must specify `<Comma>` as your field delimiter (the default). If you specified a file name with the extension of .TXT in Step 1, you may use any of the field delimiters available in the drop list (as long as the chosen character does not occur within the data itself.)

7. **Click the Finish button to perform the export.** On completion, you'll receive a confirmation screen stating your export was successful.

You can confirm the export by opening and reviewing the .csv or .txt file you specified in Step 1.

Exports can be performed from any of the program's tables: Location, Supplier, Manufacturer, Item, Customer or Inventory.
# 16.3 Related Data Fields

<table>
<thead>
<tr>
<th>Location Table</th>
<th>Supplier Table</th>
<th>Manufacturer Table</th>
<th>Item Table</th>
<th>Inventory Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td></td>
<td></td>
<td>Site</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td></td>
<td></td>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Supplier Code</td>
<td>Supplier Code</td>
<td>Manufacturer Name</td>
<td>Supplier Code</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Item Number</td>
<td>Item Number</td>
<td></td>
</tr>
</tbody>
</table>

The chart above shows the related data fields that exist within the database tables. The chart should be interpreted from left to right:

- If you will be importing data into both the **Location** table and the **Inventory** table:

  The same *values* that reside within the Import Data Columns you choose to map to the Location table's Site and Location fields must also occur within the Import Data Columns you choose to map to the Inventory table's Site and Location fields. The actual Import file used for the Location import does not have to be used for the Inventory import. It's the Site and Location *values* themselves which must be the same in both Imports to create the proper connections between the Location and Inventory tables.

  If, while importing Inventory data, a previously unknown Site or Location value is read, a new Site and/or Location will be created using the new value; the Inventory record being imported will not be associated with an existing Site and Location.

- If you will be importing data into the **Supplier** table and the **Item** table (or into the Supplier table and both the Item and **Inventory** tables):

  The same *values* that reside within the Import Data Columns you choose to map to the Supplier table's Supplier Code field must also occur within the Import Data Columns you choose to map to the Item or Inventory table's Supplier Code field. The actual Import file used for the Supplier import does not have to be used for the Item or Inventory import. It's the Supplier Code *values* themselves which must be the same in both Imports (or in all three Imports) to create the proper connections between the Supplier and Item tables (or between the Supplier, Item and Inventory tables).

  If, while importing Item data, a previously unknown Supplier Code value is read, a new Supplier Code will be created using the new value; the Item record being imported will not be associated with an existing Supplier Code.

  If, while importing Inventory data, a previously unknown Supplier Code value is read, a new Supplier Code will *not* be created using the new value; the Inventory record being imported will be rejected.
If you will be importing data into both the Manufacturer table and the Item table:

The same values that reside within the Import Data Columns you choose to map to the Manufacturer table's Name field must also occur within the Import Data Columns you choose to map to the Item table's Manufacturer field. The actual Import file used for the Manufacturer import does not have to be used for the Item import. It's the Name and Manufacturer values themselves which must be the same in both Imports to create the proper connections between the Manufacturer and Item tables.

If, while importing Item data, a previously unknown Manufacturer value is read, a new Manufacturer will be created using the new value; the Item record being imported will not be associated with an existing Manufacturer.

If you will be importing data into both the Item table and the Inventory table:

The same values that reside within the Import Data Columns you choose to map to the Item table's Item Number's field must also occur within the Import Data Columns you choose to map to the Inventory table's Item Number field. The actual Import file used for the Item import does not have to be used for the Inventory import. It's the Item Number values themselves which must be the same in both Imports to create the proper connections between the Item and Inventory tables.

If, while importing Inventory data, a previously unknown value for either Item Number, Site, Location, or Supplier Code is read, a new Item Number, Site, Location or Supplier Code will not be created using the new value; the Inventory record being imported will be rejected. Negative values for Quantity can also cause an Inventory record to be rejected. Lastly, if one or more Tracked By or Require the user to fill out options are enabled for the Item Number specified in an Inventory record that fails to supply that information, the record will be rejected. These errors will be listed in the Import-Export Error Report.

These same relationships apply when using Create New Location, Create New Supplier, Create New Manufacturer, Create New Item or Add Inventory.

The Customer table's fields are not related to fields within any of the other tables.
16.4 Import Specifics

This topic lists all Field Names, Data Types and Sizes for the fields that can be imported.

The import wizard contained in this software can automatically map the columns in your import files to the correct column in the database. To do this, however, the column header must match one that the wizard is looking for and the data type must be correct. Below is the header and data type the import wizard is expecting. Modify your .csv or .txt file with the correct column header to simply the import process. The order in which your columns are arranged in your file does not matter. You can also find a .csv file with the header and one row of sample data on the installation cd that came with this product.

The imported file formats discussed in this topic are:

Customer

Inventory

Item

Location

Manufacturer

Supplier

Data Type Definitions are listed after the Table Properties.

16.4.1 Customer Import Format:

<table>
<thead>
<tr>
<th>Column Header</th>
<th>Data Type</th>
<th>Size (Precision, Scale)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell No</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Company Name</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Custom Date 1</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 2</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 3</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 4</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 5</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Number 1</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 2</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 3</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 4</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 5</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Text 1</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 2</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 3</td>
<td>varchar</td>
<td>100</td>
</tr>
</tbody>
</table>
### Note:
You may have multiple address information for shipping, mailing, etc.

#### 16.4.2 Inventory Import Format:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Size (Precision, Scale)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Acquired</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Date Code</td>
<td>varchar</td>
<td>25</td>
</tr>
<tr>
<td>Item Description</td>
<td>varchar</td>
<td>255</td>
</tr>
<tr>
<td>Item Number</td>
<td>varchar</td>
<td>31</td>
</tr>
<tr>
<td>Location</td>
<td>varchar</td>
<td>30</td>
</tr>
<tr>
<td>Lot</td>
<td>varchar</td>
<td>25</td>
</tr>
<tr>
<td>Pallet</td>
<td>varchar</td>
<td>25</td>
</tr>
<tr>
<td>PO</td>
<td>varchar</td>
<td>25</td>
</tr>
<tr>
<td>Quantity</td>
<td>decimal</td>
<td>9(18,4)</td>
</tr>
<tr>
<td>Serial Number</td>
<td>varchar</td>
<td>25</td>
</tr>
</tbody>
</table>
### 16.4.3 Item Import Format:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Size (Precision, Scale)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt Item Number</td>
<td>varchar</td>
<td>30</td>
</tr>
<tr>
<td>Category</td>
<td>varchar</td>
<td>255</td>
</tr>
<tr>
<td>Checkout Length</td>
<td>int</td>
<td>4</td>
</tr>
<tr>
<td>Cost</td>
<td>money</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 1</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 2</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 3</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 4</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 5</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Number 1</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 2</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 3</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 4</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 5</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Text 1</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 2</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 3</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 4</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 5</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 6</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 7</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 8</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 9</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 10</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Customer (Required ?)</td>
<td>char</td>
<td>1</td>
</tr>
<tr>
<td>Date Code (Track By?)</td>
<td>char</td>
<td>1</td>
</tr>
<tr>
<td>Description</td>
<td>varchar</td>
<td>255</td>
</tr>
<tr>
<td>Dimension Unit</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>File Reference</td>
<td>varchar</td>
<td>255</td>
</tr>
<tr>
<td>Height</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Item Number</td>
<td>varchar</td>
<td>31</td>
</tr>
<tr>
<td>Length</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>List Price</td>
<td>money</td>
<td>8</td>
</tr>
<tr>
<td>Lot (Track By?)</td>
<td>char</td>
<td>1</td>
</tr>
<tr>
<td>Manager</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Max Stock Level</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Min Stock Level</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Notes</td>
<td>varchar</td>
<td>1000</td>
</tr>
</tbody>
</table>
### Field Name  | Data Type  | Size (Precision, Scale)
--- | --- | ---
Pallet (Track By?) | char | 1
PO (Required?) | char | 1
Reorder Qty | decimal | 9(15,4)
Sale Price | money | 8
Serial Number (Track By?) | char | 1
Supplier (Required?) | char | 1
Supplier Code | varchar | 30
Supplier Name | varchar | 50
Unit of Measure | varchar | 10
Weight | varchar | 50
Weight Unit | varchar | 50
Width | varchar | 50

### 16.4.4 Location Table Properties:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Size (Precision, Scale)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Date 1</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 2</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 3</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 4</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 5</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Number 1</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 2</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 3</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 4</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 5</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Text 1</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 2</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 3</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 4</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 5</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 6</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 7</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 8</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 9</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 10</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Description</td>
<td>varchar</td>
<td>255</td>
</tr>
<tr>
<td>Location</td>
<td>varchar</td>
<td>30</td>
</tr>
<tr>
<td>Notes</td>
<td>varchar</td>
<td>1000</td>
</tr>
<tr>
<td>Site</td>
<td>varchar</td>
<td>50</td>
</tr>
</tbody>
</table>
### 16.4.5 Manufacturer Table Properties:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Size (Precision, Scale)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address 1</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Address 2</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>City</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Contact Cell No</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Contact Ext.</td>
<td>varchar</td>
<td>10</td>
</tr>
<tr>
<td>Contact FAX</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Contact Name</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Contact Phone</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Country</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Custom Date 1</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 2</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 3</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 4</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 5</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Number 1</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 2</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 3</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 4</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 5</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Text 1</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 2</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 3</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 4</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 5</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 6</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 7</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 8</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 9</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 10</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Email</td>
<td>varchar</td>
<td>250</td>
</tr>
<tr>
<td>Extension</td>
<td>varchar</td>
<td>10</td>
</tr>
<tr>
<td>FAX</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Mail Stop</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Name</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Notes</td>
<td>varchar</td>
<td>1000</td>
</tr>
<tr>
<td>Phone</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Postal Code</td>
<td>varchar</td>
<td>10</td>
</tr>
<tr>
<td>State</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Web Site</td>
<td>varchar</td>
<td>255</td>
</tr>
</tbody>
</table>
16.4.6 Supplier Table Properties:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Size (Precision, Scale)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address 1</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Address 2</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>City</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Contact Cell No</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Contact Ext.</td>
<td>varchar</td>
<td>10</td>
</tr>
<tr>
<td>Contact FAX</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Contact Name</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Contact Phone</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Country</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Custom Date 1</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 2</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 3</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 4</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Date 5</td>
<td>datetime</td>
<td>8</td>
</tr>
<tr>
<td>Custom Number 1</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 2</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 3</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 4</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Number 5</td>
<td>decimal</td>
<td>9(15,4)</td>
</tr>
<tr>
<td>Custom Text 1</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 2</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 3</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 4</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 5</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 6</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 7</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 8</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 9</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Custom Text 10</td>
<td>varchar</td>
<td>100</td>
</tr>
<tr>
<td>Email</td>
<td>varchar</td>
<td>250</td>
</tr>
<tr>
<td>Extension</td>
<td>varchar</td>
<td>10</td>
</tr>
<tr>
<td>FAX</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Mail Stop</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Name</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Notes</td>
<td>varchar</td>
<td>1000</td>
</tr>
<tr>
<td>Phone</td>
<td>varchar</td>
<td>20</td>
</tr>
<tr>
<td>Postal Code</td>
<td>varchar</td>
<td>10</td>
</tr>
<tr>
<td>State</td>
<td>varchar</td>
<td>50</td>
</tr>
<tr>
<td>Supplier Code</td>
<td>varchar</td>
<td>30</td>
</tr>
<tr>
<td>Web Site</td>
<td>varchar</td>
<td>255</td>
</tr>
</tbody>
</table>
16.4.7 Data Type Definitions:

- The maximum sizes permitted by the data types defined below are greater than the field lengths used in the database. Refer to the sizes given in the tables above to avoid truncation when using Import.
- Any field defined in the tables above that has a length of only one character expects one of the following values (case insensitive):
  - For False: "0", "F", "False", "No", "N"
  - For True: "1", "T", "True", "Yes", "Y"

**char**  Fixed-length non-Unicode character data with a maximum length of 8,000 characters.

**datetime**  Date and time data from January 1, 1753, through December 31, 9999, with an accuracy of three-hundredths of a second, or 3.33 milliseconds.

**Valid Alphabetic datetime Formats** for Microsoft® SQL Server™ 2000 date data (characters enclosed in brackets are optional):

```
Apr[il][15][,] 1996 -- (mdy)
Apr[il] 15[,] [19]96 -- (mdy)
15 Apr[il][,][19]96 -- (dmy)
15 [19]96 apr[il] -- (dmy)
1996 APR[IL] [15] -- (ymd)
```

💡 Suggestion: To avoid ambiguity, use four-digit years.

If the day is missing, the first day of the month is supplied.

💡 Any of the alphabetic datetime formats shown above may be used -as long as- the format you select conforms to the year, month and date sequence exhibited by the Long Date format in effect on your PC. This can be found at:

Start > Settings > Control Panel > Regional Options > Date tab > Long Date format
For example, if your Long Date format, as shown in Regional Options is **dddd, MMMM dd, yyyy** (Friday, June 27, 2003), you can use any of the **mdy** alphabetic formats shown above, but you can *not* use any of the **dmy** or **ymd** formats.

**Valid Numeric datetime Formats** for Microsoft® SQL Server™ 2000 (characters enclosed in brackets are optional):

```
number separator number separator number [time] [time]
```

- `[0]4/15/[19]96` -- (mdy)
- `[0]4-15-[19]96` -- (mdy)
- `[0]4.15.[19]96` -- (mdy)
- `[04]/[19]96/15` -- (myd)
- `15/[0]4/[19]96` -- (dmy)
- `15/[19]96/[04]` -- (dym)
- `[19]96/15/[04]` -- (ydm)
- `[19]96/[04]/15` -- (ymd)

Slash marks (/), hyphens (-), or periods (.) may be used as separators.

Any of the numeric datetime formats shown above may be used -as long as- the format you select conforms to the year, month and date sequence exhibited by the Short Date format in effect on your PC. This can be found at:

```
Start > Settings > Control Panel > Regional Options > Date tab > Short Date format
```

For example, if your Short Date format, as shown in Regional Options is **M/d/yyyy** (6/27/2003), you can use any of the **mdy** numeric formats shown above, but you can *not* use any of the **dmy**, **ymd**, **myd**, or **dym** formats.

**decimal** Fixed precision and scale numeric data from -10^38 +1 through 10^38 -1.

**Precision** specifies the maximum *total number of decimal digits* that can be stored, both to the left and to the right of the decimal point.

**Scale** specifies the maximum number of decimal digits that can be stored *to the right of the decimal point*.

**Size** is the number of storage bytes consumed internally - this value should be ignored when determining whether or not a decimal value will be truncated - use Precision and
Scale instead, to make this assessment. Size can and should be used for all other Data Types.

**int**  Integer (whole number) data from $-2^{63}$ (-9223372036854775808) through $2^{63}-1$ (9223372036854775807).

**money**  Monetary data values from $-2^{63}$ (-922,337,203,685,477.5808) through $2^{63} - 1$ (+922,337,203,685,477.5807), with accuracy to a ten-thousandth of a monetary unit.

This data type is limited to a maximum of four decimal points. Use a period to separate partial monetary units, like cents, from whole monetary units. For example, **2.15** specifies **2 dollars and 15 cents**.

Comma separators are not allowed.

**varchar**  Variable-length non-Unicode data with a maximum of 8,000 characters.
Chapter 17 - Performing an Audit

17.1 Auditing Your Inventory

As many business owners know, keeping accurate counts of inventory is a critical part of maintaining a well-run business. For instance, if an inventory item is listed in the system as having met its reorder point, but the quantity in the system is based on an inaccurate count, your business could end up wasting money on reordering inventory that was not in danger of being depleted. On the other hand, if your system lists plenty of inventory for an item that is actually at or below the reorder point, you could be faced with too little stock on hand to fulfill orders, creating a costly back-order situation. Many business owners also know that getting accurate counts can be a time-consuming task.

Note: All screen shots in this help file are of InventoryControl Professional Edition. The screens and available features in other versions of InventoryControl and in WaspNest Inventory may differ. For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

With these issues in mind, the software was designed with a built-in audit mode that allows you to conveniently conduct audits at the PC and on one or more mobile devices while preventing access to such features as Remove and Add so that you can be assured you are getting accurate count comparisons.

Audit Mode allows you to check the counts of all your inventory while disabling the Add, Remove, Move, Adjust and Check-In and Check-Out features to make sure inventory counts in the system do not change while you are performing the audit. If you are using mobile devices, you can use them simultaneously with the PC to perform an audit by downloading the database in audit mode to each device. Audit Mode features a simple Audit screen that allows you to enter your counts for inventory in each location and compares these to the counts already in the system. You can then view the Complete Audit screen to review any discrepancies between your counts and what was in the system. At the click of a button you can reconcile the counts or you can select certain transactions to accept or reject. This software also comes equipped with several Audit Reports that allow you to review a variety of information at-a-glance.

The topics listed below are included in this section. It is best to review these topics in order as they outline the flow of performing an audit.

- **Audit Flow Overview**
- **Beginning the Audit**
- **Using the Audit Screen**
- **Reviewing the Not Counted Items Report**
- **Reconciling Your Counts on the Complete Audit screen**
- **Reviewing the Remainder of the Audit Reports**
- **Ending the Audit**
17.2 Audit Flow Overview

The audit process in this software is broken into 7 steps:

1. Create a pre-audit backup of your database.
2. Start the Audit Mode on the PC. If you are using mobile devices, create a database of the system while in audit mode and download it to the mobile devices to be used during the audit. If you are using a wireless connection, you will not need to download the audit database. Your mobile device will connect to the database as usual.
3. Use the Audit screen or the mobile devices to enter counts (and sync the mobile device data back to the PC).
5. Reconcile your counts entered in the Audit screen against the counts that were in the system.
6. Review the remainder of the Audit Reports.
7. End the Audit Mode.

17.3 Beginning the Audit

1. On the Main screen, click the Inventory icon. The Inventory menu appears at the bottom of the screen.
2. On the Inventory menu, click the Audit icon. The following confirmation message appears:

   ![Confirmation Message]

   Are you sure you want to start an Audit?

   Yes  No

3. Click Yes to begin the audit. If you are using the Pro or Enterprise version of InventoryControl, a message appears reminding you to create a pre-audit backup of your database, if you have not already done so.
4. Select Cancel on the Backup Reminder message, then to the Backup screen and create the backup now. We recommend you create the backup file with a name similar to the following:

   Pre-Audit-yyyy-mm-dd-hh-mm-ss.bkp

   This backup of your database can be restored later, if necessary, but you will lose any transactions completed since that backup. For more information on creating backups, please refer to the Backing Up the Database topic.

   Select OK to begin the audit without creating a backup (this is not recommended).

The screen will prominently display a message that Audit Mode is active and most of the Inventory menu will be disabled. An example of the Inventory menu with Audit Mode activated
With **Audit Mode Active**, you should next create mobile databases and download them to mobile devices if you will be using mobile devices for the audit. If you are using a wireless device, you will not need to download the database.

5. Now you can begin entering counts manually on the PC or on the mobile devices via the **Audit** screen. For information on using the **Audit** screen on the mobile device, please refer to the **Working with Mobile Devices** section of this help file:

**WDT2200 - Auditing Inventory**
**Windows Mobile Device - Auditing Inventory**

### 17.4 Using the Audit Screen

Now that you have started the **Audit Mode** on the PC and (optionally) downloaded the audit database to your mobile devices, you can begin your counts.

**To enter your counts on the PC:**
1. On the **Inventory** menu, click the **Audit** icon (this is the same icon you clicked to begin the **Audit Mode**). The **Audit** screen appears:

![Audit Screen](image)

**Note:** To prevent fields from clearing, click the pushpin button located to the right of the field you want to lock. This is helpful when you have to perform multiple Adds at one Location, for example. Pushpins can be used to lock the values in all but one required field so that a scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that field. (The **Add** button does not have to clicked between each scan to post these add transactions to the **Pending Transaction List**.)

Clicking the button will unlock the field.

2. **Complete the Item fields:** Enter the **Item Number** of the item you want to audit. To enter an **Item Number**, you can type or scan the value into the field, or you can use the drop down list to see the first 10 items in the database, select `<more>` on the drop down list to see all items in the **Item List**. You cannot create a new item during an audit.

Entering an **Item Number** populates the **Item Number** field as well as the **Description** field and enables the following fields:

- **Location**
- **Quantity** (unless the item is **Tracked By Serial Number** - Set on the **Add** or **Edit Item** screens, which fixes the Quantity to a value of 0 or 1)
- Any of the associated **Tracked By** fields: **Serial Number, Date Code, Lot** or **Pallet** (Set on the **Add** or **Edit Item** screens). A **Tracked By** field is enabled or disabled at the time the item is created.

Items tracked by serial number that are checked-out cannot be audited.

Below is an example of the **Audit** screen enabled:
3. **Enter a Transaction Code (optional):** This field allows you to type in a value or select a previously-entered code that describes the transaction.

4. **Enter Notes (optional):** This field allows you to add and store additional information that describes the transaction.

5. After you have entered all information on the screen, click the **Audit** button. The audit transaction will be added to the **Pending Transaction List**.

   The **Audit** button is not enabled until a valid value is entered in the **Item Number** field and the **Location** field.

6. After reviewing the **Pending Transaction List**, click the **OK** button to post the audit transactions to your database.

   You can highlight an item in the Pending Transaction List and click the Remove button to remove it from the list. You can select the Remove All button to remove all pending transactions from the list.

   Audit's pending transactions are handled differently than other inventory transactions. All pending transactions are listed (those just added as well as those previously added.) They do not go away until they are reconciled or removed from the list.

7. Repeat these steps for each item for which you want to update quantity. After you have finished updating quantity for all audited items (and downloaded any audit data from the mobile devices, if used) you are ready to review the **Not Counted Items Report**.
17.5 Reviewing the Not Counted Items Report

This software contains several audit reports that allow you to review count and discrepancy information. Most of these reports are useful for review after the audit is completed and are discussed later in this topic. The Not Counted Items Report, however, should be reviewed before you reconcile your counts. This report lists any items for which quantity was not entered into the system either through the Audit screen on the PC or via the mobile devices. By reviewing this report, you can quickly determine if any items were missed during the audit.

To View the Not Counted Items Report:

1. Click the Reports icon in the main functions section of the Main Screen. The Reports Selection screen appears displaying all Audit reports.
2. Highlight the Not Counted Items Report and click OK or just double-click the report. The report opens in the Report Viewer. For more information on viewing reports, please refer to the Report Viewer topic.
3. Review the report and add counts for any items that were missed. After you have entered any additional quantities into the system, you are ready to reconcile your counts.

17.6 Reconciling the Counts

The next step in the audit process is to reconcile your counts against those that were already in the system. You can view this screen and reconcile as you go along, or you can wait until all counts are entered and reconcile once before ending the audit.

To Reconcile:

1. On the Inventory Menu (in Audit Mode), click the Reconcile/End icon. The Complete Audit screen appears:
This screen lists all audit transactions and includes the following columns:

- **Item Number**
- **Current Quantity** - This is the quantity that was listed for this item in the system prior to the audit.
- **Audited Quantity** - This is the quantity that you entered for this item on the Audit screen. You can update this field on the Complete Audit screen by selecting the field and typing in a new number or by using the up or down arrow buttons next to the field.
- **Location** - The location you selected for this item on the Audit screen.
- **Serial Number, Lot, Pallet** - These appear populated only if this item is tracked by one or more of these fields.

2. Select from the **Action** column what action you want to take with the selected item. Your options are:

   - **Audited Qty** - Selecting this option means the system will keep the audited quantity you entered for this item on the Audit screen.
   - **Current Qty** - Selecting this option means the system will keep the quantity that was listed in the system prior to the audit.
   - **Ignore Record** - When the audit is ended, no action will be taken on this record. Quantity amounts will stay the same for this item. The system will behave as though this item was not audited. The item will not appear on any audit reports.

   You must remove those items you mark as Ignore Record from the Pending Transaction List tab on the Audit screen before you can end the audit.

3. After you have selected an action for all items on the list, click the OK button to post the transactions to your database. You are now ready to end the audit.
17.7 Reviewing the Remainder of the Audit Reports

This software contains several audit reports that allow you to review a variety of information. Available reports are:

- Accepted Audit Discrepancies Report
- Accepted Audit Result Report
- Audit History by Audit Date
- Audit History by Item Number
- Not Counted Item Report
- Unreconciled Audit Discrepancies
- Unreconciled Audit Report

These reports are accessed by clicking the Reports icon on the Main Screen. The reports are viewed in the Reports Viewer. For more information on viewing reports, please refer to the Report Viewer topic.

17.8 Ending the Audit

The last step in the audit process is to end the Audit Mode session on your PC so all features are enabled. To do this:

1. On the Inventory menu (in Audit Mode), click the Reconcile/End icon.

   If you have not reconciled all transactions on the Complete Audit screen (including removing any records marked as Ignore Record from the Audit screen/Pending Transactions List tab), the Complete Audit screen will appear. For information on using this screen, please refer to the Reconciling the Counts topic, above.

   If you have reconciled all transactions, the following message will appear:

   ![Audit Confirmation Message]

   Are you sure you want to end the Audit?

   Yes  No

2. Click Yes on the message screen to end the audit. The system will go back into regular mode and you will have access to all features on the Inventory menu.
Chapter 18 - Search Function

18.1 Searching for Information

The Find screen allows you to easily search for information within the Inventory Control database. You can limit your search to a specific table (Information you enter into each field in InventoryControl is stored in a database "table" behind the scenes. You can extract this information using the Export Wizard.) in the database, field or even a value within a field on the Find screen.

Searching for Information:

1. From the Main screen, select the Find icon. A menu of tables from which to search appears.

2. Select what you want to search for by clicking on an option in the Find menu. In this example we are going to search for Customers.

You can also access this screen by clicking the Filter button at the top of the List screens.

Note: If the table you select (Customers, Manufacturers, Items, etc.) contains over 1000 pieces of data, you will automatically be taken to the Advanced Find screen. For further information on the Advanced Find screen, please refer to the Advanced Find topic.

3. The Find screen contains three fields:

   - **Table** is used to select the table you want to search.
   - **Field** is used to select the field in the listed table to be searched.
   - **Value** is the information for which you are searching.

Selecting the Whole Word Only checkbox will search the selected table based upon the your entire entry in the Value field. Partial matches will be excluded from the search results.
Selecting the **Find All** checkbox disables the **Field** and **Value** fields. The search results will display all of the records from the table selected in Search.

You can click the **Advanced** button to go to the **Advanced Find** screen which provides you with more search options.

4. Click the **Find** button to start the search. When the search is complete, a list will appear displaying all the records that match your criteria.

   All searches are case insensitive.

   Your most recent **Find** criteria are saved and will automatically be loaded the next time you access the **Find** screen.

### Examples:

For these examples, assume that the Customer table is made up of three records containing one field, called FirstName. The values in this field are Fred, Frederick, and Sam.

<table>
<thead>
<tr>
<th>Example</th>
<th>Table</th>
<th>Field</th>
<th>Value</th>
<th>Whole Word Only Option</th>
<th>Find All Option</th>
<th>Search Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Customer</td>
<td>FirstName</td>
<td>Fred</td>
<td>Off</td>
<td>Off</td>
<td>2 records: Fred; Frederick</td>
</tr>
<tr>
<td>2</td>
<td>Customer</td>
<td>FirstName</td>
<td>Fred</td>
<td>On</td>
<td>Off</td>
<td>1 record: Fred</td>
</tr>
<tr>
<td>3</td>
<td>Customer</td>
<td>FirstName</td>
<td>Mike</td>
<td>Off</td>
<td>On</td>
<td>3 records: Fred; Frederick; Sam</td>
</tr>
</tbody>
</table>
18.2 Advanced Find

The **Advanced Find** screen allows you to search a table in the database using multiple values and logical expressions. This screen is useful when the table you are searching contains a lot of data. You can enter several parameters by which to filter your search.

When you use this screen, you will construct a filter, which limits the information you are searching for to certain parameters.

**Using the Advanced Find Screen:**

1. From the **Main** screen, click the **Find** icon. A menu of tables from which to search appears.
2. Select what you want to search for by clicking on an option in the **Find** menu. In this example we are going to search for **Customers**.

   **Note:** If the table you select (**Customers, Manufacturers, Items**, etc.) contains over 1000 pieces of data, you will automatically be taken to the **Advanced Find** screen. If you are not automatically taken to the **Advanced Find** screen, the **Find** screen will appear.

3. Select the **Advanced** button on the **Find** screen. The **Advanced Find** screen appears.

![Advanced Find Screen](image)

The **Advanced Find** screen consists of seven input fields and a **Filter Expression** panel that displays the resulting filter as you build it. These fields are described below:

- **Table** is used to select the table you want to search.
- **Parenthesis** (open and close) can be used to control the order in which criteria will be processed. The inner most pair of parentheses in any filter expression are evaluated first.
- **Field** is used to select the field in the listed table to be searched.
• **Operator** is a comparison operator used to evaluate an expression.

<table>
<thead>
<tr>
<th>Comparison Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>equal</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>not equal</td>
</tr>
<tr>
<td>&gt;=</td>
<td>greater than or equal</td>
</tr>
<tr>
<td>&gt;</td>
<td>greater than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>less than or equal</td>
</tr>
<tr>
<td>&lt;</td>
<td>less than</td>
</tr>
<tr>
<td>Like</td>
<td>is similar to value</td>
</tr>
<tr>
<td>Not Like</td>
<td>is not similar to value</td>
</tr>
<tr>
<td>Is Null</td>
<td>no value</td>
</tr>
<tr>
<td>Is Not Null</td>
<td>any value</td>
</tr>
</tbody>
</table>

• **Like** and **Not Like** are used for text pattern matching. They can only be used with plain text fields, not with dates. The following characters, used within the text value, have a special meaning for the Like and Not Like operators:

<table>
<thead>
<tr>
<th>LIKE Operator</th>
<th>Meaning</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>_ (underscore)</td>
<td>matches any single character</td>
<td>LIKE '_-inch' matches '2-inch', '3-inch', etc.</td>
</tr>
<tr>
<td>%</td>
<td>matches zero or more characters of any value</td>
<td>LIKE 'Eric W%' matches 'Eric White', 'Eric Williams', etc.</td>
</tr>
<tr>
<td>\</td>
<td>Escapes the special characters (gives them their normal meaning)</td>
<td>LIKE '%' matches '%' \ LIKE '\' matches a single ''</td>
</tr>
</tbody>
</table>

• **Value** is the information you are searching for. (This may included special characters for the Like or Not Like operators).

• **Logical** is a Boolean operator that combines one or more filter expressions into a single logical group:

<table>
<thead>
<tr>
<th>Boolean Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>gives you the intersection of two conditions</td>
</tr>
<tr>
<td>OR</td>
<td>gives you the union of two conditions</td>
</tr>
</tbody>
</table>
4. Enter the desired values for the seven **Advanced Find** fields to construct a filter fragment. For example, assume you make the following selections:

   - **Table**: Customer
   - **Field**: Address 1
   - **Operator**: =
   - **Value**: 2205 Anywhere Road

   The **Customer** table will be searched for any instance of **2205 Anywhere Road** appearing in the **Address 1** field.

5. Click the **Add** button after building each filter fragment. The filter will appear in the **Filter Expression** list as shown in the example below:

   ![Advanced Find Filter Expression](image)

6. The **Move Up** and **Move Down** buttons allow you to move a filter fragment toward the top or toward the bottom of the list, respectively. To reposition a filter fragment in the **Filter Expression** panel, click on it, then click either the **Move Up** or **Move Down** button.

   You may edit a filter fragment by first selecting the fragment in the **Filter Expression** list. The values of the filter fragment populate the seven input fields. Update any of these fields, then click **Replace** to update the selected filter fragment in the **Filter Expression** list.

7. Click the **Check** button to check the syntax of the **Filter Expression**.

8. Click the **Find** button to start the search process. When complete, a list will be displayed showing all the records that match your criteria.

   ➡️ **All searches are case insensitive.**

   ➡️ To search for a specific date, build your filter expression to include a time range of 12:00am to 11:59pm for the given date. For example, the filter expression **Date >= 12/25/02 12:00am to**
12/25/02 11:59pm will return all records that have the date 12/25/02.

9. Click the **Simplified** button to revert to the standard **Find** screen.

**Chapter 19 – WDT2200**

19.1 **WDT2200 - Setup the Device**

The Wasp WDT2200 Communication Wizard allows you to setup your Wasp WDT2200 PDT for use with InventoryControl, filter the database to be used on the PDT, and transfer data to and from the PDT.

**Note:** The WDT2200 must be powered on and connected to the PC's serial port before proceeding.

**Setting Up the Device:**

1. On the **InventoryControl Main** screen, click the **Mobility** icon. If you have more than one type of mobile device installed, a menu will appear allowing you to select which device you will be working with. If you have only one type, the **Mobility Menu** for that device will appear at the bottom of the screen.

2. On the **Mobility Menu**, select **Setup Mobile**.

The **Wasp WDT2200 Communication Wizard** screen appears with the **Setup WDT2200** tab displayed.
3. Click Auto Detect COM Port Settings. A status screen appears as the system is detecting the default settings:

![Auto Detect COM Port Settings]

The default settings are:

Parity: None
Baud Rate: 19200
Stop Bits: 1

When the system is finished looking for the settings, they will appear in the fields:
4. Normally, you should not have to make changes to the values set by the Auto Detect function, but changes can be made to the **COM Port Settings**, if necessary:

Specify the **Serial Port** to which your PDT is connected. The Serial Port drop list will display COM1 through COMn where 'n' is the highest address found on your system.

Specify the **Baud Rate** at which your PC is to communicate with the PDT. It is recommended that you use the default value of **19200**, reducing the Baud Rate to lesser values only if you encounter difficulty transferring files.

Specify the **Parity** and **Stop Bits** for the serial port if it is not defined with the defaults shown above (**None** and **1**, respectively.)

If InventoryControl is not already installed, you will receive the following message:

5. **Click Yes** to install the program.

While it is loading you will see a status bar and the device will beep occasionally.
When the install has completed, the following confirmation message will appear:

6. Click **OK** on the confirmation message.

   After the first install of InventoryControl, you can resend the program at any time by connecting the device and clicking the **Transfer Program to Mobile Device** button.

7. Next you need to create the mobile database. For more information, please refer to the **WDT 2200 - Creating the PDT Database** topic.

---

**19.2 WDT2200 - Creating the PDT Database**

After you send the InventoryControl program to your mobile device, you will need to create a mobile version of the database so you can transfer the data from the pc to the mobile device. You will also need to create a new database each time you want to send changes from the PC to the mobile device. **Create PDT Database** builds the database that will be transferred to the PDT.

**Note:** If there are inventory transactions on the PDT which have not yet been transferred to the PC, you should Receive the Data from PDT first. For more information on receiving data from the PDT, please refer to the **WDT2200 - Receiving Data from the PDT** topic. Sending a new database first will result in losing the data on the PDT.

**Creating the Database:**

1. If you are continuing the setup process, click the Next button at the bottom of the Setup WDT 2200 tab, or click the Create PDT Database tab. (You must send the InventoryControl program to the device before you can send the database.) Please refer to the **WDT 2200 - Setting Up the Device** topic for more information.

   **OR**
If you are creating a database for a device that already has the program, from the **InventoryControl Main Screen**, click the **Mobility** icon. If you have more than one type of mobile device installed, a menu will appear allowing you to select which device you will be working with. If you have only one type, the **Mobility Menu** for that device will appear at the bottom of the screen.

On the **Mobility Menu**, select **Create Mobile**.

The **Create PDT Database** tab displays:

Filter Records allows you to specify which data will be used to create the PDT database. By filtering the records to include only those that are needed at the PDT, memory is conserved as is the time necessary to do transfers between the PC and the PDT.

The default values, shown above, apply no filtering to your data. All items will be selected, including those which are not yet in a Location.

If the specified filters produce no eligible Items or Sites, no data will be transmitted to the PDT when a Send Data to PDT is attempted. An error will display on the PDT to verify/send Data to PDT.
2. Select the Site, Location, Item Numbers, Customers, Suppliers, Purchase Orders (Pro and Enterprise Versions Only) and Pick Orders (Pro and Enterprise Versions Only) to be downloaded to the device, then click OK.

Select the Specify Filter button if you will be limiting the data. Click the Hand icon to access the Find screen to search for data. The data you select on the Find screen will be entered in the text box for that section and only that data will be sent to the mobile device. Please refer to the Searching for Information topic for more information on the Find screen.

Select the Minimally Required checkbox to only send data that is required for normal operation. For example, if you select to send all Items, but don't want to send all locations, only those locations designated as Primary Locations for individual items will be sent. Or, if you don't want to send all Suppliers, but some Suppliers are entered on the Item screen/Managing Suppliers tab for items, only those suppliers entered on the Item screen will be sent.

Tips for Filtering Information

The default values apply no filtering to your data. All Items will be selected, including those which are not yet in a Location.

Site:

Source: Specify <all> or one of the Sites listed in the drop down list. This determines which Sites will be shown in the Source Site list on the WDT2200.

This is the Site for all inventory transactions to be performed by the device. If you want the device’s database to include Items at more than one Site, select <all>. You can only select ALL or 1 specific site. For example, if you have 5 sites, you cannot select 2 to be a Source. You can either select 1 or all.

Destination: If more than one Site is defined on the system and you have selected a specific Site in the Source Site field, you can select one of the Sites listed in the Destination drop down list. This determines which Sites will be shown in the Destination Site list of the WDT2200 Site Configuration function and which locations will be listed in the Move To list.

This field will be grayed-out with a value of <all>, as shown above, if only one Site is defined in InventoryControl or if a value of <all> has been specified for the Source Site. If a specific Site has been selected for the Source Site, that same site will be the default value for Destination Site, but you can change the Destination Site to a different value using the drop down list.
<table>
<thead>
<tr>
<th>A Specific Site</th>
<th>A Different Site</th>
<th>The Specified Source Site</th>
<th>The Specified Destination Site</th>
</tr>
</thead>
<tbody>
<tr>
<td>This value is forced to &lt;all&gt; when there is only one Site setup in the system.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>This value is forced to &lt;all&gt; when &lt;all&gt; is specified as the Source Site.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

As an example, if you have more than two Sites and want to be able to move inventory from Site 1 to Site 2 -and- from Site 1 to Site 3 on the mobile device, you will have to create a mobile database for Source Site 1 and Destination Site 2, transfer the database to the mobile device, use the device for those Moves, send the information back to the PC, then repeat the entire process beginning with by creating a second database to do Moves from Source Site 1 to Destination Site 3. Alternately, if your device has enough memory to hold a database containing records for all of your Items, at all Sites, you can specify a Source value of <all> and then control Source Site and Destination Site on the mobile device (see WDT2200 - Site Configuration for more information.

Location:

**From:** Specify **<all>** or use **<More>** from the drop list to find a specific Location at the Source Site that denotes the first in a range of Locations that will be included in the mobile database. The last 10 Locations used will be also be listed in the **From** drop list.

Specifying **<all>** will include all Locations for the specified Source Site in the mobile Database.

**To:** Specify **<all>** or click the **Hand** icon to find a specific Location at the Source Site that denotes the last in a range of Locations that will be included in the mobile database. The last 10 Locations used will also be listed in the **To** drop list.

Specifying **<all>** will include all Locations for the specified Destination Site in the mobile Database.

A specific value can be used for **From** even though **<all>** is used for **To:** (For example, **From:** Bin 50 used with **To:** **<all>**, would select Bin 50 through whatever the largest Bin number is.)

Similarly, a specific value can be used for **To** in combination with **From:** **<all>**. (For example, **From:** **<all>** used with **To:** Bin 100, would select every bin up through Bin 100.)
From: Specify <all> or click the Hand icon to find a specific Item Number that will establish the first valid value in a range of Item Numbers. The last 10 Item Numbers used will be also be listed in the From drop list.

To: Specify <all> or click the Hand icon to find a specific Item Number that will establish the last valid value in a range of Item Numbers. The last 10 Item Numbers used will be also be listed in the To drop list.

Include Items not in a Location: This is an option that is turned on and grayed-out when no filtering is applied. When filtering is applied in one or more of the above fields, this option becomes user-controllable. It allows you to include in the mobile database Items which are not yet in a Location, in addition to those selected via the filters specified. (This can be employed when you expect to use the mobile device to Add quantity for Items that have never been inventoried before. The mobile device user can specify previously defined Locations or create new Locations while adding the previously "Location-less" Items.)

3. Click OK when you have finished specifying filter criteria. You will see this message:

4. Click No if you want to return to the Filter Records dialog. Click Yes if you want to proceed with creating the PDT database.

Several status bars will be displayed as the PDT database is created. Depending on the filter criteria, the database may take several minutes to create.

If you have not yet created any Location, Supplier or Item data in InventoryControl, or your Filter Records criteria exclude all the data, you will receive the following message:

"Create PDT database completed. The criteria entered has resulted in no items being selected for the mobile database. Please click Back button to modify the criteria and try again."

If the above message is displayed, click OK and then the Back button to restart the Filter Records dialog. Finish creating your PC database before attempting another transfer to the PDT.
5. Click **Next** if you want to proceed to the PC to Mobile Device tab where you can send the database you just created to the device.

Click **Back** to restart the Filter Records dialog.

Click **Cancel** if you want to avoid transferring the newly created PDT database to the PDT at this time. The Create PDT Database screen will close. The database you just created for the PDT can still be transferred later.

6. You are now ready to send the database to the PDT. For more information, please refer to the [WDT2200 - Sending Data to the PDT](#) topic.

---

### 19.3 WDT2200 - Sending Data to PDT

The **Send Data to PDT** function is used to transfer data from the PC to the PDT. You will need to create the mobile database first on the **Create PDT Database** tab before using this function. For more information on creating the database, please refer to the [WDT2200 - Creating the PDT Database](#) topic.

**Sending Data to the PDT:**

1. If you are continuing the setup process, click the **Next** button at the bottom of the **Create PDT Database** tab, or click the **PC to Mobile Device** tab. (You must create the mobile database before you can send it to the device.) Please refer to the [WDT 2200 - Creating the PDT Database](#) topic for more information.

   **OR**
If you are creating a database for a device that already has the program, from the **InventoryControl Main** screen, click the **Mobility** icon. If you have more than one type of mobile device installed, a menu will appear allowing you to select which device you will be working with.

If you have only one type, the **Mobility Menu** for that device will appear at the bottom of the screen.

On the **Mobility Menu**, select **Send Data To**.

![Mobility Menu Diagram]

The **PC to Mobile Device** tab displays:
If the specified filters produce no eligible **Items** or **Sites**, no data will be transmitted to the PDT when a Send Data to PDT is attempted.

2. Make sure the WDT2200 is connected to the PC and powered on, then click the **Next** button on the PC screen to proceed.

   **Note:** If you click the **Next** button while still logged in on the PDT, the PC screen will prompt you to log out of InventoryControl on the PDT before proceeding.

   After clicking **Next**, the PC will transfer the database to the PDT:
When finished transferring the data, the following message will be displayed on the PC:
Having received both the InventoryControl program and a database, the PDT will now display the logon screen:

**InventoryControl**  
**V4**  
**User:**

**Password**

**FI-About**

Once you've entered values for **User** and **Password**, you'll be able to perform against the downloaded database.

4. After performing inventory transactions on the PDT, you can retrieve them on the Mobile Device to PC tab.

    or

Click **Finish** now to close this dialog and return to the InventoryControl Main Menu.

    or

Click the **Back** button to restart the Send Data to PDT dialog.
19.4 WDT2200 - Receiving Data from PDT

The Receive Data from PDT function is used to transfer data from the PDT to the PC.

Receiving Data from the PDT:

1. If you are continuing the setup process, click the Next button at the bottom of the Create PDT Database tab, or click the PC to Mobile Device tab. (You must create the mobile database before you can send it to the device.) Please refer to the WDT 2200 - Creating the PDT Database topic for more information.

OR

If you are creating a database for a device that already has the program, from the InventoryControl Main screen, click the Mobility icon. If you have more than one type of mobile device installed, a menu will appear allowing you to select which device you will be working with. If you have only one type, the Mobility Menu for that device will appear at the bottom of the screen.

On the Mobility Menu, select Retreive Data From.

The Receive Data from PDT function can be accessed via the Mobile Devices > PDT > WDT2200 > Receive Data from PDT menu item:
The following conditions must be true before proceeding:

- The WDT2200 must be powered on and connected to the PC’s serial port.
- The InventoryControl Log On screen must be displayed on the PDT. Logout if the PDT is still running the InventoryControl program.

If you attempt to Receive Data From PDT while InventoryControl is running on the PDT, you will receive a message that you need to logout of the program on the PDT, then try again.

After logging out of inventoryControl on the PDT, click the Back button to restart the dialog.

Click the Next button to start the transfer.

If no inventory transactions were performed on the PDT since the last time data was transferred to or from the PDT, the following message will be displayed:

<table>
<thead>
<tr>
<th>Setup Mobile Device</th>
<th>Create Mobile Database</th>
<th>PC to Mobile Device</th>
<th>Mobile Device to PC</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Receive Data From WDT2200</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Download data failed with the following error(s):</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transaction list from mobile device is empty. This is normal only when no transactions have been performed on the mobile device since last successful data retrieval.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If transactions were received from the PDT successfully, you will receive a confirmation message.

Click Finish to close this dialog and return to InventoryControl

or

Click the Mobile Device to PC tab or the Back button to restart the dialog if you want to receive data from another PDT.
When finished transferring data from one or more PDT's, proceed to Upload From Mobile Devices.
19.5 WDT2200 - Data Cycle

1. The WDT2200's **Date and Time** should be set first, then **Setup Device** is used to define COM Port settings prior to transferring the InventoryControl program.
2. **Send Program to PDT** transfers the InventoryControl program to the PDT.
3. **Create PDT Database** builds a database for the PDT that can contain all the data in the PC database or a subset of the PC's records (via the Filter Records dialog.)
4. **Send Data to PDT** sends the InventoryControl **database** to the PDT.
5. **Use the PDT**. With both the InventoryControl program and the PDT database transferred to the PDT, the PDT User can now use the PDT for Add, Remove, Move, Adjust, Details, Receive (Pro and Enterprise Version only), Pick (Pro and Enterprise Version only) or Audit transactions (when Audit Mode is active).
6. **Receive Data from PDT** transfers all the PDT transactions to the PC along with any new Customers, Suppliers or Locations the PDT User has created.
7. **Upload From Mobile Devices** allows you to select and validate data for upload into the InventoryControl database. If you make mistakes on the PDT the data can be modified before being accepted into the PC database.

Steps 1 and 2 are typically done only once per PDT. From then on, steps 3 through 7 might be repeated multiple times.

---

19.6 WDT2200 - Logging On

When you turn on the device loaded with InventoryControl, the screen will appear as follows:

InventoryControl

Users:

Password:

Key in a valid **User** and **Password** for this PDT, pressing the Enter key after each.

InventoryControl PC Users who have the appropriate security settings can log on to any InventoryControl PDT.

Successful log on will take you to the PDT [Main Menu](#).
19.7 WDT2200 - Resetting the Device

The following steps can be performed to clear all data from the WDT2200.

⚠️ Any inventory transactions not yet uploaded to the PC will be lost if the PDT is reset per the following instructions:

1) Power off the WDT2200 by pressing and holding the power key until no text is displayed on the screen.

2) With the WDT2200 powered off...

...hold down the CMD and left-arrow keys, then press the power key.

The Start Menu will be displayed:

<< START MENU >>

1. SUPERVISOR
2. WARM START
3. COLD START

⚠️ If you do not see the Start Menu shown above, power off the PDT and repeat the key sequence described above.

3) From the Start Menu, select 3. COLD START by pressing the 3 key on the PDT.

WILL DELETE ALL
DATA ?
Are you Sure ?
1=YES/0=NO

4) Respond with 1=YES to delete all data by pressing the 1 key on the PDT. The WDT2200 will be Cold Started and all data will be lost.
At the PC, with the WDT2200 connected to your PC and powered on, you must now perform a **Setup Device** on the PC, to set your COM Port Settings and then **Send Program to PDT** before you can proceed to **Create PDT Database**.
19.8 WDT2200 - Setting the Date and Time

If the InventoryControl program and a database have already been transferred to the WDT2200, the InventoryControl Log On screen will be displayed when you first power on the PDT:

InventoryControl
User:
Password:

If the WDT2200 displays the screen above when powered on, jump to Instructions for Setting Date and Time on a WDT2200 That Already Has InventoryControl Installed.

-OR-

If InventoryControl has not yet been loaded to the WDT2200, the default power-on prompt will be displayed, showing the ROM version and memory capacity:

WDT2200 V1.10
MEM 2560 KB
>

Instructions for Setting Date and Time on a Cold Started WDT2200:

1) Press and hold the Command key until the following system menu is displayed:

   1.RUN  2.TER
   3.COM  4.DIR
   5.ERA  6.TYP
   7.CPY  8.SET

2) Press the 8 key to select 8.SET

3) Press the 1 key to select 1.DATE & TIME

4) Overwrite the Date shown with today's date in the format mm-dd-yyyy. You can use the right-arrow key to correct any entry errors or press the Enter key to accept the current date and advance to setting the Time of Day.

5) Overwrite the Time shown with the current time of day in the format hh-mm-ss using values of 0 through 12 for Midnight through Noon and 13 through 23 for the hours of 1:00 PM through 11:00 PM.

6) Press the 5 key to select 5.EXIT
7) Press the Escape \( \text{ESC} \) key to exit the system menu and return to the default power-on prompt.

You should now perform the Setup Device function to load the InventoryControl program to your WDT2200.

**Instructions for Setting Date and Time on a WDT2200 That Already Has InventoryControl Installed:**

1) If the InventoryControl **Main Menu** is currently displayed:

   - 1-Add
   - 2-Remove
   - 3-Move
   - 4-Adjust
   - 5-Details
   - 6-Site Config
   - 7-Stage
   - 8-LOGOUT

select **8-LOGOUT** to exit to the InventoryControl **Log On** screen:

InventoryControl

User:

Password:

2) From the **Log On** screen, power off the WDT2200 by pressing and holding the power \( \text{ESC} \) key until no text is displayed on the screen.

3) With the WDT2200 powered off...

   ...hold down the CMD and left-arrow keys, then press the power key.

   A **START MENU** will be displayed:
<< START MENU >>
1. SUPERVISOR
2. WARM START
3. COLD START

If you do not see the Start Menu shown above, power off the PDT and repeat the key sequence described above.

4) From the Start Menu, select 2. WARM START by pressing the 2 key on the PDT.

5) The default power-on prompt will be displayed, showing the ROM version and memory capacity:

```
WDT2200 V1.10
MEM 2560 KB
> 
```

Press and hold the Command key until the following system menu is displayed:

```
1. RUN  2. TER
3. COM  4. DIR
5. ERE  6. TYP
7. CPY  8. SET
```

6) Press the 8 key to select 8.SET

7) Press the 1 key to select 1.DATE & TIME

8) Overwrite the Date shown with today's date in the format mm-dd-yyyy.

You can use the right-arrow key to correct any entry errors or press the Enter key to accept the current date and advance to setting the Time of Day.

9) Overwrite the Time shown with the current time of day in the format hh-mm-ss using values of 0 through 12 for Midnight through Noon and 13 through 23 for the hours of 1:00 PM through 11:00 PM.

10) Press the 5 key to select 5.EXIT

11) Press the 1 key to select 1.RUN from the system menu.

12) Use the left- and right-arrow keys, if necessary to select MI3WDT.EXE from the list of programs installed on the WDT2200.
Press the Enter key when the screen above is displayed:

The InventoryControl Log On screen will then be displayed, allowing you to continue operations with the new date and time settings.

19.9 WDT2200 - Main Menu

The InventoryControl WDT2200 PDT Main Menu (not in Audit Mode):

1-Add
2-Remove
3-Move
4-Adjust
5-Details
6-Site Config
7-Logout
8-Receive
9-Pick
0-About

Press the appropriate number key on the PDT to perform that function.

To Logout, press the 8 key. You will be returned to the Log On screen.

The Audit function is disabled when InventoryControl is not in Audit Mode.

The WDT2200 PDT Main Menu in Audit Mode:

Audit Mode

1-Audit
2-Details
3-Site Config
4-About

8-LOGOUT

Press the appropriate number key on the PDT to perform that function.

To Logout, press the 8 key. You will be returned to the Log On screen.

The Add, Remove, Move and Adjust functions are disabled when in Audit Mode.
19.10 WDT2200 - Interface

The Wasp WDT2200 Keypad

- Press and hold the power key to turn the unit On or Off.
- Press and release the Alpha key to toggle between Alphabetic and Numeric input.

  Cursor style in Alphabetic mode: 

  Cursor style in Numeric mode: 

- Double- or triple-tap an alphabetic key to obtain the second or third character.
- Use the Space key to input a blank space.
- Use the Clear key to backspace over a character entered in error.
- Press and release the CMD key just prior to accessing any of the secondary functions or characters shown in yellow.
- Press the large yellow Scan key to activate the bar code scanner when input is needed for an inventory transaction.
19.11 WDT2200 - About Screen

The **About** screen can be accessed by selecting the 7 key on the PDT Main Menu or the 4 key when the PDT is in **Audit Mode**.

**About** displays the current User, the device’s Serial Number, and the current state of the Allow Negative Quantities on Mobile Devices option.

```
InventoryControl
(C) 2011
Wasp Barcode
Technologies
Build #:
User:
Allow Negative:
ESC=Exit
```

**Allow Negative**:  **T** (True) indicates that the User is allowed to **Remove** or **Move** more quantity than is shown in Details for that Item. This option is set on the Options screen on the PC. For more information on this option, please refer to the Options Screen topic.

**Allow Negative**:  **F** (False) indicates that **Remove** and **Move** transactions are limited to the quantity shown in Details for that Item.

Press the Escape key to return to the Main menu.

19.12 WDT2200 - Site Configuration

When data for multiple Sites has been included in the mobile database, the WDT 2200’s **Site Config** screen allows the PDT User to specify which of those Sites is to be used for inventory transactions he or she is about to perform.

The **Source Site** will determine the locations available in the Location field of the **Add**, **Remove**, **Adjust** and **Audit** functions. It will also determine the locations available in the **From**: location field of the **Move** function.

The **Destination Site** will determine the locations available in the Move function's **To**: location field.

**⚠️** No inventory transactions can be performed on the PDT until Source and Destination Sites have been selected in Site Config. This must be done at least once following after sending a new mobile database to the device.
Configuring Sites:

1. The Site Config function can be accessed by selecting the 6 key on the PDT Main Menu, or the 3 key if the PDT is in Audit Mode.

   Site Config
   Source/Dest Site
   *(Select)

   *(Select)

   F1=Src  F2=Dest
   ESC=Menu

2. Select a Source Site by pressing the F1 key.

   Source Site:
   Warehouse 1

   Press Ent to accept.
   ESC to cancel

   F1=Prev  F4=Next

   Above, the site WAREHOUSE 1 can be accepted as the Source Site by pressing the key to accept the value.

   or

   Press the F4 key to scroll to the next Site in the PDT database.

   or

   Press the F1 key to scroll to the next Site in the PDT database.

   or

   Press the Escape key to cancel.

   When a Source Site is selected, a screen similar to the one below will appear:

   Site Config
   Source/Dest Site
   *(Warehouse 2)

   *(Select)

   F1=Src  F2=Dest
   ESC=Menu

3. Select a Destination Site by pressing the F2 key.

   Dest Site:
Warehouse 3

Press Ent to accept,
ESC to cancel

F1=Prev  F4=Next

Above, the site WAREHOUSE 3 can be accepted as the Destination Site by pressing the ENT key to accept the value.

or

Press the F4 key to scroll to the next Site in the PDT database.

or

Press the F1 key to scroll to the next Site in the PDT database.

or

Press the ESC key to cancel.

4. Use F1 or F2 again to change your Site selections or press ESC to return to the Main Menu if you are done making your Site selections.

Note: In this example, the Source and Destination Sites are different. Every inventory transaction will be for Items at the Source Site's Locations except for Moves, where the To Locations will be limited to those at the Destination Site: All Moves will be from Warehouse 2 locations to Warehouse 3 locations.

Had Warehouse 2 been selected as both the Source Site and the Destination Site, all Moves would be from locations within Warehouse 2 to other locations within Warehouse 2.

19.13 WDT2200 - Adding Inventory

The Add function is used to add quantity to any item defined in the PDT database.

Notes:

- Adds can also be done at the PC.
- Make sure the PDT's date and time are set correctly before performing inventory transactions.
- If Source and/or Destination sites are not specified during on the database you sent to the PDT, the following message will be displayed the first time you attempt to perform an inventory transaction on the PDT:

Please use the Site Config function to Select Source and Destination Sites.

ESC=Exit
Press the Escape key to return to the **Main Menu**, then select the **6** key to go to the Site Config function. For more information on configuring sites on the PDT, please refer to the topic, **WDT2200 - Configuring Sites**.

The following topics discussed in this section are:

**Adding Inventory**

**Looping on Serial Number**

**Looping on Location**

**Looping on Item Number**

**Looping on a Track By**

**Tips for Speeding Up Data Entry**

---

**Adding Inventory:**

1. From the **Main Menu**, press the **1** key. The **Add** screen appears.

   **Add**
   Item #:  
   123

   Scan or key in value and press **Ent**.  
   Press **ESC** for Menu

2. Press the **Ent** key after supplying an Item # or press the **ESC** key to return to the **Main Menu**.

   **Add**
   Item #:  
   9999999

   Entry not found.  
   Scan or key in value and press **Ent**.  
   **ESC**=Menu

If the **Item #** entered *is not found* in the PDT’s database, you will be prompted to try again, as shown above.

If the **Item #** entered *is found* in the database, the Item's **Description** will be displayed beneath the **Item #**.

318
1. Scan or key in a **Location** value. The **Location** field is required for all Add transactions.

   Enter a **Location** and press **F4** to advance to the next data entry field.
   Press **F1** to go back to the previous data entry field.
   Press **ESC** to cancel transaction and return to the previous screen.

   Add
   123
   Monitor
   Location:
   Warehouse1

   **ESC**=Cancel
   **F1**=Prev **F4**=Next

2. If you press **F4** to advance to the **Supplier** field, without first providing a **Location** value, the following message will be displayed:

   **Please scan or key**
   **in location**

   **ESC**=Exit

   Press **ESC** to Exit the error message and then provide the required **Location** value.

   If you are prompted to confirm a new **Location** that you believe should already exist in the database, press the **ESC** key to cancel, then return to the **Main Menu** to check **Site Config**. If the **Location** you entered exists only at a **Site** other than the currently selected **Source Site**, **InventoryControl** must treat that value as a new **Location** for the **Source Site**. Select a different **Source Site** in **Site Config** if that’s where you intended to perform this transaction.

   When a **Location** value has been entered, press **F4** to advance to the next required field.

   Add
   123
   Monitor
   **Supplier:**

   **ESC**=Cancel
   **F1**=Prev **F4**=Next

3. PO and Supplier values might be **required** for this Item # if track bys were set when the item was created. If not, the fields can be left empty or values may be entered optionally. For more information on Track by fields, please refer to the topic **Creating New Items**.

   Press **F4** to advance to the next data entry field.

   **Supplier:**
   ACME

   **New entry. Press ENT**
   **to accept or ESC to**
   **cancel.**
   **Ent**=OK
ESC=Cancel

As shown above, if you enter a Location or Supplier that’s not currently in the PDT database, you will be prompted to accept or reject the entry as a new value to be added to the database. The currently selected Source Site will be displayed when you are about to create a new Location.

4. Press the **ENT** key to accept the new value or the **ESC** key to Cancel the creation of a new Location or Supplier.

Add
123
Monitor
Qty:

ESC=Cancel
F1=Prev F4=Next

Key in the inventory quantity being added and press Enter to complete the Add transaction. The Qty value entered must be numeric and it must be greater than zero.

**NO TRACK BY FIELDS:** If this Item does not have enabled for the Date Code, Pallet or Lot fields, a screen like the one above will be shown, prompting the entry of Qty.

**TRACK BY FIELDS:** If this Item does have enabled for Date Code, Pallet or Lot fields, a screen like the one below will be shown, expecting input for each Tracked By field that’s enabled. In this example, Date Code is required for this item:

Add
123
Monitor
Date Code:

ESC=Cancel
F1=Prev F4=Next

Key in or scan values for each of the Tracked By fields, pressing F4 to advance to the next data entry field.

If you press F4 to advance to the next data entry field, without first inputting a required Tracked By value, a screen similar to the following will be displayed:

Please scan or key in Date Code

ESC=Exit

Press ESC to exit the error message and then provide the required Tracked By value (a Date Code, in this example).
Looping on Serial Number:

Fields can be looped, or pinned, by pressing the F3 key. An asterisk displays next to the looped field.

If track by Serial Number is enabled for this Item, the Qty field will be set to 1. A quantity of one is assumed for each Serial Number. Looping will determine the final count for this Add transaction, as you scan (or key in) one or more Serial Numbers for this Item:

```
1000066
Qty: 1
SN:  *
Count: 0
F4=Done
```

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each serial number.

Press F4 after entering the last Serial Number to the Add screen.

Notes:

- When an Item is tracked by Serial Number, you can only loop on Serial Number.
- When an Item is not Tracked By Serial Number, you can use F3 to designate a field that will be used for looping. The values in every field except Qty will remain locked while looping.

Looping on Location:

Fields can be looped, or pinned, by pressing the F3 key.

In the example below the F3 key was pressed when prompted for Location while doing an Add for this Item:

```
Add
123
Monitor
  *

ESC=Cancel
F1=Prev F4=Next
```

An asterisk (*) indicates the intention to do more than one Add for this Item #, to more than one Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on Location after entering them for the first Add. Tracking fields are needed only for any Tracked By options enabled for the Item entered.

In the example below F3 was pressed when prompted for Location and then values for Location, PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive inputs for
another Add. **PO**, **Supplier** and **Tracked By** values, if any, for this second Add will be the same as those supplied at the beginning of the loop, if any.

123  
Qty:  
Location:  

<table>
<thead>
<tr>
<th>Total Qty:</th>
<th>10.00000</th>
</tr>
</thead>
<tbody>
<tr>
<td>F4=Done</td>
<td></td>
</tr>
</tbody>
</table>

While looping on Location, all that is required for each Add are values for Qty and Location. The Total Qty field is incremented each time an Add is submitted while looping.

Press the **ENT** key to submit the Add transaction and continue looping or press the **F4** key to exit the loop.

---

**Looping on Item Number:**

Fields can be looped, or pinned, by pressing the **F3** key.

In the following example, **F3** was pressed when prompted for **Item #**:

```plaintext
Add
Item #:    *
```

Scan or key in value  
and press Ent.  
Press ESC for Menu

Above, the asterisk (*) indicates the intention to loop on **Item #**. Values entered for **Location**, **PO**, **Supplier** and any **Tracked By** fields (other than Serial Number) will remain locked after entering them for the first Add:

```plaintext
Qty:  
Item #:  
Count:25  
F4=Done
```

Above, having pressed **F3** when prompted for **Item #** and then having entered the item number and values for **Location**, **PO**, **Supplier**, any Tracked By's, and a value of **25** for **Qty**, this screen is ready to receive Qty and Item # inputs for the second Add. The **Location**, **PO**, **Supplier**, and any Tracked By values just specified will be used with every Add transaction entered until **F4** is used to exit the loop.
While looping on **Item #**, all that is required for each transaction here are values for **Qty** and **Item #**. The **Count** is incremented each time an Add is done while looping.

- Press the **ENT** key to submit the Add transaction and continue looping

  or

- Press the **F4** key to exit the loop.

When looping on **Item #**, all items entered should have the same **Tracked By** requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be reset.

**Looping on a Tracked By (other than Serial Number)**

Here, for example, **F3** was pressed when prompted for **Pallet** while doing an Add for this Item:

```
Add
123
Monitor
Pallet: *

ESC=Cancel
F1=Prev  F4=Next
```

An asterisk (*) indicates the intention to do more than one Add for this **Item #**, for more than one **Pallet**. Values entered for **Item #, Location, PO, Supplier**, and any other Tracked By fields will remain locked while looping on **Pallet**, after entering them for the first Add:

```
123
Qty:
Pallet: *

Total Qty:
30.00000
F4=Done
```

Above, having entered a value for **Pallet** and a value of 30 for **Qty** on the previous screen for the first Add, this screen is ready to receive inputs for another Add. **Item #, Location, PO and Supplier** values for this second Add will be the same as those supplied at the beginning of the loop.

While looping on this Tracked By field, all that is required for each Add are values for **Qty** and **Pallet**. The **Total Qty** is incremented each time an Add is submitted while looping.
Press the **ENT** key to submit the Add transaction and continue looping

or

Press the **F4** key to exit the loop.

When looping on a Tracked By field, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be restarted.

---

**Tips for Speeding Up Data Entry:**

- When you create a new item, if the Category, Manufacturer, UOM or any combination of pinnable fields will be used on a large number of items, create one item with those fields, then pin the fields. Now, the information will be retained in those fields so you don't have to keep re-entering it for each new item.
- Make sure you have the Close New Forms option turned off (on the InventoryControl Options screen) so the New Item screen, or any other screen where new information is added, stays open after each new item is saved.
19.14 WDT2200 - Details Screen

The Details function is used to display Location and Quantity information for any Item in the PDT’s database for the Sites selected in Site Configuration.

Details is an abbreviated version of the functionality available in the PC’s Inventory List.

Note: Source and/or Destination sites are not specified during on the database you sent to the PDT, the following message will be displayed the first time you attempt to perform an inventory transaction on the PDT:

Please use the Site Config function to Select Source and Destination Sites.

ESC=Exit

Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site Config function. For more information on configuring sites on the PDT, please refer to the topic, WDT2200 - Configuring Sites.

19.14.1 Viewing Details for Items with Tracked By options disabled:

1. The Details function can be accessed by pressing the 5 key on the PDT Main Menu or the 2 key if the PDT is in Audit Mode. The screen shown below appears:

   Details
   Item #:

   Scan or key in value and press Ent.
   Press ESC for Menu

2. Press the PDT’s ENT key after supplying an Item # or press the PDT’s ESC key to return to the Main Menu.

   If the Item # you enter is not found in the PDT’s database, you will be prompted to try again, as shown below:

   Details
   Item #:
   99999999

   Entry not found.
   Scan or key in value and press Ent. ESC=Menu

   If the Item # entered is found in the database, the Item’s Description will be displayed beneath the Item #.
3. The **Location** field is required for all **Details** transactions. Enter a **Location** and press **F4** to advance to the next data entry field.

or

Press **F1** to go back to the previous data entry field.

or

Press **ESC** to cancel the transaction and return to the previous screen.

If you press **F4** to advance *without first providing* a **Location** value, the following message will be displayed:

**Please scan or key in Location**

**ESC=Exit**

Press **Esc** to return and enter **Location**.

When a **Location** value has been entered, the screen will appear as shown below:

```
1000007
Monitor
Total Qty
626.0000

ENT=OK  F4=Next
```

Details first reports the Item's Total Qty across *all* Locations at *every* Site.

4. Press **F4** to display the next **Details** screen for this item:

```
1000007
Loc: 1

Qty at Loc: 500.0000
TrackBy Qty: 0.0000
F1=Prev  ENT=OK
```
In the example shown above, Qty at Loc has a value of 500.00000, showing that 500 of the 626 Total Qty are at Location 1. The TrackBy Qty is 0.00000 because no Tracked By options are enabled, entered or valid for this Item #.

19.14.2 Viewing Details for Items with One or More Tracked By Options Enabled:

When a Location value has been entered for an Item # that has one or more Tracked By options enabled, you will be given the opportunity to narrow the Details display by entering values for any of the Tracked By fields displayed on the consecutive screens. Press F4 to advance to each field.

If an item has all four Tracked By options enabled, all are available for inputting values which you can use to limit the TrackBy Qty that will shown in the Details display.

Input fields will only be displayed for those Tracked By options that are enabled for the Item specified.

1. The Details function can be accessed by pressing the 5 key on the PDT Main Menu or the 2 key if the PDT is in Audit Mode. The screen shown below appears:

   Details
   Item #:

   Scan or key in value and press Ent.
   Press ESC for Menu

2. Press the PDT's ENT key after supplying an Item # or press the PDT's ESC key to return to the Main Menu.

   If the Item # you enter is not found in the PDT's database, you will be prompted to try again, as shown below:

   Details
   Item #:
   9999999

   Entry not found.
   Scan or key in value and press Ent. ESC=Menu

   If the Item # entered is found in the database, the Item's Description will be displayed beneath the Item #.

   Details
   10067
   Mouse
   Pallet:
   33

   ESC=Cancel
   F1=Prev F4=Next
In the example above, the Item # specified has the Tracked By Pallet option enabled. Having previously supplied the Item # and a Location, the can supply a Pallet number, but doing so is optional.

Values you specify here will limit the TrackBy Qty shown on the Details display to some number less than or equal to the Qty value shown for the specified Location. Use of these fields is optional. If they are left blank, TrackBy Qty will equal Qty at Loc in the Details display.

In the example below, having specified a value for the Tracked By field Pallet, in addition to Location, Details is reporting a Qty at Loc of 17.00000 and a TrackBy Qty for the specified Pallet of 4.00000.

10067
LOC: AISLE 1

Qty at Loc:
17.00000
TrackBy Qty:
4.00000
F1=Prev ENT=OK

If the TrackBy Qty is zero for an Item that has one or more Tracked By options enabled, no quantity matching the TrackBy values you just specified exists for the Item at the specified Location.

3. Press F4 to advance to the next field.

   or

   Press F1 to return to the previous field.

   or

   Press the Enter key to return to the Details function for another query.
19.15 WDT2200 - Adjusting Inventory

The Adjust function allows you to modify the quantity of existing items. Adjust is like a "mini" Audit and will update the quantity using FIFO (First In First Out) to make the total equal to the quantity you enter here. The Adjust function is useful if too much or too little quantity is accidentally entered for an item (on a mobile device, for example), inventory is lost, found, broken, etc. and you need to quickly correct the quantity for that item. Adjusting is different from an Audit in that the Audit function makes other functions of the software, such as adding inventory, unavailable to ensure inventory is not added or removed while you are doing the counts. All features are still available when adjusting inventory.

The Allow Negative Quantities option applies to batch devices only. Mobile devices that are communicating with the database via a wireless connection will not allow negative quantity transactions regardless of the option settings.

Notes:

- An item tracked by Serial Number which has been Checked-Out can not be Adjusted.
- Inventory adjustments can also be made at the PC using the Adjust screen.
- Make sure the PDT's date and time are set correctly before performing inventory transactions.
- Source and/or Destination sites are not specified during on the database you sent to the PDT, the following message will be displayed the first time you attempt to perform an inventory transaction on the PDT:

    Please use the Site Config function to Select Source and Destination Sites.

    ESC=Exit

    Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site Config function. For more information on configuring sites on the PDT, please refer to the topic, WDT2200 - Configuring Sites.

The following topics are covered in this section:

Adjusting Inventory

Looping on Serial Number

Looping on Location

Looping on Item Number

Looping on a Track By (other than Serial Number)
Adjusting Inventory:

1. From the **Main Menu**, press the 4 key.

   
   Adjust
   Item #:
   123

   Scan or key in value and press Ent. Press ESC for Menu.

2. Press the **Enter** key after supplying an **Item #** or press the **ESC** key to return to the **Main Menu**.

   If the **Item #** entered *is not found* in the PDT’s database, you will be prompted to try again, as shown below.

   
   Adjust
   Item #:
   99999999

   Entry not found.
   Scan or key in value and press Ent.
   ESC=Menu.

   If the **Item #** entered is found in the PDT’s database, the Item's **Description** will be displayed beneath the **Item #**.

3. Scan or key in a **Location value**. If the **Item #** entered is found in the database, the Item's **Description** will be displayed beneath the **Item #**.

   
   Adjust
   100007
   Monitor
   Location:
   AREA 2

   ESC=Cancel
   F1=Prev F4=Next

   The **Location** field is required for all Adjust transactions.

4. After entering a **Location** and press **F4** to advance to the next data entry field.

   or

   Press **F1** to go back to the previous data entry field.

   or
Press **ESC** to cancel transaction and return to the previous screen.

If you press **F4** to advance to the next data entry field, without first providing a **Location** value, the following message will be displayed:

**Please scan or key**
in **Location**

**ESC=Exit**

Press **ESC** to Exit the error message and then provide the required **Location** value.

As shown below, if you enter a **Location** that's not currently in the PDT database, you will be prompted to accept or reject the entry as a new value to be added to the database. The currently selected **Source Site** will be displayed when you are about to create a new **Location**.

**Site:**
Warehouse2

**New Location:**
Area 7

**Ent=OK**
**ESC=Cancel**

If you are prompted to confirm a new **Location** that you believe should already exist in the database, press the **ESC** key to cancel, then return to the **Main Menu** to check **Site Config**. If the **Location** you entered exists only at a Site other than the currently selected **Source Site**, InventoryControl must treat that value as a new **Location** for the **Source Site**. Select a different **Source Site** in Site Config if that's where you intended to perform this transaction.

Press the **ENT** key to accept the new location or the **ESC** key to cancel the creation of a new **Location**.

5. If this Item *does not have* **Tracked By** enabled for the **Date Code**, **Pallet** or **Lot fields**, a screen like the one below will be shown, prompting the entry of **Qty**.

**Adjust**
100007
**Monitor**
**Qty:**

**ESC=Cancel**
**F1=Prev  F4=Next**

Key in the inventory quantity at this **Location** and press **F4** to complete the Adjust transaction. The **Qty** value entered must be numeric and it must be greater than or equal to zero.

If this Item *does have* **Tracked By** enabled for **Date Code**, **Pallet** or **Lot** fields, screens like the one below will be shown, expecting input for each Tracked By field that's enabled. A **Date Code** is required for this Item:
Adjust
100007
Monitor
Date Code:

ESC=Cancel
F1=Prev  F4=Next

Key in or scan values for each of the Tracked By fields, pressing F4 to advance to the next data entry field.

If you press F4 to advance to the next data entry field, without first inputting a required Tracked By value, a screen similar to the following will be displayed:

Please scan or key in Date Code
ESC=Exit

Press ESC to exit the error message and then provide the required Tracked By value (a Date Code, in this example).

Looping on Serial Number:

Fields can be looped, or pinned, by pressing the F3 key. An asterisk displays next to the looped field.

If track by Serial Number is enabled for this Item, the Qty field will be set to 1. A quantity of one is assumed for each Serial Number. Looping will determine the final count for this Adjust transaction, as you scan (or key in) one or more Serial Numbers for this Item:

1000066
Qty:1

SN:  *

Count:0
F4=Done

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each serial number.

Press F4 after entering the last Serial Number to the Adjust screen.

Notes:

- When an Item is tracked by Serial Number, you can only loop on Serial Number.
- When an Item is not Tracked By Serial Number, you can use F3 to designate a field that will be used for looping. The values in every field except Qty will remain locked while looping.
Looping on Location:

Fields can be looped, or pinned, by pressing the F3 key.

In the example below the F3 key was pressed when prompted for Location while doing an Adjust for this Item:

Add
123
Monitor
Location: *

ESC=Cancel
F1=Prev F4=Next

An asterisk (*) indicates the intention to do more than one Adjust for this Item #, to more than one Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on Location after entering them for the first Adjust. Tracking fields are needed only for any Tracked By options enabled for the Item entered.

In the example below F3 was pressed when prompted for Location and then values for Location, PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive inputs for another Adjust. PO, Supplier and Tracked By values, if any, for this second Adjust will be the same as those supplied at the beginning of the loop, if any.

123
Qty:
Location:

Total Qty:
10.0000
F4=Done

While looping on Location, all that is required for each Adjust are values for Qty and Location. The Total Qty field is incremented each time an Adjust is submitted while looping.

Press the ENT key to submit the Adjust transaction and continue looping or press the F4 key to exit the loop.

-------------------

Looping on Item Number:

Fields can be looped, or pinned, by pressing the F3 key.

In the following example, F3 was pressed when prompted for Item #:
Adjust

Item #: *

Scan or key in value and press Ent.
Press ESC for Menu

Above, the asterisk (*) indicates the intention to loop on Item #. Values entered for Location, PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after entering them for the first Adjust:

Qty:
Item #:

Count: 25
F4=Done

Above, having pressed F3 when prompted for Item # and then having entered the item number and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen is ready to receive Qty and Item # inputs for the second Add. The Location, PO, Supplier, and any Tracked By values just specified will be used with every Adjust transaction entered until F4 is used to exit the loop.

While looping on Item #, all that is required for each transaction here are values for Qty and Item #. The Count is incremented each time an Adjust is done while looping.

Press the ENT key to submit the Adjust transaction and continue looping

or

Press the F4 key to exit the loop.

When looping on Item #, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be reset.

Looping on a Tracked By (other than Serial Number)

Here, for example, F3 was pressed when prompted for Pallet while doing an adjust for this Item:

Adjust
123
Monitor
Pallet: *

ESC=Cancel
F1=Prev  F4=Next
An asterisk (*) indicates the intention to do more than one adjust for this Item #, for more than one Pallet. Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields will remain locked while looping on Pallet, after entering them for the first adjust:

123
Qty: *
Pallet: *

Total Qty:
30.00000
F4=Done

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the first adjust, this screen is ready to receive inputs for another adjust. Item #, Location, PO and Supplier values for this second adjust will be the same as those supplied at the beginning of the loop.

While looping on this Tracked By field, all that is required for each adjust are values for Qty and Pallet. The Total Qty is incremented each time an adjust is submitted while looping.

⇒ Press the ENT key to submit the adjust transaction and continue looping

or

⇒ Press the F4 key to exit the loop.

When looping on a Tracked By field, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be restarted.
19.16 WDT2200 - Auditing Inventory

Audit allows you to count the Quantity of one or more Items in your inventory when in Audit Mode. Before you can conduct an audit using the mobile device, you must download a new database created while InventoryControl is in audit mode. For more information on turning on the audit mode on the PC, please refer to the topic Auditing Your Inventory. For more information on creating the database, please refer to the topic WDT2200 - Creating the PDT Database.

Notes:

- Audits can also be done at the PC.
- Make sure the PDT's date and time are set correctly before performing inventory transactions.
- If Source and/or Destination sites are not specified during on the database you sent to the PDT, the following message will be displayed the first time you attempt to perform an inventory transaction on the PDT:

Please use the Site Config function to Select Source and Destination Sites.

ESC=Exit

Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site Config function. For more information on configuring sites on the PDT, please refer to the topic, WDT2200 - Configuring Sites.

Topics discussed in this section:

Auditing Inventory

Looping on Serial Number

Looping on Location

Looping on Item Number

Looping on Track Bys (Other than Serial Number)

Auditing Inventory:

1. The Audit function can be accessed by selecting the 1 key on the PDT Main Menu.

2. Press the Enter key after supplying an Item # or press the ESC key to return to the Main Menu.
Audit
Item #: 123

Scan or key in value and press Ent.
Press ESC for Menu

If the Item # you entered is not found in the PDT's database, you will be prompted to try again.

Audit
Item #: 9999999

Entry not found.
Scan or key in value and press Ent.
ESC=Menu

If the Item # entered is found in the database, the Item's Description will be displayed beneath the Item #:

3. Scan or key in a Location value. The Location field is required for all Audit transactions.

Audit
10007
Monitor
Location:
AREA 2

ESC=Cancel
F1=Prev  F4=Next

Enter a Location and press F4 to advance to the next data entry field.

or

Press F1 to go back to the previous data entry field.

or

Press ESC to cancel transaction and return to the previous screen.

If you press F4 to advance to the next data entry field, without first providing a Location value, the following message will be displayed:

Please scan or key in Location

ESC=Exit

Press ESC to Exit the error message and then provide the required Location value.

As shown below, if you enter a Location that's not currently in the PDT database, you will be prompted to accept or reject the entry as a new value to be added to the database. The currently selected Source Site will be displayed when you are about to create a new Location.
Site:
Warehouse 2

New Location:
Area 7

ENT=OK
ESC=Cancel

If you are prompted to confirm a new Location that you believe should already exist in the database, press the ESC key to cancel, then return to the Main Menu to check Site Config. If the Location you entered exists only at a Site other than the currently selected Source Site, InventoryControl must treat that value as a new Location for the Source Site. Select a different Source Site in Site Config if that's where you intended to perform this transaction.

Press the ENT key to accept the new value or the ESC key to Cancel the creation of a new Location.

4. If this Item does not have Tracked By enabled for the Date Code, Pallet or Lot fields, a screen like the one above will be shown, prompting the entry of Qty.

Audit
100007
Monitor
Qty:

ESC=Cancel
F1=Prev  F4=Next

Key in the inventory quantity at this Location and press ENT or F4 to complete the Audit transaction. The Qty value entered must be numeric and it must be greater than or equal to zero.

If this Item does have Tracked By enabled for Date Code, Pallet or Lot fields, screens like the one below will be shown, expecting input for each Tracked By field that's enabled.

Audit
100007
Monitor
Date Code:

ESC=Cancel
F1=Prev  F4=Next

Key in or scan values for each of the Tracked By fields, pressing F4 to advance to the next data entry field.

If you press F4 to advance to the next data entry field, without first inputting a required Tracked By value, a screen similar to the following will be displayed:

Please scan or key in Date Code

ESC=Exit
Press Esc to Exit the error message and then provide the required Tracked By value (a Date Code, in this example).

5. When the you are finished doing Audits, even just for an afternoon of counting during a week-long Audit, the Counts can be uploaded to the PC (please refer to the topic WDT2200 - Receiving Data from the PDT for more information). Multiple PDTs can upload their counts multiple times throughout the Audit Mode period.

6. When the PC is no longer in Audit Mode, you can create another mobile database to send to the PDT. This will return the PDT to its normal mode.

---

**Looping on Serial Number:**

Fields can be looped, or pinned, by pressing the F3 key. An asterisk displays next to the looped field.

If track by Serial Number is enabled for this Item, the Qty field will be set to 1. A quantity of one is assumed for each Serial Number. Looping will determine the final count for this Audit transaction, as you scan (or key in) one or more Serial Numbers for this Item:

```
1000066
Qty:1
SN:    *
Count:0
F4=Done
```

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each serial number.

Press F4 after entering the last Serial Number to the Audit screen.

**Notes:**

- When an Item is tracked by Serial Number, you can only loop on Serial Number.
- When an Item is *not* Tracked By Serial Number, you can use F3 to designate a field that will be used for looping. The values in every field except Qty will remain locked while looping.
Looping on Location:

Fields can be looped, or pinned, by pressing the F3 key.

In the example below the F3 key was pressed when prompted for Location while doing an Audit for this Item:

Audit
123
Monitor
Location: *

ESC=Cancel
F1=Prev F4=Next

An asterisk (*) indicates the intention to do more than one Audit for this Item #, to more than one Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on Location after entering them for the first Audit. Tracking fields are needed only for any Tracked By options enabled for the Item entered.

In the example below F3 was pressed when prompted for Location and then values for Location, PO, Supplier, any Tracked By’s, and a Qty of 10 were entered, this screen is ready to receive inputs for another Audit. PO, Supplier and Tracked By values, if any, for this second Audit will be the same as those supplied at the beginning of the loop, if any.

123
Qty:
Location:

Total Qty:
10.00000
F4=Done

While looping on Location, all that is required for each Audit are values for Qty and Location. The Total Qty field is incremented each time an Audit is submitted while looping.

Press the ENT key to submit the Audit transaction and continue looping or press the F4 key to exit the loop.
Looping on Item Number:

Fields can be looped, or pinned, by pressing the F3 key.

In the following example, F3 was pressed when prompted for Item #:

Audit
Item #: *

Scan or key in value
and press Ent.
Press ESC for Menu

Above, the asterisk (*) indicates the intention to loop on Item #. Values entered for Location, PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after entering them for the first Audit:

Qty:

Item #:

Count:25
F4=Done

Above, having pressed F3 when prompted for Item # and then having entered the item number and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen is ready to receive Qty and Item # inputs for the second Audit. The Location, PO, Supplier, and any Tracked By values just specified will be used with every Audit transaction entered until F4 is used to exit the loop.

While looping on Item #, all that is required for each transaction here are values for Qty and Item #. The Count is incremented each time an Audit is done while looping.

Press the ENT key to submit the Audit transaction and continue looping

or

Press the F4 key to exit the loop.

When looping on Item #, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be reset.
Looping on a Tracked By (other than Serial Number)

Here, for example, F3 was pressed when prompted for Pallet while doing an Audit for this Item:

Audit
123
Monitor
Pallet: *

ESC=Cancel
F1=Prev  F4=Next

An asterisk (*) indicates the intention to do more than one Audit for this Item #, for more than one Pallet. Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields will remain locked while looping on Pallet, after entering them for the first Audit:

123
Qty:
Pallet: *

Total Qty:
30.00000
F4=Done

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the first Audit, this screen is ready to receive inputs for another Audit. Item #, Location, PO and Supplier values for this second Audit will be the same as those supplied at the beginning of the loop.

While looping on this Tracked By field, all that is required for each Audit are values for Qty and Pallet. The Total Qty is incremented each time an Audit is submitted while looping.

Press the ENT key to submit the Audit transaction and continue looping

or

Press the F4 key to exit the loop.

When looping on a Tracked By field, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be restarted.
19.17 WDT2200 - Moving Inventory

The Move function allows you to move inventory quantity for an item from one Location to another. When you create an item, you can add which locations it may be. When you then add inventory (quantity) to the item, you select in which location that quantity will reside. The Move function allows you to move that inventory from the originally assigned location to another. By moving inventory in the software, you can easily keep accurate records of where all of your inventory is currently located.

Note:

- Make sure the PDT's date and time are set correctly before performing inventory transactions.
- Move transactions can also be performed on the PC's Move screen.
- Source and/or Destination sites are not specified during on the database you sent to the PDT, the following message will be displayed the first time you attempt to perform an inventory transaction on the PDT:

```
Please use the Site Config function to Select Source and Destination Sites.
ESC=Exit
```

Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site Config function. For more information on configuring sites on the PDT, please refer to the topic, WDT2200 - Configuring Sites.

The following topics are discussed in this section:

- **Moving Inventory**
- **Looping on Serial Number**
- **Looping on Location**
- **Looping on Item Number**
- **Looping on Track Bys (Other than Serial Number)**

Moving Inventory:

1. The Move function can be accessed by pressing the 3 key on the PDT Main Menu.

2. Press the PDT's Enter key after supplying an Item # or press the PDT's ESC key to return to the Main Menu.

Move
Item #: 123
Scan or key in value and press Ent.
Press ESC for Menu

If the Item # entered is not found in the PDT's database, you will be prompted to try again, as shown below.

**Move**
Item #:
99999999

Entry not found.
Scan or key in value and press Ent.
ESC=Menu

If the Item # entered is found in the database, the Item's **Description** will be displayed beneath the Item #.

3. Scan or key in a From location value.

**Move**
1000052
Fence-Rail
From:
A1

ESC=Cancel
F1=Prev  F4=Next

The From and To fields are required for all Move transactions.

Enter a From Location and press F4 to advance to the next data entry field.

or

Press F1 to go back to the previous data entry field.

or

Press ESC to cancel transaction and return to the previous screen.

⚠️ If you press F4 to advance to the To location field without first providing a From location value, the following message will be displayed:

Please scan or key in From

ESC=Exit

Press ESC to Exit the error message and then provide the required From location value.
**Note:** If the *Allow Negative Quantities on Mobile Devices Option* is disabled on the *Options* screen, you will receive a warning message if you attempt to *Move* quantity from a location that does not exist in the PDT database. The *Allow Negative* option must be set on the PC prior to creating the mobile database. You can check the state of this option on the PDT by viewing the PDT *About* screen.

New Source Site *From* locations can only be created during *Move* when the *Allow Negative Quantities on Mobile Devices* option is enabled. Please see the *Options Screen* topic for more information on this option.

When a *From* location value has been entered, press **F4** or **ENT** to advance to the *To* location field.

4. **Provide the required *To* location value.**

   **Move**  
   1000052  
   Fence-Rail  
   **To:**  
   A2  

   **ESC=Cancel**  
   **F1=Prev  F4=Next**

   As shown below, if a *From* or *To* Location value is entered that's not currently in the database, you will be prompted to accept or reject the entry as a new value to be added to the database for the *Source or Destination Site* shown.

   **Site:**  
   Warehouse 2  

   **New Location:**  
   Area 2  

   **ENT=OK**  
   **ESC=Cancel**

   If you are prompted to confirm a new *Location* that you believe should already exist in the database at that Site, press **ESC** to cancel, then return to the *Main Menu* to check *Site Config*.  
   If the *From* location you entered exists only at a Site other than the currently selected Source Site, InventoryControl must treat that value as a new *Location* for the Source Site. Select a different Source Site in Site Config if that's where you intended to perform this transaction.

   Press the **ENT** key to accept the new value or the **ESC** key to Cancel the creation of a new *Location*.

5. **If this Item does not have *Tracked By* enabled for the *Date Code*, *Pallet* or *Lot* fields, a screen like the one below will be shown, prompting the entry of *Qty*.**

   **Move**  
   1000052  
   Fence-Rail  
   **Qty:**  

   **ESC=Cancel**  
   **F1=Prev  F4=Next**
Key in the inventory Qty being Moved and press F4 or ENTER to complete the Move transaction. The Qty value entered must be numeric and it must be greater than zero.

If the Allow Negative Quantities on Mobile Devices option is disabled, you will see the following message if you attempt to Move more quantity than that which is available for this Item at the specified From location.

Available:
15.0000

Not enough qty available to complete the transaction.
ESC=Exit

Press ESC and enter a value that does not exceed the Available amount.

6. If the Item does have Tracked By enabled for Date Code, Pallet or Lot fields, a screen like the one below will be shown, expecting input for each Tracked By field that's enabled before entering a value for Qty.

Move
100068
Paint Can
Pallet:

ESC=Cancel
F1=Prev  F4=Next

Key in or scan values for each of the Tracked By fields, pressing F4 to advance to the next data entry field.

If you press F4 to advance to the next data entry field, without first inputting a required Tracked By value, a screen similar to the following will be displayed:

Please scan or key in Pallet
ESC=Exit

Press ESC to Exit the error message and then provide the required Tracked By value (a Pallet, in this example).

Note: If the Allow Negative Quantities on Mobile Devices option is disabled, any entered Tracked By value that does not match a value associated with inventory available at the previously specified From location, the following screen display will be displayed:

No item with this trackby specific in stock
ESC=Exit
If Allow Negative Quantities on Mobile Devices is enabled, any Tracked By value is allowed.

Press ESC to exit the error message and then provide a Tracked By value that matches inventory in stock at the From location.

Looping on Serial Number:

Fields can be looped, or pinned, by pressing the F3 key. An asterisk displays next to the looped field.

If track by Serial Number is enabled for this Item, the Qty field will be set to 1. A quantity of one is assumed for each Serial Number. Looping will determine the final count for this Add transaction, as you scan (or key in) one or more Serial Numbers for this Item:

```
1000066
Qty:1
SN: *
Count:0
F4=Done
```

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each serial number.

Press F4 after entering the last Serial Number to the Move screen.

Notes:

- When an Item is tracked by Serial Number, you can only loop on Serial Number.
- When an Item is not Tracked By Serial Number, you can use F3 to designate a field that will be used for looping. The values in every field except Qty will remain locked while looping.

Looping on Location:

Fields can be looped, or pinned, by pressing the F3 key.

In the example below the F3 key was pressed when prompted for Location while doing an Move for this Item:

```
Move
123
Monitor
Location: *
ESC=Cancel
F1=Prev F4=Next
```
An asterisk (*) indicates the intention to do more than one Move for this Item #, to more than one Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on Location after entering them for the first Add. Tracking fields are needed only for any Tracked By options enabled for the Item entered.

In the example below F3 was pressed when prompted for Location and then values for Location, PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive inputs for another Add. PO, Supplier and Tracked By values, if any, for this second Add will be the same as those supplied at the beginning of the loop, if any.

```
123
Qty:
Location:
Total Qty:
10.00000
F4=Done
```

While looping on Location, all that is required for each Move are values for Qty and Location. The Total Qty field is incremented each time a Move is submitted while looping.

Press the ENT key to submit the Move transaction and continue looping or press the F4 key to exit the loop.

---

### Looping on Item Number:

Fields can be looped, or pinned, by pressing the F3 key.

In the following example, F3 was pressed when prompted for Item #:

```
Move
Item #:  *

Scan or key in value
and press Ent.
Press ESC for Menu
```

Above, the asterisk (*) indicates the intention to loop on Item #. Values entered for Location, PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after entering them for the first Move:

```
Qty:
Item #:
Count:25
F4=Done
```
Above, having pressed F3 when prompted for Item # and then having entered the item number and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen is ready to receive Qty and Item # inputs for the second Move. The Location, PO, Supplier, and any Tracked By values just specified will be used with every Move transaction entered until F4 is used to exit the loop.

While looping on Item #, all that is required for each transaction here are values for Qty and Item #. The Count is incremented each time an Move is done while looping.

Press the ENT key to submit the Move transaction and continue looping

or

Press the F4 key to exit the loop.

When looping on Item #, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be reset.

Looping on a Tracked By (other than Serial Number)

Here, for example, F3 was pressed when prompted for Pallet while doing an Move for this Item:

<table>
<thead>
<tr>
<th>Move</th>
<th>123</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor</td>
<td>*</td>
</tr>
<tr>
<td>Pallet:</td>
<td>*</td>
</tr>
</tbody>
</table>

ESC=Cancel
F1=Prev  F4=Next

An asterisk (*) indicates the intention to do more than one Move for this Item #, for more than one Pallet. Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields will remain locked while looping on Pallet, after entering them for the first Move:

<table>
<thead>
<tr>
<th>123</th>
</tr>
</thead>
<tbody>
<tr>
<td>Qty:</td>
</tr>
</tbody>
</table>
| Pallet:| *

Total Qty:
30.00000
F4=Done
Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the first Move, this screen is ready to receive inputs for another Move. Item #, Location, PO and Supplier values for this second Move will be the same as those supplied at the beginning of the loop.

While looping on this Tracked By field, all that is required for each Move are values for Qty and Pallet. The Total Qty is incremented each time an Move is submitted while looping.

› Press the ENT key to submit the Move transaction and continue looping

or

Press the F4 key to exit the loop.

When looping on a Tracked By field, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be restarted.
19.18 WDT2200 - Removing Inventory

The **Remove** function allows you to remove quantity from any item in the database. Inventory is the amount or quantity of a particular item. Items must first be imported or entered on the **Add Item** screen before you can add quantity or remove quantity.

Inventory is also removed when you pick items for a Pick Order (**Applies to Pro and Enterprise Versions only**). For further information on Picking Orders, please refer to the topic **WDT2200 - Picking Orders**.

**Notes:**

- **Removes** can also be done at the PC using the **Remove** screen.
- Make sure the PDT's date and time are set correctly before performing inventory transactions.
- Source and/or Destination sites are not specified during on the database you sent to the PDT, the following message will be displayed the first time you attempt to perform an inventory transaction on the PDT:

  **Please use the Site Config function to Select Source and Destination Sites.**

  ESC=Exit

  Press the Escape key to return to the **Main Menu**, then select the 6 key to go to the Site Config function. For more information on configuring sites on the PDT, please refer to the topic, **WDT2200 - Configuring Sites**.

Topics discussed in this section are:

- **Removing Inventory**
- **Looping on Serial Number**
- **Looping on Location**
- **Looping on Item Number**
- **Looping on Track Bys (Other than Serial Number)**

---

Removing Inventory:

1. The **Remove** function can be accessed by pressing the 2 key on the **Main Menu**.

   **Remove**
   
   **Item #:**
   
   123

   **Scan or key in value**
and press Ent.
Press ESC for Menu

2. Press the PDT's Enter key after supplying an Item # or press the PDT's ESC key to return to the Main Menu.

If the Item # entered is not found in the PDT's database, you will be prompted to try again, as shown below:

Remove
Item #:
9999999

Entry not found.
Scan or key in value
and press Ent.
ESC=Menu

If the Item # entered is found in the database, the Item's Description will be displayed beneath the Item #.

3. Scan or key in a Location value:

Remove
123
Monitor
Location:
AREA 2

ESC=Cancel
F1=Prev  F4=Next

The Location field is required for all Remove transactions.

Enter a Location and press F4 to advance to the next data entry field.

or

Press F1 to go back to the previous data entry field.

or

Press ESC to cancel transaction and return to the previous screen.

If you press F4 to advance to the Customer field, without first providing a Location value, the following message will be displayed:

Please scan or key in Location

ESC=Exit
Press ESC to Exit the error message and then provide the required Location value.

**Note:** If the Allow Negative Quantities on Mobile Devices option is disabled, you will see a warning message if you attempt to Remove quantity from a Location that does not exist in the PDT database. The Allow Negative option must be set on the PC prior to creating the database.

You can check the state of this option on the PDT by using the 7 key on the Main Menu to go to the PDT About screen.

New Locations can only be created during Remove when the Allow Negative Quantities on Mobile Devices option is enabled. If you are prompted to confirm a new Location that you believe should already exist in the database, press ESC to cancel, then return to the Main Menu to check Site Config. If the Location you entered exists only at a Site other than the currently selected Source Site, InventoryControl must treat that value as a new Location for the Source Site. Select a different Source Site in Site Config if that's where you intended to perform this transaction.

**The Allow Negative Quantities option applies to batch devices only. Mobile devices that are communicating with the database via a wireless connection will not allow negative quantity transactions regardless of the option settings.**

4. Enter a Customer Number, then press F4.

Remove
123
Monitor
Customer: 00001

ESC=Cancel
F1=Prev  F4=Next

A Customer value might be required for this Item #. If not, the Customer field can be left empty or a value may be entered optionally.

As shown below, if a Customer value is entered that's not currently in the PDT database, you will be prompted to accept or reject the entry as a new value to be added to the database. The currently selected Source Site will be displayed when you are about to create a new Location.

Customer: ACME

New entry. Press Ent To accept or ESC to Cancel.
ENT=OK
ESC=Cancel

5. If this Item does not have Tracked By enabled for the Date Code, Pallet or Lot fields, a screen like the one below will be shown, prompting the entry of Qty.

Remove
100007
Paint Can
Qty:

ESC=Cancel
F1=Prev  F4=Next

Key in the inventory quantity being Removed and press ENT to complete the Remove transaction. The Qty value entered must be numeric and it must be greater than zero.

If the **Allow Negative Quantities on Mobile Devices** option is disabled, you will see the following message if you attempt to Remove more quantity than that which is available for this Item at the specified Location.

**Available:**
83.0000

**Not enough qty available to complete the transaction**
ESC=Exit

Press ESC and enter a value that does not exceed the **Available** amount.

If this Item does have **Tracked By** enabled for **Date Code**, **Pallet** or **Lot** fields, a screen like the one below will be shown, expecting input for each Tracked By field that’s enabled.

**Remove**
100006
**Paint Can**
**Pallet:**

ESC=Cancel
F1=Prev  F4=Next

Key in or scan values for each of the Tracked By fields, pressing F4 to advance to the next data entry field.

If you press F4 to advance to the next data entry field, without first inputting a required Tracked By value, a screen similar to the following will be displayed:

**Please scan or key in Pallet**

ESC=Exit

Press ESC to Exit the error message and then provide the required **Tracked By** value (a **Pallet**, in this example).

If the **Allow Negative Quantities on Mobile Devices** options is disabled, and a Tracked By value that **does not** match a value associated with inventory available at the previously specified **Location** is entered, the following screen will be displayed:

**No item with this trackby specific in stock**

ESC=Exit

If **Allow Negative Quantities on Mobile Devices** is enabled, any Tracked By value is allowed.
Press Esc to Exit the error message and then provide a Tracked By value that matches inventory in stock at the specified Location.

---

**Looping on Serial Number:**

Fields can be looped, or pinned, by pressing the F3 key. An asterisk displays next to the looped field.

If track by Serial Number is enabled for this Item, the Qty field will be set to 1. A quantity of one is assumed for each Serial Number. Looping will determine the final count for this Add transaction, as you scan (or key in) one or more Serial Numbers for this Item:

```
1000066
Qty: 1
SN: *
Count: 0
F4=Done
```

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each serial number.

Press F4 after entering the last Serial Number to the Remove screen.

**Notes:**

- When an Item is tracked by Serial Number, you can only loop on Serial Number.
- When an Item is not Tracked By Serial Number, you can use F3 to designate a field that will be used for looping. The values in every field except Qty will remain locked while looping.

---

**Looping on Location:**

Fields can be looped, or pinned, by pressing the F3 key.

In the example below the F3 key was pressed when prompted for Location while doing a Remove for this Item:

```
Add
123
Monitor
Location: *
```

ESC=Cancel  
F1=Prev F4=Next
An asterisk (*) indicates the intention to do more than one Remove for this Item #, to more than one Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on Location after entering them for the first Add. Tracking fields are needed only for any Tracked By options enabled for the Item entered.

In the example below F3 was pressed when prompted for Location and then values for Location, PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive inputs for another Add. PO, Supplier and Tracked By values, if any, for this second Remove will be the same as those supplied at the beginning of the loop, if any.

<table>
<thead>
<tr>
<th>123</th>
<th>Qty:</th>
<th>Location:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Qty: 10.00000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>F4=Done</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

While looping on Location, all that is required for each Remove are values for Qty and Location. The Total Qty field is incremented each time a Remove is submitted while looping.

Press the ENT key to submit the Remove transaction and continue looping or press the F4 key to exit the loop.

---

Looping on Item Number:

Fields can be looped, or pinned, by pressing the F3 key.

In the following example, F3 was pressed when prompted for Item #:

Remove
Item #: *

Scan or key in value
and press Ent.
Press ESC for Menu

Above, the asterisk (*) indicates the intention to loop on Item #. Values entered for Location, PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after entering them for the first Remove:

Qty:
Item #:
Count:25
F4=Done
Above, having pressed **F3** when prompted for **Item #** and then having entered the item number and values for **Location, PO, Supplier**, any Tracked By's, and a value of **25** for **Qty**, this screen is ready to receive **Qty** and **Item #** inputs for the second Remove. The **Location, PO, Supplier**, and any Tracked By values just specified will be used with every Remove transaction entered until **F4** is used to exit the loop.

While looping on **Item #**, all that is required for each transaction here are values for **Qty** and **Item #**. The **Count** is incremented each time a Remove is done while looping.

- Press the ENT key to submit the Remove transaction and continue looping

  or

- Press the **F4** key to exit the loop.

When looping on **Item #**, all items entered should have the same **Tracked By** requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be reset.

### Looping on a Tracked By (other than Serial Number)

Here, for example, **F3** was pressed when prompted for **Pallet** while doing a Remove for this Item:

```
Remove
123
Monitor
Pallet:    *
```

ESC=Cancel
F1=Prev  F4=Next

An asterisk (*) indicates the intention to do more than one Remove for this **Item #**, for more than one **Pallet**. Values entered for **Item #, Location, PO, Supplier**, and any other Tracked By fields will remain locked while looping on **Pallet**, after entering them for the first Remove:

```
123
Qty:    *
Pallet:  *
```

**Total Qty:**
30.00000
F4=Done

Above, having entered a value for **Pallet** and a value of **30** for **Qty** on the previous screen for the first Remove, this screen is ready to receive inputs for another Remove. **Item #, Location, PO and Supplier** values for this second Remove will be the same as those supplied at the beginning of the loop.
While looping on this Tracked By field, all that is required for each Remove are values for Qty and Pallet. The Total Qty is incremented each time a Remove is submitted while looping.

Press the ENT key to submit the Remove transaction and continue looping

or

Press the F4 key to exit the loop.

When looping on a Tracked By field, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be restarted.
19.19 WDT2200 - Removing Kit Items

This function applies to Pro and Enterprise Version users only.

The **Remove Kit** function allows you to remove a kit item from the database. This can be considered the same as shipping inventory. You can designate which customer this inventory was shipped to on this screen.

**Notes:**

- Make sure the PDT's date and time are set correctly before performing inventory transactions.
- Source and/or Destination sites are not specified during on the database you sent to the PDT, the following message will be displayed the first time you attempt to perform an inventory transaction on the PDT:

  Please use the Site Config function to Select Source and Destination Sites.

  ESC=Exit

  Press the Escape key to return to the **Main Menu**, then select the 6 key to go to the Site Config function. For more information on configuring sites on the PDT, please refer to the topic, **WDT2200 - Configuring Sites**.

Topics discussed in this section are:

- **Removing Kit Items**
- **Looping on Serial Number**
- **Looping on Location**
- **Looping on Item Number**
- **Looping on Track Bys (Other than Serial Number)**

---

**Removing Kit Items:**

1. The **Remove Kit** function can be accessed by pressing the 2 key on the **Main Menu**. The **Remove** screen appears

   Remove
   
   Item #:
   
   123

   Scan or key in value and press Ent.
Press ESC for Menu

2. Press the PDT's Enter key after supplying an Item # or press the PDT's ESC key to return to the Main Menu.

If the Item # entered is not found in the PDT's database, you will be prompted to try again, as shown below:

Remove
Item #:
9999999

Entry not found.
Scan or key in value
and press Ent.
ESC=Menu

If the Item # entered is found in the database, the Item's Description will be displayed beneath the Item #.

3. Enter the Quantity you want to remove. This is the how many Kits you want to remove.

Remove Kit
123
123 Description
QTY:
12

ESC=Cancel
F1=Prev  F4=Next

4. Next a screen will appear allowing you to scan or enter the component items for this kit item. Scan the Item Number, or use the F1/F4 keys or the arrow keys to browse through a list of the component items. Press F2 to clear your selection.

Scan/Select Item #:
1001

Rem Qty: 12
Total Qty: 30

ESC=Cancel Ent= OK
F1/F4 Browse F2=CLR

Rem Qty represents how many Kits you have removed so far and the Total Qty is how many of that component item you have removed. For example, if you have 5 of item 1001 contained in Kit 123, then the Total Qty would be 12 x 5 = 60.
5. Scan or key in a Location value (Note: If this is a non-inventory item, you will be taken directly to the Quantity screen - See Step 6):

   Remove
   123
   Item Description
   Location:
   AREA 2

   ESC=Cancel
   F1=Prev  F4=Next

   The Location field is required for all Remove transactions.

   Enter a Location and press F4 to advance to the next data entry field.

   or

   Press F1 to go back to the previous data entry field.

   or

   Press ESC to cancel transaction and return to the previous screen.

   If you press F4 to advance to the next field, without first providing a Location value, the following message will be displayed:

   Please scan or key
   in Location

   ESC=Exit

   Press ESC to Exit the error message and then provide the required Location value.

   Note: If the Allow Negative Quantities on Mobile Devices option is disabled, you will see a warning message if you attempt to Remove quantity from a Location that does not exist in the PDT database. The Allow Negative option must be set on the PC prior to creating the database. You can check the state of this option on the PDT by using the 7 key on the Main Menu to go to the PDT About screen.

   New Locations can only be created during Remove when the Allow Negative Quantities on Mobile Devices option is enabled. If you are prompted to confirm a new Location that you believe should already exist in the database, press ESC to cancel, then return to the Main Menu to check Site Config. If the Location you entered exists only at a Site other than the currently selected Source Site, InventoryControl must treat that value as a new Location for the Source Site. Select a different Source Site in Site Config if that's where you intended to perform this transaction.

   The Allow Negative Quantities option applies to batch devices only. Mobile devices that are communicating with the database via a wireless connection will not allow negative quantity transactions regardless of the option settings.
6. If this item does not have Tracked By enabled for the Date Code, Pallet or Lot fields, a screen like the one below will be shown, prompting the entry of Qty.

Remove
100007
Paint Can
Qty:

ESC=Cancel
F1=Prev  F4=Next

Key in the inventory quantity being Removed and press ENT to complete the Remove transaction. The Qty value entered must be numeric and it must be greater than zero.

If the Allow Negative Quantities on Mobile Devices option is disabled, you will see the following message if you attempt to Remove more quantity than that which is available for this Item at the specified Location.

Available:
83.0000

Not enough qty avail
able to complete the
transaction
ESC=Exit

Press ESC and enter a value that does not exceed the Available amount.

If this Item does have Tracked By enabled for Date Code, Pallet or Lot fields, a screen like the one below will be shown, expecting input for each Tracked By field that's enabled.

Remove
100006
Paint Can
Pallet:

ESC=Cancel
F1=Prev  F4=Next

Key in or scan values for each of the Tracked By fields, pressing F4 to advance to the next data entry field.

If you press F4 to advance to the next data entry field, without first inputting a required Tracked By value, a screen similar to the following will be displayed:

Please scan or key
in Pallet

ESC=Exit

Press ESC to Exit the error message and then provide the required Tracked By value (a Pallet, in this example).
Note: You can press the F2 key to view the last Serial Number entered.

If the Allow Negative Quantities on Mobile Devices options is disabled, and a Tracked By value that does not match a value associated with inventory available at the previously specified Location is entered, the following screen will be displayed:

No item with this trackby specific in stock

ESC=Exit

If Allow Negative Quantities on Mobile Devices is enabled, any Tracked By value is allowed.

Press Esc to Exit the error message and then provide a Tracked By value that matches inventory in stock at the specified Location.

Looping on Serial Number:

Fields can be looped, or pinned, by pressing the F3 key. An asterisk displays next to the looped field.

If track by Serial Number is enabled for this Item, the Qty field will be set to 1. A quantity of one is assumed for each Serial Number. Looping will determine the final count for this Add transaction, as you scan (or key in) one or more Serial Numbers for this Item:

1000066
Qty:1

SN: *

Count:0
F4=Done

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each serial number.

Press F4 after entering the last Serial Number to the Remove screen.

Notes:

- When an Item is tracked by Serial Number, you can only loop on Serial Number.
- When an Item is not Tracked By Serial Number, you can use F3 to designate a field that will be used for looping. The values in every field except Qty will remain locked while looping.

Looping on Location:

Fields can be looped, or pinned, by pressing the F3 key.
In the example below the **F3** key was pressed when prompted for **Location** while doing a Remove for this Item:

```
Add
123
Monitor
Location:  *
```

ESC=Cancel
F1=Prev F4=Next

An asterisk (*) indicates the intention to do more than one Remove for this **Item #**, to more than one **Location**. Values entered for **Item #**, **PO** and **Supplier**, if any, will remain locked while looping on **Location** after entering them for the first Add. Tracking fields are needed only for any Tracked By options enabled for the Item entered.

In the example below **F3** was pressed when prompted for **Location** and then values for **Location**, **PO**, **Supplier**, any Tracked By’s, and a **Qty** of 10 were entered, this screen is ready to receive inputs for another Add. **PO, Supplier** and **Tracked By** values, if any, for this second Remove will be the same as those supplied at the beginning of the loop, if any.

```
123
Qty:
Location:
Total Qty:  10.0000
F4=Done
```

While looping on **Location**, all that is required for each Remove are values for **Qty** and **Location**. The **Total Qty** field is incremented each time a Remove is submitted while looping.

Press the **ENT** key to submit the Remove transaction and continue looping or press the **F4** key to exit the loop.

---

**Looping on Item Number:**

Fields can be looped, or pinned, by pressing the **F3** key.

In the following example, **F3** was pressed when prompted for **Item #**:

```
Remove
Item #:  *
Scan or key in value
and press Ent.
Press ESC for Menu
```
Above, the asterisk (*) indicates the intention to loop on Item #. Values entered for Location, PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after entering them for the first Remove:

Qty:

Item #:

Count: 25
F4=Done

Above, having pressed F3 when prompted for Item # and then having entered the item number and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen is ready to receive Qty and Item # inputs for the second Remove. The Location, PO, Supplier, and any Tracked By values just specified will be used with every Remove transaction entered until F4 is used to exit the loop.

While looping on Item #, all that is required for each transaction here are values for Qty and Item #. The Count is incremented each time a Remove is done while looping.

Press the ENT key to submit the Remove transaction and continue looping

or

Press the F4 key to exit the loop.

When looping on Item #, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be reset.

---

Looping on a Tracked By (other than Serial Number)

Here, for example, F3 was pressed when prompted for Pallet while doing a Remove for this Item:

Remove
123
Monitor
Pallet: *

ESC=Cancel
F1=Prev F4=Next

An asterisk (*) indicates the intention to do more than one Remove for this Item #, for more than one Pallet. Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields will remain locked while looping on Pallet, after entering them for the first Remove.
Above, having entered a value for **Pallet** and a value of **30** for **Qty** on the previous screen for the first Remove, this screen is ready to receive inputs for another Remove. **Item #, Location, PO and Supplier** values for this second Remove will be the same as those supplied at the beginning of the loop.

While looping on this Tracked By field, all that is required for each Remove are values for **Qty** and **Pallet**. The **Total Qty** is incremented each time a Remove is submitted while looping.

👉 Press the ENT key to submit the Remove transaction and continue looping

or

Press the **F4** key to exit the loop.

When looping on a Tracked By field, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be restarted.
19.20 WDT2200 - Picking Inventory for Orders

This function applies to Pro and Enterprise Version users only.

When a pick order is actually being picked, that is, the inventory is being readied for shipping to the customer, the quantities that are removed from inventory for each item on the order are entered in the Pick screen.

Notes:

- Picks can also be done at the PC.
- Manual items cannot be picked on the mobile devices. Please refer to Creating a Pick Order for more information on Manual items.
- Make sure the PDT’s date and time are set correctly before performing inventory transactions.
- If Source and/or Destination sites are not specified during on the database you sent to the PDT, the following message will be displayed the first time you attempt to perform an inventory transaction on the PDT:

  Please use the Site Config function to Select Source and Destination Sites.

  ESC=Exit

Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site Config function. For more information on configuring sites on the PDT, please refer to the topic, WDT2200 - Configuring Sites.

The topics discussed in this section are:

**Picking Inventory**

**Looping on Serial Number**

**Looping on Location**

**Looping on Item Number**

**Looping on Track Bys (Other than Serial Number)**

Picking Inventory:

1. From the Main Menu, press 9. The Pick screen appears:

   Pick
   Order #:

   Scan or key in value
   and press Ent.
Press ESC for Menu

2. Enter the **Pick Order** number, then press the **Ent** key. Press **ESC** to return to the **Main Menu**.

   **Pick Order #:**
   00001

   Scan or key in value
   and press Ent.
   Press ESC for Menu

3. Enter the **Item Number** you are picking, then press **Ent**. Press **ESC** to return to the **Main Menu**.

   **Pick Item #:**
   1002

   Scan or key in value
   and press Ent.
   Press ESC for Menu

   If the **Item #** entered is not found in the PDT's database, you will be prompted to try again after you press **Ent**.

   If the **Item #** entered is found in the database, the Item's **Description** will be displayed beneath the **Item #** after you press **Ent**.

4. Enter the **Location** of this item, then press **F4**. Press **F1** to return to the previous screen and select a different item.

   **Pick**
   1002
   **Monitor**

   **Location:**
   001

   **ESC=Cancel**
   **F1=Prev  F4=Next**

5. Picks are always calculated in Eaches, meaning the quantity in which you stock them (as opposed to the quantity in which they are shipped to you, which may differ). Enter how many of this item you will be picking.

   **Pick**
   1002
   **Monitor**

   **EA Qty**
   1

   **ESC=Cancel**
   **F1=Prev  F4=Next**
**Note:** If this item has any track bys set (serial number, date code, pallet, etc.), you will required to enter those prior to entering a quantity. If this item is tracked by Serial Number, the quantity is limited to 1.

6. Press **F4** to complete the transaction.

**Note:** If the **Allow Negative Quantities on Mobile Devices** option is disabled, you will see a warning message if you attempt to Pick quantity from a Location that does not exist in the PDT database. The Allow Negative option must be set on the PC prior to creating the database. You can check the state of this option on the PDT by using the 7 key on the Main Menu to go to the PDT **About** screen.

New **Locations** can only be created during Pick when the **Allow Negative Quantities on Mobile Devices** option is enabled. If you are prompted to confirm a new **Location** that you believe should already exist in the database, press **ESC** to cancel, then return to the Main Menu to check **Site Config**. If the **Location** you entered exists only at a **Site** other than the currently selected **Source Site**, **InventoryControl** must treat that value as a new **Location** for the **Source Site**. Select a different **Source Site** in **Site Config** if that's where you intended to perform this transaction.

**The Allow Negative Quantities option applies to batch devices only.** Mobile devices that are communicating with the database via a wireless connection will not allow negative quantity transactions regardless of the option settings.

---

**Looping on Serial Number:**

Fields can be looped, or pinned, by pressing the **F3** key. An asterisk displays next to the looped field.

If track by **Serial Number** is enabled for this Item, the **Qty** field will be set to 1. A quantity of one is assumed for each **Serial Number**. Looping will determine the final count for this **Pick** transaction, as you scan (or key in) one or more **Serial Numbers** for this Item:

```
1000066
Qty:1
SN:  *
Count:0
F4=Done
```

As each **SN** is keyed in or scanned, the **Count** will be increased. Press **ENT** after inputting each serial number. Press **F4** after entering the last **Serial Number** to the **Pick** screen.

**Notes:**

- When an Item is tracked by Serial Number, you can only loop on Serial Number.
- When an Item *is not* tracked by Serial Number, you can use **F3** to designate a field that will be used for looping. The values in every field except **Qty** will remain locked while looping.
Looping on Location:

Fields can be looped, or pinned, by pressing the F3 key.

In the example below the F3 key was pressed when prompted for Location while doing an Pick for this Item:

```
Pick
123
Monitor
Location: *

ESC=Cancel
F1=Prev F4=Next
```

An asterisk (*) indicates the intention to do more than one Pick for this Item #, to more than one Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on Location after entering them for the first Add. Tracking fields are needed only for any Tracked By options enabled for the Item entered.

In the example below F3 was pressed when prompted for Location and then values for Location, PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive inputs for another Pick. PO, Supplier and Tracked By values, if any, for this second Pick will be the same as those supplied at the beginning of the loop, if any.

```
123
Qty:
Location:

Total Qty:
10.00000
F4=Done
```

While looping on Location, all that is required for each Pick are values for Qty and Location. The Total Qty field is incremented each time a Pick is submitted while looping.

Press the ENT key to submit the Pick transaction and continue looping or press the F4 key to exit the loop.
Looping on Item Number:

Fields can be looped, or pinned, by pressing the F3 key.

In the following example, F3 was pressed when prompted for Item #:

```
Pick
Item #: *

Scan or key in value
and press Ent.
Press ESC for Menu
```

Above, the asterisk (*) indicates the intention to loop on Item #. Values entered for Location, PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after entering them for the first Pick:

```
Qty:

Item #:

Count:25
F4=Done
```

Above, having pressed F3 when prompted for Item # and then having entered the item number and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen is ready to receive Qty and Item # inputs for the second Pick. The Location, PO, Supplier, and any Tracked By values just specified will be used with every Pick transaction entered until F4 is used to exit the loop.

While looping on Item #, all that is required for each transaction here are values for Qty and Item #. The Count is incremented each time a Pick is done while looping.

- Press the ENT key to submit the Pick transaction and continue looping

  or

  Press the F4 key to exit the loop.

When looping on Item #, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be reset.
Looping on a Tracked By (other than Serial Number)

Here, for example, F3 was pressed when prompted for Pallet while doing a Pick for this Item:

Pick
123
Monitor
Pallet: *

ESC=Cancel
F1=Prev  F4=Next

An asterisk (*) indicates the intention to do more than one Pick for this Item #, for more than one Pallet. Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields will remain locked while looping on Pallet, after entering them for the first Pick:

123
Qty:
Pallet: *

Total Qty:
30.00000

F4=Done

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the first Pick, this screen is ready to receive inputs for another Pick. Item #, Location, PO and Supplier values for this second Pick will be the same as those supplied at the beginning of the loop.

While looping on this Tracked By field, all that is required for each Pick are values for Qty and Pallet. The Total Qty is incremented each time an Pick is submitted while looping.

Press the ENT key to submit the Pick transaction and continue looping

or

Press the F4 key to exit the loop.

When looping on a Tracked By field, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be restarted.
19.21 WDT2200 - Picking Kit Items

This function applies to Pro and Enterprise Version users only.

When a pick order is actually being picked, that is, the inventory is being readied for shipping to the customer, the quantities that are removed from inventory for each item on the order are entered in the Pick screen.

Notes:

- Make sure the PDT's date and time are set correctly before performing inventory transactions.
- If Source and/or Destination sites are not specified during on the database you sent to the PDT, the following message will be displayed the first time you attempt to perform an inventory transaction on the PDT:

  Please use the Site Config function to Select Source and Destination Sites.

  ESC=Exit

  Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site Config function. For more information on configuring sites on the PDT, please refer to the topic, WDT2200 - Configuring Sites.

The topics discussed in this section are:

- Picking Inventory
- Looping on Serial Number
- Looping on Location
- Looping on Item Number
- Looping on Track Bys (Other than Serial Number)

Picking Inventory:

1. From the Main Menu, press 9. The Pick screen appears:

   Pick
   Order #:

   Scan or key in value and press Ent.
   Press ESC for Menu
2. Enter the **Pick Order** number, then press the **Ent** key. Press **ESC** to return to the **Main Menu**.

```
Pick Order #:
00001

Scan or key in value and press Ent.
Press ESC for Menu
```

3. Enter the Item Number you are picking, then press **Ent**. Press **ESC** to return to the **Main Menu**.

```
Pick Item #:
123

Scan or key in value and press Ent.
Press ESC for Menu
```

If the **Item #** entered *is not found* in the PDT's database, you will be prompted to try again after you press **Ent**.

If the **Item #** entered *is found* in the database, the Item's **Description** will be displayed beneath the **Item #** after you press **Ent**.

4. Enter the **Quantity**: This is how many Kits you want to pick.

```
Pick Kit
123
123 Description
Qty:
12

ESC=Cancel
F1=Prev F4=Next
```

5. Next a screen will appear allowing you to scan or enter the component items for this kit item.

Scan the **Item Number**, or use the **F1/F4** keys to browse through a list of the component items. Press **F2** to clear your selection.

```
Scan/Select Item #:
1001

Rem Qty: 12
Total Qty: 30

ESC=Cancel Ent= OK
F1/F4 Browse F2=CLR
```

Rem Qty represents how many Kits you have picked so far and the Total Qty is how many of that component item you have picked. For example, if you have 5 of item 1001 contained in Kit 123, then the Total Qty would be 12 x 5 = 60. Continuing this example, if you pick more than 60, a warning will appear that you are picking more than indicated on the Pick Order. You can
continue, but the discrepancy will be caught when you sync that data back to the PC and you will have to correct the quantity on the **Edit Transaction** screen.

6. Enter the **Location** of this item, then press **F4**. Press **F1** to return to the previous screen and select a different item.

   Pick  
   1001  
   Monitor  
   Location:  
   001  

   **ESC=Cancel**  
   **F1=Prev  F4=Next**

7. If a track by other than **Serial Number** is required, you will enter it now.

   Pick  
   1001  
   Monitor  
   Date Code:  
   DC-1234  

   **ESC=Cancel**  
   **F1=Prev  F4=Next**

8. Picks are always calculated in Eaches, meaning the quantity in which you stock them (as opposed to the quantity in which they are shipped to you, which may differ). Enter how many of this item you will be picking.

   Pick  
   1001  
   Monitor  
   **EA.Qty**  
   1  

   **ESC=Cancel**  
   **F1=Prev  F4=Next**

9. If this item is tracked by Serial Number or Lot, you will be required to enter the numbers/codes now.

   1001  
   **EA. QTY:1**  

   **SN:**  
   100023021  

   **Qty:4/100**  
   **F4=Done  F2=Last SN**

When looping on serial number, note that the **Qty** field displays how many serial numbers exist for this item and how many you have entered so far. In the example above, 4 serial numbers have been entered out of a possible 100 (4/100). You can press **F2** to display the last serial
number entered.

10. Press **F4** to complete the transaction.

**Note:** If the Allow Negative Quantities on Mobile Devices option is disabled, you will see a warning message if you attempt to Pick quantity from a Location that does not exist in the PDT database. The Allow Negative option must be set on the PC prior to creating the database. You can check the state of this option on the PDT by using the **7** key on the Main Menu to go to the PDT About screen.

New Locations can only be created during Pick when the Allow Negative Quantities on Mobile Devices option is enabled. If you are prompted to confirm a new Location that you believe should already exist in the database, press **ESC** to cancel, then return to the Main Menu to check Site Config. If the Location you entered exists only at a Site other than the currently selected Source Site, InventoryControl must treat that value as a new Location for the Source Site. Select a different Source Site in Site Config if that's where you intended to perform this transaction.

The Allow Negative Quantities option applies to batch devices only. Mobile devices that are communicating with the database via a wireless connection will not allow negative quantity transactions regardless of the option settings.

---

**Looping on Serial Number:**

Fields can be looped, or pinned, by pressing the **F3** key. An asterisk displays next to the looped field.

If track by Serial Number is enabled for this Item, the Qty field will be set to 1. A quantity of one is assumed for each Serial Number. Looping will determine the final count for this Pick transaction, as you scan (or key in) one or more Serial Numbers for this Item:

```
1000066
Qty: 1
SN: *
Count: 0
F4=Done F2=Last SN
```

As each SN is keyed in or scanned, the Count will be increased. Press **ENT** after inputting each serial number. When looping on serial number, note that the Qty field displays how many serial numbers exist for this item and how many you have entered so far. In the example above, 4 serial numbers have been entered out of a possible 100 (4/100). You can press **F2** to display the last serial number entered.

Press **F4** after entering the last Serial Number to the Pick screen.

**Notes:**

- When an Item is tracked by Serial Number, you can only loop on Serial Number.
- When an Item *is not* Tracked By Serial Number, you can use **F3** to designate a field that will be used for looping. The values in every field except Qty will remain locked while looping.
Looping on Location:

Fields can be looped, or pinned, by pressing the F3 key.

In the example below the F3 key was pressed when prompted for Location while doing an Pick for this Item:

```
Pick
123
Monitor
Location: *
```

ESC=Cancel
F1=Prev F4=Next

An asterisk (*) indicates the intention to do more than one Pick for this Item #, to more than one Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on Location after entering them for the first Add. Tracking fields are needed only for any Tracked By options enabled for the Item entered.

In the example below F3 was pressed when prompted for Location and then values for Location, PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive inputs for another Pick. PO, Supplier and Tracked By values, if any, for this second Pick will be the same as those supplied at the beginning of the loop, if any.

```
123
Qty:
Location:
```

```
Total Qty:
10.00000
F4=Done
```

While looping on Location, all that is required for each Pick are values for Qty and Location. The Total Qty field is incremented each time a Pick is submitted while looping.

Press the ENT key to submit the Pick transaction and continue looping or press the F4 key to exit the loop.
Looping on Item Number:

Fields can be looped, or pinned, by pressing the F3 key.

In the following example, F3 was pressed when prompted for Item #:

Pick
Item #: *

Scan or key in value
and press Ent.
Press ESC for Menu

Above, the asterisk (*) indicates the intention to loop on Item #. Values entered for Location, PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after entering them for the first Pick:

Qty:
Item #:

Count:25
F4=Done

Above, having pressed F3 when prompted for Item # and then having entered the item number and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen is ready to receive Qty and Item # inputs for the second Pick. The Location, PO, Supplier, and any Tracked By values just specified will be used with every Pick transaction entered until F4 is used to exit the loop.

While looping on Item #, all that is required for each transaction here are values for Qty and Item #. The Count is incremented each time a Pick is done while looping.

Press the ENT key to submit the Pick transaction and continue looping

or

Press the F4 key to exit the loop.

When looping on Item #, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be reset.
Looping on a Tracked By (other than Serial Number)

Here, for example, F3 was pressed when prompted for Pallet while doing a Pick for this Item:

```
Pick
123
Monitor
Pallet: *
```

ESC=Cancel
F1=Prev  F4=Next

An asterisk (*) indicates the intention to do more than one Pick for this Item #, for more than one Pallet. Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields will remain locked while looping on Pallet, after entering them for the first Pick:

```
123
Qty:
Pallet: *
```

```
Total Qty:
30.00000
F4=Done
```

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the first Pick, this screen is ready to receive inputs for another Pick. Item #, Location, PO and Supplier values for this second Pick will be the same as those supplied at the beginning of the loop.

While looping on this Tracked By field, all that is required for each Pick are values for Qty and Pallet. The Total Qty is incremented each time an Pick is submitted while looping.

Press the ENT key to submit the Pick transaction and continue looping

or

Press the F4 key to exit the loop.

When looping on a Tracked By field, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be restarted.
19.22 WDT2200 - Receiving Inventory

This function applies to Pro and Enterprise Versions only.

This screen allows you to select which purchase order you are receiving on and to mark individual items on that purchase order as received into a specific location.

Notes:

- **Picks** can also be done at the PC.
- **Manual** items cannot be received on the mobile devices. Please refer to [Creating a Purchase Order](#) for more information on Manual items.
- Make sure the PDT's date and time are set correctly before performing inventory transactions.
- If Source and/or Destination sites are not specified during on the database you sent to the PDT, the following message will be displayed the first time you attempt to perform an inventory transaction on the PDT:

```
Please use the Site Config function to Select Source and Destination Sites.
```

**ESC=Exit**

Press the Escape key to return to the *Main Menu*, then select the 6 key to go to the Site Config function. For more information on configuring sites on the PDT, please refer to the topic, [WDT2200 - Configuring Sites](#).

The topics discussed in this section are:

- [Receiving Inventory](#)
- [Looping on Serial Number](#)
- [Looping on Item Number](#)
- [Looping on Location](#)
- [Looping on Track Bys (Other than Serial Number)](#)
- [Tips for Speeding Up Data Entry](#)
Receiving Inventory:

1. From the Main Menu, press the 9 key. The Receive screen appears:

   Receive
   PO:

   Scan or key in value
   and press Ent.
   Pres ESC for Menu

2. Enter the PO number that contains the items you are receiving:

   Receive
   PO:
   10007

   Scan or key in value
   and press Ent.
   Pres ESC for Menu

3. Enter the Item Number you are receiving:

   Receive
   Item:
   1001

   Scan or key in value
   and press Ent.
   Pres ESC for Menu

   If the Item # entered is not found in the PDT's database, you will be prompted to try again after you press Ent.

   If the Item # entered is found in the database, the Item's Description will be displayed beneath the Item # after you press Ent.

4. Enter the Location into which you will be receiving the item. Note: If this item has a designated primary location (setup on the Create New Item or Edit Item screen on the PC), then that location will appear by default. You can change this location, if needed.

   A location must be entered.

   Receive
   1001
   Monitor
   Location:
   Location 1

   ESC=Cancel
   F1=Prev  F4=Next
5. The quantity ordered for this item on the PO will appear followed by the order unit quantity. The order unit quantity is the unit of measure used by this supplier for shipping purposes. In the example below, 100 boxes were ordered, each box contains 10 items and 1 is being received.

Receive
1001
Monitor
PO Qty: 100.0000
box/10.0000:
1

ESC=Cancel
F1=Prev  F4=Next

Note: If this item has any track bys set (serial number, date code, pallet, etc.), you will required to enter those prior to entering a quantity. If this item is tracked by Serial Number, the quantity is limited to 1.

6. Press F4 to complete the transaction.

Looping on Serial Number:

Fields can be looped, or pinned, by pressing the F3 key. An asterisk displays next to the looped field.

If track by Serial Number is enabled for this Item, the Qty field will be set to 1. A quantity of one is assumed for each Serial Number. Looping will determine the final count for this Receive transaction, as you scan (or key in) one or more Serial Numbers for this Item:

1000066
Qty:1

SN: *
Count:0
F4=Done

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each serial number.

Press F4 after entering the last Serial Number to the Receive screen.

Notes:

- When an Item is tracked by Serial Number, you can only loop on Serial Number.
- When an Item is not Tracked By Serial Number, you can use F3 to designate a field that will be used for looping. The values in every field except Qty will remain locked while looping.
Looping on Location:

Fields can be looped, or pinned, by pressing the F3 key.

In the example below the F3 key was pressed when prompted for Location while doing a Receive for this Item:

```
Receive
123
Monitor
Location: *

ESC=Cancel
F1=Prev F4=Next
```

An asterisk (*) indicates the intention to do more than one Receive for this Item #, to more than one Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on Location after entering them for the first Add. Tracking fields are needed only for any Tracked By options enabled for the Item entered.

In the example below F3 was pressed when prompted for Location and then values for Location, PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive inputs for another Pick. PO, Supplier and Tracked By values, if any, for this second Pick will be the same as those supplied at the beginning of the loop, if any.

```
123
Qty:
Location:

Total Qty:
10.00000
F4=Done
```

While looping on Location, all that is required for each Receive are values for Qty and Location. The Total Qty field is incremented each time a Receive is submitted while looping.

Press the ENT key to submit the Receive transaction and continue looping or press the F4 key to exit the loop.

Looping on Item Number:

Fields can be looped, or pinned, by pressing the F3 key.

In the following example, F3 was pressed when prompted for Item #:
Receive
Item #: *

Scan or key in value
and press Ent.
Press ESC for Menu

Above, the asterisk (*) indicates the intention to loop on Item #: Values entered for Location, PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after entering them for the first Receive:

Qty:

Item #:

Count: 25
F4=Done

Above, having pressed F3 when prompted for Item # and then having entered the item number and values for Location, PO, Supplier, any Tracked By’s, and a value of 25 for Qty, this screen is ready to receive Qty and Item # inputs for the second Receive. The Location, PO, Supplier, and any Tracked By values just specified will be used with every Receive transaction entered until F4 is used to exit the loop.

While looping on Item #, all that is required for each transaction here are values for Qty and Item #: The Count is incremented each time a Receive is done while looping.

Press the ENT key to submit the Receive transaction and continue looping

or

Press the F4 key to exit the loop.

When looping on Item #, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be reset.

Looping on a Tracked By (other than Serial Number)

Here, for example, F3 was pressed when prompted for Pallet while doing a Receive for this Item:

Receive
123
Monitor
Pallet: *

ESC=Cancel
F1=Prev  F4=Next
An asterisk (*) indicates the intention to do more than one Receive for this Item #, for more than one Pallet. Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields will remain locked while looping on Pallet, after entering them for the first Receive:

123
Qty: *
Pallet: *

Total Qty: 30.0000
F4=Done

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the first Receive, this screen is ready to receive inputs for another Receive. Item #, Location, PO and Supplier values for this second Receive will be the same as those supplied at the beginning of the loop.

While looping on this Tracked By field, all that is required for each Receive are values for Qty and Pallet. The Total Qty is incremented each time an Receive is submitted while looping.

Press the ENT key to submit the Receive transaction and continue looping

or

Press the F4 key to exit the loop.

When looping on a Tracked By field, all items entered should have the same Tracked By requirements. If a different Tracked By field is required, you will be prompted to enter the information before continuing. Looping will need to be restarted.

Tips for Speeding Up Data Entry:

- When you create a new item, if the Category, Manufacturer, UOM or any combination of pinnable fields will be used on a large number of items, create one item with those fields, then pin the fields. Now, the information will be retained in those fields so you don't have to keep re-entering it for each new item.

- Make sure you have the Close New Forms option turned off (on the InventoryControl Options screen) so the New Item screen, or any other screen where new information is added, stays open after each new item is saved.
Chapter 20 - Windows Mobile Device

20.1 Windows Mobile Device Data Cycle - Batch Device (No Wireless Connection)

PC:

1. [Windows Mobile Device Setup: Setup Device](#)

3. [Create Mobile Database: Created on PC](#)

4. [Synchronize Mobile Device: Download PC to Windows Mobile Device](#)

Mobile Device:

5. [Get Data from PC on Windows Mobile Device](#)

6. Use Mobile Device

7. [Send Data to PC from Windows Mobile Device](#)

PC:

8. [Synchronize Mobile Device: Upload Windows Mobile Device to PC](#)

9. [Process Mobile Device Data](#)

20.2 Windows Mobile Device Data Cycle - Wireless Connection

PC:

[Windows Mobile Device Wireless Setup](#)

Mobile Device:

Use Mobile Device
20.3 Windows Mobile Device - Interface

Once the database has been sent to the mobile device, it will be ready for conducting inventory operations. For more information on setting up your device, please refer to the Windows Mobile Device - Setup Mobile Device topic.

Tap the device's InventoryControl icon with the stylus to start the application.

An hour glass icon displays while the application opens.

The Logon screen displays.

Enter your user name and password, then tap OK.

The first time you log on to InventoryControl on your mobile device, enter Admin in the User Name field and leave the Password field blank. After you have sent the database from the PC to the mobile device, user names and passwords that are stored on the PC will be downloaded to the mobile device. Once this has occurred, you must use your normal user name and password to log on to the mobile
version of **InventoryControl**. For more information on sending the database to the mobile device, please refer to the [Windows Mobile Device - Sending New Data from the PC](#) topic.

Below is an example of the **InventoryControl Main Menu**.

![InventoryControl Main Menu](image)
20.4 Windows Mobile Device - Default Settings

The Windows Mobile version of InventoryControl offers several time-saving features:

**Site Configuration**: If your company uses the same two Sites for all inventory purpose, in the Site Configuration screen, you can set up your device to automatically include these Sites in the appropriate fields in InventoryControl.

**Pinning**: Pinning can be used to lock the values in any field. This enables you to enter repeated information rapidly without having to manually re-enter repetitive data.

20.5 Windows Mobile Device - Rebooting

If your device locks up, you can perform a warm reboot. This will reset the device and should return it to normal functioning. A warm reboot will not affect your data.

To perform a warm reboot, gently insert a pin into the Reset hole on the back of the device, then remove the pin.

The device will reset.

20.6 Windows Mobile Device - Enabling the Scanner

Before you use InventoryControl on your Windows Mobile Device for the first time, you may need to enable the scanner.

If at any time the scanner on your mobile device stops functioning, this procedure should also restore its functionality.

**Enabling the Scanner**:

1. Tap the **Start** icon at the bottom left corner of the device screen.
2. Select **Settings > Control Panel**.

![Control Panel](image-url)
3. Scroll down to locate the **Scanner Settings** icon. Double-tap the **Scanner Settings** icon.

4. Tap the **To Kpd** tab.
5. Select the **Start Scan2Key When Exit** check box. Make sure the check box has a check in it.

6. Tap the **OK** button in the upper right corner of the screen to apply the setting and close the **Scanner Control Panel** screen.
20.7 Windows Mobile Device - Entering Alphanumeric Data

You can enter letters and numbers in fields on the mobile device by using the device's key pad, using the keyboard or by scanning barcodes.

Regardless of the method you use to enter data, note that once you enter data in the first field and move to the next field, only the fields that are relevant to the data you entered will display. For example, if you enter an Item that is tracked by serial number, the Serial # field would remain on the screen, but other fields such as Date Code and Pallet would no longer display. If you enter an Item that is not tracked, all tracking fields - PO, Supplier, Lot, Date Code, Serial # and Pallet - will no longer display.

Using the Device's Key Pad

The method for using your device's numeric or alphanumeric keypad is documented in the user manual for that device. Please refer to that documentation for full details.

Using the Software Keyboard

Tap the keyboard icon at the bottom of the screen.

The keyboard options menu displays.

To open the keyboard, select Keyboard.

The keyboard (Input Panel) displays.

Tap in the field in which you want to enter data, then use your stylus to select the characters on the keyboard.

To close the keyboard, tap the keyboard icon at the bottom of the screen.

Select Hide Input Panel.
Scanning

If you have information -- such as an Item Number, Site or Location -- in barcode format, and your mobile device has a barcode scanner, you can scan the barcode to enter the data in a chosen field.

Tap in the field in which you want to enter data, then scan the barcode by aiming the scanner at the barcode and pressing the scan button.

If you find that the scanner is not responding, you may need to enable the scanner.

20.8 Setup and Synchronization Information

Batch Devices

20.8.1 Batch Windows Mobile Device Synchronization

The synchronization process involves actions on both the PC and the mobile device side. Whenever data is added or edited on the PC, it is necessary to synchronize the PC database with the mobile database before the updated data will be reflected on the mobile device. The same is true for additions and changes made on the mobile device. The databases on the mobile device and the PC must be synchronized before the changes made on the mobile device database will be reflected in the PC database.

Note: This applies to batch devices only. If you are using a wireless connection you will not need to retrieve information from the mobile device. Your mobile device will be connected directly to the database and any changes/additions you make on the mobile device will immediately update the database. For information about using a wireless connection, please refer to the topic Using a Mobile Device with a Wireless Connection.

The following topics will guide you through the different required synchronization procedures.

- Setup Mobile Device
- Create Database
- Send Data to PC
20.8.2 Batch Windows Mobile Device - Setup the Mobile Device

This is the first step in sending the InventoryControl database to your mobile device.

**Note:** This applies to batch devices only. If you are using a wireless connection you will not need to manually send information to the mobile device. Your mobile device will be connected directly to the database and any changes/additions you make on the mobile device will immediately update the database and vice versa. For information about using a wireless connection, please refer to the topic [Using a Mobile Device with a Wireless Connection](#).

**Setting Up the Mobile Device:**

1. On the **InventoryControl Main** screen, click the **Mobility** icon. A menu will appear allowing you to select which device you will be working with. If you have only one type, the **Mobility Menu** for that device will appear at the bottom of the screen.

2. On the **Mobility Menu**, select **Setup Mobile**.

   ![Setup Mobile, Create Mobile, Send Data To, Get Data From, Process Mobile](#)

   The **Wasp Mobile Device Communication Wizard** opens with the **Mobile Device Setup** tab selected.

   If this is the first install of the program on the mobile device, the software will automatically send the Platform, Program and a Clean Database to the mobile device.

   Once the mobile device has been found, the **Setup Mobile Device** tab displays the following information:
If this is the first time you are setting up the device, you can skip this screen by clicking the **Next** button. The platform, program and a clean database are automatically sent to the device.

If there was a problem with the initial setup, you can select **Platform, Program and Clean Database**.

If you already have a platform set up, select either **Program** or **Program and Clean Database**.

If you click the **Install Programs** button, the **Add/Remove Programs** screen will display.

2. Click the **Install** button. A message displays:

"You have chosen to send an empty database to the mobile device. This will wipe out any data that currently resides on the mobile device. Lost data cannot be recovered!"

3. Click **Yes** to send the database. A message displays regarding additional steps on the Windows Mobile Device.
4. If you are using Windows CE 5, you can click **OK** on this message and disregard it. If you are using any other version, you will need to click **OK** on this screen and follow the steps on the mobile device to continue. You may receive this message again during the install. Each time you receive it, you will need to check the mobile device for additional instructions.

5. When the install completed successfully, you will see the following screen:

```
Install Program

The wizard has successfully installed the InventoryControl program on the mobile device.

OK
```

6. Next the **Printing Setup** screen appears:
First, select **Yes** or **No** under the question "Do you plan to print from the mobile device?". If you select **No**, the Finish button will become enabled. Click Finish to complete the setup process. If you select **Yes**, select one of the following options:

**Yes, I will be printing from a network printer** - select this option if you will be printing to a printer on your network. You do not need to do anything else to enable printing. Click Finish to complete the setup process.

**OR**

**Yes, I will be printing with a Laser Mobile Printer** - select this option if you will be printing to a laser mobile printer. You will need to enter a **COM Port** and **Baud Rate** for this printer. Click Finish to complete the setup process.

**OR**

**Yes, I will printing with a Receipt Mobile Printer** - select this option if you will be printing to a receipt mobile printer. You will need to enter a **COM Port** and **Baud Rate** for this printer. Click Finish to complete the setup process.

7. After the install is complete, click the **Next** button at the bottom of the screen. The **Create Mobile Database** tab displays.
This tab allows you to filter the information that will be sent to the mobile device, if desired. Filtering helps save memory space on the mobile device by allowing you to select only the data you need to load onto the device as opposed to loading all available data. You can load all data, if desired.

8. Select the **Site, Location, Item Numbers, Customers, Suppliers, Purchase Orders (Pro and Enterprise Versions Only)** and **Pick Orders (Pro and Enterprise Versions Only)** to be downloaded to the device, then click **Next**.

Select the **Specify Filter** button if you will be limiting the data. Click the **Hand** icon to access the **Find** screen to search for data. The data you select on the **Find** screen will be entered in the text box for that section and only that data will be sent to the mobile device. Please refer to the **Searching for Information** topic for more information on the **Find** screen.

Select the **Minimally Required** checkbox to only send data that is required for normal operation. For example, if you select to send all Items, but don't want to send all locations, only those locations designated as **Primary Locations** for individual items will be sent. Or, if you don't want to send all **Suppliers**, but some **Suppliers** are entered on the **Item screen/Managing Suppliers tab** for items, only those suppliers entered on the **Item** screen will be sent.

**Tips for Filtering Information**

The default values apply no filtering to your data. All Items will be selected, including those which are not yet in a Location.

**Site:**
**Source:** Specify <all> or one of the Sites listed in the drop down list. This determines which Sites will be shown in the **Source Site** list on the mobile device.

This is the Site for all inventory transactions to be performed by the device. If you want the device’s database to include Items at more than one Site, select <all>. You can only select ALL or 1 specific site. For example, if you have 5 sites, you cannot select 2 to be a Source. You can either select 1 or all.

**Destination:** If more than one Site is defined on the system and you have selected a specific Site in the **Source Site** field, you can select one of the Sites listed in the **Destination Site** drop down list. This determines which Sites will be shown in the **Destination Site** list of the mobile device’s **Site Configuration** function and which locations will be listed in the **Move To** list.

This field will be grayed-out with a value of <all>, as shown above, if only one Site is defined in InventoryControl or if a value of <all> has been specified for the Source Site. If a specific Site has been selected for the Source Site, that same site will be the default value for Destination Site, but you can change the Destination Site to a different value using the drop down list.

<table>
<thead>
<tr>
<th>Source Site:</th>
<th>Destination Site:</th>
<th>The Source Sites Listed in the Mobile Device Site Configuration will Include:</th>
<th>The Destination Sites Listed in the Mobile Device Site Configuration will Include:</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;all&gt;</td>
<td>&lt;all&gt;</td>
<td>All Sites</td>
<td>All Sites</td>
</tr>
<tr>
<td>A Specific Site</td>
<td>Destination Site is the Same as the Source Site</td>
<td>The Specified Source Site</td>
<td>The Same Site</td>
</tr>
<tr>
<td>A Specific Site</td>
<td>A Different Site</td>
<td>The Specified Source Site</td>
<td>The Specified Destination Site</td>
</tr>
</tbody>
</table>

As an example, if you have more than two Sites and want to be able to move inventory from Site 1 to Site 2 -and- from Site 1 to Site 3 on the mobile device, you will have to create a mobile database for Source Site 1 and Destination Site 2, transfer the database to the mobile device, use the device for those Moves, send the information back to the PC, then repeat the entire process beginning with by creating a second database to do Moves from Source Site 1 to Destination Site 3. Alternately, if your device has enough memory to hold a database containing records for all of your Items, at all Sites, you can specify a Source value of <all> and then control Source Site and Destination Site on the mobile device (see Windows Mobile Device - Configuring Sites for more information.)
Location:

**From:** Specify `<all>` or use `<More>` from the drop list to find a specific Location at the Source Site that denotes the first in a range of Locations that will be included in the mobile database. The last 10 Locations used will be also be listed in the **From** drop list.

Specifying `<all>` will include all Locations for the specified Source Site in the mobile Database.

**To:** Specify `<all>` or click the **Hand** icon to find a specific Location at the Source Site that denotes the last in a range of Locations that will be included in the mobile database. The last 10 Locations used will also be listed in the **To** drop list.

Specifying `<all>` will include all Locations for the specified Destination Site in the mobile device Database.

A specific value can be used for **From** even though `<all>` is used for **To**:  (For example, **From:** Bin 50 used with **To:** `<all>`, would select Bin 50 through whatever the largest Bin number is.)

Similarly, a specific value can be used for **To** in combination with **From:** `<all>`.  (For example, **From:** `<all>` used with **To:** Bin 100, would select every bin up through Bin 100.)

Item Number:

**From:** Specify `<all>` or click the **Hand** icon to find a specific Item Number that will establish the first valid value in a range of Item Numbers. The last 10 Item Numbers used will be also be listed in the **From** drop list.

**To:** Specify `<all>` or click the **Hand** icon to find a specific Item Number that will establish the last valid value in a range of Item Numbers. The last 10 Item Numbers used will be also be listed in the **To** drop list.

Include Items not in a Location: This is an option that is turned on and grayed-out when no filtering is applied. When filtering is applied in one or more of the above fields, this option becomes user-controllable. It allows you to include in the mobile database Items which are not yet in a Location, in addition to those selected via the filters specified. (This can be employed when you expect to use the mobile device to Add quantity for Items that have never been inventoried before. The mobile device user can specify previously defined Locations or create new Locations while adding the previously "Location-less" Items.)
9. After you have made your filter selections, click the **Next** button. The following message appears:

![Create Database Window](image)

10. Click **Yes** to create the database. The wizard displays a confirmation message that the database has been successfully created.

![Create Mobile Database For WindowsCE](image)

11. Click the **Next** button. The **PC to Mobile Device** tab displays. Note at the bottom of the screen the wizard indicates there are two steps on this tab.

![Send Data to WindowsCE](image)
12. After checking to make sure the device is connected to your PC, click **Next**. A status bar will appear as the data is transferred. A confirmation message appears after the transfer is complete:

<table>
<thead>
<tr>
<th>Setup Mobile Device</th>
<th>Delete Mobile Database</th>
<th>PC to Mobile Device</th>
<th>Mobile Device to PC</th>
</tr>
</thead>
</table>

**Send Data to WindowsCE**

Data transfer complete. You are now ready to use InventoryControl with the mobile device.

After you are finished working with the device, you can click on the [Mobile Device to PC] tab to start retrieving the information that you’ve collected on mobile device.

13. Click **Finish** to close the **Wizard** screen.

14. On the mobile device, you will see a message similar to the following:

Click **OK** to insert the records into the mobile database. InventoryControl will start automatically on the device after the transfer.

You can now perform transactions on the mobile device.

After you have performed transactions on the mobile device, you need to send the data back to the PC.
20.8.3 Batch Windows Mobile Device - Sending the Database from the PC

As you add, change or remove data from the InventoryControl database, you will need to create and send a new database to your mobile devices. Follow the instructions below to do this.

**Note:** This applies to batch devices only. If you are using a wireless connection you will not need to retrieve information from the mobile device. Your mobile device will be connected directly to the database and any changes/additions you make on the mobile device will immediately update the database. For information about using a wireless connection, please refer to the topic [Using a Mobile Device with a Wireless Connection](#).

There are two separate procedures you must complete to successfully send data from the PC to the mobile device. You must first complete the procedure on the PC side before you can finish the procedure on the mobile device.

- **PC Procedure**
- **Mobile Device Procedure**

---

**PC Procedure**

1. On the **InventoryControl Main** screen, click the **Mobility** icon. A menu will appear allowing you to select which device you will be working with. If you have only one type, the **Mobility Menu** for that device will appear at the bottom of the screen.

2. On the **Mobility Menu**, select **Create Mobile**.

![Setup Mobile | Create Mobile | Send Data To | Get Data From | Process Mobile](image)

The **Wasp Mobile Device Communication Wizard** opens with the **Create Mobile Database** tab selected.
This tab allows you to filter the information that will be sent to the mobile device, if desired. Filtering helps save memory space on the mobile device by allowing you to select only the data you need to load onto the device as opposed to loading all available data. You can load all data, if desired.

3. Select the **Site**, **Location**, **Item Numbers**, **Customers**, **Suppliers**, **Purchase Orders** (*Pro and Enterprise Versions Only*) and **Pick Orders** (*Pro and Enterprise Versions Only*) to be downloaded to the device, then click **OK**.

Select the **Specify Filter** button if you will be limiting the data. Click the **Hand** icon to access the **Find** screen to search for data. The data you select on the **Find** screen will be entered in the text box for that section and only that data will be sent to the mobile device. Please refer to the **Searching for Information** topic for more information on the **Find** screen.

Select the **Minimally Required** checkbox to only send data that is required for normal operation. For example, if you select to send all Items, but don't want to send all locations, only those locations designated as **Primary Locations** for individual items will be sent. Or, if you don't want to send all **Suppliers**, but some **Suppliers** are entered on the **Item screen/Managing Suppliers** tab for items, only those suppliers entered on the **Item** screen will be sent.

**Tips for Filtering Information**

The default values apply no filtering to your data. All Items will be selected, including those which are not yet in a Location.

**Site:**
**Source:** Specify <all> or one of the Sites listed in the drop down list. This determines which Sites will be shown in the **Source Site** list on the mobile device.

This is the Site for all inventory transactions to be performed by the device. If you want the device's database to include Items at more than one Site, select <all>. You can only select ALL or 1 specific site. For example, if you have 5 sites, you cannot select 2 to be a Source. You can either select 1 or all.

**Destination:** If more than one Site is defined on the system and you have selected a specific Site in the **Source Site** field, you can select one of the Sites listed in the **Destination Site** drop down list. This determines which Sites will be shown in the **Destination Site** list of the mobile device **Site Configuration** function and which locations will be listed in the **Move To** list.

This field will be grayed-out with a value of <all>, as shown above, if only one Site is defined in InventoryControl or if a value of <all> has been specified for the Source Site. If a specific Site has been selected for the Source Site, that same site will be the default value for Destination Site, but you can change the Destination Site to a different value using the drop down list.

<table>
<thead>
<tr>
<th>Source Site:</th>
<th>Destination Site:</th>
<th>The Source Sites Listed in the Mobile Device Site Configuration will Include:</th>
<th>The Destination Sites Listed in the Mobile Device Site Configuration will Include:</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;all&gt;</td>
<td>&lt;all&gt;</td>
<td>All Sites</td>
<td>All Sites</td>
</tr>
<tr>
<td>A Specific Site</td>
<td>Destination Site is the Same as the Source Site</td>
<td>The Specified Source Site</td>
<td>The Same Site</td>
</tr>
<tr>
<td>A Specific Site</td>
<td>A Different Site</td>
<td>The Specified Source Site</td>
<td>The Specified Destination Site</td>
</tr>
</tbody>
</table>

⇒ As an example, if you have more than two Sites and want to be able to move inventory from Site 1 to Site 2 -and- from Site 1 to Site 3 on the mobile device, you will have to create a mobile database for Source Site 1 and Destination Site 2, transfer the database to the mobile device, use the device for those Moves, send the information back to the PC, then repeat the entire process beginning with by creating a second database to do Moves from Source Site 1 to Destination Site 3. Alternately, if your device has enough memory to hold a database containing records for all of your Items, at all Sites, you can specify a Source value of <all> and then control Source Site and Destination Site on the mobile device (see Windows Mobile Device - Configuring Sites for more information.)
Location:

**From**: Specify <all> or use <More> from the drop list to find a specific Location at the Source Site that denotes the first in a range of Locations that will be included in the mobile database. The last 10 Locations used will be also be listed in the From drop list.

Specifying <all> will include all Locations for the specified Source Site in the mobile Database.

**To**: Specify <all> or click the Hand icon to find a specific Location at the Source Site that denotes the last in a range of Locations that will be included in the mobile database. The last 10 Locations used will also be listed in the To drop list.

Specifying <all> will include all Locations for the specified Destination Site in the mobile device Database.

A specific value can be used for **From** even though <all> is used for **To**: (For example, From: Bin 50 used with To: <all>, would select Bin 50 through whatever the largest Bin number is.)

Similarly, a specific value can be used for **To** in combination with **From**: <all>. (For example, From: <all> used with To: Bin 100, would select every bin up through Bin 100.)

Item Number:

**From**: Specify <all> or click the Hand icon to find a specific Item Number that will establish the first valid value in a range of Item Numbers. The last 10 Item Numbers used will be also be listed in the From drop list.

**To**: Specify <all> or click the Hand icon to find a specific Item Number that will establish the last valid value in a range of Item Numbers. The last 10 Item Numbers used will be also be listed in the To drop list.

**Include Items not in a Location**: This is an option that is turned on and grayed-out when no filtering is applied. When filtering is applied in one or more of the above fields, this option becomes user-controllable. It allows you to include in the mobile database Items which are not yet in a Location, in addition to those selected via the filters specified. (This can be employed when you expect to use the mobile device to Add quantity for Items that have never been inventoried before. The mobile device user can specify previously defined Locations or create new Locations while adding the previously "Location-less" Items.)

4. After you have made your filter selections, click the **Next** button. The following message appears:
5. Click **Yes** to create the database. The wizard displays a confirmation message that the database has been successfully created.

6. Click the **Next** button. The **PC to Mobile Device** tab displays. Note at the bottom of the screen the wizard indicates there are two steps on this tab.

**Note:** Make sure you have the InventoryControl application closed on the mobile device before clicking **Next** on this tab. Otherwise you will receive a warning message that you need to exit the InventoryControl application on the mobile device before proceeding.
7. After checking to make sure the device is connected to your PC, click **Next**. A status bar will appear as the data is transferred. A confirmation message appears after the transfer is complete:

8. Click **Finish** to close the **Wizard** screen.

---

**Mobile Device Procedure**

On the mobile device, you will see a message similar to the following:

Click **OK** to insert the records into the mobile database. **InventoryControl** automatically starts on the device after the transfer.

See the [Mobile Device Troubleshooting](#) topic if you encounter errors while using this function.
20.8.4 Batch Windows Mobile Device - Retrieving Data from the Device

The Send Data to PC function enables you to send data from the mobile device to your PC. You will use this function after you have performed transactions (add, move, etc.) and need to send the data back to the PC.

**Note:** This applies to batch devices only. If you are using a wireless connection you will not need to retrieve information from the mobile device. Your mobile device will be connected directly to the database and any changes/additions you make on the mobile device will immediately update the database. For information about using a wireless connection, please refer to the topic Using a Mobile Device with a Wireless Connection.

Sending Data to the PC:

1. On the **InventoryControl Main Window**, click the Mobility icon. If you have more than one type of mobile device installed, a menu will appear allowing you to select which device you will be working with. If you have only one type, the Mobility Menu for that device will appear at the bottom of the screen.

2. On the Mobility Menu, select Get Data From.

   ![Wasp Mobile Device Communication Wizard](image)

   The **Wasp Mobile Device Communication Wizard** screen displays with the Mobile Device to PC tab displayed:
Make sure the device is attached to the PC, then click **Next**.

3. The data uploaded from the Windows Mobile Device is sent to an XML file.
The **Pending Uploads** screen will display to allow you to process the uploaded data in the XML file.

See the *Windows Mobile Device Troubleshooting* topic if you encounter errors while using this function.

---

**20.8.5 Batch Pending Uploads Screen**

*This function does not apply to WaspNest Inventory.*

*This screen is used when uploading a batch file from a mobile device. Users with a wireless connection will not use this screen.*

**Note:** For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select **Help > Benefits of Upgrading** on the **Main** screen.

The **Pending Uploads** screen allows you to select and validate data for upload into the InventoryControl database (on the PC). This data has previously been collected from one or more mobile devices.

**Using the Pending Uploads Screen:**

1. This screen will automatically appear after transferring data from the mobile device to the PC.

   **OR**

   From the **Mobility Menu**, click **Process Mobile**.

   ![Process Mobile](image)

   **Step 1: Upload Selection** is the first screen presented:
2. Use the **Upload Selection** screen to select one of the sets of data that has been downloaded from a mobile device. There may be several files in the list, depending on how many mobile devices you use and how often you do this step to process accumulated files.

We recommend that you always select the oldest file and process those transactions first.

The example above shows transactions uploaded from WindowsCE232 on May 31, 2007 at 19:31:30.

The device WindowsCE232 has been selected from the drop down list that displays all the mobile devices that have transferred mobile data to the PC, but have not yet been uploaded into the InventoryControl database.

3. Click **Next**.

If you had a new addition (customer, location, etc.) the New Records screen appears listing these. You can accept or reject each of them. If the new data was created in error, you can also assign an existing value to take its place.

If no new **Customers**, **Suppliers** or **Locations** were created by the mobile device User, InventoryControl will skip this step.

On occasion, you might notice that the number of new Customer, Supplier or Location records displayed here in Step 2 are less than the quantity shown in Step 1. This can happen when an existing Customer, Supplier or Location was not downloaded to the mobile device due to filtering done creating a mobile database. When the mobile device user subsequently specifies a "new" Customer, Supplier or Location while performing an inventory transaction, the "new" mobile device record gets automatically mapped to the existing PC record between Steps 1 and 2.
The New Records toolbar has the following functions:

- Select all transactions in the list for Acceptance.
- De-Select transactions in the list.
- Assign an Existing Value instead of creating a new record

When this button is clicked, a screen appears with a drop down list of existing locations from which a value can be selected. Click OK after selecting the Existing Location you want to Assign from the drop down list.

4. Click Next to continue. The Transactions screen appears:

This screen displays any pending transactions.

5. Mark the transactions you wish to Accept by clicking the checkbox. Here, we have a Receive transaction that has been Accepted. Each transaction completed on the mobile device is listed. Any errors or warnings are marked and you are allowed to accept or reject transactions or make changes to fix errors.

The Transactions toolbar has the following functions:
• ✔ Select all transactions in the list for Acceptance.

• □ De-Select transactions in the list.

• ☓ Display Error (or Warning) associated with the highlighted record.

This example shows an Add transaction that has been de-selected because there is an Error associated with it:

<table>
<thead>
<tr>
<th>Accept</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>Add</td>
</tr>
<tr>
<td>✔</td>
<td>Move</td>
</tr>
<tr>
<td>☓ ☓</td>
<td>Add</td>
</tr>
</tbody>
</table>

Click on the Display Error toolbar button to see details about this record's error.

This example shows an Add transaction that has been de-selected because there is a Warning associated with it:

<table>
<thead>
<tr>
<th>Accept</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>Add</td>
</tr>
<tr>
<td>✔</td>
<td>Move</td>
</tr>
<tr>
<td>☓ ☞</td>
<td>Audit</td>
</tr>
</tbody>
</table>

Click on the Display Error toolbar button to see details about this record's warning.

The Error or Warning message associated with the selected transaction will be displayed in the XML Process Errors screen.

Click Close to return to the Pending Transaction screen.

The Display Error toolbar button will be grayed-out when no record with an Error or Warning symbol is highlighted.

Edit Transactions allows you to make changes to the values specified at the mobile device.

6. Click Finish when you've decided which transactions to Accept and marked them appropriately.

Pending Uploads will post the Accepted transactions to the InventoryControl database and then return to the Main Window.
20.8.6 Batch Mobile Devices Pending Uploads - Edit Transactions

This function does not apply to WaspNest Inventory.

This screen is used when uploading a batch file from a mobile device. Users with a wireless connection will not use this screen.

Note: For information on the benefits of upgrading your version of InventoryControl or WaspNest Inventory, please select Help > Benefits of Upgrading on the Main screen.

The Edit Transactions screen allows you to make changes to the values specified for a transaction (add, remove, etc.) before they are added to the database. Users with a wireless connection will not use this screen.

Editing Transactions

Edit Transactions containing Kit Items

Editing Transactions:

1. From the Pending Transactions screen, click the Edit Transactions button. The Edit Transactions screen appears:
2. Make changes to the enabled fields as necessary.

3. Click **OK** to save the changes or **Cancel** to return to the **Pending Transactions** screen without making changes.

---

**Edit Transactions - Kit Items**

The steps for editing **Pick** or **Remove Transactions** containing **Kit Items** is slightly different.

1. The process is the same for uploading these transactions. If you want to edit it, on the **Step 3 - Transactions** screen, click on the component item of the Kit item you want to edit and select **Edit Transaction**.

2. The **Edit Transactions** screen shown below appears:
Change the **Quantity** or **Location**, then click the **Replace** button (or **Remove**, in the case of a **Remove** transaction).

3. The screen now shows your changes. Click **Save** on the **Edit Transactions** screen to save your changes and return to the **Step 3 - Transactions** screen.
20.9 Wireless Devices

20.9.1 Windows Mobile Device Wireless Setup

InventoryControl RF allows you to setup a wireless connection between your mobile device (if it is capable of a wireless connection) and InventoryControl. This allows you to update your InventoryControl database in real time rather than capturing data on the mobile device, then having to sync that data back to the PC (batch process). You can perform all of the basic InventoryControl functions, such as adding, removing, picking, adjusting inventory, etc. You can also print from the wireless device to any printer/label printer on your network.

Important! Make sure you have enabled wifi on your mobile device before you perform the steps listed in this topic. For help enabling wifi, please refer to the topic Windows Mobile Device - Tips for Setting Up and Using Mobile Devices (Wifi).

There are only two steps to set up your wireless device for use with InventoryControl RF. These steps are outlined below:

1. From the Main screen click the Mobility icon. The Mobility menu appears:

Select Windows Mobile/CE (Wireless). The Wasp Mobile Device Communication Wizard - Setup Mobile Device screen appears. InventoryControl will automatically try to locate and connect to any wireless devices. If a device is detected that does not already have InventoryControl RF installed, the message shown below appears:

![Information window](image)

The InventoryControl program does not exist on the mobile device.
Would you like to install it now?

Click Yes to install InventoryControl RF. A progress bar similar to the one shown below will appear:

![Progress bar](image)

During the installation process, you may see the screen shown below:
If you see this screen, click **OK** and check your mobile device. If additional steps are needed, such as a reboot of the device, instructions will be provided on your mobile device's screen.

When the installation is completed, the following message appears:

**Install Program**

The wizard has successfully installed the InventoryControl program on the mobile device.

After installation you will see the InventoryControl RF icon on the mobile device screen:
**Note:** If InventoryControl RF cannot detect the device, the screen will appear as shown below:

Click **Search for Device** to enable InventoryControl to search for your mobile device.

Click **Next** to continue.

2. The next screen is the **Windows CE Printing Setup** screen (shown below). This screen allows you to enable printing from your wireless device.
First, select Yes or No under the question "Do you plan to print from the mobile device?". If you select No, the Finish button will become enabled. Click Finish to complete the setup process. If you select Yes, select one of the following options:

Yes, I will be printing from a network printer - select this option if you will be printing to a printer on your network. You do not need to do anything else to enable printing. Click Finish to complete the setup process.

If you will be printing from network printer, you will need to manually enable InventoryControlRF to locate your printer. For instructions on how to do this, please refer to the section Enabling InventoryControl RF to Communicate with your Network Printer, below.

OR

Yes, I will be printing with a Laser Mobile Printer - select this option if you will be printing to a laser mobile printer. You will need to enter a COM Port and Baud Rate for this printer. Click Finish to complete the setup process.

OR

Yes, I will be printing with a Receipt Mobile Printer - select this option if you will be printing to a receipt mobile printer. You will need to enter a COM Port and Baud Rate for this printer. Click Finish to complete the setup process.

20.9.2 Enabling InventoryControl RF to Communicate with your Network Printer

2. On the Services screen scroll to **Wasp Inventory Windows Service**. Right-click on **Wasp Inventory Windows Service** and select **Properties**.

3. On the Properties screen, select the Log On tab.
4. Select the "This account" checkbox and then the Browse button.

5. Enter the printer name in the box provided, then click the Check Names button.
6. Click **OK**.

7. On the Log On tab, enter the password and confirmed password, then click **Apply**.

8. Click the **Apply** button.

9. A confirmation message similar to the following will appear:

   "The account .\<account name> has been granted the Log On As A Service right."

   Click **OK** on this message.

10. A message similar to the following will appear:

    "The new logon name will not take effect until you stop and restart the service."
11. Click **OK** again to close out of the screen.

12. On the **Services** screen, right-click **Wasp Inventory Windows Services** and select **Stop**, then right-click again and select **Start**.

Now you will be able to choose which network printer you want to use on the **Mobile Devices Wizard > Windows CE Printing Setup** screen.
20.10 Tips for Setting Up and Using Windows Mobile Devices

This section describes errors that may occur when setting up a wireless connection, printing to a bluetooth printer and tips for getting various Wasp supported mobile devices up and running. The information in this topic will help get you up and running with InventoryControl and InventoryControl RF on your wireless device. For help with your device that is not related to InventoryControl or InventoryControl RF, keep in mind that detailed instructions specific to your device can be found in the device manual.

The devices below are discussed in this section:

WDT3200 and WDT3250II
WPA1000 and WPA1000II
WDT1200, 1250, 1200II, 1250II
Other Devices

20.10.1 WDT3200, 3200II, 3250 and 3250II Tips

TIPS:

Enabling Bluetooth

Setting up the 3200 and 3250II to Print to a Bluetooth Printer

Setting up the 3200II to Print to a Bluetooth Printer

ERRORS:

Bluetooth Locks Up

Error Message: System.Net.Sockets.Socket Exception: An error message is available for the exception but cannot be displayed because these messages are optional and are not currently installed on this device. Please install .NETCFv35.Messages.EN.wm.cab to Windows Mobile.

Tip: Enabling Bluetooth

Navigate to: Start > Programs > Bluetooth > Bluetooth Power On
Tip: Setting up the 3200 and 3250II to Print to a Bluetooth Printer

1. Navigate to Start > Programs > Bluetooth > Bluetooth PowerON.
2. Select Bluetooth Module Power ON > OK.
3. Navigate to Start > Programs > Bluetooth > Bluetooth Printer.
4. Select the black and white icon that displays at the bottom, left of the mobile device screen.
5. Make sure your bluetooth printer is on, then select Inquiry on the mobile device.
6. When your bluetooth printer shows in the list, select it, then select OK.
7. A popup screen appears prompting for your pin number. Enter your pin number and select OK.
8. Select your printer, then select OK.
9. A popup screen appears prompting you to select a channel. Enter 7, then OK.

Now your mobile device is ready to print to your bluetooth printer. To verify, click the bottom icon again. The status should display "<your printer id> Running on COM7".

Tip: Setting up the 3200II to Print to a Bluetooth Printer:

1. Enable Bluetooth on the WDT3200II by navigating to Start > Programs > Bluetooth > Bluetooth PowerON.
2. Navigate to Start > Settings > Control Panel > Bluetooth Device. (Make sure your bluetooth printer is turned on.)
3. Click the Scan Device button on the WDT3200II. Your Bluetooth printer should show in the list of found devices.
4. At the prompt, enter the pin number for your Bluetooth printer.
5. Double click the device name with the printer icon in front of it. Select Trusted from the drop down and enter the pin number again.
6. From the same drop down menu, select Active.
7. To find the COM port for the printer (varies per mobile device), navigate to Start > Programs > Windows Explore. Double click on the Windows folder.
8. Select Details from top, right drop down. Scroll to file: BTMAN, double click it and select the Scan Device tab.
9. Double click the Bluetooth printer. From the resulting drop down menu, select Serial Port. The COM port selected for the device will display along with the Baud Rate.

Error: "System.Net.Sockets.Socket Exception: An error message is available for the exception but cannot be displayed because these messages are optional and are not currently installed on this device. Please install .NETCFv35.Messages.EN.wm.cab to Windows Mobile."

This is a connection error meaning the device cannot find the network. To enable the device to locate the network, perform the following steps:

1. On the mobile device, navigate to Start > Settings > Control Panel.


3. On the Main tab (the first tab on the screen), select the Admin Login button.

4. Enter your password in the password field. On the Profile tab the Configure button at bottom will become enabled after you login as Admin.

5. Select the Scan button and your network should appear.
   a. Select your network and click the Configure button.
   b. Click the OK button. The PSK password prompt appears.
   c. Enter your network password.
   d. Select the Commit button.

If your network does not appear:

   a. Click New.
   b. Type in your network name.
   c. Select Encryption Type: WPA2-PSK.
   d. Click WEP keys/PSKs.
   e. Enter your network password.
   f. Select the Commit button.
6. On the **Main** tab, select your network from the **Active Profile** list.

7. Click **OK**. The RF is now enabled.

---

**Error: Bluetooth Locks Up:**

Your Bluetooth connection may become frozen if you have manually enabled Bluetooth (Start > Programs > Bluetooth > Bluetooth Power On), then selected **SCAN** twice. When Bluetooth locks up, you will not be able to open a connection from Start > Settings > Control Panel > Bluetooth or from Start > Programs > Bluetooth > Bluetooth Manager. If your Bluetooth connection becomes frozen, follow the steps below:

Insert a pin or a paperclip in the reset button located on the front of the WDT3250II. This causes a warm boot of the mobile device. Now **Bluetooth > Bluetooth Manager** will open.

---

**20.10.2 WPA1000 and WPA1000II Tips**

**TIPS:**

- Setting up a Wireless Connection
- Enabling Bluetooth and Printing to a Local Printer

**ERRORS:**

- Mobile Device Locks Up
- Receiving Connection Error When Trying to Access InventoryControl RF

**Tip: Setting up a Wireless Connection**

To enable and set up wireless capabilities on the WPA1000 device, perform the following steps:

1. If your WPA1000 device is plugged into a computer, unplug it. You cannot set up WiFi with the device plugged into a computer.

2. Close all applications on the WPA1000.

3. On the **Main** screen, in the far-right, lower-corner, to the right of the keyboard icon, there is another icon that may be partially hidden as shown in the graphic below:
Click that icon and make sure "Enable wifi card" is selected.

4. Navigate to **Start > Settings > Connections tab > Wireless Manager**.
5. At the bottom of the **Wireless Manager** screen click **Menu > Wifi**.

6. On the WiFi screen, click **Connect**.

7. The **Network Name and Internet** screen appears. Select **Next**.

8. A screen appears displaying **Authentication: WPA2-PSK** and **Data Encryption: AES**. Enter your **Network Key** and click **Next**.

9. Click **Finish** and then **OK**.

10. Select the **COM Ports** tab from the bottom of the screen.

11. On the **COM Ports** tab, select **New Outgoing Port**.

12. Highlight your bluetooth printer in the list and select **Next**.

13. Select **COM 7** and **Secure Connection**.

---

**Tip: Setting up Bluetooth and Printing to a Local Printer**

*Make sure your Bluetooth printer is turned on and ready to connect before proceeding.*

1. Navigate to **Start > Settings > Connections tab > Wireless Manager**.
2. On the **Wireless Manager** screen, make sure Bluetooth is listed as turned **ON**.
3. At bottom of the **Wireless Manager** screen, click **Menu**, then **Bluetooth Settings**.

4. On the **Settings** screen, click on the **Devices** tab.

5. Click **Add** new device. The WPA1000 will search for other Bluetooth devices and display them on the screen.
6. Click on your printer in the resulting list, then click Next.

7. Enter your Network Password in the Passcode field, then click Next.

8. Select the Serial Port for the printer and then select Finish.
Error: Mobile device locks up

If your WPA1000 locks up (no keys work, etc.), perform the following steps:

1. Take the battery out of the mobile device.
2. Insert a pin or a paperclip in the reset button located on the back of the device.
3. While holding the pin in the reset button, put the battery back into the device.

Error: Receiving Connection Error when trying to access InventoryControl RF

Make sure you allow time for the device to connect to your wireless network before you attempt to login to InventoryControl RF.

1. After sending InventoryControlRF to the WPA1000, disconnect the cable from the computer (if it is connected).

2. Return to the desktop on your mobile device (close all programs). Directly below the date, the screen should display WiFi:<status>. The status will change from "Not Connected" to "Connecting..." to network name. When it is connected, the screen will display WiFi: <your network name>.

Note: If your screen does not display WiFi <status>, make sure you have enabled wifi on this device.

3. Now you can log into InventoryControl RF from Start > Programs > InventoryControlRF or by clicking the icon on your desktop.

20.10.3 WDT1200, 1250, 1200II and 1250II

Tip: WPA1200II Connectivity Status to Bluetooth Printer

Please note that the Bluetooth connection status may display Not Connect or Disconnected anytime you are not actively printing. When you print, the connection will automatically change to Connected.

20.10.4 Other Devices

For devices not supported by Wasp Barcode Technologies, please refer to the device manual for information on enabling WIFI.
20.11 Using InventoryControl and InventoryControl RF

20.11.1 Windows Mobile Device - About Screen

The About screen displays basic information about the version of InventoryControl installed on your device.

Viewing the About Screen:

To open the About screen, select Help > About.

The About screen displays:

Information on this screen includes:

- Application title (InventoryControl or InventoryControlRF)
- Version number and build number
- Setting for the Allow Negative Numbers on the Mobile Device option. This option is set on the Options screen in the PC version of InventoryControl. For more information on this option, please refer to the Options Screen topic.

Note: Negative quantities are NOT allowed on a wireless connection regardless of the settings on the Options screen.

- Source Site and Destination Site. These are the sites and locations to which the mobile device will default when moving, adding, etc. inventory. These are set on the PC. For more information on
setting the Source and Destination Sites, please refer to the Selecting Sites topic.

Note: Setting Source and Destination sites is NOT available on a wireless connection.

- Copyright information
- The Wasp Barcode website address.

20.11.2 Windows Mobile Device - Site Configuration

InventoryControl provides a time-saving feature for companies who use the same two Sites for all inventory transactions on the mobile device. On the Site Configuration screen, you can set up your device to automatically include these Sites in the appropriate fields in InventoryControl.

Configuring Site:

1. To access the Site Configuration screen, select Tools > Site Configuration.

The Site Configuration screen displays.

You can enter the data by scanning, using the device's key pad, or using the device's keyboard. Click here for more information about entering data.

2. Enter the Source Site. The Source Site field is used as the default for Add, Remove, Move (from), Adjust and Details fields.
3. Enter the **Destination Site**. The **Dest Site** field is used as the default for Move (to).

4. Tap **OK**.

After you have configured the Sites, you will see that the appropriate fields are pre-populated with the selected sites in all the device's **InventoryControl** screens.

---

### 20.11.3 Windows Mobile Device - Pinning Fields

"Pinning" can be used to lock values you have entered in any field. Pinning enables you to enter repeated information rapidly without having to re-enter repetitive data. After a field is pinned, you can manually enter data, or you can use a scanner to rapidly Add, Remove, Move, Adjust, etc. by repeatedly scanning barcodes.

For example, if you need to add the same inventory Item Number multiple times, you can pin the **Item #** field and perform continuous Adds without having to re-enter the Item Number for each Add.

**Note:** Before pinning a field, make sure the data you want pinned in the field is entered. Once you pin the field, you cannot change the data entered in the field until the field is unpinned.

Remember that once you close a screen, the field will no longer be pinned when you re-open that screen.

**Pinning Fields:**

To pin a field, tap the field name.

![Add screen with fields](image)

The entire field turns grey. This indicates the field is now pinned. Whatever information that has been entered in this field will remain until the screen is closed.

**Unpinning Fields:**

To unpin the field, click the field name again. The field will no longer be grey, and you may now change the information in the field.
20.11.4 Windows Mobile Device - Adding New Customers

You can add new Customers in InventoryControl on the Windows Mobile Device only in the Remove screen.

The new Customer will not be added unless the data for all other fields is completed correctly and the inventory is successfully removed.

Adding a Customer on the Remove Screen:

In this example, a new Customer will be added and an Item will be removed.

1. On the Remove screen, enter the data for the Item you want to remove.
2. In the Customer field, enter the new Customer you want to add.

3. Click OK. The message below appears:
4. Click Yes.

   The fields are now reset in the Remove screen.

5. If no errors display, this indicates that both the removal of the Item and the addition of the Customer were successful. To check, tap the Search icon next to the Customer field.

6. The Search Customers screen displays, and the Customer you added displays in the Customer list.

See the Mobile Device Troubleshooting topic if you encounter errors while using this function.

---

20.11.5 Windows Mobile Device - Adding a New Location

You can add new Locations in InventoryControl on the mobile device. However, you cannot add new Sites. New Locations can be added in the Add, Remove, Move, Adjust, Pick (Pro and Enterprise Versions Only) and Receive (Pro and Enterprise Versions Only) screens on the mobile device.

Notes:

- You can only add a new Location if the Allow Negative Quantities on the Mobile Device option is enabled on the Options screen (on the PC). For more information on this option, please refer to the Options Screen topic.

- The new Location will not be added unless the data for all other fields is completed correctly and the function (Add, Remove, Move, etc.) is successfully completed.

Adding a New Location:

In this example, a new Location - Location 4 - will be added in the Add screen. The steps are the same for the Remove, Move, Adjust and Receive (Pro and Enterprise Versions Only) screens.

1. On the Add screen, enter the data for the Item you want to add.

2. In the Location field, enter the new Location you want to add.
3. Click OK. The following message displays.

![InventoryControl dialog box showing option to add a new location]

4. Click Yes. The fields are now reset in the Add screen.

If no errors display, this indicates that both the addition of the Location and the Item were successful.

5. To verify that the addition was successful, enter the Site with which the Location you added is associated, then tap the Search icon next to the Location field.

6. The Search Locations screen displays, and the Location you added displays in the Location list.

![Search Locations dialog box with a list of locations]

See the Mobile Device Troubleshooting topic if you encounter errors while using this function.
20.11.6 Windows Mobile Device - Adding New Suppliers

You can add new Suppliers in InventoryControl on the Windows Mobile Device. New Suppliers can only be added in the Add screen.

Notes:

- You will only be able to add a Supplier for an Item that is tracked by supplier.
- The new Supplier will not be added unless the data for all other fields is completed correctly and the Add is successfully completed.

Adding New Suppliers:

In this example, a new Supplier will be added to the database while an Item is added.

1. On the Add screen, enter the data for the Item you want to add.
2. In the Supplier field, enter the new Supplier you want to add.
3. Click OK. The following message displays.
4. Click **Yes**. The Item and the new Supplier are added, and the fields are now reset in the **Add** screen.

If no errors display, this indicates that both the addition of the **Supplier** and the **Item** were successful.

5. To verify the supplier was added, tap the **Search** icon next to the **Supplier** field.

The **Search Suppliers** screen displays, and the Supplier you added displays in the **Supplier #** list.

See the **Mobile Device Troubleshooting** topic if you encounter errors while using this function.

---

**20.11.7 Windows Mobile Device - Adding Inventory**

The **Add** inventory function is used to add quantity to any item setup in the database.

Inventory can also be added at the PC. See the **Adding Inventory** and **Importing into the Database** topics for more information.

**Adding Inventory:**

1. From the **Main Menu**, click the **Add** icon. The **Add** screen displays.

![Add Screen](image)

**Note:** On the **Add** screen, you can enter characters manually, scan in data (see **Entering Alphanumeric Data on the Windows Mobile Device** for details) or use the Search function.
2. Enter the number of the item to which you want to add inventory in the **Item #** field.

<table>
<thead>
<tr>
<th>Add</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item #: 1001</td>
</tr>
<tr>
<td>Site:</td>
</tr>
<tr>
<td>Location:</td>
</tr>
<tr>
<td>PO:</td>
</tr>
<tr>
<td>Supplier:</td>
</tr>
<tr>
<td>Qty:</td>
</tr>
</tbody>
</table>

In the example above, one Item (1001) is being added to Site 2, Location 1.

After the Item Number is entered, the **Add** screen displays only the fields that are necessary for adding this particular Item. For example, if you enter an Item that is tracked by serial number, the **Serial No** field will remain on the screen, but other fields such as **Date Code** and **Pallet** will no longer display. **Exception:** The PO and Supplier fields will always display in the **Add** screen, even if the Item you entered is not tracked by these fields.

3. Enter the **Site** and **Location** to which the Item is to be added.

<table>
<thead>
<tr>
<th>Add</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item #: 1001</td>
</tr>
<tr>
<td>Site: Site 2</td>
</tr>
<tr>
<td>Location: Location 1</td>
</tr>
<tr>
<td>PO:</td>
</tr>
<tr>
<td>Supplier:</td>
</tr>
<tr>
<td>Qty:</td>
</tr>
</tbody>
</table>
4. Enter the **Quantity** of the Item to be added.

![Add Screen](image)

**Add**

- Item #: 1001
- Site: Site 2
- Location: Location 1
- PO: 
- Supplier: 
- Qty: 1

**Note:** If the Item Number you are adding is tracked by serial number, the quantity (Qty field) must be 1.

5. When all required information is entered, tap **OK**. The Item is added and the **Add** screen resets, ready for the next Item to be added.

   Tapping the **Reset** button clears all fields and restores all available fields to the **Add** screen display.

6. When you are finished with the **Add** screen, tap **Close** to return to **InventoryControl** main menu.

See the **Mobile Device Troubleshooting** topic if you encounter errors while using this function.

**Tips for Speeding Up Data Entry:**

- When you create a new item, if the Category, Manufacturer, UOM or any combination of pinnable fields will be used on a large number of items, create one item with those fields, then pin the fields. Now, the information will be retained in those fields so you don't have to keep re-entering it for each new item.
20.11.8 Windows Mobile Device - Details Screen

The Details screen is used to display Location and Quantity information for any Item in the mobile database for the Site selected. You can also view transactions on this screen.

Details is an abbreviated version of the functionality available in the PC's Inventory and Transactions Lists.

To View Details:

1. From the Main Menu, tap Details. The Details screen appears.

![Details Screen Image]

Note: You can enter characters manually, scan in data (see Entering Alphanumeric Data on the Windows Mobile Device for details) or use the Search function.

2. This screen consists of two sections: Filter and Search Results. The Filter section is expanded by default. To open or close a section, click on the blue arrow that precedes the section name.

If the arrow is pointing down, that section is expanded, as the Filter section is in the Details screen example, above.

If the arrow is pointing right, that section is collapsed, as the Search Results section is in the Details screen example, above.

Select the data you want to view by entering Filter information, then tapping the Inventory or Transactions buttons. Keep in mind that after you enter an item number, the fields on the screen may change. For instance, if you enter an item number that is tracked only by Serial Number, Lot, Date Code and Pallet fields will disappear because you do not need to information in those fields for this particular item.
If you want to view all Inventory or all Transaction in the database, click the Inventory or Transactions button without entering any filter information. Transactions displays all events that have been performed on this device since the last sync. Transactions can be used to verify if certain actions have been completed or to check that counts are correct.

Inventory can be used to locate items, check quantity or determine where to move an item.

The Search Results section automatically expands displaying the requested data:

<table>
<thead>
<tr>
<th>Item #</th>
<th>Desc</th>
<th>Site</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>Example...</td>
<td>Site 1</td>
</tr>
<tr>
<td>1001</td>
<td>Another E...</td>
<td>Site 1</td>
</tr>
</tbody>
</table>

You can view details for only one field, or for a combination of fields. For example, if you select only an Item Number and leave all other fields blank, the Details screen will display the total quantity of the Item Number in all Sites and Locations. If you select an Item Number and a specific Site, the Details screen will display the quantity of that Item at the specified Site only.

You can scroll right to left through the data using the bar at the bottom of the results grid.

3. You can expand the Filter section again by tapping the blue arrow or by clicking the Show Filter button. Enter new Filter information, then click Inventory or Transactions to view the search results.

To clear the fields and find details for another Item, select the Reset button.

4. To close the Details screen and return to the InventoryControl main menu, click the Close button.

See the Mobile Device Troubleshooting topic if you encounter errors while using this function.
20.11.9 Windows Mobile Device - Checking Out Inventory

The Check-Out screen allows you to check-out, or assign, inventory to customers for a specified length of time. Checking out inventory decreases the quantity of that item that you have on-hand, but does not remove the inventory from your database (since it is assumed the inventory will be checked back in). The check-out function is useful if you lease equipment to customers or have a need to temporarily loan-out inventory.

You can only check-out inventory that has been added. This means that when you create an item, you must add inventory (quantity) to it before you can check out that item to a customer. Remember that inventory is the amount or quantity of an item. You can add inventory to an item either on the Add Inventory screen or by Receiving inventory.

To Check Out Inventory:

1. From the Main menu, click the Check Out icon. The Check Out screen appears:

   ![Check-Out Screen](image)

   **Note:** You can enter characters manually, scan in data (see Entering Alphanumeric Data on the Window Mobile Device for details) or use the Search function.

2. Enter the Customer to whom this piece of inventory will be checked out. Click the i icon to search for a customer.

3. Enter the Item # you want to check out. Click the i icon to search for a item.

4. Enter the Site and Location of the item you want to check out. Click the i icon to search for a site or location.

5. Enter the Quantity you want to check out. You cannot check out more than you have available in stock.

6. Select the due date for this item from the drop down menu. You can choose the Default date (today's date), No Due Date or Custom (select your own due date). Below is an example of the
Due Date drop down menu:

7. If you are printing receipts, enter the number of receipts you want to print.

8. Click OK to check out the selected item.

20.11.10 Windows Mobile Device - Checking In Inventory

The Check-In screen allows you to Check-In inventory that has previously been Checked-Out to one or more customers. While checking in inventory does not actually add inventory (quantity) to an item, it does free up that inventory to be checked-out to another customer or to be included in a pick order.

You can only check-out inventory that has been added. This means that when you create an item, you must add inventory (quantity) to it before you can check out that item to a customer. Remember that inventory is the amount or quantity of an item. You can add inventory to an item either on the Add Inventory screen or by Receiving inventory.

To Check In Inventory:

1. From the Main menu, Click the Check In icon. The Check In screen appears:

```
Note: You can enter characters manually, scan in data (see Entering Alphanumeric Data on
```
the Window Mobile Device for details) or use the Search function.

1. Enter the Item # you want to check in. Click the i icon to search for a item.

2. Enter the Customer to whom this piece of inventory was checked out. Click the i icon to search for a customer.

3. Enter the Site and Location into which you want to check in this item. Click the i icon to search for a site or location.

4. Enter any track bys you have set up for this item.

5. Enter the Quantity you want to check in. You cannot check in more than you have checked out to the selected customer.

6. If you are printing receipts, enter the number of receipts you want to print.

7. Click OK to check out the selected item.

---

20.11.11 Windows Mobile Device - Moving Inventory

The Move function is used to move inventory quantity from one Location to another. This allows you to move inventory quantity for an item from one Location to another. When you create an item, you can add which locations it may be. When you then add inventory (quantity) to the item, you select in which location that quantity will reside. The Move function allows you to move that inventory from the originally assigned location to another. By moving inventory in the software, you can easily keep accurate records of where all of your inventory is currently located.

If the Allow Negative Quantities on Mobile Devices option is enabled on the Options screen, you can also move more quantity than is available at the source Location. For more information on this option, please refer to the Options Screen topic.

When moving an Item, the From Site and the To Site must be different. For example, you cannot move an Item from Site 100, Location 13 to Site 100, Location 13.

Inventory can also be moved at the PC. See the Moving Inventory topic for more information.

Moving Inventory:

1. From the Main Menu, tap the Move icon. The Move screen displays.
2. In this example, a quantity of Item (1001) is being moved from Site 1, Location 2 to Site 2, Location 3.

Enter the Item Number in the Item field.

Note that once the Item Number is selected, the Move screen displays only the fields that are necessary for adding this particular Item. For example, if you enter an Item that is tracked by serial number, the Serial # field will remain on the screen, but other fields such as Date Code...
and Pallet will no longer display. If you enter an Item that is not tracked, all tracking fields - PO, Supplier, Lot, Date Code, Serial # and Pallet - will no longer display.

3. Enter the Site and Location from which the Item will be moved.

4. Enter the Site and Location to which the Item will be moved.

5. Indicate the Quantity of the Item that will be moved.
6. When all required information is entered, tap **OK**.

The Item is moved and the Move screen resets, ready for the next Item to be moved.

Tapping the **Reset** button clears all fields and restores all available fields to the Move screen display.

7. When you are finished with the Move screen, tap **Close** to return to the **InventoryControl** main menu.

See the **Windows Mobile Device Troubleshooting** topic if you encounter errors while using this function.

---

**20.11.12 Windows Mobile Device - Removing Inventory**

The **Remove** function is used to remove quantity from any Item that has quantity recorded in the database. **Inventory** is the amount or quantity of a particular item.

**Notes regarding the Allow Negative Quantities option:**

- If this option is enabled (on the PC’s **Options Screen**), you can enter a **Quantity** larger than the actual amount currently shown in the mobile database for that inventory Item. If the option is not enabled, you will **not** be allowed to enter a **Quantity** larger than the amount shown in the database.

- The **Allow Negative Quantities** option also must be enabled before you can add a new Location in this screen. If the **Allow Negative Quantities on Mobile Devices** option is disabled, you will see a warning message if you attempt to Remove quantity from a Location that does not exist in the PDT database. The Allow Negative option must be set on the PC prior to creating the database. You can check the state of this option on the PDT by using the **7** key on the Main Menu to go to the PDT **About** screen.
New Locations can only be created during Remove when the Allow Negative Quantities on Mobile Devices option is enabled. If you are prompted to confirm a new Location that you believe should already exist in the database, press ESC to cancel, then return to the Main Menu to check Site Config. If the Location you entered exists only at a Site other than the currently selected Source Site, InventoryControl must treat that value as a new Location for the Source Site. Select a different Source Site in Site Config if that’s where you intended to perform this transaction.

The Allow Negative Quantities option applies to batch devices only. Mobile devices that are communicating with the database via a wireless connection will not allow negative quantity transactions regardless of the option settings.

- For more information on this option, please refer to the Options Screen topic.

Inventory can also be removed at the PC. See the Removing Inventory topic for more information.

Removing Inventory:

1. From the Main Menu, tap the Remove icon. The Remove screen appears.

You can enter characters manually, scan in data (see Entering Alphanumeric Data on the Windows Mobile Device for details) or use the Search function.

In this example, Mouse 1001 is being removed from Site 1, Location 2.
2. Enter the Item Number to be removed in the Item field.

Note that once the Item Number is selected, the Remove screen displays only the fields that are necessary for adding this particular Item. For example, if you enter an Item that is tracked by serial number, the Serial # field will remain on the screen, but other fields such as Date Code and Pallet will no longer display. If you enter an Item that is not tracked, all tracking fields - PO, Supplier, Lot, Date Code, Serial # and Pallet - will no longer display.

3. Enter the Site and Location from which this Item should be removed.
4. Optionally enter a Customer.

5. Enter the Quantity of the Item to be removed.

6. When all required information is entered, tap OK. The Item is removed and the Remove screen resets, ready for the next Item to be removed.

   Tapping the Reset button clears all fields and restores all available fields to the Remove screen display.

7. When you are finished with the Remove screen, tap Close to return to the InventoryControl main menu.

   See the Windows Mobile Device Troubleshooting topic if you encounter errors while using this function.
20.11.13 Windows Mobile Device - Removing a Kit Item

This function applies to Pro and Enterprise Version users only.

The Remove Kit function allows you to remove a kit item, which means removing quantity from the component items from your database. This can be considered the same as shipping inventory. You can designate which customer this inventory was shipped to on this screen.

Kit Items can also be removed at the PC. See the Removing Kit Items topic for more information.

Note: If the Allow Negative Quantities on Mobile Devices option is disabled, you will see a warning message if you attempt to Remove quantity from a Location that does not exist in the PDT database. The Allow Negative option must be set on the PC prior to creating the database. You can check the state of this option on the PDT by using the 7 key on the Main Menu to go to the PDT About screen.

New Locations can only be created during Remove when the Allow Negative Quantities on Mobile Devices option is enabled. If you are prompted to confirm a new Location that you believe should already exist in the database, press ESC to cancel, then return to the Main Menu to check Site Config. If the Location you entered exists only at a Site other than the currently selected Source Site, InventoryControl must treat that value as a new Location for the Source Site. Select a different Source Site in Site Config if that's where you intended to perform this transaction.

The Allow Negative Quantities option applies to batch devices only. Mobile devices that are communicating with the database via a wireless connection will not allow negative quantity transactions regardless of the option settings.

Removing Kit Items:

1. From the Main Menu, tap the Remove icon. The Remove screen appears.

You can enter characters manually, scan in data (see Entering Alphanumeric Data for details) or
use the Search function.

2. Enter the Item number you want to remove in the Item # field, or tap the i icon to access the Find screen. Please refer to the Search Function topic for information on using the Find screen.

The Remove screen changes when a Kit item is selected:

3. You can optionally enter a customer number or search for a customer.

4. Enter the quantity you want to remove and click OK. The quantity is the number of Kits you want to remove. The Remove Kit screen appears.
5. Enter the **Item #** of the component item, or tap the **i** icon to view the Kit Info screen. Only items contained in this Kit will appear.

The **Kit Info** screen displays all component items for this Kit item.

The **Item #** is the item number of the component item.

The **Total Qty** is the total quantity of this item in this kit multiplied by the quantity you want to
remove. If there are 5 items in the kit and you have indicated you want to remove 12, 60 will display here (5 x 12 = 60). If there are 10 items in the kit and you want to remove 12, 120 will display here (10 x 12 = 120).

**Undo** will "undo" all of the transactions for that component item and reset the quantity processed back to zero.

Doubleclick on the desired item. The **Remove Kit** screen will reappear with the selected item populated in the **Item #** field.

6. Enter the **Site**, **Location** and any **Track Bys** for this item.

7. Enter the **Quantity** you want to remove.

8. Click **OK** to remove the item. Now you can select another component item to remove.

---

### 20.11.14 Windows Mobile Device - Receiving Inventory

The **Receive** inventory function is used to add quantity to an item from a purchase order. Purchase Orders are created on the PC. For more information on creating Purchase Orders, please refer to the [Creating a Purchase Order](#) topic.

Inventory can also be received at the PC. **Manual** items cannot be received on the mobile devices. Please refer to [Creating a Purchase Order](#) for more information on **Manual** items.

**Receiving Inventory on the Windows Mobile Device:**

1. From the **Main Menu**, tap the **Receive** icon. The **Receive** screen displays.

![Receive Screen](image)

**Note:** On the **Receive** screen, you can enter characters manually, scan in data (see **Entering**
Alphanumeric Data on the Windows Mobile Device for details) or use the Search function.

2. Enter or search for the PO number that contains the item you are receiving.

   ![Receive Form]

3. Enter the number of the item you are receiving in the Item # field.

   ![Receive Form]

In the example above, Item 1002 is being received.

The Details section displays the shipping unit of measure, how many of the item is contained in the shipping unit of measure (eaches) and the cost information. Cost only displays if the Show
**Costing Information During Receive** option is enabled on the PC Options screen. For more information on this option, please refer to the Options Screen topic.

You can expand the Details section by tapping the blue arrow next to word Details. If there is more than one possible order unit, the Details section will open automatically and you must pick one of the UOM entries to receive. An example of the expanded section is shown below:

In this example, each box contains 10 items and costs 10 per item ($100.00 per box).

4. Enter the **Site** and **Location** into which the Item is to be received.
5. Enter the Quantity of the Item to be received. Keep in mind that you should enter the Order Unit of measure here. For instance, if you are receive 1 box of 10, enter 1 rather than 10. InventoryControl will do the math behind the scenes and break the shipment down to 10 for you.

![Receive Screen]

**Note:** If this item were tracked by serial number, the quantity would be entered in eaches since you can only have 1 item per serial number.

If you enter a quantity that is higher than the quantity entered on the Purchase Order, a warning will appear. You can continue with the higher quantity if you so choose.

6. When all required information is entered, tap **OK**. The Item(s) is marked as Received and the **Receive** screen resets, ready for the next Item to be received.

   Tapping the **Reset** button clears all fields and restores all available fields to the **Receive** screen display.

7. When you are finished with the **Add** screen, tap **Close** to return to **InventoryControl** main menu.

See the [Windows Mobile Device Troubleshooting](#) topic if you encounter errors while using this function.
The **Pick** inventory function is used to remove quantity from an item as it is added to a pick order. Pick Orders are created on the PC when an order comes in from a customer. For more information on creating Pick Orders, please refer to the [Creating a Pick Order](#) topic.

Inventory can also be picked at the PC. **Manual** items cannot be picked on the mobile devices. Please refer to [Creating a Pick Order](#) for more information on **Manual** items.

**Note:** If the **Allow Negative Quantities on Mobile Devices** option is disabled, you will see a warning message if you attempt to Pick quantity from a Location that does not exist in the PDT database. The Allow Negative option must be set on the PC prior to creating the database. You can check the state of this option on the PDT by using the 7 key on the Main Menu to go to the PDT **About** screen.

New **Locations** can only be created during Pick when the **Allow Negative Quantities on Mobile Devices** option is enabled. If you are prompted to confirm a new **Location** that you believe should already exist in the database, press **ESC** to cancel, then return to the Main Menu to check **Site Config**. If the **Location** you entered exists only at a **Site** other than the currently selected Source Site, InventoryControl must treat that value as a new **Location** for the Source Site. Select a different Source Site in Site Config if that's where you intended to perform this transaction.

The **Allow Negative Quantities** option applies to batch devices only. Mobile devices that are communicating with the database via a wireless connection will not allow negative quantity transactions regardless of the option settings.

**Picking Inventory on the Windows Mobile Device:**

1. From the **Main Menu**, tap the **Pick** icon. The **Pick** screen displays.

   ![Pick Screen](image)

   **Note:** On the **Pick** screen, you can enter characters manually, scan in data (see [Entering Alphanumeric Data on the Windows Mobile Device](#) for details) or use the Search function.
2. Enter or search for the **Order #** that contains the item you are picking.

<table>
<thead>
<tr>
<th>Pick</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order #:</td>
</tr>
<tr>
<td>Item #:</td>
</tr>
<tr>
<td>Site:</td>
</tr>
<tr>
<td>Location:</td>
</tr>
<tr>
<td>Date Code:</td>
</tr>
<tr>
<td>Pallet:</td>
</tr>
<tr>
<td>Lot:</td>
</tr>
<tr>
<td>Serial #:</td>
</tr>
<tr>
<td>Quantity:</td>
</tr>
</tbody>
</table>

3. Enter the number of the item you are picking in the **Item #** field.

<table>
<thead>
<tr>
<th>Pick</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order #:</td>
</tr>
<tr>
<td>Item #:</td>
</tr>
<tr>
<td>Site:</td>
</tr>
<tr>
<td>Location:</td>
</tr>
<tr>
<td>EA.Qty:</td>
</tr>
</tbody>
</table>

In the example above, one Item 1001 is being picked.

4. Enter the **Site** and **Location** from which the item is being picked. If you have selected a **Primary Location** for this item (on the Add/Edit Item screen) the Site and Location fields will automatically populate. You can change these fields if needed.
5. Enter the Quantity of the Item to be picked. If you enter a higher quantity than is indicated on the Pick Order, a warning will appear, but you will be allowed to enter the higher quantity.

**Note:** Notice that this is in eaches.

6. When all required information is entered, tap OK. The Item(s) is marked as Received and the **Receive** screen resets, ready for the next Item to be received.

Tapping the **Reset** button clears all fields and restores all available fields to the **Receive** screen display.
7. When you are finished with the Add screen, tap Close to return to InventoryControl main menu.

See the Windows Mobile Device Troubleshooting topic if you encounter errors while using this function.

20.11.16 Windows Mobile Device - Picking Kit Items

The Pick inventory function is used to remove quantity from an item as it is added to a pick order. Pick Orders are created on the PC when an order comes in from a customer requesting inventory. For more information on creating Pick Orders, please refer to the Creating a Pick Order topic.

Note: If the Allow Negative Quantities on Mobile Devices option is disabled, you will see a warning message if you attempt to Pick quantity from a Location that does not exist in the PDT database. The Allow Negative option must be set on the PC prior to creating the database. You can check the state of this option on the PDT by using the 7 key on the Main Menu to go to the PDT About screen.

New Locations can only be created during Pick when the Allow Negative Quantities on Mobile Devices option is enabled. If you are prompted to confirm a new Location that you believe should already exist in the database, press ESC to cancel, then return to the Main Menu to check Site Config. If the Location you entered exists only at a Site other than the currently selected Source Site, InventoryControl must treat that value as a new Location for the Source Site. Select a different Source Site in Site Config if that’s where you intended to perform this transaction.

The Allow Negative Quantities option applies to batch devices only. Mobile devices that are communicating with the database via a wireless connection will not allow negative quantity transactions regardless of the option settings.

Picking Inventory on the Windows Mobile Device:

1. From the Main Menu, tap the Pick icon. The Pick screen displays.

   ![Pick Screen]

   Note: On the Pick screen, you can enter characters manually, scan in data (see Entering
**Alphanumeric Data on the Windows Mobile Device** for details) or use the Search function.

2. Enter or search for the **Order #** that contains the item you are picking.

3. Enter the number of the item you are picking in the **Item #** field or click the i icon to search..
4. Enter the Quantity you want to pick. This is the number of kits you want to pick.

5. On the **Pick Kit** screen, enter the **Item number** of the component item you want to pick or click the i icon to search.

If you click the search icon, the following Kit Info screen will appear allowing you to select a component item. Only items contained in the selected Kit will appear on this screen.
The **Kit Info** screen displays all component items for this Kit item.

The **Item #** is the item number of the component item.

The **Total Qty** is the total quantity of this item in this kit multiplied by the quantity you want to pick. If there are 5 items in the kit and you have indicated you want to pick 12, 60 will display here (5 x 12 = 60). If there are 10 items in the kit and you want to pick 12, 120 will display here (10 x 12 = 120).

**Undo** will "undo" all of the transactions for that component item and reset the quantity processed back to zero.

Doubleclick on the desired item. The **Remove Kit** screen will reappear with the selected item populated in the **Item #** field.

6. Enter the **Site** and/or **Location** from which the item is being picked. If you have selected a **Primary Location** for this item (on the **Add/Edit Item** screen) the Site and Location fields will automatically populate. You can change these fields if needed.
7. Enter the **Quantity** of the Item to be picked. If you enter a higher quantity than is indicated on the Pick Order, a warning will appear, but you will be allowed to enter the higher quantity if you so choose.

**Note:** Notice that this is in eaches.

8. When all required information is entered, tap **OK**. The Item(s) is marked as Received and the **Receive** screen resets, ready for the next Item to be received.

Tapping the **Reset** button clears all fields and restores all available fields to the **Receive** screen.
display.

9. When you are finished with the **Add** screen, tap **Close** to return to **InventoryControl** main menu.

See the *Windows Mobile Device Troubleshooting* topic if you encounter errors while using this function.

---

### 20.11.17 Windows Mobile Device - Adjusting Inventory Quantities

The **Adjust** function is used to modify the inventory quantity for existing Items.

Inventory amounts can also be adjusted at the PC. See the **Adjusting Inventory** topic for more information.

The Allow Negative Quantities option applies to batch devices only. Mobile devices that are communicating with the database via a wireless connection will not allow negative quantity transactions regardless of the option settings.

**Adjusting Inventory:**

1. From the **Main Menu**, tab the **Adjust** icon.

   The **Adjust** screen displays.

   ![Adjust Screen]

   **Note:** You can enter characters manually, scan in data (see *Entering Alphanumeric Data on the Windows Mobile Device* for details) or use the Search function.
2. Enter the Item Number in the Item # field. In the example below, quantity for item 1001 at Site 1, Location 3, is being adjusted because one of these items is broken.

![Adjust Screen Example](Image)

Note that once the Item Number is selected, the Adjust screen displays only the fields that are necessary for adding this particular Item. For example, if you enter an Item that is tracked by serial number, the Serial # field will remain on the screen, but other fields such as Date Code and Pallet will no longer display. If you enter an Item that is not tracked, all tracking fields - PO, Supplier, Lot, Date Code, Serial # and Pallet - will no longer display.

3. Enter the Site and Location for the Item you want to adjust.
4. Enter the **Transaction Code** in the **Trans Code** field. You can type any code directly into this field. Enter the code your company has defined for this transaction.

5. Select either **By Count** or **By Diff** and enter an amount. Click the down arrow in the **By Count/By Difference** field to select one of these options. **By Count** is used when a literal count has been made of inventory. **By Difference** is used when you want to indicate the amount by which the inventory has increased or decreased. For example, if you have counted 15 of an item, but the software indicates you have 16, select **By Count** and enter 15. If, however, the software indicates you have 16 items and you break one, you can indicate this by entering **By Diff** and selecting a reason code that indicates breakage. Keep in mind that you cannot enter negative numbers. You must indicate whether the system should add or subtract quantity by selecting the appropriate Reason code. Reason codes are defined for you later in this topic.
6. The Reason field is only used when the adjustment is By Difference. You do not need to use this field if you choose By Count. If you do select By Difference in the Reason field, you must enter a Reason Code.

To search for a Reason Code, select the Search icon by the Reason field. The Adjust Code screen displays.
The first three codes in the screen are used when quantities are being added. The second three codes are used when quantities are subtracted.

- **Positive**: Indicates inventory was added.
- **Found**: Indicates inventory previously missing has been found.
- **Return**: Indicates the inventory is a returned item.
- **Negative**: Indicates inventory was removed.
- **Breakage**: Indicates inventory is broken.
- **Lost**: Indicates inventory is missing.

Select a code and tap **OK**.

7. When all required information is entered, tap **OK**. The item's quantity is adjusted and the Adjust screen resets, ready for the next Item to be adjusted.

   Tapping the **Reset** button clears all fields and restores all available fields to the Adjust screen display.

8. When you are finished with the Adjust screen, tap **Close** to return to InventoryControl main menu.

See the Mobile Device Troubleshooting topic if you encounter errors while using this function.

---

20.11.18 Windows Mobile Device - Auditing Inventory

Audit allows you to count the quantity of one or more items in your inventory when in Audit Mode.

Before you can conduct an audit using the mobile device, you must download a new database created while InventoryControl is in audit mode. For more information on turning on the audit mode on the PC, please refer to the topic Auditing Your Inventory. For more information on creating the database, please refer to the topic Windows Mobile Device - Setup Mobile Device.
Inventory can also be audited at the PC.

- **Switching to Audit Mode on the Windows Mobile Device**
- **Returning to Normal Mode on the Windows Mobile Device**

### Switching to Audit Mode on the Windows Mobile Device

1. To switch the device to Audit mode, you must first start an Audit on the PC side and send the new database to the mobile device. For information on this, please refer to the topic [Auditing Your Inventory](#).

2. Next, create a new mobile database, then synchronize the database with the Windows Mobile Device.

The mobile version of **InventoryControl** opens in Audit mode.

To perform an Audit, select **Audit**.

The **Audit** screen displays.
Enter an Item Number, Site and Location.

Note that once the Item Number is selected, the Audit screen displays only the fields that are necessary for Auditing this particular Item. For example, if you enter an Item that is tracked by serial number, the Serial # field will remain on the screen, but other fields such as Date Code and Pallet will no longer display. If you enter an Item that is not tracked by anything, all tracking fields - Lot, Date Code, Serial # and Pallet - will no longer display.

- Enter the Transaction Code in the Trans Code field. This is a free form text field. Enter the code your company has defined for this transaction.
Enter the **Quantity**.

![Audit Screen](image)

Tap **OK**.

The Audit Item is entered and the screen resets, ready for the next Item.

Note that when the screen resets, only the fields used for the Item you just entered display. To reset the screen so that all available fields display, tap **Reset**.

When you have finished entering Items for the Audit, close the **Audit** screen by tapping the **Close** button.

To send the Audit information to the PC, use the **Send PC Data** option. See [Windows Mobile Device - Send PC Data](#) for full details on this process.

---

**Returning to normal mode on the Windows Mobile Device**

1. After sending the Audit data to the PC and processing the data on the PC side, on the PC, select **Tools > Audit > End Audit**.

   A confirmation message displays.

2. Select **Yes** on the confirmation screen.

   **InventoryControl** returns to normal mode on the PC.

3. Next, create a new **mobile database**, then **synchronize** the database with the Pocket PC.
4. Close the mobile version of **InventoryControl**, then restart the application.

   The mobile version of **MobileInventory** opens in normal mode.

See the **Windows Mobile Device Troubleshooting** topic if you encounter errors while using this function.
20.11.19 Windows Mobile Device - Searching for Information

You can use the Search function to enter data in many of the Inventory Control fields.

Whenever the Search function is available, the Search icon displays next to a field.

To Search:

1. Enter full or partial information in the field you want to search, or leave it blank. Tap the Search icon to open the Search screen.

**Add**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Options</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item #:</td>
<td></td>
<td>i</td>
</tr>
<tr>
<td>Site:</td>
<td></td>
<td>i</td>
</tr>
<tr>
<td>Location:</td>
<td></td>
<td>i</td>
</tr>
<tr>
<td>PO:</td>
<td></td>
<td>i</td>
</tr>
<tr>
<td>Supplier:</td>
<td></td>
<td>i</td>
</tr>
<tr>
<td>Lot:</td>
<td></td>
<td>i</td>
</tr>
<tr>
<td>Date Code:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial #:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pallet:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qty:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** When searching for Items you can enter full or partial:

- **Item Numbers**
- **Serial Number** - If applicable. This option is not available on the Add or Receive screens.
- **Alternate Item Number**
- **Description**
- **All**

The Search screen opens. The example below is of the Search Items screen.
The title of the screen is specific to the field you select. For example, if you select the Search icon next to the Item field, the Search Items screen opens. If you select the Search icon next to the Site field, the Search Sites screen opens.

When searching for a Location, note that you must first select a Site, then the Location. If you do not select a Site first, the Search Location screen will be empty.

If more than 500 records are found, the message will display asking if you want to continue or further refine your search criteria to limit the search results. Click OK to go to the Find screen to refine your search.

2. To further refine your search, select a search option from the drop down, then enter full or partial information and tap Find.

By default InventoryControl RF searches using All of the search options.

Please note that InventoryControl and InventoryControl RF contains partial search capability. For example, if you are searching for item 1234, and enter 123, the application will return all items that contain the numbers 123 in the Item Number field.

If your entry returns no results, you can clear the search field, then tap Find to display all records.
3. Select the Item you want, then tap **OK**.

The **Search** screen closes and the item you selected displays in the appropriate field.
20.12 Windows Mobile Device Troubleshooting

This topic covers error messages and issues that may arise while using the Windows Mobile Device.

The subjects currently covered in this Troubleshooting topic are listed below. Click the subject that most closely matches what you are searching for.

Click the subject you want to troubleshoot:

Error/Alert Messages (listed in alphabetical order):

- Customer does not exist. Do you want to add this new customer?
- Customer is not valid
- Item doesn't exist
- Location doesn't exist. Do you want to add this new location?
- Location is not valid
- Pallet is not valid
- Please select one record from the list and click OK button to return to previous form
- Quantity is not valid
- Serial is not valid
- Site does not exist
- Source and destination sites are set to be the same...
- Supplier does not exist. Do you want to add this new supplier?
- The Adjust reason you entered is not valid
- The mobile device has unprocessed transactions...
- There is not enough quantity in stock to complete the transaction...

Issues

- Search screen is empty (no choices)

"The Adjust Reason You Entered is not Valid"

This message displays when you have selected By Difference and you have not entered a Reason code. You must either choose a Reason code or change your selection to By Count.

"Quantity is not valid."

This message displays when you have either not entered a number in the Quantity field, or you have enter alpha characters in the Quantity field.
**Customer**

"Customer is Not Valid"

This message displays if you leave the Customer field empty when it is a required field. You must enter a Customer in the Customer field.

"Customer does not exist. Do you want to add this new customer: <CUSTOMER NAME>?

This message displays if you enter a Customer in the Customer field that does not currently exist in the mobile database. For more information on adding customers, please refer to the Windows Mobile Device - Adding Customers topic.

**Get Data from PC**

"The mobile device has unprocessed transactions. Please process them on the PC database first, then you can get new database records from the PC side."

This message indicates there are database records that have been sent from the device to the PC, but the data has not been processed on the PC side. Be sure you have completed the entire Send PC Data process, including processing the mobile device data in the Pending Uploads wizard.

**Items**

**Messages**

"Item doesn't exist. Hard Drive 500."

Leaving the Item Number screen blank.

In screens where an Item Number is required, you will receive this message if you leave the Item Number field blank and tap OK.
Locations

Messages

"Location is not valid."

This message displays if you do not enter a Location in the Location field or too many characters have been entered in the Location field. You must enter a Location in the Add, Remove, Move, Adjust and Stage screens. You can add a new Location on the mobile device if the one you need is not currently in the mobile device database.

"Location does not exist. Do you want to add this new location: <LOCATION NAME>?"

This message displays if you enter a Location that does not exist in the mobile device database. Click here if you want to add this Location to the database.

Move

Messages

"Source and Destination sites are set to be the same. Destination site and location needs to be different than the Source Site and Location."

This message indicates you selected the same Site and Location for both the Source from which you were moving the Item and the Destination to which you were moving the Item. You cannot have the same Site and Location for both the Source and the Destination.

You must either change the Site and Location in the From Site and From Loc fields, or change the Site and Location in the To Site and To Loc fields.

For example, if you entered Site 201 and Location A20 in both the Source and Destination Site/Location fields, you are trying to move an Item from its current Location to its current Location.

If the Item is currently located at Site 201, Location A20, to move it to another site you must enter a different Destination, such as Site 100, Location B13.
<table>
<thead>
<tr>
<th><strong>Pallet</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Messages</strong></td>
<td></td>
</tr>
<tr>
<td>&quot;Pallet is not valid.&quot;</td>
<td></td>
</tr>
<tr>
<td>This message displays if:</td>
<td></td>
</tr>
<tr>
<td>• The Item Number you entered is tracked by Pallet and you have not entered a Pallet in the <strong>Pallet</strong> field.</td>
<td></td>
</tr>
<tr>
<td>• The Pallet you entered is not the correct Pallet by which the Item you entered is tracked.</td>
<td></td>
</tr>
<tr>
<td>• A Pallet that does not exist has been entered in the <strong>Pallet</strong> field.</td>
<td></td>
</tr>
<tr>
<td>If a Pallet is required, you must enter the Pallet by which the entered Item Number is tracked.</td>
<td></td>
</tr>
</tbody>
</table>
Messages

"Please select one record from the list and click OK button to return to previous form."

This message displays if you do not select any record in the Search screen and then tap OK.

You must either select a record in the Search screen, then tap OK, or tap Cancel to exit the Search screen without selecting a record.

List area in Search screen is empty (no choices presented).

If you click the Search icon next to a field in any screen in the mobile version of InventoryControl and the Search screen offers no list of choices, then no data for this field has been downloaded from the PC. You can add three types of records on the mobile device: Locations, Suppliers and Customers.

For other records, you must add data from the PC side, then send the new data to the mobile device.

Topics Related to Adding Data from the PC Side:

- Create New Purchase Order
- Create New Pick Order
- Create New Item
- Create New Manufacturer
- Create New Site
Serial Number

Messages

"Serial # is not valid."

This message displays if:

- The Item Number you entered is tracked by Serial Number and you have not entered a Serial Number in the Serial # field.
- The Serial Number you entered is not the correct Serial Number by which the Item you entered is tracked.
- A Serial Number that does not exist has been entered in the Serial # field.
- If a Serial Number is required, you must enter the Serial Number by which the entered Item Number is tracked.

Sites

"Site does not exist."

This message displays if you enter a Site that is not in the database.

You cannot create Sites on the mobile device. You can only create Sites on the PC side. You must either select another Site, or create the new Site on the PC side, download this new data to the device, and then select it on in the appropriate screen on your mobile device.

Stock

Messages

"There is not enough quantity in stock to complete the transaction. Quantity remaining: 0."

This message will display if you attempt to Remove, Move or Adjust a greater quantity of an Item than is currently in stock.

If there is an adequate quantity of the Item at a different Site and Location, you can select the Item from that Site and Location. If the quantity in all Sites and Locations is less than the amount you are trying to Remove, Move or Adjust, you will not be able to process this Item until enough a large enough quantity of the Item has been stocked.
Supplier

"Supplier does not exist. Do you want to add this new supplier: <SUPPLIER NAME>?"

This message displays when you enter a Supplier that is not currently in the mobile device database in the Supplier field. For more information on adding suppliers on the mobile device, please refer to Windows Mobile Device - Adding Suppliers.
Chapter 21 - Glossary

Adjust - This term refers to adjusting the quantity of inventory at a specified location. Adjust is like a "mini" Audit and will update the quantity using FIFO (First In First Out) to make the total equal to the quantity you enter here. The Adjust function is useful if too much or too little quantity is accidentally entered for an item (on a mobile device, for example), inventory is lost, found, broken, etc. and you need to quickly correct the quantity for that item. Adjusting is different from an Audit in that the Audit function makes other functions of the software, such as adding inventory, unavailable to ensure inventory is not added or removed while you are doing the counts. All features are still available when adjusting inventory.

Archive - The Archive Transaction feature allows you to archive inactive transactions prior to a specified date. Archiving old information keeps your database running quickly and efficiently.

Assembly Item - (Pro and Enterprise versions only.) Assembly items are created when you combine two or more existing items to create a new item. You will use the Assembly item type when you want to "build" several of the new items to have on hand in your inventory.

Audit - Auditing your inventory means you are counting the inventory you actually have on hand and comparing that number with what is listed in the software. This allows you to ensure you have actual counts in the system. Audit Mode allows you to check the counts of all your inventory while disabling the Add, Remove, Move, Adjust, Check-In and Check-Out features to make sure inventory counts in the system do not change while you are performing the audit. If you are using mobile devices, you can use them simultaneously with the PC to perform an audit by downloading the database in audit mode to each device. Audit Mode features a simple Audit screen that allows you to enter your counts for inventory in each location and compares these to the counts already in the system. You can then view the Complete Audit screen to review any discrepancies between your counts and what was in the system. At the click of a button you can reconcile the counts or you can select certain transactions to accept or reject. This software also comes equipped with several Audit Reports that allow you to review a variety of information at-a-glance.

Barcode - A barcode is graphical representation of a set of numeric or alphanumeric characters that can be read by a barcode scanner. For a detailed explanation of barcodes, please refer to the topic What is a Barcode?.

Build Assembly - (Pro and Enterprise versions only.) The function that allows you to build your assembly item. Building Assembly Items can be thought of as the "manufacturing" portion of the Assembly Item feature. When you Build an Assembly Item, the on hand amounts for the sub-items are reduced by the number needed to make the Assembly Item, and the on hand amount for the Assembly Item is increased. Assembling/Building Assembly Items increases inventory for the Assembly Item in the same way that Adding increases inventory for other item types.

Check-In - This feature does not apply to WaspNest Inventory. Check-in inventory means you are returning inventory that has been "checked-out", or assigned, to customer back into your on-hand inventory.

Check-Out - This feature does not apply to WaspNest Inventory. InventoryControl gives you the ability to check-out, or assign, inventory to a customer for a specified (or open-ended) amount of time. This removes the inventory from your on-hand amounts until it is checked back in. Items that are check-out cannot be permanently removed from your inventory until they are checked back in.
**Disassemble** - (Pro and Enterprise versions only.) The process of **Disassembling Assembly Items** will reduce your inventory for the Assembly Item and increase your inventory of the associated sub-items. You will be **Removing** inventory for the Assembly Item and **Adding** inventory to the sub-items, unless the sub-item has been marked to be scrapped. Scraping an item means that inventory will be reduced for that item during the Disassemble process. You can mark the sub-item as "Always Scrap" during the Assembly Item creation process so that it will always be scrapped when disassembled. This is useful for packaging materials, such as boxes, that will not be returned to inventory.

**FIFO** - An abbreviation for first-in, first-out, FIFO is a method employed in accounting for the identification and valuation of the inventory of a business. This is the inventory method the system uses when adjusting or removing inventory. FIFO assumes that the first goods added are the first removed.

**Inventory** - Inventory is the amount or quantity you have of a particular item.

**Inventory Item** - An inventory item is anything you want to track the location and quantity of. The term item is used in InventoryControl to mean anything that is put into stock (see Item entry below).

**Item** - Items represent the actual material or good that you will have in your inventory. For example, you might create an Item entry for Mouse - Wireless. Then you can add inventory, or quantity, to that Item. If you are using the Enterprise or Professional version of this software, you can also create items that are non-inventory. This is useful if you need to create an item for marketing pamphlets, counter displays or anything you need to have, but for which you don't need to track quantity.

**Kit Item** - (Pro and Enterprise versions only.) **Kit items** are a group of items that are sold together, but are still considered separate inventory items. As opposed to Assembly Items, you cannot add inventory, move or check out/in **Kit Items**. While Assembly Items can be created in advance (pre-assembled) and kept in inventory, **Kit Items** are created at pick or sale time.

**Location** - Locations are contained with a Site and represent the place where inventory is kept. A location is typically shorthand for a physical place such as a shelf in your warehouse. Commonly used conventions include Location codes like this:

```
01 02 05   (for Row #, Shelf #, Bin #)
```

Another example would be to create Site labeled Warehouse 1 containing a Locations labeled Bin1 and Bin 2.

**Move** - The Move function allows you to move inventory from one location to another.

**Non-Inventory Item** - A non-inventory item is anything you order or receive, but do not want to track the location and quantity of. An example of a non-inventory item might be marketing materials like a product flyer that is taken to trade shows or put in product boxes. Once you are out you may never buy more of that item and you don't need to know how many are left. You may need to include non-inventory items on a purchase order and verify receipt to have a payment paper trail but you do not need to keep track of the item after it is received. InventoryControl allows you to add non-inventory items onto purchase orders in the Pro and Enterprise versions.

**Order Unit** - This is the supplier's unit of measure used when ordering an item. This may be box, pallet, etc. This is different from the "Eeaches" stocking unit. For example, "jar" may be the stocking unit, but the supplier may ship the item in boxes containing 10 jars.
Site - The Site is a broad term containing one or more Locations. Inventory is assigned to the locations within the site. For example, you might create a Site labeled Warehouse 1 containing a Locations labeled Bin 1 and Bin 2.

Stocking Unit - This is the portion by which an item's quantity will be tracked. This unit represents "Eaches", meaning how you want each item of this type to be measured. (Examples: bag, barrel, basket, block, bottle, box, carton, container, drum, gallon, jar, pack, package, pallet, section, tub, vial, etc.) You can designate a different stocking unit for each item in your system, if desired.

Track By - This feature does not apply to WaspNest Inventory. This software allows you to track your inventory by several fields, if desired. Track By options are: Serial Numbers, Lot, Date Code and/or Pallet. Tracking allows you to follow the movements of inventory from receiving, adjusting, moving, checking out, etc.

It is important that you determine how you want to track each Item. Typically, small Items that are all the same may not need to have any Tracked Bys selected. Items such as printers may need to be tracked by Serial Number, so returns and maintenance can be properly tracked. Medical supplies or food may need to be tracked by Date Code and/or Lot.

Transaction Code (TransCode) - Transaction Codes can be any code your business assigns to certain types of Adjustment transactions. Assigning these codes can help you with reporting as each type of adjustment (breakage, return, etc.) can be given it's own code. This software does not contain any preset codes to give you the opportunity to assign a code that best suits your needs, and to allow the entry of codes you already use in your business for these types of transactions. Transaction codes are entered on the Adjust screen.
Index

A
About Screen ...................................................36
About Screen - WDT2200 .................................315
Adding Inventory ................................................135
Adding Inventory on the WDT2200 ...............317
Adding Inventory on the WMD ..........................443
Adding Notes ....................................................54
Adding Users to Security .................................230
Adjusting Inventory on the WDT2200 .............329
Admin Information ............................................24
Administration Menu Overview ......................225
Administrator Functions - Backing Up the Database ...........................................236
Adjusting Inventory Amounts ..........................156
Adjusting Inventory on the WDT2200 ............336
Advanced Find ...............................................288
Alerts Menu .....................................................52
Allow Negative Quantities on the Mobile Device .................................................238
Allow Over Pick ................................................238
Allow Over Receive ...........................................238
Always Show Email Destination List ...............238
Archiving Transactions .................................249
Assembly Items ..............................................89
Assembly Items - Building ..........................103
Assembly Items - Disassembling ....................107
Assembly Items - Editing .................................84
Assembly Items Examples ..................................88
Assembly Items Overview ...............................88
Audit Flow Overview ...................................278
Audit Reports ..................................................278
Audit Screen - Using ....................................278
Auditing Inventory using the WMD ...............477
Auditing Your Inventory ...............................278
Automatic Customer Number - Setting ..........238
Automatic Item Numbers - Setting ...............238
Automatic New ............................................238
Automatic Notification of Low Order Items ....238
Automatic Serial Numbers .............................73
Average Costing ...........................................16

B
Backing Up the Database ................................236
Barcode Best Practices ...................................9
Best Practices ................................................9
Build Assembly Screen .................................103
Building Assembly Items ............................103
Business Examples - Overview .......................25
Business Examples - Setting up Suppliers .....32

495
C
Changing Your Password ..................................42
Check for Alerts.............................................52
Check for Software Updates .............................238
Check in on Windows Mobile Device ...............449
Check Out - Windows Mobile Device ............448
Checking for Software Updates .......................49
Checking In Inventory ....................................148
Checking Out Inventory ..................................152
Close New Form ..........................................238
Companies - Examples ..................................25
Company Information - Entering .....................227
Connections - Troubleshooting Wireless Connection .............................................426
Copying User Security ....................................230
Cost Tracking ..............................................16
Costing - Average Costing ................................16
Costing - Cost Tracking ..................................16
Costing - Using in InventoryControl ...............16
Counting Inventory .......................................278
Creating Kit Items .........................................84, 163
Creating New Assembly Items .........................89
Creating New Customers ................................57
Creating New Items .......................................60
Creating New Locations ..................................74
Creating New Manufacturers ............................76
Creating New Pick Orders ...............................175
Creating New Sites .......................................55
Creating New Suppliers ..................................80
Custom Fields - Using ....................................22, 253
Customer List Example ...................................127
Customers - Adding New on the WMD ..........439
Customers - Creating New ..............................57
Customers - Editing .......................................86
Customizing Numbers .....................................210
Customizing Pick Order Numbers .....................210
Customizing Purchase Order Numbers .............210
D
Data Cycle - Windows Mobile Device .............386
Data Cycle - Wireless Device ..........................386
Data fields - Related .......................................267
Database - Backing Up ....................................236
Database - Creating on the WDT2200 .............294
Database - Restoring .....................................237
Database - Sample ............................................2
Decimal Places .............................................238
Deleting Purchase and Pick Orders ................199
Designing and Labeling Sites and Locations ...12
Details Screen - WDT2200 .........................325
Disassembly ...............................................107
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lists - Site List Example</td>
<td>125</td>
</tr>
<tr>
<td>Lists - Supplier List Example</td>
<td>129</td>
</tr>
<tr>
<td>Lists - Transaction List Example</td>
<td>132</td>
</tr>
<tr>
<td>Lists - Working With</td>
<td>112</td>
</tr>
<tr>
<td>Location Labels - Printing</td>
<td>218</td>
</tr>
<tr>
<td>Location List Example</td>
<td>126</td>
</tr>
<tr>
<td>Locations - Adding on the WMD</td>
<td>440</td>
</tr>
<tr>
<td>Locations - Creating New</td>
<td>74</td>
</tr>
<tr>
<td>Locations - Designing and Labeling</td>
<td>12</td>
</tr>
<tr>
<td>Locations - Editing</td>
<td>85</td>
</tr>
<tr>
<td>Locations Business Examples</td>
<td>30</td>
</tr>
<tr>
<td>Logging On</td>
<td>1, 34</td>
</tr>
<tr>
<td>Logging On to the WDT2200</td>
<td>307</td>
</tr>
<tr>
<td>Logging Out</td>
<td>48</td>
</tr>
<tr>
<td>Low Stock Level Notification</td>
<td>51</td>
</tr>
<tr>
<td>Main Screen Overview</td>
<td>38</td>
</tr>
<tr>
<td>Manage Licenses</td>
<td>36</td>
</tr>
<tr>
<td>Manage Payment Methods</td>
<td>202</td>
</tr>
<tr>
<td>Manage Shipping Methods</td>
<td>206</td>
</tr>
<tr>
<td>Manually Adding Inventory</td>
<td>135</td>
</tr>
<tr>
<td>Manufacturer List Example</td>
<td>128</td>
</tr>
<tr>
<td>Manufacturers - Editing</td>
<td>86</td>
</tr>
<tr>
<td>Manufacturers - New</td>
<td>76</td>
</tr>
<tr>
<td>Max Row Count</td>
<td>238</td>
</tr>
<tr>
<td>Mobile Device - Wireless Connection</td>
<td>418</td>
</tr>
<tr>
<td>Mobile Device Setup - WDT2200</td>
<td>291</td>
</tr>
<tr>
<td>Mobile Devices - Edit Transactions</td>
<td>415</td>
</tr>
<tr>
<td>Mobile Devices - Pending Upload Screen</td>
<td>411</td>
</tr>
<tr>
<td><strong>Mobile Devices - Supported</strong></td>
<td>24</td>
</tr>
<tr>
<td>Mobile Devices - Troubleshooting Wireless Connections</td>
<td>426</td>
</tr>
<tr>
<td>Moving Average</td>
<td>16</td>
</tr>
<tr>
<td>Moving Inventory</td>
<td>144</td>
</tr>
<tr>
<td>Moving Inventory on the WDT2200</td>
<td>343</td>
</tr>
<tr>
<td>Moving Inventory on the WMD</td>
<td>450</td>
</tr>
<tr>
<td>New - Locations</td>
<td>74</td>
</tr>
<tr>
<td>New - Manufacturers</td>
<td>76</td>
</tr>
<tr>
<td>New - Pick Order</td>
<td>175</td>
</tr>
<tr>
<td>New - Sites</td>
<td>55</td>
</tr>
<tr>
<td>New - Suppliers</td>
<td>80</td>
</tr>
<tr>
<td>New Customers</td>
<td>57</td>
</tr>
<tr>
<td>New Items</td>
<td>60</td>
</tr>
<tr>
<td>Notes - Adding</td>
<td>54</td>
</tr>
<tr>
<td>Numbers - Customizing</td>
<td>210</td>
</tr>
<tr>
<td>Numbers - Customizing Pick and Purchase Order Numbers</td>
<td>210</td>
</tr>
<tr>
<td>Options Screen</td>
<td>238</td>
</tr>
<tr>
<td>Orders - Deleting Purchase and Pick Orders</td>
<td>199</td>
</tr>
<tr>
<td><strong>P</strong></td>
<td><strong>R</strong></td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Packing Slip CC Emails ................................238</td>
<td>Purchase Order CC Emails ................................238</td>
</tr>
<tr>
<td>Packing Slip for Session ................................238</td>
<td>Purchase Order FAQ ........................................198</td>
</tr>
<tr>
<td>Password - Changing .......................................42</td>
<td>Purchase Order List Example ...............................131, 193</td>
</tr>
<tr>
<td>Payment Methods - Managing ..............................202</td>
<td>Purchase Order Numbers - Customizing ..........210</td>
</tr>
<tr>
<td>Pending Uploads Screen ......................................411</td>
<td>Purchase Order/Receiving Overview ................185</td>
</tr>
<tr>
<td>Pick Order - Creating New .................................175</td>
<td>Purchase Orders - Deleting ..............................199</td>
</tr>
<tr>
<td>Pick Order CC Emails ........................................238</td>
<td>Purchase Orders - Editing .................................87, 192</td>
</tr>
<tr>
<td>Pick Order List Example .................................130, 180</td>
<td>Receive/Pick Menu Overview ................................200</td>
</tr>
<tr>
<td>Pick Order Numbers - Customizing ......................210</td>
<td>Receiving Inventory .........................................194</td>
</tr>
<tr>
<td>Pick Order Overview .........................................174</td>
<td>Receiving Inventory on the WDT2200 ..........380</td>
</tr>
<tr>
<td>Pick Orders - Deleting .......................................199</td>
<td>Receiving on the WMD .....................................461</td>
</tr>
<tr>
<td>Pick Orders - Editing .........................................86, 179</td>
<td>Reconciling Your Counts - Auditing ................278</td>
</tr>
<tr>
<td>Picking Inventory on the WDT2200 ......................367</td>
<td>Related Data Fields .........................................267</td>
</tr>
<tr>
<td>Picking Items on the WMD ....................................465</td>
<td>Remote printing ..............................................418</td>
</tr>
<tr>
<td>Picking Kit Items on the WMD .............................468</td>
<td>Removing Inventory .........................................140</td>
</tr>
<tr>
<td>Picking Orders - How to ....................................181</td>
<td>Removing Inventory on the WMD ....................453</td>
</tr>
<tr>
<td>Pinning on the WMD ..........................................438</td>
<td>Removing Kit Items ........................................170</td>
</tr>
<tr>
<td>Previously Processed Mobile Data ....................238</td>
<td>Report Selection ...........................................220</td>
</tr>
<tr>
<td>Printers - Selecting ........................................214</td>
<td>Report Viewer ...............................................221</td>
</tr>
<tr>
<td>Printing from a wireless device .........................418</td>
<td>Resetting the WDT2200 ..................................308</td>
</tr>
<tr>
<td>Printing Labels ............................................218</td>
<td>Restoring the Database ...................................237</td>
</tr>
<tr>
<td>Printing Labels - Selecting a Printer ..................214</td>
<td>S</td>
</tr>
<tr>
<td>Privileges - Setting Security ............................230</td>
<td>Sample Database ..............................................2</td>
</tr>
<tr>
<td>Profiles - User Security Profiles .......................230</td>
<td>Search - on the WMD ......................................482</td>
</tr>
</tbody>
</table>
Searching for Information..........................286
Security - Adding Users ............................230
Security - Copying User Profiles .................230
Security - Editing Users ............................230
Security - Inactive Users ...........................230
Security - Setting Site Security .................230
Security Screen .....................................230
Selecting Reports ...................................220
Selecting Sites .......................................45
Serial Numbers - Automatic .......................73
Setting Security Privileges .......................230
Setup Company Information .....................227
Shipping Methods - Managing ..................206
Show Cost Information During Receiving .......238
Show Warning Messages .........................238
Site Configuration - WDT2200 .................315
Site Configuration on the WMD ...............437
Site List Example ................................125
Site Security ........................................230
Sites - Creating New ...............................55
Sites - Designing and Labeling ...............12
Sites - Editing .......................................85
Sites - Selecting .....................................45
Sites and Locations Business Examples ......30
Sites Business Examples .......................30
SMTP Password ....................................238
SMTP Port ............................................238
SMTP Server ........................................238
SMTP SSL/TSL ....................................238
SMTP User ..........................................238
Software Updates - Checking For .............49
SQL Server Backup Location ...................238
Stock Level - Notice of Low .....................51
Supplier List Example ................................129
Suppliers - Adding New on the WMD .......442
Suppliers - Business Examples .................32
Suppliers - Editing .....................................86
Suppliers - New .........................................80
Supported Mobile Devices .......................24
Sync - WMD ............................................393
System Administrator Information ..........24
T
Tracking Cost .........................................16
Transaction Code List .............................238
Transaction List Example .......................132
Transactions - Archiving .........................249
Troubleshooting the WMD .....................485
Troubleshooting Wireless Connection .......426
U
Update License Screen ............................43
Inventory Control Printable Help

Updates - Software - Checking For...................... 49
Users - Adding to Security .............................. 230
Users - Editing in Security .............................. 230
Users - Making Inactive ................................. 230

V
Valuation ..................................................... 16
Viewing Reports ............................................ 220, 221

W
WDT2200 - About Screen ................................. 315
WDT2200 - Adding Inventory ............................ 317
WDT2200 - Adjusting Inventory ........................ 329
WDT2200 - Auditing Inventory .......................... 336
WDT2200 - Creating the PDT Database.............. 294
WDT2200 - Data Cycle .................................... 307
WDT2200 - Details Screen ............................... 325
WDT2200 - Interface ....................................... 314
WDT2200 - Logging On .................................... 307
WDT2200 - Main Menu .................................... 313
WDT2200 - Moving Inventory ............................ 343
WDT2200 - Picking Inventory ............................ 367
WDT2200 - Picking Kit Items ............................. 373
WDT2200 - Receiving Data from the PDT.......... 304
WDT2200 - Receiving Inventory ......................... 380
WDT2200 - Removing Inventory ......................... 351
WDT2200 - Removing Kit Items ......................... 359
WDT2200 - Resetting ..................................... 308
WDT2200 - Sending Data to the PDT ............. 299
WDT2200 - Setting the Date and Time .......... 310
WDT2200 - Setup ......................................... 291
WDT2200 - Site Configuration .......................... 315
WDT3250II - Troubleshooting Wireless Connection ........................................ 426
Windows Mobile Device - Check In Inventory .... 449
Windows Mobile Device - Check Out ............... 448
Windows Mobile Device - Data Cycle ............... 386
Wireless Connection ..................................... 418
Wireless Mobile Device - Data Cycle ............... 386
Wireless Printing ......................................... 418
WMD - About Screen ..................................... 436
WMD - Adding Inventory ................................. 443
WMD - Adding Locations ................................. 440
WMD - Adding New Customers ......................... 439
WMD - Adding New Suppliers .......................... 442
WMD - Adjusting Inventory ............................ 473
WMD - Auditing Inventory .............................. 477
WMD - Default Settings ................................. 389
WMD - Device Synchronization ....................... 393
WMD - Enabling the Scanner ......................... 389
WMD - Entering Alphanumeric Data ................. 392

502
Wmd - Interface..............................................387
WMD - Moving Inventory.................................450
WMD - Picking Items........................................465
WMD - Picking Kit Items ................................468
WMD - Pinning Fields ....................................438
WMD - Rebooting..........................................389
WMD - Receiving Inventory ..............................461
WMD - Removing a Kit Item............................458
WMD - Removing Inventory..............................453
WMD - Retrieving Data from the Device .......409
WMD - Searching for Information .................482
WMD - Sending the Database from the PC...403
WMD - Setup the Mobile Device......................394
WMD - Site Configuration...............................437
WMD - Troubleshooting.................................485
Working with Lists.......................................112
WPA1000 - Troubleshooting Wireless
Connection ..................................................426